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RESUMEN:| | 3 fotogrametria ha experimentado un cambio importante por la irrupcion de

nuevo software de facil manejo y coste reducido que puede favorecer su
aplicacién para el estudio de multiples problemas. El presente proyecto analiza
la aplicacién de las técnicas de fotogrametria convergente y los programas
informaticos actualmente disponibles para el estudio de muros en peligro de
colapso. Se comparan diferentes opciones para la obtencion de modelos de
nubes de puntos, mallados con textura fotografica y ortofotografias.
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software easier to use and lower in price. This thesis analyzes the application of
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1.1 PRESENTACION

El presente trabajo se corresponde con un proyecto fin de carrera de la titulacion de Ingenieria
Técnica en Topografia.

El proyecto se ubica en el ambito del Intensive Program Erasmus: “Geometric Documentation
of Heritage: European integration of Technologies”; llevado a cabo en el Monasterio de San
Prudencio de Monte Laturce enclave perteneciente al municipio de Clavijo, comunidad
auténoma de La Rioja, durante el mes de Julio de 2010.

La idea original surge por parte del tutor, al mostrarle nuestro interés por la posibilidad de
realizar un proyecto sobre el Monasterio de San Prudencio, debido a nuestra asistencia al
Programa Erasmus citado anteriormente.

Se decide finalmente la elaboracidn de la documentacién, por métodos fotogramétricos, de las
zonas del Monasterio que se encuentran mas degradadas y a las cuales se les puede considerar
en peligro de derrumbe. De esta forma se han recogido datos para que la existencia de dichos
elementos arquitectonicos en peligro, queden debidamente documentados para posteriores
usos o como un mero referente de su existencia para la posterioridad.

El proyecto fin de carrera recibe finalmente el titulo: “Documentacion y representacion de
paramentos verticales en riesgo de colapso. Aplicacion en el Monasterio de San Prudencio
(Clavijo, La Rioja)”.

Este proyecto se ha realizado junto con otro elaborado por mi compariera del Laboratorio de
Documentacién Geométrica del Patrimonio’, Raquel Méndiz Mateo; los cuales se
complementan, ya que tienen un foco de accién comun con algunos objetivos comunes y otros
diferentes.

Se han realizado conjuntamente las fases de planificacién y de toma de datos en campo, asi
como el inicio del aprendizaje de los diferentes software, dejando el resto de los apartados
para elaborarlos de forma individual.

1.2 JUSTIFICACION

La necesidad de la elaboracidon del presente proyecto, surge del andlisis del estado
arquitecténico del edificio en el que se realizan los trabajos en el IP Geometric Documentation
of Heritage.

Un simple vistazo al Monasterio de San Prudencio es suficiente, para darse cuenta del estado
de degradacion al que se ha visto sumido el monumento.

Existen ciertos muros del complejo arquitectdonico, que se encuentran en un estado bastante
lamentable, los cuales corren en la actualidad un riesgo casi inminente de derrumbe. De hecho
entre una visita y otra al monasterio, durante la ejecucién de este proyecto, hemos podido

1 1% . . .
También referido, en ocasiones, en este proyecto por el acrénimo LDGP.
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constatar el desprendimiento de ciertos elementos de los muros; lo que evidencia alin mas si
cabe, la necesidad de abordar con premura ciertos trabajos de documentacién y conservacién.

El patrimonio perdido no tiene ya solucién, pero el que ha perdurado hasta nuestros dias, en
opinién de todos los que hemos trabajado en el yacimiento; merece ser documentado,
conservado y puesto en valor.

Por este motivo los precursores y elaboradores de este proyecto hemos creido necesario la
documentacién de las zonas del Monasterio de San Prudencio en peligro mds inminente de
desaparecer.

1.3 LOCALIZACION DEL MONASTERIO?

La localidad de Clavijo se encuentra en la Comunidad Auténoma de La Rioja, mas
concretamente en la Subcomarca del Valle Oriental del Iregua, a unos 16 kildmetros de la
capital de dicha comunidad, Logrono. Al Norte linda con Alberite, al Este con Ribafrecha, al Sur
con Trevijano, Leza del Rio Leza y Nalda, y al Oeste con Albelda de Iregua.
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Imagen 1.1:4Mapa de la zona del M\onnaster/o de.S&n Prudencio
Las ruinas del Monasterio de San Prudencio de Monte Laturce se ubican en el barranco de
Fuentezuela, un afluente del rio Leza, entre las localidades de Clavijo y Ribafrecha. El Monte
Laturce, también llamado Collado de Clavijo, es la cumbre de las Pefias de Clavijo, situadas en
el municipio homdnimo. Bajo la cumbre, en la vertiente sur se haya la ermita de Santiago y en
la cima de dicho monte se encuentra una gran cruz de cemento erigida en conmemoracion de
la batalla de Clavijo.

’ Este apartado ha sido redactado por mi compariera del LDGP Raquel Méndiz.




Documentacion y representacion de paramentos verticales en riesgo de colapso.
Aplicacién en el Monasterio de San Prudencio (Clavijo, La Rioja). 1. INTRODUCCION

Imagen 1.2: Vista general del monasterio desde el camino de acceso por Ribafrecha

El Monte Laturce es un enclave privilegiado debido a la belleza de su paisaje. Se ubica entre
tres valles, inundados de historia y siempre vinculados a la cultura y crianza de grandes vinos.
Estos tres valles son el Valle del Ebro, el del Iregua y el del Leza.

El rio Iregua nace en la Sierra de Cebollera. Sus principales afluentes son el rio Mayor, que
entra por la izquierda y el rio Lumbreras por la derecha, pero tiene muchos arroyos a ambos
lados, para finalmente desembocar en el rio Ebro a su paso por Logrofio. Por su parte el rio
Leza nace en la Sierra de Cameros y es poseedor de numerosos afluentes, de los que cabe
destacar el rio Jubera. Desemboca en el margen derecho del rio Ebro a su paso por el
municipio riojano de Agoncillo.

Desde la cima del Monte Laturce se puede contemplar un maravilloso paisaje. Al fondo se
puede observar Logrofio, en el centro de la llanura formada por los rios Ebro e Iregua. A mano
izquierda destacan Navarrete, parte del municipio de Ribafrecha y un poco mas arriba Leza de
Rio Leza y la muralla rocosa de Zenzano. Mas al fondo infinidad de poblaciones a las orillas del
Ebro y entre la niebla se observa el Ledn dormido y la sierra de Codés, y mas lejos aun vy si el
dia esta despejado se pueden observar los Picos de Europa.

El acceso al Monasterio puede efectuarse indistintamente por el Valle de Leza o por Clavijo. El
primer acceso es relativamente facil y comienza en la carretera de Ribafrecha a Soto de
Cameros, y tiene una longitud aproximada de 3 kilémetros en pendiente ascendente que nos
conducen al pie del monasterio. El segundo es quizas mds complicado y al mismo tiempo mas
ameno. La salida en este caso es desde el mismo municipio de Clavijo, llegando casi al final de
la localidad y sin comenzar a subir a la Ermita de Santiago hay un camino recién arreglado a
mano derecha y descendiendo por él durante aproximadamente media hora nos encontramos
en la muralla norte del Monasterio de San Prudencio.
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1.4 HISTORIA Y ARQUITECTURA DEL MONASTERIO®

No existe un acta fundacional del Monasterio de San Prudencio, por lo que no se puede
conocer la fecha exacta. El primer documento conservado data del afio 950. En esta fecha el
Abad abdica y los monjes se entregan al abad del monasterio de San Martin de Albelda.

Posiblemente el monasterio surgié con el animo de repoblar y aculturar el valle del rio Leza.

La tradicién vincula el origen del monasterio a la existencia de San Prudencio de Armentia, que
habia muerto en Osma. Se decide colocar su cuerpo en una caballeria y enterrar el cuerpo en
el lugar en el que se detuviera el animal. Este seria Monte Laturce donde los monjes que le
acompaiaban levantaron la iglesia denominada inicialmente de San Vicente.

El Monasterio se desliga de Albelda, y a mediados del siglo XI hasta el afio 1181 acat6 las reglas
cistercienses.

Durante unos cuantos afios el monasterio recibe varias donaciones. A partir de 1162 existe una
laguna en las fuentes documentales, este posiblemente sufriéd un retroceso al ser restaurada
por los sefiores de Cameros la abadia de Santa Maria de Rute.

El protagonismo del monasterio de San Prudencio resurge a partir de 1176 coincidiendo con el
restablecimiento de las fronteras entre Navarra y Castilla.

En 1203 el sefior de Cameros confirma el monasterio a la orden del Cister y lo coloca bajo
proteccién real. El Papa Inocencio lll le confirma todas sus posesiones. EI monasterio
permanecera en ese estado de autonomia hasta su desaparicién en el siglo XIX.

Entre las ruinas que han perdurado hasta nuestros dias, estan los restos de dos iglesias
medievales, una de época romadnica levantada o restaurada en el siglo XlIl, denominada iglesia
baja o de Yuso; y la iglesia gdtica colindante por el Este y que se sitla en un nivel superior
recibiendo el nombre de iglesia Alta.

El siglo XVII se reconstruye la arquitectura del conjunto de habitaciones monasteriales, del cual
queda en pie una pared orientada al Sur, asi como restos de otra iglesia levantada en esa
época.

La primera iglesia de la que se tiene constancia se trata de una nave dividida en tres tramos
cubierta por una bdveda de cafién ligeramente apuntado. Hay que entrar desde el nivel
superior donde se ubicaba la iglesia gética, quedando la primera a modo de cripta.La puerta de
acceso a la iglesia Baja corresponderia a un arco ciego doblado” y apuntado que se encuentra
al oeste de la construccion. Posiblemente los monjes, levantaron o reedificaron después del
1181, la iglesia Baja, al restablecerse San Prudencio.

A partir de esa iglesia se construyd otra colindante por el Este, como una prolongacién
construida en un nivel superior. Esta nueva iglesia estaba en construccion en el afio 1381.

 GARCIA GUINEA, M. A., PEREZ GONZALEZ, J.M. y otros (2008). Enciclopedia del Romdnico en La Rioja. La Rioja.
Volumen I. Fundacién Santa Maria la Real. Centro de Estudios del Romanico.

* Arco formado al superponer otro similar de menor tamafio. (http://www.lromanico.com)
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Cada tramo estuvo iluminado por una ventana. La mas occidental a base de tres arquivoltas’
de medio punto, lisas las dos interiores y adornada la interior con grueso baquetén®. L ventana
central, de acuerdo al gusto gédtico, tiene una imposta’ de hojas de vid. Y la ventana mas
occidental es de menor altura por encontrarse sobre la puerta y esta formada por un sencillo
arco de medio punto. En la portada, aunque estd parcialmente soterrada se pueden ver sus
arquivoltas decoradas.

Finalmente, en el siglo XIX, afectado por la supresién general de las érdenes monasticas; se
produjo el abandono de San Prudencio. Sus efectos se vendieron en subasta verificada el 12 de
febrero de 1837 en la llamada Casa del Priorato en Lagunilla.

> Cada una de las molduras que conforman una serie de arcos concéntrico. (http://es.wikipedia.org)

6 Tipo de moldura redonda, en forma de tallo, vertical y normalmente dispuesta en hilera con otras, utilizada
especialmente en la arquitectura goética. (http://es.wikipedia.org)

7 la imposta es a la jamba lo que el capitel a la columna. (http://es.wikipedia.org)



http://es.wikipedia.org/wiki/Arquitectura_g%C3%B3tica
http://es.wikipedia.org/wiki/Jamba
http://es.wikipedia.org/wiki/Capitel
http://es.wikipedia.org/wiki/Columna_(arquitectura)

2. ANTECEDENTES
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2.1 PROYECTO IP

El Intensive Program Erasmus: “Geometric Documentation of Heritage: European integration of
Technologies” es un programa de trabajo multidisciplinar e internacional, en el que se realizan
una serie de acciones enfocadas a la documentacién del patrimonio; mediante topografia
clasica y fotogrametria utilizando instrumentos punteros como GPS y escaneres laser.

El IP se define en la pagina® del mismo de la siguiente forma:

“El objetivo principal que se persigue en este proyecto es el intercambio metodoldgico prdctico,
en materias afines a la medida y la representacion del patrimonio, entre profesores y
fundamentalmente alumnos, de diferentes paises”.

“Para la consecucion de este fin se espera la
participacion de un grupo de aproximadamente 25
alumnos y 8 profesores de (Alemania, Italia,
Grecia, Lituania y Espafia)”.

intensie Program ERASMU S TORCART 2008/ 2010
Geometric Documentation of Heritage:
European integration of Technologies
Julio, 2010
La Univessidad del Pals Vasco, funis con fa Natonal Technical Uniesity of Athens (Gmcia)
o P

ot South Fataa EEUL ), b Haton Gty Unwo 5481 { Aeman).ia Univer scad
Maded, ia Univarsta dogs 2ud ol Sena (iaka) y b Vinaius Godmmino Techmios.

Dammacartrada an
Monasterio de San Prudencio del Monte Laturce
(Clavijo, La Rioja).

“Las actividades se centrardn en el desarrollo de
proyectos concretos de documentacion de
elementos patrimoniales, en concreto el apartado
prdctico se desarrollard en el Monasterio de San
Prudencio (La Rioja, Espafia). En él se aplicardn
técnicas digitales de registro de informacion
geomeétrica, constituidas por receptores GPS,
estaciones totales topogrdficas, escdneres ldser y

sistemas fotogramétricos”.

“Yrmament da los dats obtaricos y
mcin 68 modaios 30, planos y

“Los datos obtenidos serdn tratados de la siguiente
manera: en primer lugar serdn documentados,
mediante la adicion de la metainformacion
necesaria para garantizar su utilidad a lo largo del
tiempo, seguidamente serdn procesados con el fin
de obtener las representaciones cartogrdficas y
modelos virtuales de representacion que puedan
ser difundidas por medio de Internet”.

Imagen 2.1: Cartel del programa IP

“Como resultados se pretenden: un conjunto de registros métricos del momento de la
intervencion, modelos grdficos de difusion y finalmente relaciones de colaboracion

interpersonal e interinstitucional”.

Ademas de todo el contenido técnico y educacional, destaca también el componente humano.
La convivencia en un entorno multicultural, la interrelacion con companeros de profesién con
intereses y metas similares a los tuyos. A partir de esta experiencia se pueden obtener

visiones diferentes sobre los trabajos y las técnicas topograficas.

Yo he sido participante de este Programa Erasmus en la ediciéon 2009/2010, ésta es una de las
razones por las que elaboro el presente proyecto englobado en las acciones que este

® La pagina del proyecto IP Erasmus es: http://moodletic.ehu.es/moodle/course/view.php?id=1664



http://moodletic.ehu.es/moodle/course/view.php?id=1664
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Programa promueve relativas al patrimonio y en concreto a la documentacion del Monasterio
de San Prudencio.

2.2 RASGOS GENERALES DEL PROYECTO FIN DE CARRERA (PFC)

El presente proyecto aborda, la documentacidén por métodos fotogramétricos de las zonas de
riesgo del Monasterio de San Prudencio en el municipio de Clavijo (La Rioja, Espafia).

La documentacién se realiza mediante métodos fotogramétricos, consistentes en camaras
réflex convencionales, topografia clasica y varios software de restitucién.

Los software utilizados son: PhotoModeler Scanner 6 de la casa Eos Systems, Image Master de
la marca Topcon y Orthoware, desarrollado por la empresa E-metria.

Se pretenden obtener Modelos 3D de los elementos objeto de estudio como documentacién
de los mismos, y como base para la obtencidn de las secciones mas definitorias del muro; que
nos permitirdn analizar su desplome. También se quieren obtener las ortofotografias para la
realizacion de los analisis estratigraficos y demas estudios pertinentes, por parte de otros
profesionales participantes en el Proyecto IP.

También es objetivo del proyecto la elaboracion de un andlisis de los software utilizados y su
comparacién para resefar las caracteristicas mas importantes y que a nuestro juicio resultan
puntos fuertes de dicho software.

2.3 DESCRIPCION DE LAS ZONAS DE RIESGO A ESTUDIAR

El Monasterio de San Prudencio de Monte Laturce se trata de un complejo arquitecténico en
ruinas de gran tamafio. Ocupa un drea de 160 metros de largo por 63 metros de ancho
aproximadamente.

Debido a su gran tamafo es muy dificil de abarcar todos los trabajos de una sola vez, por lo
tanto se debe dividir en varias zonas de forma que los trabajos tengan un contenido mas
abarcable. Por esta razdn, en el programa IP en Julio de 2010 se centraron los trabajos en una
Unica zona del monasterio consistente en la zona de la Cripta y de la Iglesia, situada al suroeste
del yacimiento.

Durante los trabajos en esta zona y del analisis del resto del monasterio, se han seleccionado
varios muros que se encuentran en un serio riesgo de colapso, y de los cuales se ve una
necesidad de documentacidn urgente.

Los elementos seleccionados, y que son el objeto de estudio del presente proyecto, son
Unicamente cinco; aunque existen en el monasterio mas zonas de las que resultaria
interesante documentar lo antes posible ya que también se encuentran en un avanzado estado
de deterioro.
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Como no se han realizado estudios previos, similares al nuestro; no existen documentos en los
que los elementos que vamos a estudiar se encuentren denominados con algin nombre
especifico. Por lo tanto, se denominaran para este proyecto.

Para denominar a los muros, lo dptimo seria denominarlos haciendo referencia a la parte del
complejo monastico que son, pero esto no es posible ya que no es conocido; y cada uno puede
hacer una interpretacién subjetiva sin realizar un estudio que lo justifique.

Por esta razén, en una reunién de todos los miembros del laboratorio que realizan trabajos
sobre el monasterio, se fijé un nombre para cada una de las zonas, que seria a partir de
entonces el utilizado para hacer referencia a las mismas.

Se decidio hacer referencia a los muros mediante letras del alfabeto, y en caso de identificar el
elemento, con una denominacién mas descriptiva.

e Muro R

e Muro J

== Muro Iglesia norte
= Arco Iglesia

Los muros que se van a estudiar se denominan de la siguiente forma:

e MuroP
e MuroR
e Muro)

e Muro Iglesia norte
e Arco Iglesia

En las siguientes imagenes se muestran indicados los muros de forma mas detallada, en
fotografias generales de las zonas en la que se encuentran los cinco elementos.

10
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e TR
Imagen 2.3: Muros objeto del estudio

La imagen siguiente estd tomada desde el lado opuesto a la fotografia anterior, y en ella se
pueden distinguir los muros que no aparecian en la otra.

%N o™

Imagen 2.4: Muros objeto del estudio

A continuacidn se hace una descripcién de cada uno de los muros:

Muro P

El muro “P” se trata de un muro aislado, de aproximadamente un metro de espesor partido
por la parte central por una gran grieta; una de las partes tiene mas desplome que la otra.

Presenta la dificultad de que tiene un muro préximo en su parte norte que nos impide sacar las
fotografias con cierta distancia, por lo que necesitaremos un objetivo de focal pequefia.

11
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Imagen 2.5: Fotografia del muro “P”

Este muro “P”, tiene unas dimensiones aproximadas de 4,4 metros de ancho y 7,8 metros de
alto.

Muro R

Este muro se encuentra en la parte mas al sur del monasterio en el borde de un barranco tiene
dos partes diferenciadas, una mas alta que la otra. En la parte mas alta tiene una ventana, y en
la parte baja un orifico de grandes dimensiones.

El recubrimiento de la piedra esta en muy malas condiciones; esto lo pudimos experimentar al
comprobar que de un dia para otro de trabajo de campo se habian desprendido algunas de las
partes del mismo.

Aungque tiene mucho espacio delante, hay un pequefio arbol delante de la parte mas baja del
muro por lo que se nos presentaran ciertas dificultades para la toma de fotografias; y
deberemos tomar las fotografias del muro por partes.

12
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Imagen 2.6: Fotografia del muro “R”

Las dimensiones del muro R son aproximadamente de 7,7 metros de largo y 8 de alto, en su
parte mas alta.

Muro J

El muro J se encuentra ubicado en la parte norte de la iglesia, se encuentra aislado y tiene un
agujero enorme en su parte este. En la parte oeste tiene una zona mas alta que le da la forma
caracteristica. Este muro tiene un espesor menor a los anteriores muros descritos, resultando
a aproximadamente de unos 40 centimetros en su parte mas gruesa y de unos 10 en la mas
estrecha.

A continuacidn se muestra una fotografia del muro J desde su cara sur:

Imagen 2.7: Fotografia del muro “J”

13
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Las dimensiones del muro J son aproximadamente de 5,6 metros de largo y 8,5 de alto, en su
parte mas alta.

Muro Iglesia norte

Este muro es el mas grande de todos los que se tienen previstos documentar, tiene unas
dimensiones de 21 metros de largo y 13,5 de alto. Se encuentra en la parte norte de la iglesia y
es el muro mas deteriorado de todos los que son objeto de estudio de este proyecto. Es
complicada su documentacion debido a sus dimensiones.

BT N =

Imagen 2.8: Fotografia del muro norte de la iglesia

Este muro en su parte alta tiene mucho desplome, aparentemente puede colapsar en
cualquier momento. Puede llegar a ser peligroso realizar cualquier intervencién directa sobre

7

él.

Este muro es un caso especial ya que a la otra cara por estar fuera de la iglesia, y por lo tanto,
ubicarse en otra unidad; se le ha dado otro nombre. Este muro en su cara norte se denomina
muro “M”.

Imagen 2.9: Fotografia del muro “M”, parte trasera del muro norte de la iglesia

14
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Sus dimensiones son 10,7 metros de largo, por 7 metros de alto.

Se encuentra en su parte oeste cubierto por gran cantidad de vegetacidn, lo que impide
documentar la verdadera geometria del muro en esa parte.

Arco Iglesia

Este muro como su nombre indica se encuentra en el interior de la iglesia.

Imagen 2.10: Fotografia del arco de I ilesia

Aunque por la parte del interior aparenta estar en buenas condiciones, esto no es asi ya que
por la parte opuesta a la vista de la fotografia anterior se puede ver que la zona central del
arco estd bastante deteriorada.

Este muro presenta unas dimensiones de unos 7 metros de largo y 5,2 de alto.

Como se ha mencionado en la introduccién se estan realizando dos proyectos sobre estas
zonas, en este caso el presente proyecto se centra Unicamente el muro “R” y el arco de la
iglesia de los cuales se obtendra el modelo tridimensional, las ortofotografias y las secciones
caracteristicas.

Estos muros son suficientes para poder llevar a cabo el otro objetivo del proyecto que se trata
de la comparacion de los software utilizados. A partir de la documentacién de estos se podra
sacar conclusiones para la elaboracién del analisis comparativo.

15
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3.1 OBJETIVOS

El presente proyecto conlleva una serie de objetivos que se quieren alcanzar y son la meta de
su desarrollo. Existen varios objetivos, de los cuales unos pueden ser considerados como
objetivos principales, y el resto como objetivos secundarios.

El objetivo principal es en primer lugar, la documentaciéon geométrica, por métodos

fotogramétricos, de las zonas del Monasterio de San Prudencio de Monte Laturce las cuales se
encuentran en un estado de deterioro mds avanzado; y que por lo tanto se estima de maxima
urgencia su documentacion, ya que existe un verdadero peligro de colapso o de alteracién
parcial o total de su estructura.

Es perceptible a simple vista el lamentable estado de algunos de los muros del Monasterio, en
los cuales se pueden observar dafios fatales para la estructura; asi como en algun caso, se
percibe, sin necesidad de ser medido, un desplome muy significante.

Las condiciones de estos muros hacen que el trabajo en sus inmediaciones resulte en
ocasiones peligroso, y con el paso del tiempo cada vez mds. Por esta razén es imprescindible la
elaboracion de la documentacion evitando para ello la actuacién directa sobre el elemento en
la medida de lo posible.

Una vez correctamente documentadas estas zonas, podrian instalarse sistemas de seguridad
gue impidan el transito por la zona de peligro.

El otro objetivo primordial es la comparacion de sistemas fotogramétricos, mediante el
estudio de las caracteristicas de cada uno de los software utilizados, realizando una
comparacion de las cualidades mas interesantes de cada uno de ellos.

También, derivado de la comparacién realizada, se pretende establecer las caracteristicas
Optimas de cada programa, que a nuestro juicio resultarian mds interesantes que presentase
un hipotético programa que se desarrollase.

Los objetivos secundarios son los siguientes:

=>» Aprendizaje del proceso completo para la elaboracién de un modelo geométrico por
fotogrametria con sus diferentes fases: planificacién, toma de datos, tratamiento de
los mismos, restitucion y obtencién de los productos requeridos.

=>» Iniciacién y perfeccionamiento en el conocimiento y utilizaciéon de los diversos
programas que van a ser utilizados para la restitucion de los modelos. En este caso se
utilizardn PhotoModeler Scanner, Image Master y Orthoware.

=>» Complementar los trabajos realizados o proyectados por otros estudiantes o
profesionales, tanto en el ambito de la Universidad de Pais Vasco, como en el resto de
universidades nacionales y extranjeras participantes en el Programa Erasmus. Y
contribuir al desarrollo de los trabajos objetivo iniciados en dicho programa.
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=>» Servir de base o complemento a futuros trabajos o proyectos que se realicen sobre el
Monasterio o en el Laboratorio de Documentacion Geométrica del Patrimonio, asi
como en posibles IP Erasmus proximos.

=>» Contribuir en la medida de nuestras posibilidades al conocimiento general del
patrimonio, asi como a su posible difusidon publica; fundamental para su puesta en
valor e impulso de su conservacion.

=>» Comprender la importancia de el proceso de documentacion de los trabajos realizados
y la necesidad de tomar conciencia de términos como trascendencia, estandares o
metadatos; fundamentales para la perdurabilidad de la informacidn.

3.2 PRODUCTOS A OBTENER

En primer lugar se pretende realizar el registro fotogramétrico de los muros objeto de andlisis
en el proyecto, de lo que resultaran varias colecciones de fotografias.

De la misma forma, para la realizacién del trabajo es necesaria la medicion de los puntos de
apoyo fotogramétrico, los cuales deberan ser clasificados y ordenados segun las areas a las
que pertenecen. Y se almacenaran, al igual que las imagenes, de forma ordenada y lo mas
intuitiva posible, con la intencién de facilitar el trabajo a futuros usuarios.

Las representaciones que se tiene previsto obtener son las ortofotos de los muros del
monasterio que se encuentran en riesgo, correctamente presentadas a la escala
correspondiente segun la precisién obtenida y las necesidades previstas.

También se tiene el objetivo de obtener las secciones mas caracteristicas de los muros
obtenidas a partir de los modelos 3D construidos por fotogrametria.

Por ultimo, una tabla comparativa resumen de las conclusiones obtenidas a partir del analisis
de las caracteristicas de los diferentes software utilizados; poniendo en valor las caracteristicas
gue a nuestro juicio resultan mas interesantes de cada uno de ellos.
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4.1 INSTRUMENTAL

4.1.1 TOPOGRAFIA

Para la toma de los puntos de apoyo se han utilizado dos estaciones totales diferentes, segun
disponibilidad.

Las estaciones utilizadas han sido una Leica TPS1205 y una Leica TCR 307.

Imagen 4.1: Leica TPS1205 (izquierda) y Leica TCR307 (derecha)

Las dos disponen de la funcidon de medicidn de coordenadas sin prisma mediante laser, que fue
la utilizada para la medicién de todos los puntos de apoyo fotogramétrico establecidos en
campo.

También ambas estaciones ofrecen la posibilidad de realizar el estacionamiento mediante
interseccion inversa lo que permite una mayor comodidad requiriendo que exista visibilidad a
al menos tres puntos de coordenadas conocidas.

El modelo TPS1205 es bastante mas moderno, por lo que ofrece mas posibilidades que el
modelo TCR307. Una de las caracteristicas mas perceptibles, y que aportan mucha comodidad
al usuario es la existencia en el modelo mas reciente de teclado alfanumérico similar al de los
teléfonos moviles.

Otra diferencia muy importante, es que el almacenamiento de los datos en el modelo TPS
1205 se realiza en una tarjeta de memoria, lo que la permite ser sustituida en caso de agotarse
su capacidad, cosa nada habitual. Este hecho tiene la ventaja de que la descarga de los datos
resulta mas comoda, sin necesidad de cable ni de la estacién; ya que la descarga se puede
realizar con un lector de tarjetas.
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Las caracteristicas de las estaciones totales y los certificados se encuentran en los anexos 1y 2
de la presente memoria.

4.1.2 FOTOGRAMETRIA

Para la toma de fotografias se ha utilizado una camara réflex Canon EOS 5D Mark Il de 21.1
megapixeles.

P
]
]
’
H
(]

v

Imagen 4.2: Cémara Canon EOS 5D Mark I

Los objetivos utilizados han sido dos: un Canon fijo de distancia focal 35 mm y un Zeiss de 21
mm, cuya descripcion se encuentran también en el anexo 2.

Estos fueron utilizados alternativamente en funcidén de las necesidades de cada elemento a
fotografiar.

4.1.3 MATERIAL COMPLEMENTARIO Y FUNGIBLE

Ademas de las estaciones, la cdmara y los objetivos ha sido necesario el siguiente material:

- Tripode

- Jalén

- Prisma y miniprisma
- Pegadianas

- Dianas

- Silicona
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Una mencion especial es necesaria para la descripcion del pegadianas, ya que es un
instrumento no comercializado, de uso especifico en el Laboratorio de Documentacion.

Imagen 4.3: Pegadianas

El pegadianas, “esta compuesto por tres tubos huecos de acero inoxidable de 1,5 metros de
longitud cada uno, de didmetro creciente, de manera que permite alojar uno dentro de otro.
La longitud necesaria se consigue por medio de la fijacidon entre ellos, a través de unos
tornillos pasantes accionados por unas palomillas. En la parte superior de los tubos se acoplan
los dispositivos auxiliares donde colocar las dianas. Estos elementos van sujetos por medio de
un tornillo, de forma que puedan cabecear para adaptarse a diferentes superficies. El
dispositivo auxiliar posee varias ranuras, de forma que se puedan colocar dianas de diferentes
tamanfios o medidas. El proceso de fijado consiste en introducir las esquinas de las dianas en el
soporte, de manera que quede la parte adhesiva hacia el operario. En ella se deposita una
pequefia cantidad de material adherente y se procede a aproximar al lugar donde debe ir
emplazada. La accion del adhesivo hace que se desprenda del soporte, del que Unicamente
esta enganchado por las esquinas.” °

4.1.4 SOFTWARE

Como resulta evidente atendiendo al objeto de estudio del presente PFC, en este caso, el
software utilizado es la principal herramienta a tener en cuenta, ya que se trata del medio para

? Articulo “Elementos Auxiliares en Fotogrametria de Objeto Cercano”; Valle Meldn, J.M. ; Lopetegui
Galarraga, A. ; Mesanza Moraza, A. ; Rodriguez Miranda, A.; “Topografia y Cartografia” Vol. XX — N2 118-
119, Septiembre — Octubre — Noviembre — Diciembre 2003.
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obtener los resultados y un objetivo del proyecto en si mismo; ya que el andlisis comparativo
de los programas utilizados es uno de los objetivos principales.

La lista de los principales software utilizados para la elaboracién del proyecto son los
siguientes:

e Photomodeler Scanner 6
e Topcon Image Master

e Orthoware

e Rapidform X0S3

e Meshlabv1.2.3

e AutoCAD 2002 y 2008

La descripcidon de cada uno de los programas, mediante una presentacidn general y una breve
resefia sobre para qué han sido utilizados en cada uno de los casos, se encuentra recogida en
el anexo 3 de la presente memoria.

En lo relativo a los programas para la elaboracién de fotogrametria de bajo coste, los software
estudiados han resultado finalmente tres: Photomodeler Scanner 6, Topcon Image Master y
Orthoware. Aunque el peso de este Ultimo en el presente proyecto es escaso, ya que sera
abordado con mayor detenimiento por mi compafiera de proyecto.

4.2 METODOLOGIA

En primer lugar se va a proceder a realizar un resumen de los aspectos tedricos principales y su
identificacion con los procesos seguidos en los programas fotogramétricos utilizados o
estudiados para la documentacién realizada de las zonas de riesgo objeto del presente
proyecto.

4.2.1 FOTOGRAMETRIA ESTEREOSCOPICA

La fotogrametria estereoscépica es la fotogrametria realizada a partir de imagenes cuyos ejes
de toma son coplanarios y paralelos.

El trabajo en fotogrametria estereoscdpica se realiza por pares de fotografias. Estas imagenes
deben tener cierto recubrimiento entre si; sera de esta zona comun entre ambas fotografias
de la cual podremos obtener el modelo estereoscdpico. EIl modelo estereoscépico se forma a
partir de la disposicion de los haces que han generado la fotografia, de forma relativa entre si
(orientacidn relativa). Si la orientacidn es correcta los rayos de los puntos homadlogos se cortan
en un punto. El conjunto de puntos de intersecciones constituyen el modelo estereoscdpico.
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La peculiaridad de la fotogrametria estereoscépica, es que se trabaja sobre un modelo en tres
dimensiones. Por lo tanto para realizar la restitucién de los objetos, es necesario ir marcando
los puntos “posandose” sobre el modelo, el desplazamiento se hace en los tres ejes.

La estereoscopia, tiene los fundamentos comunes a los de la visidon binocular humana. Los
seres humanos obtenemos dos imdgenes, una con cada ojo, en el cerebro se fusionan y
percibimos el relieve de los objetos.

Como ya se ha mencionado las fotografias estereoscdpicas son perpendiculares al objeto y
habitualmente se les exige un recubrimiento a partir del 60 por ciento.

Muro en planta

Posiciones de camara
Imagen 4.4: Esquema de disposicion de fotografias estereoscopicas

Tanto Image Master como Photomodeler Scanner utilizan imagenes estereoscépicas para
generar el modelo; ambos programas necesitan de la identificacién, por parte del usuario, de
puntos homdlogos para realizar la orientacion relativa y de puntos de control para la absoluta.

También en ambos casos, como se va a explicar posteriormente, la generacion de las nubes de
puntos se realiza por correlacién.

Para la generacién de las lineas de rotura, en Image Master se trabaja sobre en nuestro caso
sobre una estereoscopia que nosotros no podemos percibir, debido a que no disponemos del
sistema de visualizacidn necesario. El “scroll” del ratén desplaza la marca sobre el eje Z, pero
no lo percibimos ya que no estamos viendo el modelo tridimensional. Existe la posibilidad de
realizar el posado mediante correlacion, de forma que se garantiza un mejor resultado, aunque
la herramienta puede resultar un poco lenta.

El programa ofrece la posibilidad de realizar una visidon estereoscdpica, si se dispone de un
monitor 3D especial y de gafas polarizadas. De esta forma se percibiria el relieve y se podria
realizar el posado fisico, resultando mas eficaz.
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4.2.2 FOTOGRAMETRIA CONVERGENTE

En fotogrametria convergente los ejes no son paralelos, sino que deben presentar cierta
convergencia. La generacidn del modelo se realiza también a partir de las intersecciones de los
haces de los puntos homdlogos, pero en este caso las intersecciones tienen un angulo mayor,
gue es lo que busca este tipo de fotogrametria.

Las imagenes de una misma serie deben cubrir un dngulo de 90°, teniendo una separacion
entre si de unos 10 o 15 grados. Las fotografias también deben tener recubrimiento ya que
todo lo que se quiera restituir posteriormente debe aparecer como minimo en dos fotografias.

Muro en planta

V

Posiciones de camara

Imagen 4.5 Esquema de disposicion de fotografias convergentes

En este tipo de fotogrametria el trabajo se realiza con cada imagen por separado y con
visualizacion monoscdpica. El proceso se basa también en la identificacion de puntos
homoélogos en todas las fotografias.

Orthoware se basa en fotografias convergentes para obtener el modelo y la ortofoto. Este es
capaz de realizar toda la identificacion de puntos homdlogos por correlacién automatica, sin
necesidad de introducir ningiin punto manualmente.

4.2.3 ORIENTACION INTERNA (CALIBRACION)

Segln el método general de la fotogrametria, la orientacién interna corresponde a la
reconstruccion de los haces que han dado lugar a la fotografia.

En la fotogrametria analdgica tradicional esta reconstruccion se realizaba de forma mecanica u
Optica.

En el caso de la fotogrametria digital, esta reconstruccion de rayos se realiza de forma
analitica, mediante la calibracion de la cdmara. En la calibracién se calculan los pardmetros de
la geometria de la toma fotografica, como la focal y la posicién del punto principal del sensor;
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ademas de los parametros de distorsion de la lente, tanto de la distorsion radial como de la
tangencial.

La calibracién se realiza a partir de una serie de fotografias tomadas a un patrén, en el cual los
programas son capaces de reconocer ciertos puntos y de esta forma, y con el valor aproximado
de la focal obtenido del fichero EXIF, mediante interseccidon analitica de rectas; es capaz de
calcular la posicién de todos los puntos de la matriz de la hoja de calibracién, y realizando un
ajuste, a partir de estos todos los parametros de calibracidn anteriormente mencionados.

Existen también otras formas de realizar la calibracidn en algunos de los programas. En
Photomodeler, por ejemplo, existe la posibilidad de realizar la calibracion a partir de puntos de
coordenadas conocidas. En este caso, al conocerse las coordenadas se puede realizar a partir
de cinco puntos de apoyo la calibracidn, ya que el modelo estaria ya escalado; y a partir de
estos puntos introducidos se puede calcular los pardmetros y la orientacién de las fotografias.
En este caso estariamos realizando una orientacién externa, ya que se realizan
simultdaneamente también la calibracidn relativa y absoluta. También nos ofrece la posibilidad
Photomodeler de realizar la calibracion sin puntos de control utilizando unos parametros de
calibracién aproximados y calculando los correctos valiéndose de bastantes puntos homadlogos
identificados de forma precisa en todas las fotografias.

El calculo con Orthoware es también bastante especial, ya que realiza la calibracién sin patrén,
sin puntos de control y sin parametros aproximados valiéndose Unicamente de de los datos del
fichero EXIF y una gran cantidad de puntos homodlogos identificados en las fotografias
mediante correlacién automatica. Esta calibracidén se realiza una vez que se ha ejecutado la
orientacién de las fotografias.

4.2.4 ORIENTACION RELATIVA

Siguiendo con el método general de la fotogrametria, la orientacion relativa consiste en
orientar las fotografias una respecto a otra de manera que se forme el modelo. Esto es
reproducir la posicidn de los haces de rayos en el momento de las tomas de las fotografias.

Una vez que se ha realizado la orientacién relativa, se dispone del modelo creado; ya que por
interseccidn de los rayos de los haces que definen los puntos homologos, se puede calcular la
posiciéon del punto en el modelo.

La orientacién relativa se realiza identificando sobre las fotografias puntos homdlogos, de
forma que haciendo coincidir los rayos de esos puntos, se llegue a la reconstruccién de la
posiciéon de los haces en el momento de la toma de las fotografias.

En Photomodeler se realiza la orientacidn identificando sobre las imdgenes los puntos
homdlogos manualmente, cuando existen al menos 6 puntos comunes marcados en todas las
fotografias se puede realizar la orientacidn relativa de las fotografias.
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En Image Master sin embargo, se introducen los puntos de control directamente, por lo que en
este caso se realizan la orientacion relativa y absoluta de forma conjunta.

Orthoware tiene una peculiaridad, que es el permitir detectar puntos homdlogos sin necesidad
de introducir puntos manualmente. Habitualmente es capaz de emparejar mas de mil puntos
de forma automadtica por correlacidén, por lo que la orientacidn relativa es muy buena y el
modelo resultard ser muy robusto, ya que tiene muchisimos puntos comunes en todas las
fotografias.

4.2.5 ORIENTACION ABSOLUTA

Segun el método general de la fotogrametria, la orientacién absoluta consiste en el escalado y
nivelado del modelo. Para ello se realizan tres traslaciones, tres giros y un escalado aplicando
un solo factor de escala.

Para la realizacidon de la orientacién absoluta, son necesarios tanto en Photomodeler como en
Image Master la definicién de al menos, cuatro puntos de coordenadas conocidas. A partir de
estos puntos se realizan las transformaciones necesarias para la orientacién y el escalado del
modelo, por lo que tendremos el modelo completo formado tal y como se encontraba en la
realidad.

La distribucion de estos puntos debe ser lo mds dispersa posible, intentando recubrir todo el
elemento y lo mas separados posibles para realizar mejor el escalado.

4.2.6 ORIENTACION EXTERNA

Se realiza de forma analitica y consiste en aunar las orientaciones relativa y absoluta en un
Unico paso.

Este proceso se fundamenta en la condicion de colinealidad, la cual consiste en que el punto
objeto, su imagen y el centro de proyeccidn se encuentran en la misma recta.

El calculo se realiza a partir de las ecuaciones de colinealidad para cada una de las fotografias,

7

estas ecuaciones contienen doce parametros: las coordenadas imagen (x’, y’, c), las
coordenadas del centro de proyeccion (X, Yo, Zo), las coordenadas del punto objeto (X, Y, Z) y

los elementos de rotacién (w, @, k).

Este cdlculo de la orientacidn se realiza generalmente a partir del conocimiento de la distancia
principal (c), bien porque ha sido medido o porque ha sido calculado en la calibracion en la
orientacién interna. También se conocen las coordenadas de los puntos imagen (x’, y’), ya que
se miden sobre las fotografias; es necesario conocer también un numero suficiente de puntos
de coordenadas conocidas medidas sobre el terreno (X, Y, Z).
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A partir de estos datos y a través de las ecuaciones mencionadas, sélo hace falta calcular las
coordenadas de los centros de proyeccion (X,, Yo, Zo) y los giros (w, @, k) para las dos imagenes.

4.2.7 GEOMETRIA EPIPOLAR Y CORRELACION AUTOMATICA

La correlacién en este caso, se refiere a la identificacion de puntos homélogos sobre dos
fotografias.

El principio de geometria epipolar simplifica en gran medida el proceso de correlacion.

La geometria epipolar, consiste en que el plano que pasa por los centros proyectivos de un par
fotogramétrico corta a los planos focales en dos rectas, las cuales se denominan rectas
epipolares. La singularidad de estas rectas es que cualquier punto que se encuentre en una de
ellas, tiene su homdlogo en la otra; por lo tanto, a la hora de realizar la blisqueda automatica
del homdlogo de un punto determinado, habrd que buscarlo sobre la linea epipolar de la otra
fotografia.

Ademas de en la correlacidn automatica, la geometria epipolar se usa en los programas de
fotogrametria utilizados, como una ayuda para la identificacidon de puntos homélogos realizada
por el usuario.

Tanto en Photomodeler como en Orthoware, una vez que se ha realizado la orientacion
relativa del modelo; al marcar un punto en una de las fotografias, nos aparece la linea epipolar
sobre la otra, de forma que ya sabemos que el punto homédlogo del punto marcado se
encuentra sobre dicha linea.

Esto posibilita en Photomodeler, que una vez que ha sido marcado un mismo punto en mas de
una fotografia, por interseccidn de las lineas epipolares; el programa nos puede indicar de
forma aproximada donde se encuentra ese mismo punto en el resto de fotografias, e incluso
centrarnos la imagen en dicha zona. La precisién de la linea epipolar, depende de la calidad de
la orientacion realizada.

La férmula seguida normalmente para la realizacion de la correlaciéon automatica, es la
correlacién por relajacidn jerarquica, también conocida como imagen piramidal.

Esta consiste en la creacion de imagenes de menor resolucion a partir de las imagenes de los
pares. Existen entonces varias imagenes de resolucion cada vez mas baja en una disposicion
piramidal.

La correlacidn se inicia a partir de la imagen de menor resolucién y se va identificando nivel a
nivel la zona de la fotografia donde se encuentra el punto homodlogo al que se quiere correlar.

De esta forma se consigue acelerar el proceso ya que al saltar de nivel a una resolucion mayor,
la zona en la que se debe buscar el punto se va disminuyendo por lo posibilitamos que el
procedimiento sea mas rapido.
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Para realizar la comparaciéon entre las zonas e identificar donde se encuentra el punto
homdlogo, se debe indicar los pardmetros correspondientes al tamafio de las ventanas de
correlacién y de busqueda de posibles homdlogos. La ventana de correlacion es el patron que
se va a ir buscando en cada fotografia, y la de busqueda es la ventana en la que se va a ir
buscando el patron.

Por ejemplo, en Orthoware para realizar la correlaciéon, hay que indicarle al programa el
tamanfio de dichas ventanas y el nimero de niveles en el que se quiere distribuir el proceso de
correlacién.

Tanto el principio de geometria epipolar como el de correlacién automatica se distinguen
claramente en Orthoware, ya que a la hora de realizar el emparejamiento de los puntos
singulares detectados nos da la posibilidad de realizar el emparejamiento por geometria
epipolar o por correlacién. Por lo tanto, por lo que hemos explicado anteriormente, si no se ha
realizado una orientacidn previa a esta identificacion deberemos utilizar la correlacion para el
emparejamiento de puntos; en el caso de haberse introducido puntos homélogos
manualmente y de haberse realizado la orientacidn de las fotografias, no es necesaria la
correlacién, y podremos basarnos principalmente en la geometria epipolar para realizar el
emparejamiento.

El proceso de correlacion, es en el que se basan todos los programas fotogramétricos que
hemos utilizado para la creacién de las nubes de puntos; por lo que esta metodologia ha sido
de gran importancia para el desarrollo de la ciencia fotogramétrica. Este desarrollo es
facilitado por la evolucion de los ordenadores, que permiten realizar la comparacién de los
pixeles de forma muy rapida.

Para poder realizar la correlacidon automatica de forma eficaz, lo mas conveniente es que las
fotografias sean lo mas similares posibles entre si.

4.2.8 NUBES DE PUNTOS

A partir del modelo orientado, con la orientacién relativa, es posible la generacidn de las nubes
de puntos de los elementos fotografiados.

La posicidon de los puntos de la nube se calcula por interseccion, a partir de la correlacion entre
dos fotografias; el programa busca pixeles homdlogos a partir de la comparacién con un
patrén, y mediante la interseccion de las rectas que pasan por ambos puntos es capaz de
calcular la posicidn de todos los puntos de una superficie.

Para la creacidon de una nube de puntos, es necesario seleccionar el par en el cual se va a
correlar, y a partir del cual se va a generar la nube de puntos.

La seleccidon del par se realiza analizando la geometria de cada uno de los pares posibles, en
Photomodeler se ha de atender a que la relacién base/distancia sea pequefia y que el angulo

29



Documentacion y representacion de paramentos verticales en riesgo de colapso.
Aplicacién en el Monasterio de San Prudencio (Clavijo, La Rioja). 4. MATERIAL Y METODOS

entre las fotografias de un mismo par sea menor 30°. El residuo de cada uno de los puntos
deberia ser menor a un pixel, y el residuo medio menor a 0,5 pixeles.

Estos parametros se tienen en cuenta de esta forma, debido a que para que la correlacién
funcione correctamente, como se ha mencionado en el apartado anterior, es necesario que las
fotografias no sean muy diferentes, ya que se debe realizar la identificacion de puntos
automaticamente.

Esta es la razén por la que en el apartado de toma de fotografias, en el capitulo de ejecucién
de este proyecto, se recomendardan metodologias de toma con la finalidad de que las
fotografias pertenecientes a una misma serie sean lo mas homogéneas posibles.

También se debe a este factor, la recomendaciéon de que el dngulo de las fotografias de un
mismo par no sea mayor a 30° ya que esto puede hacer que la forma del objeto varie
demasiado en unas fotografias respecto a otras, y por lo tanto se dificulte la correlacion
automatica de los pixeles.

El criterio de relacién base/distancia, tiene exactamente la misma finalidad, controlar que la
escala de las fotografias sea similar ya que en caso contrario resultaria también mas
complicada la identificacién automatica de puntos homdlogos.

4.2.9 MALLADO (MODELADO DE LA SUPERFICIE)

La triangulacién de la malla es un paso que se realiza a partir de la nube de puntos calculados
por correlacidn. Consiste en la creacion de una malla de tridangulos a partir de los puntos de la
nube, conformando estos los vértices de los tridangulos. Por lo tanto el modelado de la
superficie resultard mas ajustado a la realidad cuanto mayor sea la densidad de la nube de
puntos, y por consiguiente, la malla de tridngulos. Aunque la densidad de la malla debe
depender de las caracteristicas del objeto y de la finalidad que se le vaya a dar al producto
resultante.

A la hora del cdlculo de los triangulos, uno de los principales problemas suele ser, que como la
superficie que definen los tridangulos tiene dos caras suele presentar problemas de en qué cara
se debe poner la textura fotografica. Para esto la solucion es el calculo de la normal de cada
uno de los triangulos, y hacer que todas las normales tengan el mismo sentido, de esta forma
dispondremos de toda la textura en una de las caras. En caso de encontrarse la textura en la
cara opuesta a la deseada, existird la posibilidad de voltearla para disponerla en la cara
correcta.

4.2.10 ORTOFOTOS

Una ortofotografia es una proyeccidon ortogonal de un elemento, por lo tanto, esto nos
permite realizar medidas en el plano definido de ortoproyeccidn.
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La generacion de la ortofoto se realiza a partir de la creacién del modelo 3D del elemento.
Sobre el modelo del elemento se fija la textura fotografica, y la ortofoto no es mas que la
proyeccion ortografica del modelo, observada desde un plano especifico, definido por el
usuario.

De forma prdctica, tras la generacién del modelo 3D con textura fotografica libre de distorsion,
se debe seleccionar el plano imagen deseado de la ortofotografia.

La diferencia en la generacidn de las ortofotos con cada software de los utilizados, es la forma
de definir el plano imagen. Mientras que en Image Master solamente se define el eje X de la
ortofoto mediante dos puntos, ya que el eje Y de la ortofoto serd siempre la vertical del
modelo; tanto en Photomodeler como en Orthoware el plano de la ortofoto se puede definir
mediante tres puntos que definen el plano de proyeccion.

4.2.11 EDICION DE LOS PRODUCTOS

La edicidn tanto de las nubes de puntos, como de las mallas de tridngulos; es fundamental
durante el proceso de la generacion del modelo tridimensional, ya que de esta forma se puede
intervenir durante el proceso para obtener un producto final de mayor calidad.

En el caso de Photomodeler la capacidad de edicidn es mayor, ya que permite editar la nube
de puntos antes de generar la superficie, Image Master , sin embargo, permite editar la malla
pero no la nube ya que la generacidon de la superficie en Image Master es directa sin
posibilidad de actuacién sobre la nube de puntos.

En los productos obtenidos se debe realizar una edicién final, fundamentalmente para eliminar
las partes erréneas y no dar lugar a la confusidon del usuario final del producto que hemos
obtenido.

Lo mas importante es que el resultado se ajuste a los requisitos de veracidad, y no anteponer
el aspecto visual. En todos los productos, debemos eliminar aquellas partes donde no
podemos garantizar que el resultado sea éptimo; o si se prefiere, marcar o indicar claramente
las zonas que, por ejemplo, no tienen el mismo rigor métrico.

Esta idea se encuentra englobada, en el concepto de verosimilitud estudiado en el LDGP. Este
término hace referencia al rigor técnico de los datos que estamos mostrando, o a la constancia
gue tenemos, en el caso de las reconstrucciones virtuales, de que el elemento representado
fue tal y como se representa.

) , 14 . . .
A este respecto, se defiende en la metodologia propuesta®; la necesidad de diferenciar entre,
en el caso de una reconstruccion virtual de un conjunto constructivo, los elementos que se han

10 VALLE, J.M., 2007. Tesis Doctoral Documentacion Geométrica del Patrimonio: Propuesta conceptual y
metodoldgica. Capitulo 6: Organizacion de procesos y estandarizacion de los resultados de la documentacién
geométrica. Apartado 6.4.1: Modelos de verosimilitud.
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conservado, los que de los cuales tenemos evidencias documentales y los que corresponden a
reconstrucciones hipotéticas fundamentados en modelos de arquitectura similar.

Esto se desarrolla en casos précticos, como el de la Iglesia de Tusculo (Italia) (LDGP 2006),
entre otros.

Imagen 4.6: Modelos de verosimilitud de la iglesia de tusculo (LDGP 2006). Conservado
(amarillo), fuera de contexto (naranja), evidencias indirectas (verde) y sin evidencias (azul).

4.2.12 IMPORTACION Y EXPORTACION

Este es un aspecto fundamental para la realizacién de los trabajos ya que nos permite buscar
soluciones a ciertas deficiencias que puede mostrar cada uno de los programas. Los formatos
de exportacidn mds comunes son:

Producto Formato de exportacion
Modelos 3D VRML
Mallas de triangulos DXF
Puntos y nubes de puntos ASCII

Tabla 4.1: Formatos de exportacion mds comunes

Las importaciones se pueden realizar también desde muchos tipos de formato, aunque el mas
habitual suele ser el ASCII, para la importacién de los puntos de control.

En este apartado, tanto Image Master como Photomodeler nos presentan bastantes opciones,
tanto de importaciéon como de exportacion.

Image Master presenta una gran cantidad de formatos opcionales para la importacion de todo
tipo de ficheros: de puntos, de nubes de puntos, de mallas, de ortoimagenes,... Con respecto a
la exportacién, Image Master permite exportar puntos, nubes de puntos y mallas; en VRML,
DXF y TIN.
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En el caso de Photomodeler, en lo relativo a la exportacion también presenta bastantes
opciones y formatos™, como DXF 2D y 3D, VRML, 3D Studio,... Y para la importacién acepta
también varios formatos, como TXT, PLY, STL, BYU,...

11 . s . . s . s
Todos los formatos de exportacion e importacion se encuentran recopilados en el capitulo 7 de
comparacion del presente proyecto y en la tabla resumen correspondiente.
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5.1 EJECUCION DEL TRABAJO

El siguiente diagrama resume el trabajo que se ha de realizar desde la recopilacidon de la
informacidn previa, hasta la obtencidn de todos los resultados requeridos.

Recopilacién de
informacion previa
\ 2
Planificacién del
trabajo de campo

A 4 L 4
Captura de Apoyo fotogramétrico
fotografias - Materializacién del apoyo
+ - Medicién de coordenadas
Revision y - Croquizado
clasificacién v
+ ‘ + Resefias del apoyo
Obtencion de pares Obtencion de series
fotogramétricos de fotografias
Orientacion
Generacion del [] Trabajo de gabinete
modelo [] Trabajo de campo
+ Resultados
Edicion y revisiéon
Modelos
tridimensionales
Ortofotografias Secciones
Planos

Diagrama 5.1: Procesos de ejecucion

5.2 TOMA DE DATOS

5.2.1 RECOPILACION DE INFORMACION PREVIA

De forma previa a los trabajos en campo para la toma de los datos, hay que hacer un
inventario de la informacion de la que se dispone previamente. Este proceso, en nuestro caso
es muy importante, ya que disponemos de gigabytes de informacion obtenida en los trabajos
realizados en el campamento, como se indico en el apartado de introduccion. Disponiamos de
gran cantidad de imagenes y de sus puntos de apoyo fotogramétrico.
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Finalmente, confirmamos, que aunque este material nos fuese util en el proceso de
planificacidn; resultaria insuficiente para la documentacién de algunas de las zonas objeto de
nuestro proyecto.

5.2.2 SALIDAS A CAMPO

5.2.2.1 TRABAJOS PREVIOS

De forma previa al inicio del proyecto fin de carrera como tal, se realizaron una serie de
trabajos relacionados con el proyecto IP Erasmus en el Monasterio de San Prudencio.

Para comenzar, se midid una red de bases topograficas por métodos GNSS dispuestas por todo
el yacimiento; materializadas por estacas con clavos. De estos trabajos se obtuvieron las
coordenadas UTM de las bases con cota ortométrica recogidas en las resefas
correspondientes de las mismas, las cuales se encuentran en el Anexo 4 de resefias.

Otro material de incumbencia para nuestro proyecto, remanente de los trabajos del
campamento, fueron las dianas del apoyo fotogramétrico en el interior de la iglesia; las cuales
utilizamos pero fueron medidas de nuevo presuponiendo que podian haberse movido por
inclemencias meteoroldgicas.

Merece la pena recordar que tanto mi compafiera Raquel con la que realicé el trabajo de
campo como yo, tomamos parte también en los trabajos realizados en el yacimiento durante
el campamento, por lo que conociamos previamente las zonas que iban a ser documentadas;
lo cual resulté muy util, sobre todo, en la planificacidn de los trabajos de campo.

5.2.2.2 PLANIFICACION

De forma previa al trabajo de campo, se realizd una planificacién de los trabajos que era
necesario realizar. La planificacion previa es fundamental para la eleccién del material
necesario y para la optimizacién del tiempo.

Los trabajos a realizar estaban bien definidos de forma previa, lo que hizo que el trabajo fuese
mas agil; a pesar de ciertos fallos en la toma de fotografias debido a la inexperiencia.

Como material de apoyo, se elabord un cuadernillo de campo en el cual estaban recopiladas
las fotos disponibles de los muros objeto del proyecto para poder croquizar de forma mas
eficiente el apoyo fotogramétrico; también contenia plantillas para la elaboracion de las
resefias y listados con coordenadas de las dianas que se habian dispuesto en los trabajos
realizados en verano.
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5.2.2.3 TRABAJOS PROPIOS DEL PROYECTO

El trabajo de campo propio del PFC, constd de tres visitas al monasterio, las cuales se proceden
aresumir:

Jueves 10 de Marzo de 2011

En esta salida se procedid a la disposicion de dianas como materializacién de los puntos de
apoyo en varios de los muros; y en la medicidn, estacionandonos en una base de coordenadas
conocidas de las mismas. También se dispusieren otra serie de dianas en zonas visibles desde
la misma estacién para facilitar en dias sucesivos el estacionamiento, posibilitando el uso de
estas dianas para realizar el estacionamiento por interseccion inversa.

Se tomaron algunas fotos de los muros en los que ya habia sido dispuesto el apoyo.
De vuelta al laboratorio, se realizé la descarga de todos los datos obtenidos.
Miércoles 30 de Marzo de 2011

Los trabajos realizados en esta salida, resultaron muy similares a los de la anterior;
disponiendo dianas en los muros que nos faltaban y midiendo las mismas.

Se tomaron también bastantes fotos, aunque debido a nuestra inexperiencia y a la falta de
luminosidad, algunas resultaron ser no muy buenas; bien porque habian salido demasiado
oscuras o porque resultaron movidas debido a que la velocidad de captura habia sido
demasiado lenta por la falta de luminosidad.

Quedaron pendiente para el siguiente dia los trabajos a realizar en el interior de la iglesia.
Martes 19 de Abril de 2011

En esta ultima salida se realizaron los trabajos que habian quedado pendientes. Se dispusieron
algunas dianas mds, como complemento a las que habian perdurado desde los trabajos
realizados en el campamento; y se dieron coordenadas tanto a las nuevas como a las antiguas.
Esto se hizo asi ya que no podiamos confiar en que las dianas que se habian encontrado a la
intemperie desde hace varios meses no se hubiesen movido o modificado su forma debido a la
lluvia y demas inclemencias.

Se tomaron también las fotografias necesarias del interior de la iglesia, asi como las que habian
sido defectuosas de las tomadas en salidas anteriores.

El plan de trabajo de esta salida fue similar a la anterior, nos dedicamos a completar todas las
tareas que habiamos dejado pendientes de los dias anteriores.

Hay que mencionar que este dia tuvimos algun problema con la meteorologia, ya que hubo
una tormenta al mediodia, aunque finalmente pudimos completar todo el trabajo que se habia
planificado.

Con esta salida culminamos la adquisicion de datos necesaria para la ejecucién de nuestro
proyecto.
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5.2.3 FOTOGRAFIAS
5.2.3.1 ASPECTOS A TENER EN CUENTA

En la toma de las fotografias hay varios aspectos a tener en cuenta, los cuales pasamos a
resefar.

Camara y objetivos utilizados

En el laboratorio de documentacién hemos tenido a nuestra disposicion dos cdmaras: una
Canon Eos 5D y una Canon Eos 5D Mark Il. Las caracteristicas se pueden consultar en el Anexo
1 del presente proyecto.

La eleccién de una de ellas para la toma de datos ha sido muy sencilla, ya que la 5D Mark Il es
bastante mas moderna y tiene mas resolucion; 21,1 megapixeles en contraposicion a los 12 de
la Eos 5D.

En lo que a los objetivos respecta, disponiamos de dos objetivos calibrados: un Canon fijo de
distancia focal 35 mm y un Zeiss de 21 mm, cuyas descripciones se encuentran también en el
anexo 1. Estos fueron utilizados alternativamente en funcién de las necesidades de cada
elemento a fotografiar, aunque finalmente la mayor parte de las fotografias utilizadas
pertenecen al objetivo de 21 milimetros de focal. Este no tiene el enfoque fijo por lo que la
calibracién estd realizada en una posicién en la cual hay que tomar todas las fotografias. Esta
posicidn es el enfoque al infinito, por lo que es imprescindible comprobar antes de tomar cada
fotografia si el objetivo se encuentra en esta posicion.

Condiciones climaticas (Luz — hora del dia)

Para la toma de fotografias el dia ideal, debido a las condiciones de luz, no es lo que
comunmente se entiende por un dia bonito, incluso para la realizacion de trabajos
topograficos. Lo éptimo para la toma de fotografias es que el dia no sea soleado, sino que sea
un dia nublado y que no haya cambios de luz; y es necesario evitar también la lluvia debido a
que puede estropear el equipo, y la lluvia reduce los contrastes y humedece los paramentos lo
que produce un cambio de tonalidad en el material.

El problema que el Sol nos presenta es la posibilidad de aparicion de sombras en ciertas partes
de los elementos fotografiados; lo que puede dar lugar a la ocultacién de ciertos elementos de
los muros, a la imposibilidad de la correcta percepcion del color y a la pérdida de detalle. E
incluso, en el caso de que la toma sea de cara al sol puede provocar reflejos en la lente.

Para evitar dichos reflejos hay que prever la posicién del sol a cada hora del dia y planificar la
toma de fotografias en el momento mas adecuado.
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Relacidén apertura — exposicion — sensibilidad

La apertura del diafragma, la velocidad o tiempo de exposicidn de la toma y la sensibilidad 1SO
del sensor son los parametros a tener en cuenta a la hora de realizar la toma de la fotografia.

e Apertura del diafragma

El diafragma es un dispositivo alojado en el objetivo, compuesto por unas ldminas que al
accionarse amplian o reducen el didmetro de la apertura por la que entra la luz.

En nuestro caso, como en la mayoria de las camaras actuales, las cdmaras tienen un diafragma
de tipo iris; el cual recibe este nombre por asemejarse al funcionamiento de la pupila del ojo,
reduciendo el didmetro a medida que aumenta la cantidad de luz incidente.

La apertura del diafragma se cuantifica en una serie de nimeros que expresan el nimero de
veces que el didametro de la apertura se divide por la distancia focal.

/8 /11 /16 f/22

Imagen 5.1: Numeros identificativos de la apertura en un diafragma tipo iris
(www.dzoom.org.es)

El tamafio de esta apertura afecta a la luminosidad de la fotografia. Para un mismo tiempo de
exposicion, una apertura mayor produce una incidencia también mayor de luz sobre el sensor
de la camara lo que conlleva una mayor claridad en la fotografia.

El indice de apertura afecta también a la profundidad de campo. La profundidad de campo es
la distancia comprendida entre el punto mas préximo y mas lejano del espacio fotografiado
que aparece correctamente enfocado.

A medida que disminuye el tamafio de la apertura del diafragma la profundidad de campo
aumenta.

Otro aspecto a tener en cuenta, es la difraccion. Cuando un haz de luz atraviesa un orificio se
produce difraccién. Cuanto mas se cierra mayor se vuelve el circulo de indeterminacidn. Por lo
tanto es recomendable evitar los diafragmas muy cerrados para la toma de las fotografias.

e Tiempo de exposicion
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Las cadmaras permiten un gran abanico de posibilidades en lo que a la velocidad de la toma se
refiere, entre 1/4000 segundos y varios segundos, incluso el modo bulb en el que se mantiene
expuesto el sensor mientras que esté pulsado el disparador.

La velocidad de la toma debe adecuarse en funcién de la luz y del hecho de si estamos
utilizando tripode o no.

En el caso de utilizar tripode no tenemos ningun limite, y si no se utiliza depende de la focal del
objetivo. Esto es debido al desplazamiento que sufria un objeto aunque no es muy
recomendable usar velocidades menores a 1/50 6 1/20, en el caso de los objetivos utilizados
por nosotros, porque hace que tengamos bastantes posibilidades de que la foto nos salga
movida.

e Sensibilidad ISO

Es un parametro que heredan las camaras digitales de la fotografia analdgica, aunque el
fundamento no tiene nada que ver con la sensibilidad de las antiguas peliculas.

En la fotografia analdgica, la sensibilidad hace referencia al tamafio del grano de la pelicula o
carrete; esto significa que a una sensibilidad menor, grano mas fino, la resolucién de la
fotografia es mayor; por lo que tendrd mas detalle.

En fotografia digital, la menor sensibilidad ISO (normalmente 100), es el tope de lo que da de si
el sensor. Al cambiar la sensibilidad lo que hacemos es modificar de cierta forma el sensor de
manera que el procesamiento de los datos recibidos es diferente, y aunque obtenemos una
foto mas clara, obtenemos una foto con mas ruido, lo que tampoco nos conviene.

La maxima ISO que se recomienda utilizar es la ISO 400.

1/200s F/11 1/200s F/11
ISO 100 1SO 400

Imagen 5.2: Comparativa del efecto del cambio de sensibilidad 1SO
(www.juegosytecnologia.com)
Geometria

La geometria de las fotos se refiere a la diferencia entre la posicion tedrica de la imagen del
punto y de la real, debido fundamentalmente a las distorsiones provocadas por el sistema
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Optico. Los tipos de distorsiones y demas aspectos relativos a la distorsidén se describen en el
apartado 5.2.1 Distorsiones, de la presente memoria.

Posicion de la toma

En lo que a este apartado se refiere se diferencian dos tipos de fotogrametria, ya descritos en
el apartado de metodologia: estereoscdpica y convergente.

En fotogrametria estereoscépica se trabaja por pares de fotografias, las tomas deben ser
perpendiculares al elemento y deben tener cierto recubrimiento, normalmente al menos el
60%, para que la orientacion sea sdlida.

En fotogrametria convergente las fotografias deben ser relativamente convergentes, y cubrir
un angulo de aproximadamente 90° entre la primera y la ultima fotografia. El trabajo se realiza
por separado en cada imagen de forma monoscédpica.

Encuadre

El objeto o la parte de este que se quiere fotografiar deben aparecer en la imagen, lo que se
recomienda comprobar en el LCD de la cdmara tras la toma. Este es también uno de los
motivos por los cuales se toman las fotografias por duplicado, ademds de porque pueden salir
movidas si no se estd utilizando tripode.

Hay que evitar en la medida de lo posible ajustar excesivamente en los bordes de la foto ya
que la calibracidon de la cdmara no abarca completamente hasta el limite de la foto, y es
precisamente ahi donde tiene mayor incidencia la distorsién.

Al tomar una serie de fotos del mismo objeto hay que intentar que entre éstas no haya mucha
diferencia en la distancia al objeto, evitando diferencias grandes de escala entre ellas.

5.2.3.2 EJECUCION DE LA TOMA DE FOTOGRAFIAS
Modo de ejecucién

Para la toma de las fotografias el proceso a seguir, y el que realizamos, es el descrito a
continuacién:

Inicialmente, resefiar que es recomendable que la totalidad de las fotos de una misma serie se
tomen con los mismos parametros de velocidad, apertura y sensibilidad con la intencion de
que todas las fotografias que formen posteriormente un mismo modelo sean lo mas
homogéneas posibles.

12 . . . . 4

Los valores de los pardmetros recomendados o indicados como ideales en este apartado, estan basados en:
VALLE, J.M. y MARTINEZ, M2 P., Junio 2003. Prdcticas de Fotogrametria I. Capitulo 1: Introduccién a la fotografia
practica.
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Para la determinacion de los pardmetros de captura, configuramos la cdmara en el modo “Av”
en el cual se indica la apertura del diafragma deseada; para poder controlar la profundidad de
campo, y la velocidad se selecciona automaticamente en funcién de las condiciones de luz del
area a fotografiar.

La sensibilidad I1SO, como se ha mencionado anteriormente, lo ideal es que sea el valor mas
bajo posible de los que permite la cdmara, por lo que en un principio partiremos siempre de un
valor de 100 ISO.

A la hora de seleccionar la apertura, es recomendable evitar diafragmas muy abiertos ya que la
profundidad de campo resultard muy pequefia, lo que puede hacer que no veamos enfocados
todos los objetos que aparezcan en la fotografia; y también los diafragmas muy cerrados ya
que pueden producir difracciéon. Lo ideal es una apertura alrededor de 11, pudiendo
aumentarla si es necesario hasta 8 en caso de luminosidad escasa.

Una vez que tenemos la ISO vy la apertura fijadas, encuadraremos el objeto a fotografiar en el
objetivo, y presionando levemente el disparador comprobaremos la velocidad que la cdmara
nos recomienda.

Un tiempo de exposicién ideal es de 1/100 o 1/200, dependiendo el maximo permisible de la
focal del objetivo que se esta utilizando; cuanto mayor sea la focal del objetivo el tiempo de
exposicién minimo aceptable es menor, ya que la posibilidad de que la foto salga movida
aumenta considerablemente.

En nuestro caso, tomamos como velocidad minima para el objetivo de 35 milimetros la 1/50, y
para el de 21 milimetros la 1/20.

Si consideramos adecuada la velocidad que la camara nos recomienda, podemos dar por
buenos esos parametros, en el caso de que el valor indicado sea demasiado pequefio
deberemos modificar los pardmetros anteriores hasta conseguir la configuracién 6ptima.

La primera alternativa posible, es en el caso de que no estemos al limite en el valor de
apertura que hemos tomado como minimo, probar a bajarlo un poco y de la misma forma que
anteriormente comprobar la velocidad que nos marca en esta ocasion la camara.

Siempre es recomendable realizar los cambios poco a poco e ir viendo el comportamiento de
los parametros. En el caso de no ser suficiente, volveremos a disminuir la apertura del
diafragma hasta lograr una velocidad aceptable o llegar al limite recomendado para la
apertura.

En caso de alcanzar el limite recomendado, la segunda opcién de la que disponemos, es variar
la configuracién de la sensibilidad ISO y subirla levemente volviendo a realizar el proceso
anterior desde el inicio partiendo de los pardmetros de apertura recomendados e ir
reduciéndolos en caso de ser necesario.

La sensibilidad se puede subir hasta un valor de 400 ISO, una sensibilidad mayor nos puede
producir ruido en las zonas de sombra.
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Es muy importante tener en cuenta, que en tomas con el sol de cara, la velocidad que nos
marca la camara puede verse influenciada por este exceso de iluminacién; en estos casos, y si
no es posible aplazar la toma a otro momento del dia con el sol en otra posicion, la forma de
proceder es visar por el objetivo hacia el suelo de la zona mds préxima al objeto y realizar la
configuracion de los parametros en funcién de las lecturas realizadas en esa zona.

Una vez que sabemos el valor de los parametros con los que debemos tomar esa serie de
fotografias deberemos proceder cambiando el modo de la cdmara a “M” manual, indicando los
pardmetros obtenidos y tomando toda la serie de fotografias sin variar la configuracion.

Se debe hacer en modo manual, ya que si se hace en otro modo los parametros irian
cambiando entre foto y foto, en funcién de la luminosidad en cada momento.

También resefiar que es interesante buscar un momento para tomar las fotografias en que la
luminosidad esta estable y no haya cambios bruscos que puedan provocar que unas
fotografias resulten bastante mds oscuras que otras, o que aparezcan sombras proyectadas
sobre el objeto.

Los valores indicados como ideales se obtienen de la experiencia y de las recomendaciones del
tutor del proyecto.

Ejecucion

El primero de los dias de trabajo en campo tomamos las fotos de los muros “P” y “R” utilizando
la cdmara Canon Eos 5D Mark Il y el objetivo Canon de 35 mm, a excepcién de la parte norte
del muro “P” en la que no hay espacio suficiente y ademds de tomarse por partes con el 35
mm la tomamos también con el 21 mm.

El segundo de los dias tomamos las fotografias del muro “J” y del muro norte de la iglesia por
la parte del exterior de la misma. Estas fotos resultaron ser demasiado oscuras al visualizarlas
en el laboratorio por lo que quedaron pendientes de ser tomadas otra vez en una salida
posterior.

En la tercera y Ultima salida repetimos las tomas que habiamos dejado pendientes y tomamos
también las fotos de los muros desde el interior de la iglesia. Con esto terminamos la coleccidn
de fotos que deben resultar suficientes para la culminacion del proyecto.

5.2.4 APOYO FOTOGRAMETRICO

5.2.4.1 ASPECTOS A TENER EN CUENTA

Materializacion del apoyo
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Para la materializacion de los puntos de apoyo se han utilizado dianas de papel plastificadas,
de forma cuadrada y tamafio 4 x 4 centimetros.

Imagen 5.3: Diana punto de apoyo fotogramétrico (escala 1:1)

Las dianas se adhieren a la pared mediante silicona, con ayuda del pegadianas, ya que la
adherencia es muy buena, el secado es suficiente rapido en un primer momento para
mantener el escaso peso de la diana; y el deterioro producido en el elemento patrimonial, al
menos en este caso, es asumible por su escasa magnitud.

Sistema de coordenadas

Las coordenadas disponibles de las bases de referencia del Monasterio estaban en el sistema
Universal Transversal Mercator (UTM), y datum ETRS89.

El sistema UTM es una proyeccion cilindrica conforme, esto significa que los factores de escala

en la direccion del paralelo y en la direccién del meridiano son iguales.

En el sistema de coordenadas UTM la Tierra se divide en 60 husos de 6° de longitud, la zona de
proyeccion de la UTM se define entre el paralelo 80° S y 84° N. Cada huso se numera con un
numero entre el 1y el 60, estando el primer huso a partir de la longitud 180° respecto al
meridiano de Greenwich. Cada huso tiene asignado un meridiano central, que es donde se
sitia el origen de coordenadas, junto con el ecuador. Los usos se numeran de forma

ascendente hacia el Este.
La Peninsula Ibérica estd situada en los husos 29, 30 y 31; y Canarias estd situada en el huso 28.

La proyeccion UTM tiene la ventaja, a nivel global, de que ningin punto estd demasiado
alejado del meridiano central de su zona, por lo que las distorsiones son pequefas. Pero esto
se consigue al coste de la discontinuidad de los cambios de huso y por lo tanto las coordenadas

de puntos en husos distintos tienen origenes diferentes.

Para nuestro proyecto, el sistema de coordenadas utilizado no es exactamente el UTM. El
sistema que hemos utilizado es un sistema tridimensional de coordenadas apoyado en las

bases de coordenadas UTM. No se ha aplicado la correccidn por anamorfosis ya que no es
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necesario, porque las distancias radiadas en cada caso, son menores a 50 metros y por lo tanto
la deformacién producida es menor que la precisién de las coordenadas que se van a obtener

de las dianas que se estan midiendo.

El ETRS89 es el datum geodésico espacial que tiene como referencia el elipsoide SGR80 similar,

excepto una pequefia variacion en la excentricidad, al elipsoide WGS84.

Las cotas de las resefias de las que disponemos son ortométricas. La cota ortométrica es una
cota referida al geoide, nivel medio del mar; por lo que a las cotas elipsoidales que
proporcionan los sistemas GNSS se les ha corregido la ondulacién del geoide para obtener las

ortométricas.

Método topografico

El método utilizado para la obtencién de las coordenadas de los puntos de apoyo ha sido en
todas las ocasiones la radiacion de las dianas a partir de un punto de coordenadas conocidas.
En algunos de los casos estos puntos de coordenadas conocidas eran bases de coordenadas
obtenidas mediante métodos GNSS, y en otros, puntos no materializados de coordenadas
conocidas a partir de la ejecucion de una interseccion inversa visando dianas de coordenadas
previamente establecidas.

Instrumentacion

Para la medicidon de las coordenadas de los puntos de control se utilizaron dos estaciones
totales con medicién laser, capaces de medir sin prisma.

Los modelos de dichas estaciones son Leica TCR 307 y Leica TPS 1205. Las caracteristicas de los
aparatos se encuentran recogidas en el Anexo 1 de este proyecto.

5.2.4.2 EJECUCION DE LA MEDICION DE COORDENADAS

Para la medicidn de las coordenadas de las dianas, los puntos de coordenadas conocidas de los
que disponiamos fueron las bases establecidas para la elaboraciéon de los trabajos en IP
Erasmus que tuvo lugar en julio de 2010.

Estas bases disponian de coordenadas UTM ETRS89, obtenidas mediante métodos GNSS, y
cota ortométrica.

En un primer momento para dar coordenadas a nuestras dianas, estacionamos el instrumento
en la base de nombre BM10 (BenchMark 10) de coordenadas conocidas. A partir de este
punto, mediante radiacién dimos coordenadas a todas las dianas que se encontraban en esa
zona y eran visibles.
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Solamente resefiar que la medicidn de las dianas se realiza en el modo “RL” (reflectorless) sin
prisma visando directamente sobre las dianas adheridas a los muros; modo que se vale de una
sefal laser para realizar las mediciones.

Por otro lado, previendo la posibilidad del empleo de intersecciones inversas para realizar los
estacionamientos, de una forma mas sencilla, en el resto de las zonas del yacimiento; dimos
coordenadas desde esa misma estacidn a otras dianas que eran visibles ubicadas en el interior
de la iglesia y a otras que habiamos ubicado para el Unico efecto de permitir realizar una
interseccion inversa en la zona norte del muro “P”.

El resto de los estacionamientos se realizaron todos por el método de interseccidn inversa,
para el cual los instrumentos utilizados disponen de una funcién determinada.

Estas intersecciones se realizan a partir de un minimo de tres puntos de coordenadas
conocidas, resultando un calculo mas preciso si se utilizan mds puntos para la interseccién.

En nuestro caso utilizamos un minimo de 4 puntos y 5 en algunas ocasiones. Estos puntos es
recomendable que se encuentren distribuidos cubriendo los 360 grados alrededor del
instrumento, ya que unos mejores dngulos de interseccién incidiran en la precisién del punto
de estacion calculado.

Es obvia la necesidad de tener las precauciones necesarias a la hora de la toma de puntos en
campo, haciéndose siempre imprescindible la visualizacion a referencias tanto al iniciar como
al finalizar el trabajo desde un punto de estacidn, constatando que el instrumento no se ha
movido durante el periodo de trabajo.

5.2.5 ADQUISICION Y ALMACENAMIENTO DE LOS DATOS

5.2.5.1 ASPECTOS A TENER EN CUENTA
Importancia de la planificacién

Este es posiblemente el apartado mas importante en la adquisicién y almacenamiento de
datos. De una minuciosa planificacion depende el correcto desarrollo y consecucion de los
objetivos del trabajo.

La planificacidn abarca desde la eleccidn del dia idéneo para realizar el trabajo, el transporte,
el material necesario, los métodos mas adecuados, la informacidon a obtener, su tratamiento,
los formatos, el almacenamiento de los datos, la difusidn,... Una infinidad de aspectos deben
ser predefinidos para que el trabajo sea posible, esto repercutird seguramente en el tiempo
de ejecucion, en la eficiencia del trabajo y también en la calidad de los resultados obtenidos.

Modo de adquisicion
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La adquisicidn de los datos debe ser ordenada documentando todo el trabajo de campo, bien
mediante la elaboracién de croquis, mediante descripciones literales o con documentos
graficos como fotografias. Una correcta documentacién del trabajo permite gestionar mejor
los datos posteriormente y hacerlos comprensibles al personal o futuros usuarios que no
participaron en los trabajos de adquisicién.

Modo de almacenamiento

La organizacién y estandarizacién en el almacenamiento de la informacidn se convierte del
todo indispensable, sobre todo cuando la cantidad de datos es tan grande que resulta dificil
saber déonde se encuentra almacenado un dato especifico.

En lo relativo a la informacién en soportes informadticos, se debera hacer una correcta
clasificacion de la informacion mediante el uso de carpetas y ficheros dando la oportunidad de
llegar hasta la informacidon deseada de una manera lo mas intuitiva posible. El modo de
clasificacidon debe ser también documentado para que los nombres puedan ser interpretados
por cualquier usuario.

Nomenclatura de los datos obtenidos

A la hora de nombrar los ficheros y carpetas es necesario tener en cuenta el grupo de trabajo
en el que se va a emplear la informacion y los futuros usuarios de dichos datos.

En un grupo internacional, por ejemplo, serd necesario considerar el idioma a utilizar; en uno
multidisciplinar habra que tener en cuenta que cierta terminologia técnica puede resultar
desconocida para algunos grupos de profesionales.

Es importante también ubicar la adquisicidn de los datos temporalmente para que los usuarios
conozcan en qué momento de la fase del trabajo y en qué fecha han sido tomados.

Los nombres deben resultar lo mas intuitivos posibles evitando excesivas abreviaturas aunque
también hay que desechar nombres demasiado largos para los ficheros y carpetas.

Perdurabilidad de la informacion

Para garantizar que no existan pérdidas de informacién es indispensable tener el maximo
cuidado en el almacenamiento de la informacién.

Para asegurarnos que todos los datos de nuestro trabajo estdn a buen recaudo deberemos
tener una copia de seguridad de este en un soporte ajeno a nuestro ordenador, para lo que
podemos utilizar cualquier dispositivo de almacenamiento como memorias USB o discos duros.

Dependiendo del volumen de trabajo diario deberemos hacer las copias de seguridad con una
frecuencia determinada, aunque lo ideal es hacer copias diarias de toda la informacién
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podemos conformarnos con una copia de respaldo semanal. Esta periodicidad dependera del
volumen de trabajo que se realice cada dia, y de la importancia de los resultados obtenidos.
Aunque bien es cierto, que la realizacidn de estas copias se puede automatizar. Hay que tener
en cuenta que cuanto menor sea la periodicidad de las copias en caso de pérdida de
informacidn no dispondremos de todo nuestro trabajo realizado desde la dltima copia lo que
puede conllevar la necesidad de repetir el trabajo de toda una semana de nuevo, con el coste
que esto conlleva en tiempo y medios.

Existe también la posibilidad de realizar una copia de seguridad de forma permanente cada vez
gue se modifica un fichero.

Una alternativa son los sistemas RAID que consisten en un conjunto de discos duros en los
cuales se guarda la informacidn de forma redundante, y que en caso de fallar uno de los discos
con la informacién del resto es capaz de recuperar todos los datos perdidos.

Y la otra alternativa son las copias instantaneas en servidores remotos, en este caso al
modificar un archivo y guardarlo; de forma inmediata se estd almacenando una copia de ese
fichero en un disco remoto que se encuentra en otra ubicacién, y por lo tanto guarda la
informacién a buen recaudo. Esto es util cuando por ciertas circunstancias, por ejemplo un
incendio, se deterioran todos los sistemas de almacenamiento; en este caso se dispondra de
una copia de la informacidn en otro lugar y tendremos la capacidad de recuperarla. Este
sistema es el utilizado en el LDGP.

Estandarizacion de formatos

La estandarizacion de los formatos y la utilizacion de formatos abiertos para el
almacenamiento de la informacién es la forma de garantizar la accesibilidad de los datos a lo
largo del tiempo. La continua evolucion de vértigo que experimentan las nuevas tecnologias, y
especialmente en el ambito de la informatica hace que el desarrollo de nuevos formatos y
programas sea continuo, y en algunos de los casos los nuevos programas hacen que los
formatos antiguos queden ya obsoletos.

Por esta razén mediante la utilizacion de formatos abiertos podemos garantizarnos que la
comprension de los datos sea posible dentro de un tiempo indeterminado aunque los
programas que inicialmente reproducian dichos formatos estén en desuso.

Los formatos abiertos mas generalizados son los siguientes™:

PDF -> Para documentos de texto.
(Existe la version PDF/A para el archivo a largo plazo de documentos electrénicos
contemplado en la norma ISO 19005-1:2005).

DXF -> Para mapas y planos.

B VALLE, J.M., 2007. Tesis Doctoral Documentacion Geométrica del Patrimonio: Propuesta conceptual y

metodoldgica. Capitulo 6: Organizacién de procesos y estandarizacion de los resultados de la documentacion
geométrica.

48



Documentacion y representacion de paramentos verticales en riesgo de colapso.
Aplicacién en el Monasterio de San Prudencio (Clavijo, La Rioja). 5. EJECUCION

(Las diferentes versiones de DXF no son ejecutables en versiones anteriores de
AutoCAD por lo que, sobre todo para la difusiéon no es interesante utilizar una de las
mas recientes).

PNG, DNG, JPEG -> Para imagenes.
(DNG es un formato abierto para fotografias de tipo RAW, y PNG para mapas de bits e
imagenes, pero no alberga metadatos, es ideal para incluir imagenes en navegadores).

VRML -> Para modelos virtuales.

5.2.5.2 SOLUCION TOMADA

Materializacién del apoyo

Las dianas empleadas en nuestro proyecto son iguales que las utilizadas en el campamento
realizado en julio de 2010 en el Monasterio. La caracteristica fundamental a resefiar es que las
dianas, como se puede observar en la imagen 5.4 del apartado anterior, es la disposicion en la
esquina inferior derecha de un cddigo que identifica la diana. Este cddigo es Unico en cada
caso, y la idea es que no se repita nunca en ninguno de los trabajos realizados por el
laboratorio; de esta forma se evitan confusiones.

Mediante este cddigo se nombrard al punto medido correspondiente a esa diana y no se
modificara a lo largo de todo el trabajo, de esta forma a la hora de disponernos a realizar la
busqueda de sus coordenadas bien durante los trabajos relativos al presente proyecto, o bien
a posteriori por cualquier persona que esté colaborando en el proyecto general sobre el
Monasterio de San Prudencio; tendremos la garantia de que no existird una duplicidad que
pueda dar lugar a confusién ninguna.

Nomenclatura

En lo relativo a la nomenclatura de las imagenes tomadas, estas no han sido renombradas. El
nombre que les asigna la cdmara es considerado adecuado, debido a que se trata de un cédigo
numérico que avanza de forma secuencial por lo que mediante el nombre podemos saber el
orden en el que se han tomado las fotografias, y no existiran dos fotografias con el mismo
nombre.

Las imdgenes, a la hora del almacenamiento, se distribuyen en carpetas agrupando las fotos
por zonas u objetos de estudio, y diferenciando cada una de las series de fotografias
pertenecientes a cada una de estas zonas.

Formatos utilizados

Atendiendo al formato de las imdagenes, la adquisicidn se realiza tanto en formato RAW como
en JPEG de la calidad mas alta de las posibles.

El formato RAW no modifica la imagen, no la comprime y contiene toda la informacion que el
sensor a tomado; por esta razon el tamafio del archivo es bastante grande, pero a pesar de
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esto es necesario siempre guardar una copia de todas las imagenes en este formato para
disponer de toda la informacion y poder convertir la imagen a otros formatos.

El formato RAW tiene una mayor profundidad de color (por lo general 36 a 48 bits/pixel)
responsable del mayor tamafo. La diferencia principal del formato RAW respecto al resto es la
gran posibilidad que nos ofrece en la variacidn posterior de luces y colores.

En lo relativo al formato JPEG, es cierto que a partir de las imagenes en formato RAW se
pueden cambiar al formato JPEG, pero al darnos la camara la posibilidad de obtenerlo
directamente sin necesidad de transformar el RAW nos ahorramos bastante tiempo ya que
aunque la transformacidn es automatica se demora bastante en el tiempo.

El JPEG es un formato de imagenes comprimidas con pérdida, para reducir el tamafio del
archivo, mediante un estandar de compresién y codificacion.

El algoritmo de compresién del formato JPEG se basa en dos defectos que tiene el ojo
humano: el hecho de ser mas sensible al cambio de luminosidad que al de color; y que nota
mas facilmente los cambios de luminosidad en zonas homogéneas, que en zonas con
variaciones como los bordes.

Este formato es el comunmente mas utilizado el lo que a fotografia se refiere.

En JPEG, la fotografia contiene metainformacién denominada EXIF (EXchangable Image file
Format), que contiene informacion adicional sobre la toma como fecha y hora, distancia focal,
camara con que se ha tomado, tamafo de la imagen,...

El formato JPEG, ademas de ser el mas utilizado, es un formato en el que pueden trabajar
todos los programas especificos de fotogrametria de bajo coste que nosotros hemos utilizado
en el proyecto, y también el resto de programas de uso cotidiano.

Apoyo fotogramétrico

Para el apoyo, la solucidn tomadas es la mas simple, realizando su almacenamiento en ficheros
ASCII separados por tabuladores. Se ha creado un fichero para el apoyo de cada una de las
zonas u objetos a documentar, division similar a las carpetas en las que se habian dispuesto las
fotografias. Los croquis con los puntos de cada muro, irdan emparejados a los ficheros con las
coordenadas de los mismos.

Por ultimo, solo hacer referencia a que lo mas recomendable es organizar las fotos lo antes
posible después de finalizar el trabajo de campo, ya que tendremos mas fresca la forma u
orden seguido para tomar todos los datos y en caso de surgir algun problema podremos
solucionarlo mas facilmente.
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Diagrama 5.2: Diagrama de formatos de datos utilizados

5.3 CALIBRACIONES

La mayoria de los programas de restitucidon necesitan parametrizar los comportamientos de la
camara y cdmo plasman la realidad los sensores. Esta necesidad se cubre con la calibracién de
la cdmara y objetivo con los que se toman las fotografias, de esta forma mediante el uso de
alguno de los programas de calibracién obtenemos los parametros de deformacion.

Cada programa de restitucidn suele tener su propio programa de calibracién no resultando las
calibraciones obtenidas interoperables en los distintos programas, ya que aunque el objetivo
es el mismo, el proceso matematico que utilizan es parecido pero no resulta idéntico.

Si tenemos la calibracion en un programa para poder utilizar las fotos en otro, tenemos la
posibilidad de realizar la correccion de la distorsién y de la posicion del punto principal de las
imagenes con la calibracién en el programa correspondiente y posteriormente ser estas
imagenes idealizadas las que introducimos en el otro programa indicando previamente que las
fotos introducidas carecen de distorsion.

5.3.1 DISTORSIONES

Las distorsiones en las fotografias se deben a que el objetivo estd compuesto por una serie de
lentes las cuales no estan libres de defectos, aunque se intente minimizarlos o compensarlos
unos con otros.
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Esto convierte a la fotografia en una proyeccién cdnica no ideal. Los rayos pueden incidir en la
lente con un angulo y emerger con otro distinto, esta diferencia se deberd a la distorsion del
objetivo.

Se consideran dos tipos de distorsiones en las fotografias:

- Distorsion radial. La deformacién de la lente, la lente es una curva y a los rayos que
inciden en el sensor les ha introducido una desviacidn dependiente del dngulo de
incidencia de los mismos.

- Distorsion tangencial. Debido a la desviacién del eje dptico de las lentes de la cdmara
con el eje geométrico del objetivo. Falta de colinealidad de los centros.

Modelado de la distorsion

Como ya se ha mencionado éste es el objetivo de los programas que realizan las calibraciones.
Las distorsiones vienen dadas por una serie de parametros.

La distorsion radial simétrica depende de la distancia radial al punto principal y se define
como un polinomio. En caso de calibrar una cdmara de gran formato es necesario calcular
hasta cinco coeficientes, pero para una cdmara normal suele ser suficiente con dos
coeficientes.™

K1, K2, K3 -> coeficientes de la distorsion radial

La desviacion de los centros se define con una ecuacion del aspecto de una cuadrica, en la cual
intervienen dos coeficientes que son los que calculan los programas.

P1, P2 -> coeficientes de distorsidn tangencial o desviacion de los centros

Las ecuaciones de distorsidn son por lo general las siguientes, aunque cada programa puede
variar en cierta forma el proceso de calculo de los coeficientes.

Xo=x+x#|(Ky*r? + Ky sr* + Ky = v [P = (r?2 + 25 x2) + 2P, = x = y]

V.,=y+ys|(Ky*r?+K*r*+ Ky« v ) [P x (r2+ 22 y2) + 25P, s x = y]

Distorsion radial

r=4/x2+ y2 Distancia al punto principal Xc,Yc — Coordendas corregidas
x,y — Coordenadas originales

. . «s 1
Imagen 5.4: Ecuaciones de distorsion™

14 ROMERO, A., Enero 1999. Calibracion de cdmaras no métricas por el método de las lineas rectas.
http://www.mappinginteractivo.com/plantilla-ante.asp?id_articulo=434

1> Ecuaciones de distorsién de Photomodeler. Video tutorial Tema 4 — Calibracion.
http://www.worldphotogrammetry.com/home/item/7-tema-4-calibraci%C3%B3n.html
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5.3.2 ANALISIS DE LA DISTORSION

Para realizar este analisis se ha elegido una fotografia de las pertenecientes a nuestro
proyecto, y se va a comparar la imagen original con la idealizada de forma que realizaremos un
analisis de las diferencias.

Hemos importado las imagenes en AutoCAD y sobre estas hemos marcado las caracteristicas
mas significativas del muro como pueden ser los bordes; y hemos unido las dianas disponibles
ya que estas se tratan de puntos fijos facilmente identificables en las fotografias, mas incluso
que los limites del muro.

Imagen 5.5: Fotografias original e idealizada con los rasgos identificados

La fotografia en este ejemplo ha sido idealizada en Photomodeler con la calibracién obtenida
con este mismo programa para la cdmara con la que se ha tomado la fotografia original.

Hay que hacer referencia, a que como se puede observar en la anterior imagen, la fotografia
idealizada es desplazada para hacer coincidir el punto principal con el centro de la fotografia.

Por esta razén a la hora de superponer las fotografias tomamos de punto base uno
identificable univocamente en ambas fotografias como puede ser una diana, en concreto la
gue se encuentra mas cercana al punto principal.

En la siguiente imagen se presentan las fotografias superpuestas con sus respectivas lineas de
referencia y el punto utilizado como punto base del desplazamiento.
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Imagen 5.6: Fotografias original e idealizada superpuestas con los rasgos identificados

Como se puede comprobar en este caso se presenta una correccién en “almohadilla” con los
bordes convergentes hacia el centro de la fotografia; de darse el caso contario se denominaria
correccién en “barril”.

Del resultado obtenido se pueden obtener ciertas conclusiones que demuestran el
comportamiento de las distorsiones que tiene la imagen original.

En la imagen general anterior se puede percibir claramente que las deformaciones son mas
grandes en los extremos de las imagenes. Esto es un hecho a tener en cuenta ya que los
puntos que posteriormente restituyamos en las zonas periféricas de la imagen van a tener
menor precision, por esta razon es preferible dejar un margen de la fotografia sin puntos. Este
hecho habrd que tenerlo en cuenta al tomar las fotografias para que la zona que en una foto
no vamos a utilizar aparezca en el nimero suficiente de fotos restantes.

En la siguiente imagen se muestra de forma aumentada las zonas en los que el
comportamiento de dicha distorsién es mds caracteristica.
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Imagen 5.7: Detalles de la comparativa de deformacion

Como se ve en la imagen superior izquierda, en la parte alta del muro correspondiente al area
superior de la fotografia la deformacién habia desplazado los puntos del limite del muro en
direccion opuesta al centro de la imagen. Del mismo modo pasa en la parte inferior de la
imagen, pudiéndose percibir el efecto homdlogo en direccién también contraria al centro, en
la imagen derecha.

Asi mismo, en las zonas mas cercanas al punto tomado como centro para la comprobacién de
distorsiones, como es el caso de la ventana; la distorsién es mucho menor coincidiendo,
practicamente, las lineas de referencia tomadas.

Para cuantificar las variaciones que sufre el objeto en la fotografia al corregir la distorsidn, se
han medido las coordenadas pixel de las esquinas opuestas del muro, tanto en la fotografia
original, como en la corregida.

Los resultados obtenidos son los siguientes:

X original (pix) |Y original (pix) | X corregida (pix) | Y corregida (pix)
Pto. A 404 592 442 681
Pto. B 2812 5187 2800 5181
Distancia 5188 5080

Tabla 5.1: Comparativa de puntos antes y después de la correccion
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Como se puede comprobar a partir de los datos de la tabla anterior, el objeto en la fotografia
corregida ha experimentado una reduccién en su tamafio del 0,2 %. Lo que en la realidad
corresponde aproximadamente a 2 centimetros.

5.3.3 CALIBRACION IMAGEMASTER

El programa que realiza la calibracidon necesaria en ImageMaster se denomina ImageMaster
Calib, es independiente y se suministra junto al programa principal.

La calibracion se realiza con la finalidad de obtener los pardmetros de distorsion de la camara
utilizada para la toma de las fotografias. Los parametros calculados son los siguientes:

e f-> Distancia focal

e K1, K2 -> Distorsién radial de las lentes

e P1, P2 -> Distorsién tangencial de las lentes

e Xp, Yp -> Localizacién del punto principal del sensor de la cdmara

Hoja de calibracién

La calibracion de la cdmara se realiza a partir de las fotografias tomadas a un patrén con la
camara y objetivo que requieren de ser calibrados.

El primer paso de todo el proceso, como es obvio es la impresidon del patrén de calibracién. El
tamanfio de impresién del patron depende en cierta forma de la focal que se quiere calibrar.
Para un objetivo de 21 mm como el nuestro el tamafio debe de ser un A1 é un AO.

La hoja de calibracién tiene el siguiente aspecto:

Imagen 5.8: Matriz de puntos de la hoja de calibracion en ImageMaster

El patrén de calibracidn se recomienda fijar en una superficie plana, bien en una pared o sobre
el suelo, aunque es preferible en una pared o elemento vertical ya que una de las tomas que se
van a requerir es central y en el caso de disponer la hoja sobre el suelo en el caso de un A0
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seguramente nos haria falta una escalera para tomar todas las fotografias y estamos
convirtiendo la toma de estas fotografias en un trabajo mds complicado.

La hoja de calibracién, como se puede ver en la imagen anterior, se compone de 145 puntos
simples y 5 marcas.

Una de las recomendaciones que hay que tener en cuenta es no poner la hoja de calibracién
sobre una superficie reflectante ni con el sol de fondo, debe estar dispuesta en sentido
apaisado y no hacer pliegues, es decir completamente estirada.

La camara estara configurada en modo manual y con la focal y el foco en la posicidn que se
quieran tomar después todas las fotografias a utilizar en el programa. El enfoque automatico
(autofocus) debe estar desconectado y el zoom en uno de los topes, ya que si se calibra la
camara en una posicién de zoom intermedia luego no seremos capaces de ajustar el zoom
exactamente como estaba en la calibracion.

Las imdagenes las tomaremos en el tamafio madximo que nos permita la cdmara y en el formato
RAW y JPEG lo menos comprimido posible.

Image Master permite también el uso de imagenes TIF'. En nuestro caso se han utilizado las
imagenes en formato JPEG porque es el formato Util en todos los programas utilizados, y
porque es la posibilidad de nos proporciona la cdmara ademads del formato RAW de Canon.

Toma de fotografias

El programa de calibracién para ImageMaster requiere de 5 fotografias para realizar la
calibracion de la cdmara. Las posiciones de la toma estan definidas y son las siguientes:

Imagen frontal -> La camara a la altura del centro de la matriz de puntos y la hoja ajustada a
toda la superficie de la fotografia.

Imagen izquierda, derecha, superior e inferior -> La marca central debe encontrarse en el
centro de la fotografia y los puntos de las esquinas mds cercanas a la cdmara
deben estar ajustadas a las esquinas de la misma.

6 TIFF (Tagged Image File Format). Formato de archivo de graficos que permite almacenar imagenes grandes pero
perdiendo calidad, en el caso de utilizarse un TIFF comprimido. Es independiente del dispositivo en el que se usa. El
principio del formato consiste en definir etiquetas que describen caracteristicas de la imagen como dimensiones,
cantidad de colores o tipo de compresion.
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Imagen 5.9: Ejemplo de la imdgenes para la calibracion en ImageMaster

Es necesario resefiar que las imagenes que se han puesto de ejemplo en la imagen anterior
aunque son Utiles para realizar la calibracién, se podrian mejorar, ya que la marca central
podria estar mas préxima al centro de la fotografia, los puntos correspondientes mas ajustados
a las esquinas, y el reflejo de la fotografia inferior deberia haberse evitado. Bien es cierto, que
en la préctica no es tarea facil conseguir las imagenes tedricamente idéneas ya que suele
existir algun inconveniente.

Al igual que en las series de fotografias tomadas en campo, la configuracion de los pardmetros
de la cdmara en todas las fotos deben ser los mismos, de aqui la razén por la que se debe
utilizar el modo “M” manual de la cdmara.

Proceso

Paso 1: Seleccién nombre de proyecto

Una vez con el programa abierto para comenzar la calibracion el primer paso es la creacién de
un proyecto nuevo. Para esto en el menu seleccionaremos: File -> New Project.

Input Project Name (.pri)

[proiect]

Input Project Directory
I C:\Users\Pablo\Desktop\Nueva carpeta)

Imagen 5.10: Ventana de seleccion del nombre u ubicacion del nuevo proyecto

Se ha de seleccionar el nombre del fichero de proyecto y la ruta en donde va a estar ubicado.

Paso 2: Seleccién del tamafio de la hoja
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En este paso Unicamente hay que indicar el tamafio de la hoja de calibracion que hemos
utilizado.

SheetSize | A1(841X 594mm) For Wide

Imagen 5.11: Ventana de seleccion del tamaiio de la hoja de calibracion

En nuestro caso la hoja utilizada fue en A0 ya que es el tamafo que se puede utilizar para
focales pequefias, que son las utilizadas habitualmente para el tipo de fotogrametria que
nosotros realizamos.

Paso 3: Seleccidn de la imagenes

A continuaciéon aparece la ventana para la seleccién de las fotografias con las cuales se va a
realizar la calibracion. Se han de elegir 5 fotografias tomadas desde las posiciones descritas en
el apartado “Toma de fotografias”.

Buscaren: I Serie 1 LI & &5 Eav

L -
o I

Sttios recientes p— = -r
[iviios m
! < Qi Fis 2
(o (o3 o Lo X8 < <
Escritorio i 5
= _MG_0806 _MG_0807
= 2
Bibliotecas

Ay

.
Equipo
‘..! o 0

< < |
Red | :
m - "=
MG 0808 MG 0809 =
Nombre: I _vJ Abrir
Tipo: Ilmage File(* bmp,* jpa.” tif) LI Cancelar

A=

Imagen 5.12: Ventana de seleccion de las fotografias

Al introducir las imagenes el programa obtiene los pardmetros de resoluciéon de las mismas,
del fichero EXIFY; en caso de no ser esto posible, o de que exista algun error en los mismos, se
pueden modificar en: Setup -> Pixel Size Setup.

Paso 4: Confirmacion inicial de la distancia focal

Como el propio nombre indica este paso se resume en la confirmacién de la focal de la cdmara
con la que se han tomado las fotografias, la cual es obtenida por el programa también del
fichero EXIF de las imdagenes.

Y EXIF (EXchangable Image file Format). Fichero que contiene informacién adicional sobre la fotografia;
como fecha y hora, distancia focal, cdmara con que se ha tomado, tamafio de la imagen,...
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Confirmation of Initial Focal Em &

Confirm The Value of Focal Length

Input Real Focal Length, Not 35mm Format Cancel

f= 35 [mm]

Imagen 5.13: Ventana de confirmacion de la distancia focal

En el caso de que el programa no sea capaz de obtener la distancia focal mediante el fichero
EXIF existe la posibilidad de introducirla manualmente en el menud: Setup -> Focal Length
Setup.

Paso 5: Calibracidn automdatica completa

Completados los cuatro pasos iniciales anteriores, accedemos a la pantalla general del
proyecto de calibracién en la que aparecen las imagenes cargadas.

El siguiente paso a llevar a cabo es la calibracidn automadtica, para lo que se debe seleccionar
en el menu: Process -> Full Auto Calibration.

2600055 260050 245,008 5 6.9 .55 246,00 55

Image Lj=+=
Double & 16 0804 a0t

Right-C ‘
. _
.
2 _

Recogriang ponts

o%

NUM

Imagen 5.14: Pantalla principal del proyecto realizando la calibraciéon automdtica

Si no es posible la deteccién del centro de todos los puntos de la matriz de forma automatica,
se puede recurrir a la deteccién manual “Manual Measurement”.

También se puede ajustar el contraste de las imagenes en el menu: View -> Contrast
Adjustment para poder realizar una mejor identificacion de los puntos de la hoja de
calibracion.

Paso 6: Resultado de la calibracion de la cdmara
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Esta pantalla nos muestra los residuos obtenidos del proceso de calibracion. El programa
realiza un juicio de si la calibracién ha sido correcta o no. Lo clasifica en “OK” en el caso de ser
correcta, y “NG” en el caso de no serlo.

r B
Result of Camera Calibration @

Total Judge OK

| camera calibration succeeded.

Measurement Accuracy Summary

Residual of image processing
0.1121  [Pixel]

Reference Value

Residual of 3D point coordinates

= [0.2285 [mm] v= [0.3027 [mm] z= [0.5622 [mm] xvz= [0.3645 [mm]

Imdgen 5.15: Pantalla resultado de la calibracion de la cémara

En el caso de que el veredicto haya sido “NG”, esto significa que no se ha completado el
calculo de la calibracion, fundamentalmente debido a que algunas de la imagenes no son
buenas o no se ha podido medir bien en ellas; por lo que deberemos repetir los pasos
anteriores y realizar el proceso de “Manual Measurement”. Si aun asi el resultado sigue siendo
incorrecto se debe acudir a la seccién “Trouble Shooting”. Si de esta forma no se llega a un
resultado correcto, es probable que el problema sea debido a las imagenes; puede ser que
estas no se hayan tomado de forma correcta o que tengan algun otro problema. En este caso,
la Unica solucién seria volver a tomar nuevamente todas las imagenes de la hoja de
calibracion.

En lo que respecta al criterio para la obtencién del “OK” en el veredicto, es conseguir que el
residuo del procesamiento de las imagenes para todos los puntos sea menor a 0,25 pixeles.

El residuo de los puntos de coordenadas 3D, muestra la variacién causada por la deformacién
de la hoja plana. Estos residuos de los puntos de coordenadas 3D son simplemente valores de
referencia.

Paso 7: Resultado de la calibracién

En esta pantalla se muestran los parametros internos del conjunto cdmara objetivo.

En el grafico, la distorsidn esta magnificada 4 veces. En la parte “Max of Before Correction” los
valores muestran el residuo de los puntos con mayor distorsién.

Al llegar a este paso se ha creado el fichero de cdmara con extensién “.cmr” en la carpeta en la
gue se encontraban las imdagenes. La ruta se muestra en la parte superior de la pantalla.
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Lens Distortion _7 N @
Camera File Name | C:\Users\Pablo\Desktop\Nueva carpeta\Project1\Project1.cmr Current Camera File
Display Scale (Lens Distortion) 4 v Other Camera File
Print

Interior Orientation Parameters

@&

Focal Length 35.148067  [mm]

Principal Point Xp 17.952983  [mm]
Principal Point Yp 11.801403 [mm]

Lens Distortion Parameters

Radial Distortion K1 [7.:816239¢-005
Radial Distortion K2 [-7.163985-008
Tangential Distortion P1 ,m
Tangential Distortion P2 ms_

Pixel Size Xr 6.3 [um]
Pixel Size Yr '63— [um]

Max of Before Correction
473.7496% [um] |53.17326t [Pixel]

[V 1deal value (White) 2.205078¢ [9%)
[V Before Correction (Red)

Imagen 5.16: Pantalla resultado de la calibracion (pardmetros de distorsion de las lentes)

Existe la posibilidad de imprimir una hoja con los resultados de la calibracidon que se muestran
en esta pantalla incluso con el grafico. Para esto hay que presionar el botén “Print”.

5.3.4 CALIBRACION PHOTOMODELER

La calibracidn para Photomodeler se realiza en el mismo programa, a diferencia de
ImageMaster en el cual se realiza la calibracidon en un programa especifico.

Los parametros calculados son los mismos que en ImageMaster y comunes en la mayoria de
los programas que determinan la deformacién de las imagenes. Los pardmetros calculados son
los siguientes: f, K1, K2, P1, P2, Xp e Yp. También existe la posibilidad de calcular K3, aunque
Photomodeler por defecto no lo calcula. Este pardmetro se calcula para adquirir mayor
precision, y para camaras de gran formato. En el caso de una cdmara normal como la utilizada
no es necesario su calculo.

Hoja de calibracion

La calibracién se realiza a partir de las fotografias tomadas a un patrén. El tamafio de la hoja de
calibracién necesaria es de un formato Al o AO dependiendo de la focal utilizada.

La hoja de calibracién tiene el siguiente aspecto:
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Imagen 5.17: Matriz de puntos de la hoja de calibracién en Photomodeler

Para la toma de las imagenes la hoja debe fijarse en el suelo, teniendo cuidado de que se
encuentre plana, evitando los pliegues en la medida de los posible.

La hoja se compone de un total de 100 puntos de los cuales, 4 son marcas codificadas. Estas
marcas codificadas funcionan a semejanza de un cédigo de barras, y permiten al programa
identificarlas y emparejarlas con sus homélogas. De esta forma es capaz de realizar la
orientacion.

Toma de fotografias

Photomodeler para realizar la orientacion requiere de un minimo de 12 fotografias tomadas
desde cuatro ubicaciones determinadas y con la cdmara en tres posiciones concretas.

Las posiciones en las que debe estar la cdmara se muestran a continuacion:

Imagen 5.18: Posicion de la cdmara en la toma de fotos para la calibracion en Photomodeler

Las localizaciones desde donde hay que tomar las fotografias son las siguientes:
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Imagen 5.19: Localizacion de la cdmara en las fotos para la calibracién en Photomodeler

Ademas de esto, las imagenes deben estar tomadas de tal forma que el eje de la toma de una
fotografia y el de la de enfrente formen un angulo lo mds aproximado posible a 90°, ya que
esta serd la mejor interseccién para determinar la situacién de los puntos en el espacio.

Hay que tener en cuenta que la matriz de puntos debe cubrir la mayor superficie posible de la
fotografia ya que el drea de las fotografias de las cual va a ser modelada la distorsion, resultara
Unicamente la que esté recubierta por la matriz de puntos.

Por la esta misma razén, se debe intentar ajustar también los puntos de las esquinas de la
matriz a las esquinas de la fotografia.

También es preferible utilizar tripode para la toma de las fotografias, de forma que nos
evitamos problemas con movimientos de la cdmara a velocidades bajas; y por lo tanto no
tendremos restricciones en cuanto al tiempo de exposicién.

Este es un ejemplo de la serie de fotografias resultantes para la calibracidn, correspondiente a
una camara Nikon D700 de la que posteriormente mostraremos los pasos para la realizacion
de su calibracién.

Imagen 5.20: Ejemplo de la imdgenes para la calibracion en Photomodeler
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Atendiendo a todas los aspectos a tener en cuenta que hemos descrito anteriormente, resulta
necesario indicar que estas imagenes podrian ser mejores, y recubrir mas superficie con la hoja
de calibracidon; pero aun asi, son perfectamente utiles para la calibracion. Ya que como se ha
indicado también para Image Master no siempre es posible, por diversas razones, obtener las
imagenes tedricamente perfectas.

Ejemplo practico

Como ya se ha mencionado en el apartado anterior, en este ejemplo practico vamos a mostrar
los pasos para la calibracidon de una camara de la marca Nikon modelo D700.

Esta es una camara utilizada en los trabajos realizados durante el proyecto IP Erasmus en el
Monasterio de San Prudencio en Julio de 2010.

Paso 1: Abrir el proyecto de calibracién

El primer paso es iniciar un proyecto de calibracién. Para ello hay que seleccionar la opcion
“Camera Calibration Project” marcada en la imagen siguiente:

Getting Started... (7 ]

Click to create a new project:
Points-based project

Shapes-based project
*.Camem Calibration project
Automated Coded Target project

PMV project

Click to get help and learn:

Start Tutorial Videos
Open Help File

Click to open a recent project:

1: C\ ... \Calib PM (Nikon D700 ZScan).pmr
\Calib PM (Nikon D700 ZScan).pmr

\Calibracién\Calibracién.pmr

4: C:\ ... \Analisis distorsién\Idealize.pmr
Browse for project...

Click to access the web:

Main web site
Support FAQ
Available Modules

Open Copy of Tutorial Project
Check for updates (last check: 05/17/2011 17:31:48)

PhotoModeler Scanner

Imagen 5.21: Pantalla de inicio de Photomodeler

Paso 2: Seleccién de imagenes

En este paso se eligen las imagenes que queremos utilizar en la calibracién, para lo cual es
necesario buscarlas en el navegador de la izquierda y pulsar el botén indicado para pasarlas al
recuadro de la derecha, en el que se mostraran las imagenes que van a ser importadas al
proyecto creado.
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s

Select Photos - Camera Calibration project e
Select the photos that you will be using in this calibration project. 4 calibration requires between & s
and 12 photos, and must include photos 'rolled at 90 degrees. Make sure targets are crisp and .
targets cover as much of the photo frame as possible.

|\ CalibPM -
Name Size Tipode elems‘: Photo # |Name ‘ Size
s, DSC047) 243MB Suchivo TIE | | There are no items to show.
& _DSC0474 349MB  Archivo TIF
| & _DSC0475 349MB  Archivo TIF
&/ _DSC0476 349MB  Archivo TIF |5
| _DSC0477 351MB  Archivo TIF
| _DSC0478 351MB  Archivo TIF
|&|_DSC0479 351MB  Archivo TIF | | 5
&/ _DSC0480 352MB  Archivo TIF
|&_Dsco4s1 352MB  Archivo TIF Al
| & _DSC0482 352MB  Archiva TIF  _ 5
‘-\_‘:&Q:—«:’"—E&;r T < [l R

C:\A\PM\CalibraciéniCalib PMY_DSC0473.TIF

Imagen 5.22: Pantalla de seleccion de imdgenes

Paso 3: Calibracidén automatica

El siguiente paso es el inicio de la calibracién automatica. Tras la seleccion de las fotografias
aparece directamente la ventana de calibracién automadtica de la cdmara, para lo que hay que
pulsar el boton “Execute Calibration”.

e Edt View Making Kd-l\g Broject Wiviow: - Qptions: - Dense Stace: Help B
DA 3B 8 %NS D2 RkZ | EB+. O | 0eandse~ | o&%HAHN00[E N,
LEEEREE-E-S-8BlL. S BV .

[Phototist 9

¢B ¢8| & ag[anphotos  [o]

.-..-.-.-__'
Automatic Camera Calibration (===

[ )

Imagen 5.23: Pantalla general del programa

El proceso comienza automaticamente y va mostrando en la pantalla el proceso que estd
realizando en cada momento hasta que finaliza y muestra los resultados.

Al inicio muestra el nimero de puntos que se han encontrado en cada foto. Unicamente serdn
las fotos en las que haya encontrado las cuatro marcas codificadas, las que se utilizaran para el
calculo de los parametros de calibracién. En caso de no utilizarlas lo indica, como se puede ver
en la pantalla de la izquierda de la imagen siguiente.
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r N 1 B
Automatic Camera Calibration M Automatic Camera Calibration &
Camera Calibration - - Overall RMS residual changed from 32.003920 to 31.953524. .

5 * ¥p deviation 0.077389, remaving Xp.
Auto-marking - Overall RMS residual changed from 31.953524 to 32.484555.
- Photograph 1 = “Yp deviation 0.062180, remaving Yp.
* automarking done : 102 points, 4 control paints -0K - Overall RMS residual changed from 32.484555 to 32.452104.
- Photograph 2 = * deviation Fw=0.062903 Fh=-1.000000, removing K3.
* automarking done : 101 points, 4 control points -0K - Overall RMS residual changed from 32.492104 to 32.167035.
- Photograph 3 * deviation Fw=0.064645 Fh=-1.000000, removing K2.
* automarking done : 101 points, 4 control points -0K - Overall RMS residual changed from 32.167035 to 32.151211.
| | - Photograph 4 * deviation Fw=0.062755 Fh=-1.000000, removing K1.
* automarking done : 101 points, 4 control points -0K - Dverall RMS residual changed from 32.151211 to 31.617432.
- Photograph 5 * Fw deviation 0.055387, removing Fu.
* automarking done : 165 points, 4 control points -0K - Overall RMS residual changed from 31.617432 to 32.455612.
- Photograph 6
* automarking done : 240 points, 3 contral points -will nat use - Checking correlations
- Photograph 7 ‘E
* automarking done : 169 points, 4 control points -0K Calibration finished with questionable results. Overall RMS: 32,4551
- Photograph 8 - Parameters solved: F. (4
* automarking done : 136 points, 4 control points -0K - - Parameters not solved: Xp, Yp, Fw, Fh, K1, K2, K3, P1, P2. -
[ Execute Calibration ] [ Options... ] [ Show Report... ] [ Execute Calibration ] [ Options... ] E Show Report... ]

Imagen 5.24: Pantallas resultado proceso de la calibracion

En la pantalla de la derecha de la imagen, indica los parametros que han sido resueltos en esa
calibraciéon. En nuestro caso de forma automatica sélo ha sido capaz de calcular la focal (F).

Paso 4: Resultado de la calibracion

Pulsando el botdon “Show Report”, accedemos al informe del resultado de la calibracién.

En nuestro caso especifico muestra un error de que el residuo es mayor a 430 pixeles, lo que
indica que la calibracién automatica, como se puede percibir de la no resolucidon de los
pardmetros, es muy mala.

r — N
# ° Project Status Report M

= Status Report Tree -
Project Name: *= Project has not yet been saved =
=]--Problems and Suggestions (1)
[=)--Project Problems (1)
Problem: A large percentage of your points are sub-pixel
marked so it is assumed you are striving for a high accuracy
result. The largest residual (Point817 - 430.301712) is greater
than 1.00 pixels 3
Suggestion: In high accuracy projects, strive to getall |~ |
point residuals under 1.00 pixels. If you have just a
few high residual points, study them on each photo to
ensure they are marked and referenced comectly. if
many of your points have high residuals then make
sure the camera stations are solving comectly. Ensure
that you are using the best calibrated camera
possible. Remove points that have been manually
marked unless you need them.
Problems related to most recent processing (0)
[#-Information from most recent processing
=} Quality
|- Photographs
(=) Cameras
=1--Cameral: NIKON D700 [20.00]
Calibration: yes

[ Close ] [Wlite to text file... ] i Help 1

Imagen 5.25: Pantalla Informe de resultado de la calibracion

Paso 5: Marcado de los puntos ho detectados

Cerramos todas las ventanas hasta que volvamos a encontrar la pantalla principal.
Revisaremos las fotos que no han sido orientadas, y borraremos los puntos que haya
detectado el programay no se correspondan a los de la matriz.
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Los puntos que no corresponden se pueden clasificar en dos tipos: los que no suponen ningun
problema ya que no estan emparejados y se muestran de color gris (ni siquiera seria necesario
eliminarlos); y los que si son problematicos, porque se encuentran emparejados e intervienen
en la orientacidn y por consiguiente en los calculos mostrandose en color blanco. Estos deben
ser eliminados.

En la imagen siguiente aparecen en la parte izquierda muchos puntos no correspondientes a la
matriz, por lo que conviene eliminarlos. La marca rodeada con color rojo es una marca que no
ha sido detectada automaticamente por lo que la deberemos marcar manualmente.

Imagen 5.26: Imagen con marca no detectada y pyimytbs”fuera de la matriz

Este proceso se deberd seguir con todas las fotografias que se estan utilizando en la
calibracion.

<F
~0o g|

~ O | [Photo2:_DSCOST4 : riented :6% ~ O 3| [Photel - _DSC0473: orented : 6%

~ O 13| [Photo? :_DSCOAT9: oriented 6% ~ O (1] [Photos - DSCOA7A 1 not oriented :6% ~ O (3] [Photos:_DSCOT7: orented :6% ~og

=700 | [Photol :_DSCO483 : not criented :6% ~ O 3] [Photo10: DSC0482: oriented : 6% = O 3] [Photod: _DSCOM8I : orented 6% ~o

Imagen 5.27: Imdgenes con todos los puntos detectados correctamente

Paso 6: Reintento de la calibracién automatica

La recalibracién se realiza en el siguiente menu: Project -> Camera Calibration. Antes de
ejecutar la calibraciéon hay que modificar las opciones, deseleccionando el marcado de puntos
como se indica en la imagen siguiente:

68



Documentacion y representacion de paramentos verticales en riesgo de colapso.
Aplicacién en el Monasterio de San Prudencio (Clavijo, La Rioja).

5. EJECUCION

. FocalTeql
3. Drientation
[¥] 4. Automatic Referencing Stage 1

| 5. Processing Stage 1
E. Automatic Referencing Stage 2
7. Processing Stage 2
8. Deviation and Correlation check

Open the Camera Information dialog
to view current camera parameters:

Camera...

Parameters to Calibrate
Automatic processing parameter assignment

Processing Stage: | Stage 1 v

Focal Length: Fiducial Camera Pixel Aspect:
‘width: Height:
Principal Point: X Y

Radial Lens Distortion: K1: [§ K2:

Format size:

Decentering Lens Distortion: P1: | P2

Please note: Calibration options should not be changed
unless you are experiencing problems and you need to skip
certain stages.

0K

] [ Cancel ] [ Help ]

Imagen 5.28: Pantalla opciones de calibracion

Una vez deseleccionada esta opcidn se realiza la calibracion automadtica; indicando el

resultado, como se ve a continuacion, que todas las imagenes han sido utilizadas y que se han

calculado los pardmetros deseados.

[E=)

Automatic Camera Calibmﬁoi_

u Automatic Camera Calibmﬁoi

Camera Calibration

Auto-marking - Skipped - Verifying Photos
- Photograph 1
* previously automarked : 100 paints, 4 control points -0K
- Photograph 2
* previously automarked : 100 points, 4 control points -0K.
- Photograph 3
* previously automarked : 100 paints, 4 control points -0K
- Photograph 4
* previously automarked : 100 points, 4 control points -0K
- Photograph 5§
* previously automarked : 100 points, 4 control points -0K.
- Photograph &
* previously automarked : 100 paints, 4 control points -0K
- Photograph 7
* previously automarked : 100 paints, 4 control points -0K
- Photograph 8
* previously automarked : 99 points, 4 control points -0K

- second pass done, 100 3D points

>

Calibration processing-2

- Calibrating parameters: F, Xp, Yp. Fw, K1,K2, K3, P1, P2.
- second and final pass done

* Overall RMS residual: 0.301507

m

Checking standard deviation and correlation values:

- Checking deviations

* P2 deviation 0.000002, remaving P2.

- Overall RMS residual changed from 0.301507 to 0.301512

- Checking correlations
* K3 is corelated with K2:-97.7%, removing K3.
- Overall RMS residual changed from 0.301512 to 0.318222.

Calibration successful with an overall RMS residual of 0.318222
- Parameters solved: F, Xp, Yp, Fw, K1,K2, P1.
- Parameters not solved: Fh, K3, P2,

1

[ Execute Calibration ][ Options... ] [ Show Repot...

{ [ Execute Calibration ] [ Options... ] [ ShowRepatt.. |

Imagen 5.29: Pantallas resultado proceso de la calibracion

En el informe de calibracién se comprueba que la calibracion sigue presentando un problema

pero este es que el residuo es 1,4 pixeles cuando el maximo admisible es 1, segun el criterio

del programa y recogido en el manual de Photomodeler.

(=) Status Report Tree

[=--Quality

(= Cameras

Project Name: *™ Project has not yet been saved =™
[=)-Problems and Suggestions (1)
(=) Project Problems (1)
Problem: A large percentage of your points are sub-pixel
| marked so it is assumed you are striving for a high accuracy
- resut. The largest residual (Point33 - 1.455638)is greater than
1.00 pixels.

Problems related to most recent processing (0)
[#)Information from most recent processing

[+ Photographs

[=--Camera1: NIKON D700 [20.00]

Suggestion: In high accuracy projects, strive to get all |=
point residuals under 1.00 pixels. ff you have just a
few high residual points, study them on each photo to
ensure they are marked and referenced comectly. if
many of your points have high residuals then make
sure the camera stations are solving comectly. Ensure
that you are using the best calibrated camera
possible. Remove points that have been manually
marked unless you need them.

Calibration: yes

Close Wite to text file...

Imagen 5.30: Pantallas informe de la recalibracion
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Paso 7: Solucidn de problemas

Para poder reducir el residuo maximo de la orientacion debemos conocer los puntos que
presentan un residuo mayor, lo que se puede consultar en el menu: View -> Point Table —

Quality.

En la imagen siguiente se puede observar los puntos que presentan un residuo mayor a 1.

Point table - Quality

RM: rg Ph Ref.
Id Name Resisdual E:s?c Lal't;t:st Photos )Ffre(isi :reds' gre(isi (Trlr?)htnes :’neglj gseln Frozen C:\eck
(pixels) | (pi..  |Residual Q) | Froces.. Tag
99 0.7547... |1.4556... |9 1234,..53362... 5.3573... |89334... 0.0007... 48.191... |yes no
11 0.5975... |1.2997... |2 1,234,../5.5248... |6.5936... |9.6930... |0.0006... 48.458... yes no
6 0.5011... |1.2546... |2 1,234,../43332... |51613... |9.1287... |0.0007... |51.793... |yes no
98 0.5603... |1.0074... 3 1,234,../4.0751... |4.3678... 8.7775... |0.0006... 51.891... yes no
14 0.4238... |0.9732... |2 1,234,../41352... 45784... |9.0544... |0.0007... 58.414... |yes no
20 0.4244... |0.9267... 2 1,234,..44673... |4.2642... 9.0466... 0.0006... |51.425... yes no
7 0.4456... |0.8866... |4 1234,..46161... 59972... |9.6254... 0.0006... 51.880... |yes no
19 0.3505... |0.8673... |10 1,234,../4.6803... |4.5850... 9.0253... |0.0004... 49.892... yes no
5 0.3523... |0.8591... |2 1,234,../4.0938... |4.7082... 9.0064... |0.0004... 54.125... yes no

Imagen 5.31: Tabla de calidad de los puntos

En este momento nos encontramos en una disyuntiva. Primero se ha de comprobar la razén
por la que dichos puntos tienen un residuo mayor.

En el caso de que el punto esté mal ubicado, es obvio que se deberd eliminar. Pero, por otra
parte, suele ser habitual que los puntos de las esquinas de la matriz de calibracién tengan unos
residuos algo mayores. En este caso es donde debemos tomar la decisidn, de por cudl de las
siguientes soluciones nos decantamos:

- Dejar los puntos que tienen un residuo un poco mayor y asumimos que la precision de la
calibracion resultard finalmente algo menor, y de esta forma disponemos de la calibracién en
todo el 4rea de las fotografias que ocupa la matriz de puntos. Por lo que podremos restituir
puntos que se encuentren mas hacia los bordes de la fotografia.

- O eliminar estos puntos, y asumir, que aungque tengamos una precision mayor en la
calibracion; solo podremos restituir los puntos que se encuentren en el interior del poligono
formado por los puntos utilizados en la calibracion.

Para este ejemplo la solucién tomada es la segunda, por lo que se eliminaran los puntos de
residuo mayor a 1 pixel.

La solucidn para reducir el residuo es eliminar los puntos que tienen los mayores residuos. El
residuo maximo de cada punto se corresponde con la cuarta columna de la tabla de la imagen
anterior.

Para eliminar un punto Unicamente en la imagen en la que este tiene mayor error, es
necesario abrir la imagen correspondiente y suprimir el punto.

Después de borrar cada punto hay que “procesar” para que se recalculen los residuos. En este
caso los puntos eliminados han sido:
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Punto Imagen
99 9
11 12
6 2
99 8
20 2
14 4

Tabla 5.2: Puntos eliminados

Una vez que el residuo maximo es menor que 1 pasaremos al siguiente paso.

Paso 8: Calibracidn final

En esta ocasién en las opciones, hay que deseleccionar también el cdlculo de la distancia focal
y de la orientacidn, ya que en el caso de volver a orientar cambiarian otra vez todos los valores
de los residuos.

Parameters to Calibrate
[11. Automatic Marking Automatic processing parameter assignment
0 Esnation Processing Stage: | Stage 1 v
71 4. Automatic Referencing Stage 1 Focal Length: Fiducial Camera Pixel Aspect:
5. Processing Stage 1 Format size: width: Height:
[V] 6. Automatic Referencing Stage 2 Principal Point: X [ hs il
7. Processing Stage 2 Radial Lens Distortion: K1 K2 K3
8. Deviation and Correlation check Decentering Lens Distortion: P1: | P2:
Open the Camera Information dialog Please note: Calibration options should nat be changed
to view current camera parameters: unles_s you are experiencing problems and you need to skip
certain stages.
[ OK ] [ Cancel ] [ Help ]

Imagen 5.32: Pantalla opciones de calibracion

Tras realizar la calibracién obtenemos finalmente un informe de resultados satisfactorio, en el
que no se nos indica ningun problema.

e TS

[SE® Status Report Tree
Project Name: Calib PM {Nikon D700 ZScan).pmr
Problems and Suggestions (0)
Information from most recent processing
= Quality
[#----Photographs
(=)~ Cameras
(=~ Camera1: NIKON D700 [20.00]
Calibration: yes
Number of photos using camera: 12
Average Photo Point Coverage: 84%
[=)-Photo Coverage
Number of referenced points outside of the Camera’s
calibrated coverage: 0
[#---Point Marking Residuals
[#---Point Tightness
[#-~Point Precisions

&
#

[ Cose |[wicwtestie. ][  Hep |

Imagen 5.33: Informe de resultados sin problemas
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En el botdn “Write to text file...” se tiene la opcidn de grabar un fichero de texto con todos los
resultados.

Para finalizar la calibracién lo éptimo es realizar un analisis de los valores de los errores
obtenidos en el cdlculo de cada parametro, asi como comprobar el grado de correlacion
existente entre el cdlculo de cada parametro.

El error en el cdlculo de cada pardmetro debe ser inferior al pardmetro, ya que en caso
contrario no estariamos mejorando la funcién de distorsién si empledsemos dicho pardmetro
en las ecuaciones. Y la correlacidn no debe ser excesivamente alta (nunca mayor del 80%), ya
gue significaria que el valor de un pardmetro es muy dependiente de otro lo que no nos
resultaria una calibracién buena.

El programa ya tiene en cuenta estos pardmetros para no calcular el parametro en tal caso,
pero nosotros podemos consultar dichos errores en el apartado “Information from most
recent processing” del informe de resultados, o en el fichero de resultados en el caso de haber
sido creado.

Al cerrar esta ventana informe de resultados, se nos da la posibilidad de guardar la calibracidn
de la camara finalizada en la libreria de cdmaras de que dispone Photomodeler. En tal caso al
introducir una imagen realizada con esta cdmara, gracias a los datos del fichero EXIF adjunto a
las fotografias, el propio programa nos reconoceria la cdmara y no seria necesario ni introducir
los parametros ni un fichero de cdmara.

Los pardmetros de la cdmara que finalmente estamos utilizando pueden ser consultados en el
menu: Poject -> Camera.

Camera Viewer _— -

Cameras in Project Name
NIKON D700 [20.00] [Default] KON D700 [20.00)
Calibration Used by Photos
pe 1.2345678591011.12
Calibrator

Image Size

Focal Length W 4256 H: 2832

205272
Fiducials

Format Size W]
We 360012 H: 239549 Type: [NoFiducids v

Fiducials: ~ mm
Principal Paint ‘ "

X 17.8246 Y. 121453

EXIF Fields

Make: NIKON
CORPORATION

Model:  NIKON D700

Lens Distartion

K1: 2.424e004 P1: 1.228e-005
K2: -3.951e-007 P2: 0.000e+000
K3: 0.000e+000

Focal Length

L New J [ Delete J Calibration Quality Values 20,0000
Overall Residual RMS: 03035
[ Copy I I Setias Defoult ] Masimum Residual: 03473 Fomat Size
[Load from disk,..ll Library... ] Photo Coverage (%): 84 W: 36.0000 H: 239549
| 0K | [ Cancel } [ Help J

Imagen 5.34: Pantalla en la que se indican todos los paradmetros de la
cdmara y de su calibracion.

Anadlisis de las fotografias para la calibracion
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Una vez que tenemos el proyecto de la calibracion terminado, podemos comprobar en la
visualizacidn 3D las posiciones de las cdmaras para la toma de cada una de las fotos utilizadas
para calibrar.

El aspecto de los puntos de la matriz de calibracién con las posiciones de cdmara es el que se
muestra a continuacion:

Imagen 5.35: Visualizacion 3D de los puntos y las posiciones de cdmara

El andlisis que vamos a realizar, es si la toma de las imagenes para la calibracion es la
tedricamente ideal.

Como se ha mencionado anteriormente el dngulo ideal entre imdgenes opuestas es de 90°.

Para medir los angulos hemos introducido en AutoCAD las proyecciones ortograficas de los
puntos y las cdmaras. Los resultados obtenidos son los siguientes:

Imagen 5.36: Proyeccion ortogrdfica acotada (“Front view” en la izquierda y
“left view” en la derecha).
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En esta ocasidn el angulo mayor varia entre 66° y 33°. Aunque no son éptimos, tampoco es
necesario dedicar demasiados esfuerzos a conseguir el angulo ideal; solamente intentar tener
en cuenta estos valores en la medida de lo posible.

Calibracidn inversa

A modo informativo, ya que este no es el objetivo del presente proyecto, se va a describir las
posibilidades que ofrece el programa para trabajar sin calibracién previa.

El programa permite trabajar con una cdmara desconocida. Esto podria ser el caso, por
ejemplo, de que obtengamos una serie de fotografias las cuales no hemos tomado nosotros y
no dispongamos de la cdmara con la que han sido tomadas para realizar la calibracién.

En las opciones que el programa nos muestra, la mds interesante, es la de nos permite realizar
la calibracién inversa a partir de una serie de puntos de control tomados en campo. Si
disponemos de las coordenadas de un minimo de 5 puntos de control identificables en las
fotografias podremos realizar la calibracion.

Q) i&n unknown camera, whose parameters will be solved by

@ Control Points / Imports [need 5 or more control points]
Shapes [predefined shapes such as boses, wedges, pyramids, etc.]
Constraints [heed 3 or more parallel and perpendicular lines in perspective]

Approximation [camera will not be solved - suitable for photo review only]

Imagen 5.37: Opciones de trabajo con cdmara desconocida

En este caso, el programa asigna a cada fotografia una cdmara desconocida independiente, en
la que sélo se conocen los parametros procedentes del fichero EXIF.

Una vez que se han introducido puntos de control suficientes con coordenadas desconocidas,
el programa es capaz de realizar el calculo de los parametros de distorsion; asi como de la
focal, que variara algo con la indicada en el fichero EXIF.

El que se le asigne a cada fotografia una cdmara independiente, y por lo tanto distinta focal,
hace pensar en la posibilidad de tomar las imagenes en modo de autoenfoque ya que las
variaciones, no muy grandes, de la distancia focal seran detectadas y determinadas en el
proceso de calibracién.

Existe otra posibilidad de operar empleando la calibracién de otra cdmara que no se
corresponda con la utilizada.

Al asignar la cdmara a la imagen se nos mostrara un mensaje en el que se nos informard de
que los parametros de la cdmara no corresponden con los obtenidos del fichero EXIF, el cual
deberemos obviar.
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The images listed below do not match the characteristics of the
camera to which they are assigned [shown above the image).
Processing the project in this state will either fail or will give poor
ACCUracy.

Item | Name Width |Height | EXIF-Foc
Camera Canon EOS5D... 5616 3744 350 ‘

Photo#1 _DSC0305.tif 4256 2832 200
Camera Canon EOS5D.. 5616 3744 350
Photo#2 _DSC0306.tif 4256 2832 200
Camera Canon EOS5D... 5616 3744 350

< 1

Please correct by assigning the correct camera.

[ Close [ Hep |

Imagen 5.38: Mensaje de no concordancia de pardmetros

Se introducen puntos homodlogos en todas las fotografias de forma precisa, y cuando se ha
realizado la insercion de un numero de puntos considerable se ha de realizar el calculo de la
calibracién inversa aplicando el siguiente ajuste en las opciones de procesado:

g .

Steps  Options I Reasons | Audit Summary I Audit Overview | Audit Photo | Audit Points |

[]1. Orientation (&InverseCamera) Accuracy Potential based on Audit Details (1-5):  4-High

(") orient only unoriented photos S =
@ orient all photos No suggestions Next Suggestion

-

[¥] 2. Global Optimization
[¥] 3. Self Calibration

[¥] Process Constraints

[T] Save Project before processing

Imagen 5.39: Ventana opciones de procesado

De esta forma se recalcularan los parametros de la calibracién y se creard una camara nueva
dandote la opcidn de almacenarla también en la libreria.

Se ha intentado realizar la calibracion mediante este ultimo proceso y no se han obtenido
resultados satisfactorios en la prueba realizada. En teoria el correcto funcionamiento de este
sistema, depende de alcanzar un nimero considerable de puntos (al menos 40 o 50 segun
algunos ejemplos encontrados en la red — www.worldphotogrametry.com); y de la precisién en
la determinacidn de los mismos.

5.3.5 CALIBRACION ORTHOWARE

Orthoware es un programa diferente en lo que a la calibracidn se refiere. Al igual que el resto
de programas de restitucion precisa los parametros de distorsion de la camara, pero su forma
de obtenerlos es diferente a la forma habitual de ImageMaster y Photomodeler.
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Para poder trabajar con Orthoware no es necesario disponer previamente ni del fichero de
camara, ni de los pardmetros de la calibracidon. Es en el propio proceso de trabajo cuando este
programa calcula dichos pardmetros.

Al contrario que los otros dos programas utilizados, Orthoware no calcula la calibracién a partir
de fotografias de una hoja de calibracién o patrén materializado; sino que la realiza a partir de
los puntos emparejados en las fotografias del propio proyecto que se estd ejecutando, después
de haber sido correctamente orientado.

En realidad el proceso de calibracion de Orthoware es similar a la calibracién inversa de
Photomodeler. Orthoware se vale de los puntos homdlogos obtenidos por correlacion
automatica para realizar la calibracién de la cdmara o cdmaras del proyecto, dependiendo de
la opciodn elegida.

Opciones de calibracion

Orthoware permite realizar la calibracién de un modelo de cdmara o de multiples modelos de
camara segun se requiera.

Para poder realizar la calibracién, los puntos homdlogos marcados (a partir de ahora se
denominardn “marks”) deben estar perfectamente identificados y emparejados; ya que la
calidad de la calibracién depende de cémo se haya realizado este proceso de identificacidon y
emparejado.

Para la calibracién existen dos opciones principales:

Single Camera Calibration -> Se realiza la calibracién de un tnico modelo de camara con el cual
se han tomado todas las imagenes del proyecto

Multiple Camera Calibration -> Se calibran un nimero indefinido de modelos de cdmara, uno
para cada imagen.

Para realizar la calibracion se accede a la pantalla correspondiente en el menu: Project ->
Cameras -> Calibration.

Para poder realizar la calibracion es necesario que existan al menos 8 puntos 3D, aunque bien
es cierto que la calibracién serd mejor cuantos mas puntos tenga disponible el programa para
realizar la calibracidn, siempre que estén correctamente identificados y emparejados.

La calibracién se realiza Unicamente de las imagenes que se encuentran seleccionadas. Si se
quiere realizar una “Single Camera Calibration” para un grupo de imdgenes, pero existe otro
tomadas con otro modelo de cadmara, sera necesario bloquear la orientacién de las que no
queremos realizar la calibracidon y de este modo podriamos ya proceder a calibrar el grupo
deseado seleccionandolas previamente.

En la practica, las funciones “Single Camera Calibration” y “Multiple Camera Calibration” son
dos opciones las cuales tienen una aplicacion bien definida.
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La “Single Camera Calibration” se utiliza cuando todas las fotografias del proyecto estan
tomadas con la misma cdmara y con la misma configuracién de enfoque, zoom y focal.

Por el contrario, la “Multiple Camera Calibration” nos permite poder enfocar cada imagen por
separado. Si se hace esto, aunque todas las imagenes se han tomado con la misma cdmara la
focal varia levemente entre fotografia y fotografia; por esto serd necesaria una calibracién
independiente para cada fotografia.

Esta posibilidad de utilizacidon del Autofocus “AF” nos supone una gran ventaja ya que nos
aseguramos que todas las fotografias estardn correctamente enfocadas, lo que en ocasiones
con un objetivo fijo puede resultar ciertamente complicado.

Calibration @

Lalibration Type
() Multiple Camera Calibration
(® Single Camera Calibration
[[] Actualize Camera
Internal Parameters to Calibrate
Focal Length (0100000 4
Principal Paint
1] (0001000 4
Y |0.001000 3
Radial Distortion
K1 [0.001000 4
K2 (000000 %
K3 [0.000100 4
Tangencial Distortion
P1 [oomooo 3
P2 [oootoon &
Select All
[ Calibrate ] [ LCancel J

Imagen 5.40: Pantalla opciones para la calibracion

Las opciones que se presentan en la calibracidon, como se puede ver en la imagen anterior, son
las siguientes:

Actualize Camera -> Actualiza los pardmetros de foto calculados a la cdmara cuando se finaliza
la calibracion.

Refresh Orientation -> Actualiza la orientacién a la vez que calcula los pardmetros internos.

Use Camera Internal Params -> Utiliza los pardmetros internos correspondientes a la cdmara,
en vez de los de cada fotografia.

Se pueden seleccionar los parametros que queremos que sean calculadas. En las cajas de texto
se puede seleccionar la precisidn con la que queremos que se calcule cada parametro. El
programa va calculando el parametro iterativamente y cuando el valor calculado del
parametro en la ultima iteracidn tiene una variacidon respecto a la anterior menor que el valor
de precision indicado dara el valor del parametro como bueno.
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Una vez que se ha realizado la calibraciéon; en la pantalla del modelo de cdmara se muestran
los parametros calculados que anteriormente se encontraban a 0.

La consulta de la pantalla de modelos de cdmara se realiza en el menu: Project -> Cameras ->
Models.

Camera Models

Properties In use camera models
T T ypupeoura Y 141KCIN D700 - NIKON CORPORATION (Image Params]
oL 19.9500771
b U m 9
'CD ¥ [mr = 15.9699249
J Resolution fpx] LY < I
2832 >
Available camera models
| 11.9978362 Canon Powershot A57015
— Canon 40D Sigma 24mm
g 7996459 FinePix52Pro - FLUIFILM
Tmm~2) Sl Renisa 3t
a1 1.449701E07
K3 (mm™-6 . -§.529826E-10
mm™-1] -3.317835E-05
220 as il 0000381366
New Set as default
T .

Imagen 5.41: Pantalla modelos de camara, pardmetros de cdmara calculados

Como se ve en la imagen, este programa calcula el parametro K3 por defecto, que
anteriormente se ha comentado que no es estrictamente necesario para cdmaras normales. Se
puede calcular si se quiere obtener una calibracién mas precisa.

Breve comparacion de las calibraciones

A pesar de que en el proyecto existe un apartado especifico para la comparacion de las
cualidades y procesos de cada programa, Unicamente realizar un breve resumen de los puntos
mas importantes.

La principal diferencia entre las calibraciones es la capacidad de intervencién que tiene el
usuario sobre los resultados. Mientras que en Imagemaster el proceso es completamente
automatico, no permitiendo ni seleccionar los parametros de distorsion que se quieren
calcular; en Photomodeler y Orthoware si existe esta opcién. De los tres programas, el que
mas permite la interactuacidn es Photomodeler, lo que resulta un punto a favor.

Otra cualidad de los programas es que tanto Photomodeler como Orthoware permiten la
calibracion inversa sin necesidad de calibracién previa; lo que tiene como consecuencia la
posibilidad de utilizar el autofocus “AF” en la toma de fotografias (“multiple camera
calibration” en Orthoware).
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5.4 FLUJO DE TRABAJO

5.4.1 FLUJO DE TRABAJO EN IMAGE MASTER

Image Master es un programa de la casa Topcon para la generacién de modelos 3D y ortofotos
a partir de fotografias estereoscdpicas.

El flujo de trabajo en Image Master resulta bastante cerrado. Se trata de una serie de pasos
que hay que seguir para la generacién del modelo y las ortofotos. El esquema del flujo y los
pasos a realizar son los siguientes:

GOPCON IMAGE MASTER)

v

Crear nuevo
proyecto

v

Insertar datos de

¢7 entrada ﬁ

Fotografias Puntos de control

| |
v

Abrir fotografias

v

Marcar puntos

v

ORIENTACION
IMAGENES

v

Generar pares

ORIENTACION
PARES

Abrir par
estereoscépico
v
Dibujar lineas de
rotura

CREACION DEL

MODELO
Seleccionar puntos: Limpiar modelo
Definicion plano ortofoto P
GENERAR Exportar modelo
ORTOFOTO (VRML)

Exportar ortofoto
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Diagrama 5.2: Flujo de trabajo en ImageMaster

Paso 1: Crear un proyecto nuevo

En la pantalla principal del programa se pulsa sobre “New Project”, marcado en la imagen; y
emerge la ventana en la que hay que indicar el nombre del proyecto y la ruta en la que se
quiere ubicar.

P 7 Oientation ]S
Dol ik oo IXXKIXKK P iWmoeE %@ H @ OPGNE |d
- o |~ A @0 O EE

o]
s oot roct e _ G|

The project folder is created in the following place.
| C:\Users\Pablo\Desktop\ Change...

it -ax

Objects [Images | Image List [ Stereo List
For Help, press F1 KANA CAP NUM SCRL

Imagen 5.41: Pantalla principal y nuevo proyecto

Paso 2: Abrir imagenes

Primero hay que acceder al modo “Orientation” y para abrir las imagenes hay que accionar el
icono de la cdmara de fotos: @

Aparece la ventana en la que hay que seleccionar la carpeta en la que se encuentran las
imagenes que se quieren abrir.

Busgaren: [ )| Fotos ~| e @@
5

Esciitorio

E _MG_0759 _MG_0761 _MG_0763
Bibliotecas

o

Equipo

-

Cancelar

Imagen 5.42: Pantalla para especificar la ubicacion de las fotografias
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Una vez seleccionada la carpeta aparece otra ventana en la que se permite la seleccion de las
fotografias individualmente.

50761 PG MG 0763 PG

|fmet1s

Select All(A)
Select None(E)
Phice GEIBE0e F: \Users\Pablo\Desktop\Fotos

Register
LMG_O?SQ.JPG
Cancel

Image File Name

Imagen 5.43: Ventana registro de imdgenes

En esta pantalla se selecciona también el fichero de camara resultante de la calibracién con el
programa Image Master Calib.

El fichero tiene el siguiente aspecto:

3 e o e rote N o =

Archive Edicién Formato Ver Ayuda

21.009384 // Focal Length -
17.553642 // Xp —i
11.534916 // Yp

2 // Distortion Model

4 // Number of Distortion Parameters

2.155644e-004 // k1 3
-4.245722e-007 // k2 3
-7.434786e-006 // pl

-1.130067e-005 // p2

0.006200 // X Resolution

0.006200 // Y Resolution |
0 // Number of Fiducial marks

4

Imagen 5.44: Fichero de cdmara

Cuando se han realizado todas las selecciones se pulsa el botén “Register”.

Aparece el siguiente mensaje:

Imagen 5.45: Ventana copiar imdgenes en carpeta proyecto
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Lo mas cdmodo es responder que si pero si son muchas fotos la carpeta de proyecto puede
llegar a pesar demasiado y resultar menos manejable.

Las imdgenes aparecen en la pantalla principal del programa abriéndose realizando doble click
sobre cada una de ellas.

En la siguiente imagen se muestra la pantalla principal del programa en el modo de orientaciéon
con las tres imagenes que se han importado abiertas.

Al abrirlas aparece la imagen completa en un recuadro y en el otro la zona ampliada que
delimita el recuadro azul que indica el area de visualizacion del zoom en la foto completa.

[@ Topcon image Master - 1
File) EdME) View) O
@ Model 09 Remote @ Regi
PoFE OO
TRe oM A

Progect “ax MG_0759 | [ _MG_0761 | ] _MG_0763 (i) Modell =2

Q) Sewpls
on [} Onentstion [ Stereo
LK1 BEDS

indow(¥)  Help(t)

() File = Modell\Modell
£ Stations )

Images v ox
# (L Modell

Images Image List | Stere
For Help, press F1 FULLODGOSOM  ZOOML NuM

Imagen 5.46: Pantalla principal con las imdgenes abiertas

Paso 3: Importacion de los puntos de control

Para acceder a la importacion de los puntos de control hay que pulsar el siguiente icono: xy2

En la ventana de abrir los puntos de control se selecciona el fichero ASCII con las coordenadas.

e 222
Buscaren: [} Apoyo ~| eBmcEr
ey Nombre = Fecha de medifica... Tipo
s racerdes fglesfa muro oeste - rel 07/04/2011 18:17 Documen
_|iglesia muro oeste 31/03/2011 17:35 Documen
Escritorio
w=!
Bibliotecas
i
A
Equipo
w
Red
« n »
Nombre:  figlesia muro oeste -rel ~| Ao
Tipo: |P0|nt Files(*.csv:".gcp;”.apa;”sim;"bd) L] Cancelar

Imagen 5.47: Ventana abrir puntos de control
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Es recomendable introducir los puntos de control en coordenadas desplazadas, para esto se
recomienda restar un numero fijo a las coordenadas de todos los puntos, en nuestro caso
540000 metros a las coordenadas X y 4680000 a las coordenadas Y. Esto se recomienda para
que el programa pueda realizar los célculos mas facilmente.

Una vez seleccionado el fichero aparece la siguiente ventana:

TSR —

File Name: I C:\Users\Pablo\Desktop\Apoyo\jglesia muro oeste - rel. txt

Number of Header Lines: 0 v l
Delimiter: [~ Comma [~ Space ¥ Tab

Coordinate System: Mathematical (XYZ : ENH )

01 [ 02 [ 03 [ 04
Name X Y iz
D4_C837 8237.937  8484.068  709.585
( 8237.961  8484.141  708.571
D4_C834 8238.041  8484.534  707.186
D4_C833 8238.723 8484331  706.226
D4_C835 8241,100 8484110  704.825
8238.017  8483.341  707.987
8238.171 8483724  706.246
8238.039  8483.921  704.868
8233.068 8482246  707.691
D4_C841 8233.018 8482680  705.608

Cancel

Imagen 5.48: Ventana personalizacion de la importacion

Hay que indicar el nimero de lineas de cabeceras que tiene el fichero y el elemento por el que
estan separadas las coordenadas.

Al importar las coordenadas se muestra el siguiente mensaje de confirmacién:

Image Master -L | ﬂ

lol 18 points were loaded.

Imagen 5.49: Mensaje de confirmacion de la carga de los puntos de control

Una vez completada la carga de los puntos, apareceran a partir de este momento en el
modelo. Los puntos se han cargado en una capa que recibe el nombre del fichero que los
contenia.

Es necesario importar los puntos de control para poder realizar la orientacion de las
fotografias.
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En la siguiente imagen se ve el modelo en el que aparecen los puntos que han sido
importados.

(@ Topcon Image Master - (Model {

Fie) EGMD Viewl) Orentation(@) Setpl® Window(W) Help(H) x

@ Model 9 Remote @ Registration [FE3 Orientation | [ Stereo

POEE KD T w BOoEE ¥ @-H-@ MEDBE

TRR 26 KA
Project -3 x ) Modei1 ==
= [ Arc pera capturas

= 6 Modeil
(D File = Modell\Modell
3 Stations ©)

Images vax
(2 Modell

[

image List cax

— - 2
7o e <

MET6FG T8 5 .75 .F5

bjects | Images Image List | Sterec
For Help, press F1 ANGLE -83.000, 0.000, -92.000 SCALEL  KaN P NUM

Imagen 5.50: Pantalla modelo con los puntos importados

Paso 4: Marcado de puntos de control

Este es el paso previo a la orientacidén de las imagenes. Con las fotografias abiertas se pulsa el
siguiente icono para abrir la ventana para la insercién de puntos: 4

‘Measure Tie Poim- @
Name Il Ll Measure I
-Image Coord. 3D Coordinates Calculate(Q)... I
X: 0 XypEsress=sim] Close I
|
Y: 0 Y: XXXXXXXX [m]
Z: EXXXXXXX [m]

[” Center Detectior [ Corner Detectic

Imagen 5.51: Ventana medicion de puntos

La forma de proceder es la siguiente: se selecciona un punto de los que aparecen en la lista del
cuadro de texto de la anterior ventana pulsando sobre la flecha. Se marcan los puntos
correspondientes al seleccionado en la lista en todas las fotografias. Una vez marcados se
pulsa el boton “Measure” para marcar definitivamente los puntos.

Es necesario tener cuidado al marcar los puntos, ya que dependiendo del modelo, puede
resultar bastante facil confundirse. Hay que intentar marcar el punto lo mas precisamente
posible en el centro de la diana, aunque esto afectara en el resultado tampoco es necesario
hacer muchisimo zoom para intentar marcar el punto en la fotografia.
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En la siguiente imagen se muestran las fotografias con todos los puntos de control

correctamente identificados:

(@ Topcon Image Master - Modell

FileE) EGE) View Orientation(@ Setup(S) Window(¥) Help(t)
@ Model 3 Remote @ Registration [ Orientation | F Stereo

POEE KOG o ®mORD H- L' EaDmB
TRe o KB
Project > A% | mI_MG.0750 |l _MG076) [l _MG_0763 |l Modell v X
& [ Arc para capturas
= [ Modell o--c- e W Image (_MG_0759) =
File = Modell\Modell
£ Stations (0)
D4 30290
‘ i
|Images v ax
@ 1 Modell
« v 0
By [@[E]=
Image List v ax
BTG .01 G NGOT59.FG
Objects | Images Image List | Stereo List
For Help, press F1 FULLOGO6303  ZOOMI KANA CAP NUM SCRL

Imagen 5.52: Imdgenes con los puntos importados

Paso 5: Orientacion de las fotografias

Para ejecutar la orientacién de las fotografias, existen dos posibilidades. Se puede realizar la

orientacién pulsando el botén “Calculate” en la ventana de medicién de puntos, o pulsando en

icono en el que aparece una calculadora:

Una vez que se ha calculado, se muestra la pantalla de resultados:

T o

Result List I Y-Parallax ] Image Coordinates I Calculated Coordinates I Camera Locations ] Ground Resolution I

Remeasure(M) I

Calculate(C)... I
Close I

Layer of Control Points : liglesia muro oeste - rel_bd

Orientation Result List

Pair/Image Name |judge I Y-Parallax... I Image Co... | message :

_MG_0763 oK 0.540K
“MG_0761 OK 0.630K
“MG_0759 oK 0.650K

Imagen 5.53: Ventana resultados de la orientacion (Result List)
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Esta pantalla tiene varias pestafias en las que se muestran los diferentes resultados de la

orientacion.

En la primera, denominada “Result List”, se muestra el valor del residuo medio junto a un

“OK” si el resultado es bueno (menor que 1 pixel); o nada si no es bueno. En la columna

denominada “judge” se muestra un veredicto respecto a la orientacién de la foto. Si el

veredicto es correcto aparece como “OK”. Si no es correcto se muestra la razén en la columna

“message”.

En la siguiente imagen se muestra la pestafia “Image Coordinates”:

Orientation Resul

Result List | Y-Parallax Image Coordinates ICalculaied Coordinates | Camera Locations | Ground Resolution |

Residuals of Image Coordinates

Remeasure(M)

Image Name | Point Name | cheyfpixel] [judge I

MG_0761 D4_C833 131
MG_0759 D4_C902 128
MG_0759 D4_C042 1.09
MG_0763 D4_C833 1.08
MG_0759 D4_Cs01 1.08
MG_0761 D4_C838 1.04
MG_0761 D4_C840 0.95
MG_0761 D4_C832 091
MG_0763 D4_C003 0.88
MG_0761 D4_Ca41 0.83
MG_0763 D4_C902 0.79
MG_0759 D4_Ce41 0.63
MG_0759 D4_C838

MG_0761 D4_C003

MG_0759 D4_C840

MG_0759 D4_C833

M N7 na ro4n

Caleulate(C)...

Imagen 5.54: Ventana resultados de la orientacion (Image Coordinates)

En esta lista se muestra los puntos con mayor error en pixeles indicando también en la
fotografia que se encuentran. En caso de haber obtenido un veredicto negativo para la
orientacién se puede probar a eliminar los puntos con mucho error para intentar mejorar el

resultado.

La otra pestafia de nuestro interés es la “Calculated Coordinates”:

Orientation Results

Result List I Y-Parallax | Image Coordinates ~ Calculated Coordinates | Camera Locations | Ground Resolution I

Standard Deviation  [m] sx [0.0010

sy [0.0017

sz [00010

Maximum Residuals [m] DX l0.0026

Calculated Coordinates and Residuals

py |0.0035

Control Points : |12

0z |4).0023

Point Name | Xm] [ Y | Zim

| DX fm]

| DY fm]

D4_CS01 82378849 84786111 702.5769
D4_CS02 8238.1007 84777812 702.5227
D4_C303 8238.1443  8477.8708 704.0610
D4_C042 82375002  8478.7171 704.7405
D4_CB45 82379540  8478.3443 705.9854
D4_C840 82380675 84822451 707.6906
D4_C841 82380177 84826776 705.6088
D4_C842 82379870 84813440 706.5352
D4_CB43 8238.1295  8481.3056 707.2708

-0.0011
0.0017
0.0003

-0.0008
0.0000

-0.0005

-0.0003
0.0000

-0.0005

-0.0000

0.0011
-0.0008
-0.0002

0.0011

D4 Cg44 8237.9750  8480.2822 707.4080
<« m

Select () | Select None(C) |  Regist Coord(S) | Save Fie(w)..

Imagen 5.55: Ventana resultados de la orientacién (Calculated Coordinates)
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En esta pestafa se muestran las coordenadas calculadas de cada uno de los puntos marcados y
el diferencial de las mismas respecto a las coordenadas de la importacion.

Estos diferenciales son tan pequeios porque Unicamente cuantifican el resultado de los
calculos realizados por el programa sin tener en cuenta otras fuentes de error como el
procedente de la medicién de coordenadas.

Paso 6: Creacién de los pares

Para crear los pares se deben seleccionar las dos imagenes que lo van a formar, teniendo en
cuenta seleccionar en primer lugar la fotografia izquierda del par.

El icono para definir el par es el siguiente: |

El trabajo con los pares se realiza en el modo denominado “Stereo”. En la imagen se muestra
este modo con los pares ya creados:

Filel) Edt(E) Viewll) MeasureM) SetuplS Window(W) Help(t)
@ Model 9 Remote @ Registation [ Crientation [{j Sereo)
POE pOCos BOEE ¥ @ B @ TEDE
0 F8 S hMlolv—| e HS

Objects | Images | Image List | Stereo List
For Help, press F1 /ANGLE -80.000, 0.000, -89.000 SCALE121 KANA CAP NUM SCRL

Imagen 5.56: Pantalla principal con los pares creados

Una vez tenemos los pares creados es necesario recalcular la orientacién, con el mismo icono
que en el paso anterior. Una vez creados los pares, el programa requiere volver a procesar la
orientacion.

Si se crean los pares antes de orientar las imagenes, sélo seria necesario realizar la orientacion
una Unica vez.

En esta ocasion la pantalla de resultados varia mostrando los siguientes resultados:

87



Documentacion y representacion de paramentos verticales en riesgo de colapso.

Aplicacién en el Monasterio de San Prudencio (Clavijo, La Rioja). 5. EJECUCION
Resuit List |Y»Parallax | Image Coordinates | Calculated Coordinates | Camera Locations | Ground Resolution |

Layer of Control Points : [iglesia muro oeste - rel_td M‘

Orentation Result List SetlabOlt
Pair/Image Name | judge I Y-Parallax... l Image Co... l message : Close |
_MG_0763 - _MG_0761 OK 0740K  0680K
“MG_0761 - _MG_0759 OK 0670K  0680K
< . ] »

Message :

Imagen 5.57: Ventana resultados de la orientacion de los pares (Result List)

En esta ocasidon ademas de mostrar el residuo medio se muestra el paralaje del par, dando
otra vez veredicto de si el resultado es correcto o no.

Paso 7: Dibujado de las lineas de rotura

El primer paso es abrir los pares haciendo doble click sobre los mismos.

Las lineas de rotura son una serie de lineas que se dibujan en los bordes de los elementos en
los que hay un salto, de esta forma se le ayuda al programa a modelar la superficie. Los
tridngulos que se crean no cruzan las lineas de rotura.

Para crear las lineas es necesario activar el siguiente icono: |~/

Las lineas se dibujan en 3D, por lo tanto es necesario segln se va dibujando ir haciendo
coincidir las cruces en el mismo elemento en ambas fotografias. Existe la posibilidad de que el
programa lo haga por correlacién, lo cual es bastante recomendable. Esta opcidn se activa con
el siguiente icono: 44

(@ Topcon Image Master - Sterea (_MG_0763 - NG 0761

FlelD EGHD Viewd) Messurel) Setwpld WindowW) Help(t) i &
@ Model 0 Remote @ Registration [ Orientation i Stereo| 4 82379219 ] _ Open(0) | Reverse®)

PoSE Hoio LRy ] 3 477.8835 ] Sty | Sl

0 38 % kK V| se BS 03,2082 [n) et

Project = 2% .MG.0763 -_MG_0761 | Modell
= 0 Arc para capturas
= [ Modell

File = Modell\Modell
£ Stations (0)

Images v ax
= o Modell
= B Stereo Pairs (2)
R MG 0763 -_MG 0761
B _MG 0761 -_MG 0759
= 10 fmet6 3)
_MG_0763.9G
W MG 076196
W _MG_0759.0P6

bjects | Images sge List | Stereo List
XYZ=(8237.9195, 84779456, 7034763 ){m) SD=6.8437[m] RES: dXY=0,0029(m) dZ=0.0342{rm] SCALEOS  KANA CAP NUM SCR

Imagen 5.58: Proceso de dibujo de las lineas de rotura
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El resultado que se obtiene es el siguiente:

[ Topcon Image Master - [Stereo [ MG 0759 - MG 0761

File®) EStD View

@ Mode 39 Remote @

& _MG_0761.°G
_MG_0763.JPG

Images t | Stereo List
XYZ=(8237.7293, 8485 6815, 7055436 ){m) SD=7.0800(m] RES: dXY=0,0030{m] 4Z=00212(m] SCALE: 0101533 ANA CAP NUM

Imagen 5.59: Par con lineas de rotura dibujadas

También es necesario dibujar una polilinea que limite el drea del que se quiere realizar la
superficie, como se ha hecho en la imagen anterior.

Paso 8: Generacion de la superficie

Para generar la superficie hay que seleccionar la polilinea que limita el drea que se quiere

2R

mallar y pulsar el icono | @ | si se quiere mallar un Unico par, o | g | si se quieren combinar

A7 117

varios pares.

Aparece entonces una pantalla de opciones, en la cual debemos indicar la capa en que
queremos crear la superficie; el intervalo de los puntos de la nube que generard la malla, si
estamos utilizando poligono exterior o lineas de rotura, el filtrado y la textura que queremos
utilizar. En el botdon “Select Pair” seleccionaremos los pares que se quieren utilizar para el
mallado.

| Layer Name |SURFACE-1 v | NewLayer(N) oK
Cancel

Mesh Interval 0.01 m]

TIN Creation

[V Fit Outiine IV Breakiine

Filtering
IV Median ™ Mean

Texture

[V Texture Mapping " Left Image
" Right Image
@ Combine Multiple Images

Imagen 5.60: Ventana opciones de creacion de superficie
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Aplicacién en el Monasterio de San Prudencio (Clavijo, La Rioja).

El resultado obtenido en este ejemplo es el siguiente:

@ Topcon image Master -

File®) Edt()) View()) DotalD) Setup(l Window(W) Help(H)

@ Model |9 Remote @ Registration [ Orientation [ Stereo.

DosE i XX XX o o8B ¥ @
0 B8 koo~ A Pm AEE

Project = 3 X Modent
= T

1A ORE8® g

5. EJECUCION

# (3 Modelt
£ stations ()

Objects -
I D+ Ponts08) -
ik Peint Names
Fi~ Polylines (5)
24 TN Q)
I Tetures
& [ Ortho-images (2
2 orthedl

[ orthed2

O ortho03

2 Bevation Teds (=
& O3 Layers @)

w0
I3 iglesia muro oes
A8 SURFACE-1
18 SURFACE:2

0 stations ()

Objects [images Image List [ Stereo Uit
For Help, press F1

ANGLE -94.000, 0.000, 93000 SCALE1A6El  KANA CAP NUM SCR

Imagen 5.61: Modelo con la superficie creada

Paso 9: Generacion de la ortofoto

Primero hay que definir el plano de la ortofoto. Para su definicion se deben indicar dos puntos

de control que definirdn el eje X. El eje Y sera siempre el definido por las coordenadas Z de los

puntos de control.

Para definir el eje XY es necesario en el modo “Model” accionar el icono

fEIevation View Setup

|

Please select two points on the horizontal
axis of the elevation view.

D4_C042 (iglesia mt v]
D4_C003 ( iglesia mifid

Left Point

Right Point

~Rotation Angle -

Omega -0 [deg]

-88.481 [deq]

Kappa

1

Cancel

Imagen 5.62: Ventana configuracion de la vista de elevacion

No existe la posibilidad de definir el plano imagen de la ortofoto mediante tres puntos, por lo

gue nos obliga a que el eje Y de la ortofoto se corresponda siempre con el Z del sistema de

coordenadas utilizado. Esta es una opcidn que Image Master no nos permite, y que otros

programas, como Photomodeler si que lo hacen.

Para crear la ortofoto se pulsa el icono:
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El resultado es el que aparece en la imagen.

(dl Topcon Image Master - (Model ( Modeil
File()) Edit()) View(Y) Dosta(D) Setup(S) Window(W) Help(t)

@ Model | 0 Remote @ Registration [ Crientation [ Stereo

AR G e XX XX O BOGE % EH- 1 @ OFF00 P g
0 “E8 ko ~hOm IEE
-8 x 9 Modelt | - x|

{Project
=M arc

- @ Modell

3 stations ()

-0 Modell
© 53 System
=103 Objects

[@é% Point Clouds (0)

[0+ Points (18)
@l Point Names
&~ Polyiines (5)  |=

OA ™)
(I8 Tedures ©
2 @ Ortho-images (2
& ortholl. e

=

O orthel3
M'3® Elevation Texs (
=00 Layers (4)
gso - | Dmmsers

@ 0 02)

MG.0T63.FG

G
SCALE 214359 NA CAP NUM SCRL

Objects [ Image Image List | Stereo List
ANGLE -90.000, 0.000, -90.994

Imagen 5.63: Pantalla con la ortofoto creada

Paso 10: Exportacion de la Ortofoto

La exportacion de la ortoimagen se realiza en el menu File -> Export -> Ortho-image File.

Se ha de indicar el nombre y la ubicaciéon donde se quiere guardar.

El resultado es el siguiente:

Imagen 5.64: Ortofoto exportada
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En esta ortofoto aparecen elementos que no nos interesan y que deberan ser eliminados. Esto
se puede realizar en el mismo programa editando la malla y eliminando todos los triangulos
gue no nos interesan y volviendo a crear y exportar la ortofoto, o de forma mas rdpida y
comoda en un programa de edicién de imagenes como Photoshop.

Paso 11: Limpieza del modelo

Para eliminar los tridngulos que no nos interesan deberemos pulsar el icono de seleccidn [}

e ir borrando los triangulos sobrantes.

El resulta final es el siguiente:

@ Topcon Image Master - [Model { Modell o
File(f) EditE) View(l) Orientation(Q) Setup(s) Window(W) Help(t) x
@ Model 99 Remote @ Registration |EF Orientation |fq Stereo.

AAFE G BOEE ¥ @ H- @ D8
L LI -

Project v Ax 3 Modeil |

-] < — S— ;

-6 Model1 ]/"\lq = —— =
£ Stations () o f—
| e
==l -
el
Images v ix
& Modell

£ By Stereo Pairs (2) T~

B _MG_0759 -_MG 0761 e | Tt

& _MG_0761 - _MG_0763 / =
=M 20100519 20MP_2Lmm (3] = = ||

_MG_0759.0PG ]

[

_MG 07616 e

@l _MG_0763.°G o< == s

-y o g um | o

L—" = = et B
Image List v ¥ x
- . -
P P oS
507555 e MBS

Objects | Images Image List | Stereo List
For Help, press F1 ANGLE -89.000, 0.000, -118.994 SCALEL61051  KANA CAP NUM SCRL

Imagen 5.65: Malla recortada

La exportacién del modelo se realiza en el menu: File -> Export -> Shape File.

Esta exportacidn se puede realizar a formato DXF, TIN y VRML. Esto permite la utilizacién de la
malla en una amplia variedad de programas, en los que se podrd gestionar y editar la
superficie.

La exportacion de la malla es posible de realizar desde la creacién de la misma, aunque en
nuestro caso se espera a que haya sido limpiada.

También se puede esperar a tener la malla limpia para realizar la generacién y exportacion de
la ortofoto; y de esta forma nos ahorrariamos parte de la edicién que posteriormente requiere
la ortofotografia.
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5.4.2 FLUJO DE TRABAJO EN PHOTOMODELER SCANNER

Photomodeler Scanner se trata de un software que permite la elaboracién de modelos
digitales en tres dimensiones a partir de fotografias digitales de un objeto. Permite también la
obtencidn de ortofotos.

El diagrama del flujo de trabajo es el siguiente:

6OTOMODELER SCANNI%

Abrir fotografias
AR Voo H
i Idealizar imagenes 1
bLeccccccas ( ......... '
Marcar puntos
ORIENTAR
Importar puntos de Corregir residuales
control
Marcar puntos de
control
ORIENTAR /
REORIENTAR

Dibujar perimetro

v

GENERAR NUBE DE

PUNTOS L
+ i___+ Realizar sélo una vez

Limpiar nube

v

GENERAR MALLAS

v

Transformar malla a
superficie
Visualizacion
ortografica
EXPORTAR
ORTOFOTO

EXPORTAR MODELO

Diagrama 5.3: Flujo de trabajo en PhotoModeler Scanner
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Paso 1: Iniciacion del proyecto

Una vez se ha iniciado el programa, para crear el proyecto hay que seleccionar la opciéon
“Point-based project” marcada en la siguiente imagen.

Getting Started... (2 I ]

Click to create a new project: Click to open a recent project:
Points-based project 1: G\ ... \Pablo\Desktop\muro R\PM\fase 6.pmr
Shapes-based project 2: C\ ... \Pablo\Desktop\muro R\PM\fase 2000.pmr
Camera Calibration project 3: C\ ... \Pablo\Desktop\arco\PM\fase 222.pmr
Automated Coded Target project 4: I\in_ch_east_2\in_ch_east.pmr
PMV project Browse for project...

Click to get help and learn: Click to access the web:
Start Tutorial Videos Main web site
Open Help File Support FAQ
Open Copy of Tutorial Project Available Modules

Check for updates (last check: 05/31/2011 23:44:17)

@ PhotoModeler Scanner

Imagen 5.66: Pantalla de inicio de Photomodeler

Tras esto nos aparecera la ventana en la que deberemos seleccionar las fotografias que vamos
a utilizar en el proyecto.

errores

Select Photos - Points-based project

Select the photos that you will be using in the project. When you click Next your camera library will be
searched and if a camera match is found, the camera will be added to your project and assigned ta
the photos.

. fotos -

Name Tipo de eleme... Photo # |Name Size

X MG 0770 Archiv JPG There are no items to show.
™ MG_0774 Archivo JPG
™ MG_0778 Archivo JPG
™ _MG_0782 Archivo JPG
™ _MG_0736 Archivo JPG
™ MG_0790 Archivo JPG
™ MG_0794 Archivo JPG

Cancel Back Next

Imagen 5.67: Pantalla de seleccion de imdgenes

Para seleccionar las fotografias es necesario seleccionar y pasarlas al recuadro de la derecha,
se puede hacer esta operacion de forma individual con cada seleccién de fotografias o pasar
directamente todas las fotografias pulsando el botén indicado en la imagen anterior.

El siguiente punto a definir es la cdmara con la que se han realizado las fotografias. En el caso
de no haberse trabajado nunca con esa cdmara en el ordenador, sera necesario seleccionar el
fichero de cdmara o un proyecto en la que se utilice la misma camara que la del proyecto
actual.
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En nuestro caso como se habia utilizado con anterioridad, el ordenador reconoce que las
fotografias han sido tomadas con una camara conocida debido a los datos del fichero EXIF.

En este caso, se nos da la opcidn de seleccionar la cdmara de la libreria que queremos utilizar
en el proyecto, seleccionando la calibracion mas actual de la que disponemos.

Which camera?

Your camera library contains more than one camera that
matches the photos in this project. Please select the camera
that you wish to assign to the photos in this project.

Canon EOS 5D Mark Il [21.00] er
Canon EOS 5D Mark Il [21.00] 2 & 2011

| L) o= |

Imagen 5.68: Pantalla de seleccion de cémara

El programa nos muestra entonces un mensaje informativo de que todas las fotos han sido
asignadas a la cdmara de la libreria que hemos seleccionado.

Camera Matching Inform;ﬁm

All photos were automatically matched with a camera
from your Camera Library [Canon EOS 5D Mark |1
[21.00]_2_5_2011). Project cameras and their
parameters can be viewed on the Cameras dialog box.

not show this message again:

0K ] [ Help ]

Imagen 5.69: Mensaje de aviso de asignacion de cadmara

El programa también muestra un mensaje recomendando importar Unicamente unas pocas
fotografias debido a esto puede dar lugar a algun error en la identificacion de puntos.

-
Warning

It is recommended you import and work with only a few
unoriented photographs at a time as this reduces the
chance of failure and makes it easier to find mistakes if
any are made.

["]Da not show this message again.: |
L
Imagen 5.70: Mensaje de aviso

En este momento accederemos a la pantalla principal del programa en la que podremos ver las
imagenes que hemos seleccionado marcadas con un aspa roja, la cual indica que las imagenes
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no han sido orientadas. Podemos abrir la visualizacién de las imagenes haciendo doble click
sobre las mismas.

File Edit View Marking Referencing Project Window Options DenseSurface Help
$. 0. veaapse~ GlGHT 2| Sy

PEE [N 8 %NS 20-le RS
EEEEDE BB Q-BE. &

9 | [Photo Windows

BeE|E e ” [pm..-x _MG_OT78 : not oriented : 1%

Photod :_MG_0782  not oriented : 5% -0

[Select] Click on an item to select it and to perform various actions or view information.

Project has not been processed & Lot Alent

Imagen 5.71: Fotografias sin orientar

Paso 2: Identificacidon de puntos homdlogos

El marcado de los puntos sobre la fotografia se realiza en el modo “Referencia”, el cual se

activa accionando el siguiente icono: @

Se irdn marcando punto por punto en todas las fotografias. Una de las fotografias se denomina
como fotografia de referencia y es reconocible por tener un recuadro azul alrededor.

IREFERENCEI selected items from Photo6 : _MG_0790 : oriented: 7% ~ O .3

| " 4

Imagen 5.72: Fotografias de referencia

Serd en la fotografia referencia donde se debera marcar siempre el primer punto. Para cambiar
la fotografia referencia hay que salir del modo “Referencia” y volver a activarlo.

A continuacidn se muestran todas las imdgenes con los puntos identificados y marcados:
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Hle Edt Vww Muking Beferencing Project Window Options DenseSurface Heip

HEW RS 8 %NS 202k U E+. 0. 0aapse~ 44"
EHOEEEE-E- Q- BEH. Qowr  FQwe [,
[Phots Lt 3| [Photo Windows o

(BH| @ &1 7 [Photods MG.OTMR: not onented: 1% =00 3| [Phota2 MG 0774 : not crented - 7% < O | [Photel _MG.0770  not oriented 5% o

Photod :_MG_0782  not oriented : 5% oo

Photoh :_MG_0790 : nct oriented : 7% ~ O (1| [Photo3 : MG 0785 : not oriented : 7% -0

[Select] Clck on an item to select it and to perform various actions or view information,

Project has not been processed § Lataien

Imagen 5.73: Fotografias con los puntos identificados

El programa, cuando se han identificado el suficiente nimero de puntos para poder realizar la
orientacién, 6 puntos comunes en suficientes fotografias; muestra un mensaje en la esquina
inferior derecha, advirtiéndonos de la posibilidad de procesar.

Photo #1 may now orient.
Try processing.

Imagen 5.74: Mensaje posibilidad de procesar

Es recomendable procesar cuando se tenga la posibilidad, ya que en las fotografias orientadas
apareceran las lineas epipolares siéndonos muy utiles en la identificacidn de los puntos
restantes.

Paso 3: Orientacion de imagenes

El procesado se realiza accionando el icono | 4*

Steps | Options | Reasons | Audt Summary | Audit Overview | Audit Photo | Audt Points |

Accuracy Potential based on Audit Details (1-5):  4-High

1. Orientation of 7 unoriented photos 5 5
No suggestions Nexst Suggestion

2. 3D global optimization

3. No self calibration
Reference Checker is disabled.

Constraints will be processed

[T Save Project before processing

Imagen 5.75: Ventana de orientacion
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Las imdgenes se orientaran pulsando el botdn “Process”. Una vez realizada la orientacion se

muestra un mensaje en el que se indica el error de la orientacion.

The 3D Processing was successful.
You may save the solved project or
continue working.

OK

’ [ Show Report } |

Help

J

Imagen 5.76: Resultado de la orientacion

Con la orientacion realizada se pueden ver los puntos marcados en el visualizador 3D, asi como

las posiciones de la cdmara en cada toma:

|30

Imagen 5.77: Puntos y cdmara en el visualizador 3D

Para comprobar la precision de los puntos accedemos a los residuos a través del menu View ->
Point table — Quality.

|Point table - Quality

Id

14
20

10
15

Name

RMS
Residual
(pixels)
0.5536...
0.4984...
0.5645...
0.5438...
0.5499...
0.4353...
0.5214...
0.5038...
0.4036...
0.4858...

Larg:
Resic
(pi..

0.8958...
|0.8539...
08291...
|0.8255...
0.7894...
|0.7528...
0.7350...
|0.7244...
0.7007...
|0.6338...

~N U W R N R W W] e

Photo
Largest |Photos
Residual

X

=

Precisi...

1,23,5,...3.0152...
1,2.34,.../5.4726...
1,34,5,..|74771...
1,234,..2.9884...
1,234,...2.8790...
1,2.34,...4.1076...
1,234,...4.2888...
1,2.34,.../5.6853...
1,234,...3.1088...
1,2.34,...2.8440...

Y

Precisi...

4.0673...
31373..
6.1508...

|3.4225...
4.2254...

|3.7810...
3.2612...
|3.280...
2.8640...
|3.1808...

4

Precisi...

6.9854...
|5.6566...
7.9941...
7.9967...
7.3041...
|7.4616...
7.7201...
5.0178...
7.9160...
|8.2064...

Tightnes| Angle

0

0.0003...
0.0002...
0.0001...
0.0003...
0.0002...
0.0001...
0.0002...
0.0001...
0.0001...
0.0001...

(deg.)

50.163...
52.221...
40.903...
54.290...
46.801...
55.297...
56.830...
49.273...
56.705...
51.648...

Imagen 5.78: Residuos de los puntos

Useln
Proces...

yes

Frozen

no

no

no

no

no

no

no

no

no

no

Ref.
Check
Tag
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Como se ve en la imagen el residuo mayor es 0,89 y corresponde al punto 2 en la imagen 1.
Este resultado de la orientacién puede ser mejorado moviendo los puntos sobre las imagenes.
La forma de proceder es la siguiente:

En primer lugar debemos activar la visibilidad de los vectores de los residuos. Se fija el factor
“magnify” en 50 para poder visualizar mas facilmente la direccién del error.

[Visibility on Photos [oiE1 |

=1 $¢ Points
[V] Marks T30
[7]3D offsets ~ [¥]IDs
3D IDs [T Tags
3D Tags [ Target Areas

[V] Residuals ~ magnify: 50
=" Camera station
[ Point coverage [ | 3D

+ Settings
+ Layers

Imagen 5.79: Ventana visibilidad en las fotografias

Iremos desplazando de uno en uno los puntos que en la tabla se indican como de mayor
residuo, en la direccion del vector; y procesando a medida que los modificamos.

Hay que tener en cuenta que se debera desplazar el punto, Unicamente para conseguir situarlo
de una forma mas correcta en el centro de la diana, sin alejarlo en ningln caso. De alejarlo,
aunque el error resultase mejor, realmente no estariamos obteniendo una orientacién mejor o
mas precisa; sino que Unicamente estariamos maquillando el resultado para que los errores
resultantes fuesen menores, en contraposicién al rigor en la orientacién.

El maximo residuo ird variando poco a poco. Podemos realizar este proceso hasta que el
residuo de todos los puntos resulte bastante homogéneo.

A continuacion se muestra el resultado después de este proceso. Como se ve el residuo
maximo se ha reducido a la mitad:

[Point table - Quality

RM g |Ph . Ref.

Id Name Rgsisdual k:;?c Larogt:st Photos Diaciers :recisi... grecisi... '(I;ghtnes ?dneggl? IL’Jrs:clgs Frozen C:eck
(pixels) | (pi... Residual Tag

|14 0.2172... [0.3905... |3 1,234,...|28591... [1.6385... |29542... [0.0001... [52.227... [yes  |no

5 ' 0.2301... |0.3901... |4 [1,234,..[1.6239... [1.4959... [4.1336... [0.0001... [56.709... |yes  |no

13 [ 0.2602... |0.3896... |2 [1,2,34,..|2.6969... |1.4788... |3.5648... |7.7807... |56.622... lyes  |no

\7 | 01914... [0.3872... 2 |1,2,34,.../1.5607... |1.7880... [4.1760... |0.0001... |54.293... lyes  |no

I [ 0.2885... [0.3649... |5 [1,234,../1.5031... [2.20%6... |3.8143... |0.0001... [46.809... yes  |no

9 [ |0.2176... |03629... |7 [1,2,34,..21456... |[1.9761... |3.8971... |8.8838... [55.291... yes  |no

3 [ 0.2400... [0.3612... |5 [1,234,../13381... [1.4345... 3.7005... [8.7500... |50.346... [yes  |no

12 | 0.2608... |0.3580... |1 1,2,34,...|2.5205... |1.7307... |3.6335... |0.0001... |55.082... 'yes  |no

6 [ 0.2356... [0.3369... |4 [1,2,3,4,../1.4859... |1.6619... |4.2870... |9.3835... |51644... lyes  |no

3 | 0.2357... [0.3289... |3 [1,234,../18322... |21395... |4.0943... |6.7806... |53.712... [yes  |no

Imagen 5.80: Residuos de los puntos corregidos
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Paso 4: Insercidn de los puntos de control

La importacién del fichero de los puntos de control se realiza en el menu File -> Imports.

Aparece la ventana en la que se debe seleccionar el fichero de los puntos en formato ASCII sin
cabeceras y separados por tabuladores.

| Abrir
. » Arco para capturas » apoyo v | %9 ll Buscarapoyo b

Organizar v Nueva carpeta =~ @

C 4 Nombre ° Fecha de modifica... Tipo Tam

i Favoritos

& Descargas | | iglesia muro oeste - rel 04/04/2011 11:48 Documento de tex...

¥ Dropbox || iglesia muro oeste 31/03/2011 17:35 Documento de tex...

B Escritorio 3

] Sitios recientes

4 Bibliotecas
i:] Documentos
|| Imagenes
& Msica

B videos

«& Grupoen el hogar = < | 1 ] »

Nombre: iglesia muro oeste - rel - [AII Imports V]

Imagen 5.81: Ventana importacion del fichero de puntos de control

Al igual que se realiza en otros programas es recomendable introducir coordenadas relativas
para facilitar todos los calculos al programa. En caso de utilizar coordenadas UTM reales
pueden surgir problemas en la visualizacion 3D ya que al programa le cuesta bastante
procesar.

Existen dos opciones de importacion. La primera opcién es importar los puntos como fijos lo
que indica que tendran unas coordenadas fijas inalterables y que forzardn a la orientacion a
una posicion concreta.

Settings I

Import name: iglesia muro oeste - rel.txt

Import file units:

Degrees of freedom
& Control Import, defines project's orientation (The Project
~ changes to match Import)

@ Points are fixed
() Points can adjust according to the precisions:
m

= PinImport, project orientation is not affected (Import changes
= to match Project, Import can translate, rotate and scalel

_ Static Import, Import and Projects orientation already match
() (Import will be part of 3D project right after import and no
marking is required)

Types ta import

[¥] Points Lines Surfaces
Options

Merge verticies which are closer than 0.0

[7] Flip suiface facing direction (reverse vertex order)

E 0K [Cancel] [ Help ]

Imagen 5.8: Ventana opciones de importacion (puntos fijos)
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También se pueden importar indicando la precisién con la que se han medido las coordenadas

de los puntos con la estacidn total, lo que permitira cierta holgura a la hora de la orientacion.

En el caso de marcar los puntos como fijos es necesario haber realizado muy bien la medicién

de las coordenadas y el identificado de puntos sobre las fotografias, sino los residuos de los

puntos se nos dispararan considerablemente.

. ¢ & O
import Optors NN

Settings ]

Import name: iglesia muro oeste - rel.txt

Import file units:

Degrees of freedom
&, Control Import, defines project's orientation (The Project
= changes to match Import)

() Paints are fixed

(@ Points can adjust according to the precisions:
0.005 m

~ Pinlmport, project orientation is not affected (Import changes
= to match Project, Import can translate, rotate and scalel

~ Static Import, Import and Projects orientation already match
() (Import will be part of 3D project right after import and no
marking is required)

Types to import

Points Lines Surfaces
Options

Merge verticies which are closer than 0.0

[ Flip surface facing direction (reverse vertex order)

[ OK J [Cancel] [ Help ]

Imagen 5.83: Ventana opciones de importacion (precision 5 mm)

En nuestro caso marcamos la precisién de los puntos como 5 milimetros.

Una vez importado el fichero se abre la ventana de importaciones en las que se muestran los

puntos para poder ser emparejados con los puntos identificados en las fotografias.

Imports Explorer ey [ _-j'

g | & 'g(&)g‘ﬂ W)y M| o e

Type |Name N | Filename |Path | TR

A ‘iglesia muro oe...}iglesia muro oe...iC:\Users\Pablo... ‘ 1 r

! ! ! 2 D4_C836  8237,... 8484,... 708,5... 0,005 0,
3 D4_C834 8238,... 8484,.. 707,1... 0,005 0L
4 D4_.C833  8238,... 8484,... 706,2... 0,005 0
6 D4_.C838  8238,..8483,.. 707,9.. 0,005 0~
7 D4_C832 8238,... 8483,... 706,2... 0,005 0
g D4_C003  8238,... 8483,... 704,8... 0,005 0,
9 D4_C840 8238,... 8482,... 707,6... 0,005 0(
10 D4_C841 8238,... 8482,... 7056... 0,005 0(
11 D4.C843  8238,.8481,..707,2.. 0,005 0
12 D4_C842 8237,... 8481,... 706,5... 0,005 0(
13 D4.C844  8237,.. 8480,.. 7074.. 0,005 0,
14 D4.C845  8237,.8478,..7059.. 0,005 0
15 D4_C042 8237,... 8478,.. 70474 0,005 0~
< | mn | »

3D List 7

Imagen 5.84: Explorador de importaciones
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Para emparejar los puntos se deben seleccionar en la lista o en la vista 3D y tras pulsar el icono
marcado en la imagen se selecciona el punto correspondiente en la fotografia.

Al emparejar los puntos de control, los errores de los puntos se disparan; ya que el programa
ha dado unas coordenadas relativas a los puntos cercanas al origen; y ahora le estamos
indicando las coordenadas verdaderas, aunque recortadas, de los puntos.

En la siguiente imagen se ven los puntos de control marcados en la fotografia:

[Photot: MG 0782 criented: 16%

Imagen 5.85: Fotografia con puntos de control antes de procesar

Por la razén anteriormente descrita debemos volver a procesar el proyecto pero realizando la
orientacién de todas las fotografias. En la imagen siguiente se ve la configuracidn que se debe
marcar en las opciones de procesado:

Steps Options | Reasons | Audit Summary | Audit Overview | Audit Photo | Audit Points |

[]1. Orientation (8lnverseCamera) ‘ Accuracy Potential based on Audit Details [1-5):  1-Lowest

() orient only unoriented photos

@ orient all photos Suggestion #1 of 5 Next Suggestion

[¥] 2. Global Optimization Verify all references using a Point Audit. -
[7]3. Self Calibration

[¥] Process Constraints

[7] Save Project before processing [ Close ] [ Help

Imagen 5.86: Ventana opciones de procesado

En residuo de los puntos tras procesar vuelve a sus valores habituales.
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Imagen 5.87: Fotografia con puntos de control después de procesar

Paso 5: Idealizado de las imagenes

Este paso se puede realizar en cualquier momento pero es necesario antes de generar las
nubes de puntos.

Idealizar las imagenes significa corregir de distorsién, para lo cual se utilizan los pardmetros de
distorsion de la cdmara calculados al realizar la calibraciéon de la misma, y los cuales el
programa obtiene del fichero de camara.

Las imagenes se idealizan en el menu Project -> Idealize Project.

Aparece entonces la siguiente ventana en la que se debe indicar las imagenes que se quieren
idealizar, y pulsar el botdn “Execute”.

Resampling

Number of images to resample in parallel:
Note: the larger the number the faster the processing

but the more memory used. If too large then processing
will slow with swapping or memory will run out.

Photos to |dealize

Photo Set | All Phatos v | [

[ Execute } [ Close J [ Help ]

Imagen 5.88: Ventana de idealizacion del proyecto

Cuando finaliza el idealizado se muestra el siguiente mensaje:
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PhotoModeler Scanner

The Project has been converted to use an Idealized Camera, We suggest
7L\ you reprocess to maximize accuracy and then save the project under a

Nnew name.

. Aceptar

Imagen 5.89: Mensaje de confirmacion del idealizado 7

Tras el idealizado es necesario volver a procesar ya que los puntos de las imdgenes se han
movido ligeramente.

Asi mismo, es necesario también ejecutar el guardado del proyecto de forma previa a la
elaboracion de las mallas y nubes de puntos. En caso de hacerlo el propio programa nos
mostrara un mensaje al respecto:

— .
'."h°f°M°de'e_- )

The project has not been saved yet. You must save the project before I
7,!,\ running DSM.

Imagen 5.90: Mensaje aviso necesidad de guardar el proyecto

Una vez guardado ya se puede proceder a la creacién de las nubes de puntos.

Paso 6: Creacidn de la nube de puntos

De forma previa a la generacion de las nubes hay que dibujar en las fotografias el contorno de
la zona de la que se quiere obtener la superficie. Para dibujar este limite hay que pulsar el

siguiente icono:

Photo Windows
Photo3 : MG _0778 : oriented : 11%

| D4 2 cpm:D4 C301) | ieom D& C2icpm D& Co01

so-at

Imagen 5.91: Imdgenes con el contorno dibujado

Cuando se han marcado estos contornos se puede proceder a la creacion de las nubes.
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Se accede a la ventana correspondiente a través del menu Dense Surface -> Create Dense
Surface...

DSM Options | Meshing Options |

“ Information and Warnings

| Project residual quality: max 0.46 pixels, ims 0.22 pixels (acceptable)

Number of active DSM trims in project: 2 Surface: generated from 3D paints
Base to Height Ratio:0.49 (acceptable)

Photos
Photo Set 4l Photos v Pais: Al

L..|Phot... Phot...| b/h ra... | Angle ... | Photo1 ... |Photo2... -~
o2 7 1087 49171 _MG0774 _MG_0794

= 4 0252 11675 _MG0778 _MG_0782 L
I~ 3 5 0486 17449 _MG0778 _MG_0786

() 3

nA IRROA MG NTIR MG N700

Settings

= Basic -
Sampling rate 10.000
Sampling rate units milimeters £
Extents from DSM Trims
+] Depth range [0.778m/0.778m] -~
Sampling rate ‘

The 3D points are spaced approximately this distance apart on the surface.

[ Ewecue | [ cConcel | [ Hep |

Imagen 5.92: Ventana crear nubes de pZntos

En esta ventana se puede realizar la seleccién de los pares que se quieren utilizar para la
creacion de las nubes de puntos.

Hay que configurar una serie de parametros de los cuales se recopila a continuacion la
descripcién que el programa hace de ellos:

'E”.‘ Basic
Sampling rate 10.000
Sampling rate units millimeters
BExtents from DSM Trims
|zl Depth range [0.778m/0.778m]
|=| Advanced
Sub-pixel 7

Supersampling factor 4
Matching region radius 5

L
Imagen 5.93: Opciones creacion de nubes

Sampling rate -> Intervalo de los puntos de la nube de puntos.

Depth range -> Intervalo de profundidad en el que se escanearan los puntos de la nube.

Sub-pixel -> Se utiliza para obtener superficies mds precisas. Mas lento pero suele ser
necesario.

Super-sampling factor -> Un factor que se utiliza en el método de Subpixel. Cuanto mas alto
sea el factor, menos artefactos ondulados en la superficie resultante, pero la
fase de subpixel sera mas lenta. 2 6 4 por lo general van a funcionar.

Matching Region Radius -> El tamano de la mitad del area de correlacién utilizado en la
busqueda. Cuanto mayor es mas lento, con resultados mas suaves, pero quizas
atil si las caracteristicas de la textura son grandes. Cuanto mas pequefio es mas
rapido, pero puede ser mas ruidoso.
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Texture type -> 1 = Las imagenes origen tienen una débil textura aleatoria que no se repite. 10
= Las imdgenes origen tiene una textura de repeticion regular. Un nimero mas
bajo produce un resultado mas denso, pero a veces con mas ruido. Un elevado
ndmero produce una escasa...

Después de las pruebas realizadas por mi compafiero de laboratorio Miguel Moreno, y tras mi
constatacion a través de la experiencia, se pueden recomendar de forma genérica los valores
de los pardmetros avanzados que aparecen en la imagen anterior.

Existen también diferentes pardmetros en los que basarse en el caso de que se quiera
seleccionar el par con la mejor geometria.

Si se pulsa el botdén “Best” se seleccionan los pares con mejor geometria en funcién de los
pardmetros que se indiquen en la siguiente ventana:

Select the criteria for photo pairs to be included:
Base/Height ratio range: ~ Min: 0.1 toMax: 05
Max residual on either photo must be below: 1.0 RMS: 05

Angle between pair must be below: 30

[ OK ] [ Cancel } [ Help ]

Imagen 5.94: Ventana seleccionar mejores pares de fotos

Cuando se han seleccionado los pares deseados se crearan las nubes de puntos pulsando el
botdén “Execute”.

Durante el proceso se va indicando la parte del procedimiento que se estd realizando, y
finalmente el resultado como se muestra en la ventana:

-
DSM Summary

Processing photo pairs:

Sampling rate: 10.0000

Extents: From trims

Depth range: above: 0.7780 / below: 0.7780

Processing photo pair 3 (1 trims) - 5 (1 trims).

Unusally large resampled image: 6110 » 4684. This pair may have weak geometry.
Created mesh with 236448 points and 0 triangles.

DSM finished 1 Pointteshes created.

[ Close ] [ Help ]

&
Imagen 5.95: Ventana resultado del proceso

A continuacidn se ve el resultado de la nube de puntos creada:
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Rese] ﬂvuonsl

Imagen 5.96: Nube de puntos sin limpiar

Antes de crear la superficie es necesario limpiar el ruido y las zonas que no nos interesan.

D) =

Imagen 5.97: Nubes de punto limpia

Paso 7: Generacion de la malla

A partir de la nube de puntos limpia se puede crear la malla, que se creara por triangulacion de
los puntos.

Se accede a las opciones para la creacién de la superficie en el menu Dense Surface -> Modify
PointMesh.
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ﬁ Select the meshing and clean-up steps below by checking or unchecking. Use
H the + to expand and see the individual step's adjustable settings

[[Uncheck all | [ Checkall | [ Expandal | [ Collapse al |

i+ 1. Register & Merge F

3 2. Denoise Point Cloud 0

(+I 3. Decimate Point Cloud

[+ 4. Mesh Point Cloud ]

1 5. Decimate Triangles ]

[+ 6. Fill Holes ™

7. Unify Normals ]

[+ 8. Fill Fiords ¥

5 9. Smooth ]

(2] 10. Sham Smooth s

i+ 11. Contours =
I 4. Mesh Point Cloud

Convert the point cloud into a tiangulated mesh

[ Execute ] [ Cancel l [ Help ]

Im[:gen 5.98: Opciones de mallas de puntos

En esta ventana se seleccionan los procesos que se quieren ejecutar y se pulsa el botdn
“Execute”. La nube de puntos que se quiere mallar debe estar seleccionada.

DSM Summary

4. Mesh Point Cloud
PaintMesh now has 219914 points and 426829 triangles.

5. Decimate Triangles
Not run.

B. Fill Holes
PointtMesh now has 213667 paints and 421226 triangles.

1

7. Unify Normals
PaintMesh now has 134673 points and 372026 triangles

8. Fill Fiords
Pointtesh now has 134679 points and 381371 triangles.

6. Fill Holes
PointtMesh now has 194059 paints and 383328 triangles.

Imagen 5.99: Pantalla resultado creacion de la malla

Pr-S——

La malla resultante es la siguiente:

Imagen 5.100: Malla resultante
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Paso 8: Generacion de la ortofoto

De forma previa a la exportacién de la ortofoto se debe transformar la malla de la que
disponemos en una superficie, lo que se realiza con la malla seleccionada accionando el
siguiente icono: | 2

Previamente, seguramente, deberemos reducir el nimero de tridngulos que componen la
malla ejecutando la opcidn “Decimate Triangles” de las opciones de mallas de puntos.

Una vez que hemos obtenido la superficie, debemos cambiar el modo de visualizacién del
visualizador 3D a vista ortografica.

3D Viewer Options
View
= Visibilty
Vector types
Surface types Reset direction View
ki ) Top Front o Left _) Perspective @ Orthographic
= Settings () Bottom ) Back () Right  Rotate around (short-cut key: &)
ﬁ:fﬁs ) View from camera: Model Center. | | Selected Center
view
Ad d
A Scale/Rotation
oG M || Result of Scale/Rotation

[ [1]'S ] [ Cancel ] [ Help ]

Imagen 5.101: Pantalla opciones del visualizador 3D

Para exportar la ortofoto se debe proceder a través del menu File -> Exports -> Export Ortho
Photo...

Nos aparece la pantalla de exportacién en la que debemos seleccionar el plano sobre el que
gueremos obtener la ortoimagen y la resolucidn de la misma.

Source Data Low Resolution Preview
@ all photo-textured surfaces

_ rectangle on photo

given by extents of three points below

Over-scan border (%) 0

Projection Plane
() Top XY () FrontXZ @ RightYZ

") Bottom XY () BackXZ () LeftYZ

() 3 points Update preview

Rotation ([deg.) @ 0

- 180 Scale / Image Size

@ Image Size 40396 X 4096 pixels

: @I Scale 100 ixels per
Resampling Method Zalllt g P 10

| Nearest neighbor ) Bilinear @ Bicubic () Print Scale 1: /10 at 100 | | ppi

[ Export... ] [ Close ][ Help ]

Imagen 5.102: Pantalla exportacion de ortofoto
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Pulsando sobre el botén “Update preview” nos aparecera en el recuadro superior derecho de
la pantalla una visualizacidn previa de el resultado de la ortofoto que va a ser exportada.

Una vez que se procede a la exportacién, mediante el botén “Export”, es necesario indicar la
ruta dénde se quiere guardar la ortofoto.

A continuacion se muestra la ortofoto obtenida:

Imagen 5.103: Ortofoto obtenida con PhotoModeler

Breve comparacion de los procesos

Al igual que se ha realizado tras los apartados de calibracion, a pesar de que en el proyecto
existe un apartado especifico para la comparaciéon de las cualidades y procesos de cada
programa, Unicamente realizar un breve resumen de los puntos mas importantes.

Una de las principales diferencias entre Image Master y Photomodeler, es la capacidad de
intervencién sobre la generacién de nubes de puntos y mallas que el segundo nos ofrece.
Aunque en contraposiciéon a esto, hay que decir que no se describe ningun patrén de
utilizacidn de los pardametros que se ofrece la posibilidad de ajustar; por lo que su utilidad se
reduce muy considerablemente, ya que debemos guiarnos Unicamente a través de la
experimentacion sin unas pautas que nos sirvan de soporte.

Otra diferencia, es también, que Image Master es completamente automatico en la generacion
de las mallas, mientras que Photomodeler permite realizarla por pasos, pudiendo editar de
forma previa la nube de puntos que va a generar la malla de tridngulos.
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Otro inconveniente de Image Master es la imposibilidad, al definir el plano imagen de la

ortofoto, de seleccionar tres puntos para su definicion. Solo se nos permite definir el eje X de

la ortofoto, mientras que el eje Y va a ser siempre la vertical del modelo. Sin embargo en

Photomodeler si que se nos da la posibilidad de definir el plano mediante tres puntos.

5.4.3 FLUJO DE TRABAJO EN MESHLAB

Meshlab es un programa libre creado por los alumnos de la Universidad de Pisa, el cual se

puede utilizar para la edicion de mallas y nubes de puntos, pudiéndose descargar de forma

gratuita en la pagina “meshlab.sourceforge.net”.

En este apartado mostraremos como a partir de la exportaciéon de una nube de puntos en

PhotoModeler creamos una superficie en MeshLab. El diagrama es el siguiente:

C

PHOTOMODELER

)

.

Exportar la malla de
Photomodeler a
formato ASCII

v

Transformar el
fichero TXT a PLY

.

(

MESHLAB

v

Importar la nube en
PLY a MeshLab

v

Generar la superficie

v

Recortar la
superficie

v

Transferir el color

Diagrama 5.4: Flujo de trabajo en MeshLab

EXPORTACION DE MALLAS DE PHOTOMODELER E IMPORTACION EN MESHLAB

Una vez que tenemos creadas las mallas en PhotoModeler para poder utilizarlas en Meshlab

debemos realizar la exportacion.

111



Documentacion y representacion de paramentos verticales en riesgo de colapso.
Aplicacién en el Monasterio de San Prudencio (Clavijo, La Rioja). 5. EJECUCION

La exportacion se realiza a formato ASCIl con extension “.txt”, el cual contendra las
coordenadas XYZ de cada punto y los valores RGB asignados a cada punto a partir de las
fotografias.

Paso 1: Exportacion de la malla en formato ASCII (.txt)

Se abre la tabla de mallas (PointMesh table) en Photomodeler. Se selecciona la malla que se
quiere exportar y se pulsa el icono indicado en la parte superior derecha de la siguiente
imagen.

P PhotoModeler Scanner: fase 8.pmr
Fle Edt View Marking Referencing Project Window Options Dense Surface Help

PEE >33 8% NS0 2P B E+. 0. 9anapse~ &
Q-8 B. Gl v & [whie v,

Nontext | (Suface |Texture # Samping | 23PN m’: m Texture | o ng‘"
Material D Photo  Contous Rate |1y ancve o (ES0% |Type po
‘White Mesh1 nja 1 0 5.0000... mm 0.1311... 0.1311... 3 DSMTr... 10
White Mesh2 nja 2 0 5.0000... mm 0.1311.., 0.1311... 3 OSMTr... 10
Whte  MeshS..nfa 2 o Wa nfa  ma na na na nfa
White Mesh4 nja 2 0 1.0000... mm 0.1311... 0.1311... 3 DSMTr... 10
Whte  Mesh3 nja 1 o Wa e Wa na  ma  ma
Whte  Meshi..na 2 o Wa  nia Ws  nfa na s
White MeshS nja 4 0 1.0000... mm 0 0.1564... 3 OSM Tr... 10
White Mesh6 nfa 7 ] 1.0000... mm . 0.0882.., 3 DSMTr... 10
White Mesh7 nja 7 0 1.0000... mm ... 0.0552... 3 DSMTr... 10
Whte  Meshi..nja 2 o Ws  njs W ns ma  nja
Mesh8 nfa 0

Imagen 5.104: Pantalla con la tabla de mallas

Hay que recordar el nimero de puntos que tiene la malla, indicados en la tercera columna de
la tabla. Este nimero serd necesario en un paso posterior consistente en la transformacién del
formato del fichero ASCII.

Una vez pulsado el icono indicado anteriormente sdélo serd necesario indicar el nombre con el
que se quiere guardar la malla, y el tipo de archivo al que se quiere exportar en este caso a
ASCII (.txt) como se puede comprobar en la imagen.

File export name . [Z]

Guardar en: IDArcoigbsia V‘ O 2 E° -

7,, \)Fotografias
£ mallas
Documentos
recientes

2

2

Escritorio

Mis documentos

98

iPC

=

‘Q MNombre: ‘PoinlcloudAlcd Vé [ Guardar I
>

Test files [Points/RGB] (*.txt) v g Cancelar

Mis sitios dered = Tipo:

Imagen 5.105: Pantalla de exportacion de archivo
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Paso 2: Transformacion del archivo (.txt) a (.ply)

MeslLab no permita la importacidn de fichero (.txt) por lo tanto sera necesario transformar el
fichero a (.ply). Photomodeler da la oportunidad de exportar en este formato pero sélo en el
caso de mallas de tridngulos y no para nubes de puntos.

T — - 5

Archivo Edicion Formato Ver Ayuda

-0.566466 -0.392388 -0.710797 29 30 26
-0.566758 -0.392290 -0.712277 27 27 27 [
-0.567264 -0.391962 -0.711715 28 28 27 —
-0.567642 -0.391549 -0.711014 32 32 30
-0.568702 -0.391594 -0.711059 34 34 33
-0.570383 -0.392054 -0.711782 35 35 35
-0.575045 -0.392510 -0.712414 34 35 30
-0.564381 -0.393081 -0.715328 33 33 33
-0.565371 -0.393075 -0.715291 37 37 37
-0.566115 -0.392232 -0.713857 36 36 36
-0.566687 -0.391947 -0.713363 34 34 34
-0.567748 -0.391990 -0.713406 31 31 31
-0.568320 -0.391706 -0.712914 31 31 31
-0.569005 -0.391499 -0.712547 32 32 32

Imagen 5.106: Fichero (.txt) exportado

>

En el caso de que se quieran exportar varias nubes de puntos, no se deben juntar en
PhotoModeler, sino que hay que exportarlas de forma individual; y es en este momento
cuando se pueden juntar seleccionando todo el texto del fichero y copidndolo a otro
afiadiendo los puntos al final del mismo.

La razén de esto es que cada nube de puntos obtiene el color de una fotografia. Si se juntan
nubes que no aparecen completamente en una fotografia, existiran puntos sin color.

Para transformar este fichero a (.ply) es necesario Unicamente afadir al principio del mismo la
cabecera de la siguiente imagen.

El valor marcado en rojo se corresponde con el mencionado anteriormente, y es el nimero de
puntos que forman la nube. En el caso de que se hayan juntado varias nubes de puntos como
hemos indicado anteriormente, es necesario introducir el sumatorio de los puntos de todas las
nubes de puntos que se han juntado.

Archivo Edicién Formato Ver Ayuda
bly . -
format ascii 1,0 T
element vertef 2109414 —
property float
property float y
property float z
property uchar red
property uchar green
property uchar blue
end_header
-0.566466 -0.392388 -0.710797 29 30 26
-0.566758 -0.392290 -0.712277 27 27 27
-0.567264 -0.391962 -0.711715 28 28 27
-0.567642 -0.391549 -0.711014 32 32 30

Imagen 5.107: Fichero (.ply) transformado

Por ultimo hay que guardar el fichero indicando en el nombre la extensién “.ply”.

Paso 3: Importacion en MeshLab
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Una vez abierto el programa, emerge directamente la pantalla de apertura de fichero. Es
necesario seleccionar los ficheros que queremos utilizar en el programa.

Open File
Buscar en: !A_:) Nubes —j & ok B
5

Documentos
recientes

Escritorio

X

&

Mis documentos
MiPC
Mis sitios de red  Nombre: IPoinchoud Arco ﬂ Abrir I

Tipg: | &l known formats ( *.3ds * ply * st *.abj *.qobj % off *pts * v | Cancelar

A

Imagen 5.108: Pantalla abrir archivo

Esta es la nube de puntos que se va a utilizar de modelo en este ejemplo:

B eeMI@F /XD XXX

Imagen 5.109: Pantalla principal de MeshLab con las nubes cargadas

En este caso la nube de ejemplo seleccionada se trata de una muy densa compuesta por varias
nubes de intervalo 1 milimetro. De esta forma el resultado serd visualmente mas atractivo.
Tener en cuenta que se trata Unicamente de puntos aunque pueda parecer una superficie.

GENERACION DE SUPERFICIES

Paso 4: Generacion de superficie

Para la generacion de superficies es necesaria la ejecucién de una serie de comandos. En el
caso de este programa, al ser un conjunto de rutinas independientes programado por
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diferentes estudiantes el trabajo es un poco complejo no reduciéndose las acciones a pulsar un
icono.

El primer paso es ejecutar el menu Filters -> Point Set -> Compute normals for point sets.

Aparece entonces la siguiente ventana, en la cual se recomienda'® dar por bueno el valor por
defecto.

ompute normals for point sets
Compute the normale of the verticer of a mesh

without explofting the triangie connectivity, usefty
For datazet with no faces

Mumber of neigbors 10]

’ Default l ’ Help ]

[ Close ] [ Apply ]

Imagen 5.110: Pantalla Compute normals for point sets

Como describe el mismo programa lo que el comando realiza es: “Calcular las normales de los
vértices de una malla sin explotar la conectividad del tridngulo, atil para un conjunto de
datos sin caras”.

Deberemos pulsar el botén “Apply” para ejecutar el comando. Este no tiene variacién grafica
en la nube de puntos.

En segundo lugar se debe ejecutar el menu Filters -> Point Set -> Surface recostruction:
Poisson.

Este comando segln su descripcion “Usa los puntos y las normales para construir una
superficie usando la aproximacion de reconstruccién de superficies de Poisson”.

Los pardmetros que se recomienda utilizar son los que aparecen en la imagen. El primero de
ellos se corresponde con el intervalo de los puntos que se van a crear.

Surface Reconstruction: Poisson

Uise the points and normal to build a surface uang
the Poisson Surface reconstruction approach.

Octree Depth [10 2

Solver Divide ls

Samples per Node |15

Surface offsetting [ {

[ Default ] [ Help ]

[ Close J E Apply ;

Imagen 5.111: Pantalla Surface Recostruction: Poisson

'8 Recomendacion del tutorial consultado: Video tutorial Tema 6 — Photomodeler y MeshLab.
http://www.worldphotogrammetry.com/home/item/15-tema-6-photomodeler-y-meshlab.html
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El resultado de la ejeccucién de este commando es una nueva capa con puntos que generan
una superficie, como se puede ver en la siguiente imagen:

sHlG ReMIPT /LD XXX

Imagen 5.112: Pantalla nube con los puntos de Poisson creados

Como se puede apreciar en la imagen se crean mas puntos de los necesarios, por lo que el
siguiente paso consistira en eliminar los puntos que no nos interesan.

Paso 5: Recorte de la superfice creada

Para seleccionar los puntos hay que pulsar el icono de la izquierda marcado en la imagen, y
para eliminarlos hay que pulsar el otro icono marcado.

€ Meshiab v1.2.3 - Poisson mesh piy]
O Bl ER Flers Bender ew Windows Jooks e

s G n® a0 eFn <« sME)EEMADS /RO X

S tes [

Imagen 5.113: Pantalla nube con los puntos de Poisson recortdos
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Paso 6: Transferencia de color a los puntos de Poisson

El comando se ejecuta en el mend Filters -> Sampling -> Vertex Attribute Transfer.

Hay que indicar en el primer recuadro la capa de la que se quiere obtener el color, y en la otra

la capa a la que se quiere transferir el atributo.

Yertex Attribute Transfer =

Fransfer the choozen per-vertex attributes from one mesh to
another Useful to transfer attributes to different representations
of a zame object.

For each vertex of the target mesh the dlozest point (not vertex:}
on the source mesh s c ted, and the i ted nterpolated
attributes from that source point are copied into the target vertex.
The algorthm assumes that the two meshes are reasonably simiar

and aligned,
Source Mesh !Pointcloud Arco.ply Vl
Target Mesh }'Poisson mesh.ply Vl

[7] Transfer Geometry
[ Transfer Normal
Transfer Color

[] Transfer quality

[] store dist. as quality
wonfd unit e onfl .. 2.5456)

Max Dist Search (abs and %) |
§ ?) [ 0.050912 S 2000

[ Default ] [ Help ]

( Close ) [ Apply J

Imagen 5.114: Pantalla Vertex Attribute Transfer

Pulsando el botdn “Apply” se realizara la transferencia del color.

En la siguiente imagen se muestra el resultado de la transferencia:

LEMIOF /XD XXX

Layer haog fr Potsson mesh.ply 5x
1 Portdoud Arcoply s

2 Possonmeshply ® §

Aopiled fiter

Imagen 5.115: Pantalla nube con los puntos de Poisson con el color transferido

Para ver la malla hay que pulsar el botdn “Smooth” indicado en la siguiente imagen:
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Imagen 5.116: Pantalla superficie de Poisson

En la siguiente vista se puede apreciar mejor el modelado de la superficie:

Imagen 5.117: Pantalla superficie de Poisson vista perspectiva

Como se puede apreciar el resultado no es muy bueno, debido entre otras razones a que la
superficie carece de textura fotografica, sino que cada tridngulo toma el color de los puntos
colindantes.

A pesar de esto en este caso la textura parece bastante realista debido a que la nube de
puntos a partir de la cual se ha creado la superficie es muy densa, y por lo tanto el tamaifo de
los tridngulos que componen la superficie también.
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El modelado de la superficie no resulta de todos modos muy bueno. Este programa no alcanza
en calidad ni resultados a los comerciales pero en algln caso puede resultar util.

Por ultimo resefiar la existencia de filtros de color que pueden resultar utiles para apreciar
mejor la forma de la superficie. Uno de los recomendables es el denominado “minaert”, y que
se ejecuta en el siguiente menu: Render -> Color -> Minnaert.gdp.

2 ¢« MBI EEMIPT /RED XXX

Imagen 5.118: Pantalla superficie de Poisson con el filtro de color Minnaert

Este filtro establece una textura grisacea sombreada que facilita en gran medida la percepcién
de la forma y detalles de la superficie.

Para reinstaurar el color original: Render -> Color -> Per vertex.

5.4.4 FLUJO DE TRABAJO EN RAPIDFORM X0OS3

RapidForm XOS3 es un programa comercial de la marca INUS Technology, util en nuestro caso
para trabajar sobre nubes de puntos, mallas, mallas texturizadas, etc.

El flujo de trabajo se corresponde con el siguiente diagrama:

119



Documentacion y representacion de paramentos verticales en riesgo de colapso.
Aplicacién en el Monasterio de San Prudencio (Clavijo, La Rioja).

( RAPIDFORM )

Importar las mallas
VRML

v

Combinar las mallas

v

Definir los planos de
seccién

v

Generar las
secciones

v

Exportar secciones a
AutoCAD

Diagrama 5.5: Flujo de trabajo en Rapidform X0S3

5.3.4.1 IMPORTACION Y COMBINADO DE MALLAS

Paso 1: Importacién de las mallas

5. EJECUCION

Una vez que hemos ejecutado el programa, para importar las mallar debemos acceder a la

importacion en el menu: Insert -> Import; o pulsar el siguiente icono:

1

De esta forma accedemos a la pantalla de importaciones en la que deberemos seleccionar el
archivo. En nuestro caso, en el programa con el que hemos generado las mallas, estas han sido

exportadas en formato VRML.

Import @
Buscaren: | () Exportaciones v @2 m
. [Bineas wall &
9 (B wal R dxf
Documentos @ wall R north + west
recientes =) wall R north + west
= 5] wall R secciones
LS [ wall R secciones
Escritorio
Mis documentos
3
MiPC
‘;} Nombre: | wall R VRML v
>

Mis sitios de red  Tipa: ‘ All Supported Files

Fix Erroneous Data [Juse asci Convert

[[Juse Custom Setting

Run
Mesh Buildup Wizard

Import Only.

Imagen 5.119: Pantalla de importacion
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Cuando se ha importado la malla nos aparece el siguiente mensaje en el cual debemos definir

las unidades de las mallas.

Confirm Input (Scanner) Unit @

Size
The object size of imported data could be inappropriate.
If the imported size and actual size are not matched, choose proper unit for actual size,
Sample Size
Before: 0.0127468406 m

Unit v
‘g— After: 12,7468405904 m

I OK H Cancel ]

Imagen 5.120: Pantalla de confirmacion de las unidades de importacion

Seguidamente se mostrara la malla importada:

@ Rapidform X05/5can - Your mantenance wil expire in 65 days. @ u

. Blale B3R5 555k

B Froperies
T 24 e
e | Popares

— 10

ModelView  Support

3 G310 . A [ -] fae PBRALGAA[AMAN G . wE uN W QUNEHRS G A HE.

0075 - -

Imagen 5.121: Pantalla principal con la malla importada

Paso 2: Combinado de mallas

Una vez que se han importado todas la mayas podemos combinarlas siguiendo
procedimiento que se muestra a continuacion.

el
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€ Rapidform X0S/Scan - Your maiatenance will expire i -65 days

Ede Seledt EGU loset Tools Messwre Vew Adding Help

@ n
@@ v K Xgironmelnsac
A FRER £30. BRAARR#00S HTINN DAOHNOSH a2 A 3. Bal=8BE5 8505
v W B operties o %
ZH] 01 owe
Nome | Propeies
SO o yHARFE0 R, B -lw-] RRAHLACARNBAMAK G. ¥ N . OuUBER S G2 HE.
Reay 00712 - M

Imagen 5.122: Pantalla principal con ambas mallas importadas

Para abrir la pantalla de combinacion de mallas hay que accionar el siguiente icono:

Se abren los menus que se ven en la siguiente imagen:

& Rapidform X05/5can - Your maintenance wil expire in 65 days
Bt seed 01 jued Toos Memwe Vew Addins Help

o @l
@ @ > K Xigirioumelnzac
ot ot sostan )
AT RERE £30. BERARR #0060 0000 FAIOTDE L2 Al%. BEHBBEELEI 5.
_ ¥ Combine ) @& e - -
z o L
o
=
|5 rovescnce
iy G
vatern! [
J Geomety

|+ Model view . support

ety Thumbnais
(ClnaAVAML  [7] sl cete VAL

Finee [ donp.. T e Lllvie
& cHHARBEQH. @B o] RBLARBMMMMAN G. B Ak . QuBNLES S A HE.
Ready

001z - I

Imagen 5.123: Pantalla principal ment combinar

Hay que seleccionar las mallas que se quieren combinar y determinar si se quiere borrar la
region de recubrimiento.

Segun lo experimentado se recomienda activar esta opcidn ya que surge una zona vacia en la
junta de las mallas que hace que el resultado no sea tan uniforme.
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5.3.4.2 GENERACION DE SECCIONES

Paso 3: Definicion del plano de seccidn

La definicion del plano se realiza en el menu Insert -> Ref. Geometry -> Plane.

& Rapidform 30%/5can - Your

S N Y e e A A A A S

¥ Input Options
ot [F

{ Position

-] PBALAGRAMMAMA N T, RN NN W, QUGKRS G 2HE
000 - I

Imagen 5.124: Pantalla principal mend afiadir plano de referencia

Aungue existen varias opciones para generar las secciones: marcar el plano mediante una linea
dibujada manualmente, desplazar el plano hasta la posiciéon deseada,... Posiblemente la mas
adecuada es la generacidn a partir de un plano definido previamente, ya que en este caso
definimos la orientacion del plano y las coordenadas del centro.

Una vez que hemos dispuesto el plano de la forma deseada lo crearemos confirmando la
accion en el mend.

00 8050560 AnA N 88K F 5500

dHAEHEV R, B e VBAHGAARAMAH &, RN UK V. NGRS 2HE

N

Imagen 5.125: Pantalla principal, mallas con el plano de referencia creado
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Paso 4: Generacion de la seccion

Al menu de generacidn de secciones se accede desde la barra “3D Sketch” y el icono marcado.

& Rapidform X0S/5can - Your maintenance will expire in -65 days o B
fie Seeq fon e Too Meswre View Adedn Help
= webuid Dorm smoothss
B o * . Of ot | Bed e i & & FAEON S ARABEHIR
30 sweten v -
IR FEE €30 5 RA SO DI EAOIIHE L2 A . Ga
ey . B eropertes x
v Section @@ @ B804}, tome ot
tome Fropet
) Common
Nome  puanes
VVVVVV | Appearance
vy [ TigE
=) Geometry
Planes
Along Curve
- [ Base Planes | BB (5
Planei \ J B4
< »
o RB@HLHGAMAMABA T . AU NH N QUL S A HE.
©000 -

Imagen 5.126: Pantalla principal menu secciones

Se selecciona la opcién “Select Plane” para seleccionar el plano definido anteriormente y

confirmamos la generacion de la seccion.

&R iform XOS/Scan - Your maini in -65 days
Ede Seet Ear  Jrsen Jooks jadns  Help
oo
® @ ——
oo > A1 Lok ES MEAC
Meih  Region Group ot Cloud 30 sketch

REA #0006 2T00 ? BEEEEE LA N BelsBBEE LB .

=) 41

Name

S10m
e Doup.. § Heip £l vie Model View  Support .
¢ s dyHARBEOD H. A e -] RBALAHAGAMAMAMAK G. B2 AN E. QUSSR A b E.

Feay

Imagen 5.127: Pantalla principal, mallas con la seccion generada

B] Froperties

tame
Propertes

00000 - M
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5.3.4.3 EXPORTACION DE SECCIONES A AUTOCAD

Paso 5: Exportacion de secciones

La exportacidn se realiza en el menu File -> Export. Aparece el siguiente menu, en el que hay
gue seleccionar la ubicacidn, el nombre y el tipo que queremos que sea el fichero.

Guardar en: | [} Mis documentos vi O 5 2 ol FEF

) CameraCalib Projects

5\
) () Corel User Files
Documentos (L) Downloads
recientes ) ImageMaster Projects

= ﬁMi musica
\ ‘;'i (5] Mis archivos de origen de datos
(Y Mis imégenes

Escritorio
8 Mis videos
)My Albums
J _JPhatoModeler Scanner
Mis deEiranlos _JRapidform XOR3 RC3
(_JRapidform X052 SP1 Hotfixa
(_JRapidform X053
) g [-)Rapidform X053 Hotfix1
i
MiPC
« ) Nombre: seccidn 1 v
J »
Mis sitios de red | Tipo: AutoCAD DXF File [* d) v
[TJuse Custom Setting
Unit Precision

Imagen 5.128: Pantalla de exportacion

La exportacion se realizara a un fichero (.dxf) formato de intercambio de archivos de AutoCAD.

A continuacidn se muestra la seccion abierta en AutoCAD.

¢ NOIRODDD OO M| MmN ONA
9509090 BOABS

FORZC REALLA| ORTO)| POLAR [REFENT RASTREO, GLN [WODELD

Imagen 5.129: Pantalla de AutoCAD con la seccion exportada
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. oz

Breve comparacion de la edicién de mallas y nubes de puntos

Aunque existe el apartado especifico sobre la comparativa entre los diferentes aspectos en
todos los programas, se ha visto necesario un pequeno resumen de las caracteristicas mas
importantes de cada uno de los programas.

Partiendo del no conocimiento en profundidad ni de MeshLab ni Rapidform, debido a que no
conforman uno de los objetivos del proyecto, se va a resumir de forma muy breve las
percepciones obtenidas durante el trabajo con los mismos.

Rapidform es un programa madas completo, con muchas mas utilidades, mds intuitivo y mas
agradable visualmente. Esto puede ser debido a que este se trata de un programa comercial
por lo que dispone de mas medios, mientras que MeshlLab es un programa de distribucion
gratuita.

Teniendo en cuenta también en la comparacidn, las fases de edicién de nubes de puntos y
mallas tanto de Photomodeler como Image Master; no resultan comparables, al menos en el
caso de Rapidform.

Este resulta un programa especifico para las operaciones con nubes de puntos y mallas por lo
gue sus capacidades superan en mucho las de los otros dos programas no especificos.

Comparando Image Master y Photomodeler entre si, a mi juicio las posibilidades presentadas
para la edicidn son similares, a excepcién de la posibilidad en Photomodeler de editar nubes
de punto.

En la edicién de mallas, para mi gusto, resulta bastante mas comodo y eficiente Image Master.
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6.1 RESULTADOS OBTENIDOS EN LA DOCUMENTACION

Como se explica en el apartado de antecedentes, los muros de los que finalmente se ha
realizado la documentacién en el presente proyecto, son el Arco de la Iglesia y el denominado
muro “R”. De los cuales, cumpliendo con los objetivos marcados, se han obtenido los modelos
tridimensionales, las ortofotografias y las secciones caracteristicas de los mismos.

El trabajo se ha realizado siguiendo los procesos relatados en todo el capitulo de Ejecucién del
presente proyecto.

En los siguientes apartados se van a describir los productos obtenidos en los trabajos
realizados.

6.1.1 MODELOS 3D

Se han obtenido cuatro modelos tridimensionales de las zonas objeto de la documentacién,
dos de cada zona obtenidos con cada uno de los software que se han estudiado en este
proyecto.

Los resultados obtenidos han sido los siguientes:

6.1.1.1 MODELO TRIDIMENSIONAL DEL ARCO DE LA IGLESIA OBTENIDO POR IMAGE MASTER

El modelo del arco se ha obtenido a partir de 3 imagenes tomadas con la camara Canon 5D
Mark Il y el objetivo Zeiss de 21 mm. Para su orientacién se han utilizado 15 puntos de
coordenadas conocidas los cuales se encuentran recopilados en las resefias del apoyo
fotogramétrico en Anexo 5 de esta memoria.

Imagen 6.1: Modelo del Arco de la Iglesia obtenido por Image Master (vista 1)
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Para la generacion de la superficie se ha dibujado previamente lineas de rotura de las zonas

con mayor variacion del relieve del muro.

A continuacion se muestra otra vista del mismo modelo, en el que se puede apreciar mejor el
relieve del muro, y como se han modelado cada una de las piedras del arco.

Imagen 6.2: Modelo del Arco de la Iglesia obtenido por Image Master (vista 2)

En esta vista se pueden apreciar algunas de las deficiencias que presente el modelo ya que
existen algunas zonas que resultan ocultas en las fotografias, y por lo tanto el software no es
capaz de modelar; y al no aparecer en las fotografias, la textura fotografica no es real en esas

Zonas.

La vista desde el otro lateral es la siguiente:

Imagen 5.3: Modelo del Arco de la Iglesia obtenido por Image Master (vista 3)
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Como se percibe en la imagen, el modelo presenta algin problema en la prominencia de la
parte derecha del modelo ya que existe ocultamiento en la fotografia.

La posible solucién para estas zonas es la incorporacién al proyecto de fotografias en las que
fuese visible esa zona, pero en este caso es complicado tomar esas fotografias ya que se
tratarian de fotografias tomadas desde arriba, por lo que necesitariamos algin elemento en el
gue subirnos; material del cual no disponiamos en campo.

Como se puede ver el resultado obtenido es muy agradable visualmente, e inspeccionandolo
parece resultar bastante fiel a la geometria del elemento.

Imagen 6.4: Detalle del modelo del Arco de la Iglesia obtenido por Image Master

En la imagen anterior se puede verificar que la apariencia es excelente, y se puede confirmar
de la inspeccion del modelo en el visualizado 3D que la geometria se ajusta muy bien a la
realidad realizando una evaluacién a simple vista.

Tras esta evaluacion, el resultado obtenido parece muy satisfactorio; sobre todo por el aspecto
visual y la geometria que parece bastante fiel a la realidad.

6.1.1.2 MODELO TRIDIMENSIONAL DEL ARCO DE LA IGLESIA OBTENIDO PHOTOMODELER

En este caso el modelo ha sido creado mediante la utilizacién de 14 fotografias, tomadas
también con la cdmara Mark Il y el objetivo de 21 mm. Se han utilizado para orientar, un total
de 21 puntos, de los cuales 14 han sido emparejados con los puntos de control de coordenadas
conocidas. Los puntos utilizados se pueden consultar en el Anexo 5 de resefias de los puntos
de apoyo fotogramétrico.

El modelo obtenido tiene el siguiente aspecto:
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Imagen 6.5: Modelo del Arco de la Iglesia obtenido por Photomodeler (vista 1)

Este modelo, aunque a simple vista parece tan bueno como el anterior, realmente no lo es.

En primer lugar existen zonas como el promontorio de la parte derecha del modelo, que se ha
mencionado en el modelo anterior y en el cual en este caso no se ha generado superficie.

Se nota una diferencia bastante notable también, en la parte interior del arco; la cual en el
modelo de Image Master estd completamente modelada, aunque la textura no se éptima, y
gue en este caso solamente se ha creado la maya de tridngulos en algunas zonas. Esto es asi a
pesar de que la nube de puntos contenia también puntos en esa zonas, aunque si es cierto que
con menos densidad.

Estas pequenas deficiencias se pueden observar en la siguiente imagen:

Imagen 6.6: Modelo del Arco de la Iglesia obtenido por Photomodeler (vista 2)
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El la vista desde el otro lado se puede observar mejor todo a lo que hemos hecho referencia:

Imagen 6.7: Modelo del Arco de la Iglesia obtenido por Photomodeler (vista 3)

Observando la siguiente vista en detalle, podemos percibir que el aspecto visual de la malla es
bastante peor en Photomodeler ya que se distinguen los tridngulos, lo que proporciona al
modelo una apariencia bastante basta y poco agradable.

En resumen, para este muro, el modelo elaborado mediante Image Master resulta mas
agradable visualmente y mejor modelado. Ahora sélamente nos queda realizar el analisis para
evaluar la precisidn de los modelos creados a partir de los dos programas.

Este analisis se realiza en el apartado de este mismo capitulo de resultados, en el apartado
“Determinacion de la precision en modelos 3D”.

6.1.1.3 MODELO TRIDIMENSIONAL DEL MURO “R” OBTENIDO IMAGE MASTER

Los modelos de este muro se han elaborado de forma similar a los del arco. Para este modelo
se han utilizado un total de 9 fotografias en las que se han identificado 21 puntos de control y
entre todas las fotografias y 7 puntos de paso de los que no conociamos las coordenadas.

Los puntos utilizados son los que aparecen en la resefia correspondiente.

La creacion del modelo de este muro, presenta mas dificultades que el del arco; debido a que
se trata de un elemento de tamafo mayor y a que existen ciertos problemas en la toma de las
fotografias.
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En este caso, hay un arbusto en frente del muro, el cual realiza ocultamientos de la parte
izquierda del muro; por lo que no pudimos utilizar fotografias del muro completo, sino que
debidos de tomarlas en dos tramos conformando después pares diferentes para cada zona.

Es importante resefiar, que el modelo de este muro consta de dos pafios: el principal que es el
gue se ve en la siguiente fotografia, denominado pafio norte; y el paifio oeste, de menor
tamafo.

Imagen 6.8: Modelo del muro “R” obtenido por Image Master (vista 1)

Debido a que Image Master requiere fotografias estereoscépicas, esto nos fuerza a realizar el
modelado de cada uno de los pafios por separado. En este caso se realizé en diferentes
proyectos; pudiendo unir posteriormente de las mallas en el mismo programa. Para lo que se
exporta la malla el DXF, se importa en el otro proyecto y después se le ha de poner la textura;
para lo cual deberemos tener orientadas todas las fotografias en un mismo proyecto.

También se puede realizar todo el proceso en un mismo proyecto desde el principio, lo que de
hecho resultard mas rapido.

En la imagen siguiente se observan los dos pafios de los que se compone el muro. La unién de
las dos mallas no resulta del todo mala, ya que aunque se presentan algunos pequefios
agujeros el resultado final tiene una apariencia bastante continua.
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22 modelo

Imagen 6.9: Modelo del muro “R” obtenido por Image Master (vista 2)

El aspecto visual del modelo, como es caracteristica en Image Master es muy bueno; pero en
este caso hay que destacar que en las zonas mas lisas del muro el modelo resulta con una
pequefia ondulacién lo que se achaca a errores del programa. La causa de estos defectos es
desconocida.

Imagen 6.10: Detalle del modelo del muro “R” obtenido por Image Master

A pesar de este problema el resultado obtenido es bastante bueno, considerando que los
resultados logrados con Image Master son muy satisfactorios.

6.1.1.4 MODELO TRIDIMENSIONAL DEL MURO “R” OBTENIDO POR PHOTOMODELER

Las conclusiones para este modelo son similares a las obtenidas para el modelo del Arco
obtenido por Photomodeler; aunque bien es cierto, que el resultado en este caso es un poco
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mejor, ya que se trata de un muro mas uniforme. Por eta razén el modelado de la superficie
deberia resultarle mas sencillo al programa.

Imagen 6.11: Modelo del muro “R” obtenido por Photomodeler (vista 1)

En este caso también ha sido necesaria la creacidon de mallas independientes. En este caso la
parte mas alta y mas baja del pafio norte también se tratan de mallas diferentes.

El resultado en este caso es bastante bueno, como se observa en las imagenes:

Imagen 6.12: Modelo del muro “R” obtenido por Photomodeler (vista 2)
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En la vista en detalle se aprecian también los triangulos que conforman la malla lo que no
contribuye a convertir el modelo en un producto tan agradable visualmente como el obtenido
en Image Master.

Imagen 6.13: Detalle del modelo del muro “R” obtenido por Photomodeler

Al igual que se ha hecho con el modelo del otro muro, el analisis de la precisién del mismo en
los dos programas se encuentra en el apartado “Determinacién de la precisién en modelos
3D”, de este mismo capitulo.

6.1.2 ORTOFOTOGRAFIAS

Las ortofotos como ya se ha explicado anteriormente en apartado de metodologia, se
obtienen a partir de la superposicion de la fotografia en los modelos tridimensionales de los
elemento, y obteniendo una ortoproyeccién del mismo respecto un plano seleccionado
mediante 2 o tres puntos, dependiendo de cada software.

Los resultados obtenidos son bastante similares, teniendo Unicamente en cuenta que al ser un
resultado a partir del modelo; estas heredan los defectos del mismo, en lo que ha zonas sin
modelar se refiere.

A continuacion se muestran las ortofotos obtenidas del Arco:
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Imagen 6.14: Ortofoto Arco Image Master (izquierda) y ortofoto Arco Photomodeler (derecha).

Las precisiones de todas las ortofotos se encuentran analizadas en el apartado 6.3 de este
capitulo.

En el caso de las ortofotos del muro “R” existe una diferencia mayor, ya que surgieron
problemas en Photomodeler a la hora de la conversidn de las mallas de tridngulos a superficie,
quedando unas franjas verticales sin textura, las cuales ha habido que suprimir de la
ortofotografia.

Las ortofotos del muro “R” son las siguientes:

Imagen 6.15: Ortofoto muro “R” Image Master (izquierda)
y ortofoto muro “R” Photomodeler (derecha).

Las ortofotos del pafio oeste se encuentran incompletas debido a que como el muro es muy
alto y presenta un cambio de profundidad la parte superior observa desde el lateral del muro,
gueda oculta en todas las fotografias.

Los resultados finales de las ortofotos se encuentran presentados en su plano correspondiente
en el Anexo 8 de planos.
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6.1.3 SECCIONES

Las secciones son un producto derivado también del modelo tridimensional. Se obtienen a
partir de éste mismo mediante la definicién de un plano de corte. Estas resultan Gtiles para
conocer la forma del objeto a una altura determinada, o la silueta de una pared determinada.

La idea de obtener las secciones en los muros de riesgo es debido a que nos resulta
interesante conocer el desplome que estos presentan; ya que aunque los dos muros que se
han documentado en este proyecto no presentan un desplome elevado, en el caso de otros
muros de los calificados como de riesgo de desplome si que sucede asi.

En este caso las secciones resultan interesantes para conocer el relieve del muro en un lugar
puntual. Las secciones no se obtienen de un lugar cualquiera, sino que se utilizan para
documentar posiciones concretas que resultan de un interés definido; como pueden ser la
vertical en medio de una ventana o puerta, la zona donde el muro presenta un relieve especial
en discordancia con el resto,...

A continuacion se muestran en una vista isométrica las secciones del arco.

=

Imagen 6.16: Secciones obtenidas a partir del modelo del Arco

En nuestro caso las secciones han sido obtenidas mediante Rapidform, definiendo las
coordenadas del centro del plano de corte. El proceso de obtencién de las mismas se describe
en el apartado “flujo de trabajo” de la presente memoria.

Las secciones se pueden utilizar para conocer las coordenadas de cualquiera de los puntos que
se encuentre en ellas.

Hay que decir que la precision de las secciones es la misma que la de el modelo 3D a partir del
cual se generan. En este caso las secciones estan obtenidas a partir de los modelos creados
mediante Image Master.

A continuacion se muestran las secciones obtenidas del muro “R”:
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Imagen 6.17: Secciones obtenidas a partir del modelo del Arco

En este caso se puede distinguir la silueta del muro al ver todas las secciones todas juntas, esto
es asi porque se han seleccionado los planos de corte mas descriptivos, ya que son los que nos
aportan mayor cantidad informacién sobre la forma del elemento.

Todas las secciones, tanto las verticales como las horizontales se encuentran presentadas en
los correspondientes planos, los cuales se encuentran en el Anexo 8 de la presente memoria.

6.2 DETERMINACION DE LA PRECISION EN MODELOS 3D

Para la determinacion de la precision de los modelos 3D, la metodologia empleada ha sido la
comparacién de las coordenadas de los puntos de control de coordenadas conocidas, y de las
posiciones de las dianas sobre el modelo.

De esta forma, podemos cuantificar el grado de fidelidad que el modelo tiene a la posicion de
los puntos de apoyo medidos en campo mediante topografia clasica.

Para realizar este analisis se ha procedido medir las de coordenadas pertinentes sobre cada
uno de los modelos, en el programa en el que han sido creados.

Con respecto a la capacidad de obtener las coordenadas de los puntos, Image Master y
Photomodeler no presentan exactamente las mismas posibilidades. En el caso de Image
Master es mas facil, y mds real la determinacién de la posicion, ya que permite medir puntos
directamente sobre la superficie. El programa realiza una interpolacién entre las coordenadas
de los puntos de la nube mas préoximos y calcula la posicién del punto seleccionado sobre la
superficie. Por lo tanto, conociendo las coordenadas tanto de los puntos tomados en campo,
como de las posiciones de las dianas sobre el modelo; el programa ademas de mostrarnos las
coordenadas de los puntos nos muestra también la distancia horizontal y la geométrica,
procedentes de un simple calculo a partir de los incrementos de coordenadas.
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En el caso de Photomodeler, sin embargo, éste no es capaz de calcular la posicién de los
puntos sobre la superficie; ni siquiera las coordenadas de los puntos de la nube. Por esta
razon, se restringe mucho mas la posibilidad de este analisis ya que la comparacién se debe
realizar con puntos calculados a partir de su identificaciéon en las fotografias y por lo tanto
estos participan en la orientaciéon del modelo. Esto no imposibilita un cierto analisis de la
precision del modelo, ya que aun asi, sigue habiendo dos tipos de puntos en la orientacién. A
los que se les han introducido las coordenadas de los puntos de control, y que por lo tanto el
error resultard minimo; y a los que no, que aunque han recibido cierta influencia al haber
participado en la orientacidn, no se les ha forzado a una posiciéon determinada mediante la
definicién de sus coordenadas.

Puede resultar extraiio, que si hablamos de determinar las coordenadas de los puntos, estos
sigan presentando un error en su posicidon respecto a estas mismas. Esto no se trata de un
error, sino de el hecho de que a la hora de realizar la importacién de los puntos de control, a
estos se les ha asignado cierta precisiéon lo cual permite el grado de holgura indicado a la
orientacién del modelo; ya que debido a los instrumentos y métodos de medicidon de los
puntos en campo, sigue existiendo cierta incertidumbre en la posicidn exacta de los mismos.
En el caso del presente proyecto, se les ha introducido a los puntos una precision de 5
milimetros, los cuales resultan bastante razonables de asumir.

La forma de proceder en ambos programas es muy sencilla y breve, la cual se procede a
describir en los siguientes apartados.

6.2.1 MEDICION DE LAS DIFERENCIAS EN IMAGEMASTER

Para acceder a la herramienta de medicidn se debe ejecutar el menu: Data -> Distance -> Plot
on screen.

Se presenta entonces una pantalla en la que se mostraran las coordenadas de los puntos
seleccionados.

Distance ( Specified by Mouse ) &J

X [m] Y [m] Z [m]
o B

Point 1

Point 2 ! 0 I g

Distance

DX : [m]

DY: [m]

DZ: [m]

Horizontal Distance : [m]
Slope Distance : [m]

Snap(s)... I

Imagen 6.18: Ventana de medicion de distancias
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Para seleccionar los puntos de control, es necesario tener en cuenta la necesidad de empleo
de la opcién “snap”, para asegurarnos que estamos seleccionando el punto concreto; y no
cualquier otro de la superficie a su alrededor. Esta opcién nos permite definir el tipo de
elemento que queremos seleccionar y por lo tanto nos filtrara el resto de elementos.

Snap Setting

" Free

{* Point

" Polyline Vertex
" Polyline Side

" TIN Vertex

" Point Cloud Point

" Dynamic Interpolation

1 m _[—

Imagen 6.19: Ventana de medicion de distancias

Conociendo la herramienta, la forma de actuar es sencilla, ya que nos limitaremos a
seleccionar los puntos entre los cuales queremos medir la distancia, utilizando la opcién
“snap” en el caso de los puntos de control.

6.2.2 MEDICION DE LAS DIFERENCIAS EN PHOTOMODELER

En el caso de Photomodeler la medicidn de distancias es similar, a excepcion de la condicién de
gue Unicamente se puede medir entre puntos definidos, y no sobre la superficie.

Para realizar la medicidn se mostraran Unicamente los puntos en el visualizador 3D. Tanto los
puntos calculados como los puntos de control nos aparecerdn muy proximos los unos de los
otros, por lo tanto resultaria complicado seleccionar el punto deseado. Por esta razon al
intentar seleccionar un punto entre algunos que se encuentran muy proximos se nos
desplegard un menu en el que se nos dard la opcién de elegir el punto que queremos
seleccionar, como se muestra en la imagen:
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Imagen 6.21: Ventana de visualizacion de coordenadas

6. RESULTADOS

, mediante el cual se mostrara una ventana en
la que se irdn mostrando las coordenadas de los puntos seleccionados.

6.2.3 ANALISIS DE LA PRECISION DEL MODELO DEL ARCO OBTENIDO POR

IMAGEMASTER

Tras la medicidon de las distancias para todos los puntos de apoyo medidos en campo,
incluyendo los puntos de comprobacidn no utilizados en la orientacién; se han obtenido los

siguientes errores:
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Imagen 6.22: Croquis de los puntos de control del Arco

Puntos | Distancia Puntos Distancia

3 0,013 840 0,003
42 0,014 841 0,007
796 0,010 842 0,001
797 0,008 843 0,004
798 0,007 844 0,003
832 0,006 845 0,005
833 0,018 901 0,020
834 0,006 902 0,017
838 0,003 903 0,005

Tabla 6.1: Errores de los puntos de control del Arco

El punto azul de la imagen se trata de un error grosero en la medida en campo por lo que no se
tiene en cuenta. Los puntos de color magenta de la tabla corresponden a puntos de
comprobacidn no utilizados en la orientacion del modelo.

Como se puede observar en la tabla los puntos con mayor error son en 901, 833 y 902
respectivamente. Por lo tanto podemos afirmar que en la zona inferior izquierda del arco
(puntos 901 y 902), el modelo tiene un peor ajuste a los puntos de control; mientras que el
error del punto 833 puede explicarse debido a que se encuentra en una zona bastante
compleja y su modelado no ha sido resuelto de forma éptima por el programa.

Atendiendo a los valores de los errores obtenidos, se puede decir que el modelo ajusta mejor
por la parte superior, ya que en los puntos de esa zona se han medido distancias menores.
Esto puede ser debido a que en la zona baja se localizan menos puntos.

Las tablas completas de las mediciones realizadas con las coordenadas de los puntos incluidas,
se encuentran en el Anexo 6 de tablas de errores.

Analizando los errores obtenidos se puede definir la precision del modelo en 2 centimetros, el
cual es un resultado que se podia esperar. Hay que tener en cuenta que estas distancias
medidas son geométricas y por lo tanto es previsible que los errores en las ortofotos que se
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generen a partir de estos modelos, el verdadero objetivo de la documentacion, tengan unos
errores algo menores.

6.2.4 ANALISIS DE LA PRECISION DEL MODELO DEL ARCO OBTENIDO POR
PHOTOMODELER

Las distancias obtenidas realizando las medidas sobre el modelo en Photomodeler son las
siguientes, siendo los puntos los mismos que en el apartado anterior:

Puntos | Distancia Puntos Distancia
796 0,009
797 0,011
798 0,009

Tabla 6.2: tabla de errores de los puntos del arco

En este caso, los puntos de mayor error son el 797, 901, 796 y 798 respectivamente. Este
resultado es bastante mas légico que el anterior, ya que los puntos que mas error presentan
son los de comprobacion; y por lo tanto puntos a los que no se les han asignados las
coordenadas del punto de control. A excepcidon del 901, que al igual que en el modelo
obtenido por Image Master, también es uno de los de mayor error.Puesto que la geometria de
la zona no es conflictiva no deberia haber razén que justifique un mayor error, por lo que
deberemos deducir que ha podido surgir cierto defecto en la medida de sus coordenadas en
campo.

Las tablas completas de las mediciones realizadas con las coordenadas de los puntos incluidas,
se encuentran en el Anexo 6 de tablas de errores.

Para este caso la precision del modelo se fijaria en 1 centimetro, atendiendo al error maximo
obtenido, que es 1,1 centimetros. Este resultado es mejor que con Image Master pero hay que
tener en cuenta que el andlisis se ha realizado de forma diferente, ya que en Photomodeler se
carece de la posibilidad de medir coordenadas sobre la superficie generada.

6.2.5 ANALISIS DE LA PRECISION DEL MODELO DEL MURO “R” OBTENIDO
POR IMAGE MASTER
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Los croquis de los puntos de control del muro “R”, y las diferencias entre coordenadas medidas
entre los puntos y las dianas son las siguientes:

Puntos | Distancia Puntos | Distancia Puntos Distancia
731 0,007 740 0,003 5 0,006
732 0,006 741 0,002 6 0,014
733 0,005 742 0,001 7 0,006
734 0,006 812 0,005 752 0,006
735 0,005 744 0,001 753 0,001
811 0,004 1 0,006 754 0,003
737 0,004 2 0,010 755 0,005
738 0,005 3 0,014 756 0,004
739 0,004 4 0,008 757 0,004

Imagen 6.23: Croquis y tablas de errores de los puntos del muro “R”

En este caso, los puntos de mayor error son el 3, el 6 y el 2. Estos resultados dan lugar a un
anadlisis muy claro, ya que todos los puntos de mayor error son puntos de comprobacién no
utilizados en la orientacién del modelo; por lo que es obvio que presenten una mayor
diferencia respecto a los que si que han sido utilizados en la orientacion.

En comparacion con el otro modelo generado con el mismo programa, hay que decir que este
es mas preciso; esto puede ser debido a que la distribucién de los puntos es mds uniforme.

A partir del andlisis realizado, y del error maximo obtenido, de 1,4 centimetros; la precisidon de
este modelo se puede fijar en 1,5 centimetros; la cual lo reconoce como un buen resultado
para la metodologia utilizada.

Las tablas completas de las mediciones, se encuentran en el Anexo 6 de tablas de errores.
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6.2.6 ANALISIS DE LA PRECISION DEL MODELO DEL MURO “R” OBTENIDO
POR PHOTOMODELER

El muro analizado en este apartado es el mismo que el del anterior, por lo tanto los puntos
también son los mismos.

Los datos obtenidos como resultado de las mediciones realizadas han sido los siguientes:

Puntos | Distancia Puntos | Distancia Puntos | Distancia

5 0,007
6 0,005
7 0,003

1 0,001

2 0,011

3 0,013

4 0,005

Imagen 6.3: Croquis y tablas de errores de los puntos del muro “R”

En este caso los puntos con mayor error han sido el 3 y el 2 respectivamente, los mismos que
en el caso anterior y por lo tanto puntos de comprobacidn.

Como se puede observar, en este caso los resultados con los dos programas resultan muy
similares; aunque bien es cierto que la media de los errores es algo menor para el modelo de
Photomodeler. Pero como hemos dicho antes el analisis en los dos programas no es el mismo
por lo que es mas normal que las distancias medidas en este Ultimo sean menores.

El error maximo obtenido, correspondiente al punto 3, es de 1,3 centimetros ;por lo que
podemos fijar la precision final de este modelo realizado por Photomodeler en 1,5
centimetros, similar al anterior; por lo que confirma que la precisién de los modelos de este
muro oscila en ese rango de precision.

Al igual que en el resto de casos, las tablas completas se encuentran en el Anexo 6.

6.3 DETERMINACION DE LA PRECISION EN ORTOFOTOGRAFIAS

La forma mediante la cual se puede cuantificar la precisién de una ortofoto es mediante la
comparacién de coordenadas, o medida de distancia, entre dos puntos de posicién conocida
en el terreno los cuales se perciban también en la ortofoto.

En nuestro caso para dicha labor, disponemos de las coordenadas conocidas de los puntos de
apoyo tomadas en campo materializadas mediante dianas que aparecen evidentemente
también en las imdgenes tomadas y por consiguiente en la ortofotografia.
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Esta determinacién de la precision la realizamos tomando las medidas en AutoCAD, en el cual
debemos importar tanto los puntos de apoyo como la ortofoto.

Para poder realizar estas mediciones es necesario que el punto de vista que tenemos de los
puntos, se corresponda con el plano imagen de la ortofoto.

Para esto hay que tener en cuenta, el procedimiento que hemos seguido en Imagemaster para
la elaboracién de la ortofotografia.

Atendiendo a este aspecto, el plano imagen que marcamos en Imagemaster para la
generacion de la ortofoto esta definido por dos puntos de control, que marcaran la direccidn
del eje x de la ortoimagen siendo el eje y de ésta el eje z en el terreno, el cual el programa
conoce debido a que el modelo se encuentra orientado con los puntos de control tomados en
campo.

Una vez en AutoCAD, para tener como vista de los puntos la misma que el plano de generacién
de la ortofoto, modificamos el sistema de referencia (SCP de AutoCAD) fijando su origen en el
primero de los puntos, que definen el plano imagen, seleccionados en Imagemaster; vy la
orientacién del eje X de la ortoimagen hacia el segundo; de forma que el eje XY de AutoCAD se
convierta en el plano imagen.

Imagen 6.24: Vista en AutoCAD de la ortofoto con los puntos superpuestos y el SCP definido.

En la imagen anterior se observa como ha sido establecido el sistema de referencia siendo los
puntos coloreados en azul los utilizados en Imagemaster a efecto de definicion del plano
imagen de la ortofoto. También se ha realizado el escalado de la imagen utilizando la distancia
entre los dos puntos coloreados.

Una vez hemos realizado este paso, podemos proceder a medir las distancias planas entre la
posicion del punto tomado mediante topografia y la posicién central de la diana en la imagen;
mediante lo cual obtendremos una estimacién de la precision.
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6.3.1 ANALISIS DE LA PRECISION DE LA ORTOFOTO DEL ARCO DE LA
IGLESIA OBTENIDA POR IMAGE MASTER

De forma gréfica se ha realizado un andlisis de precisidn, coloreando para esta demostracion
los puntos segln su precision y su naturaleza.

Imagen 6.25: Ortofoto con los puntos coloreados segun precision y naturaleza.

El significado de cada uno de los colores es el siguiente:

Azul -> Puntos utilizados en la definicién del plano imagen.

Verde -> Puntos utilizados (junto a los azules) para la generacion del modelo 3D.
Rojo -> Punto de precision mucho menor al resto.

Magenta -> Puntos no utilizados para la generacién del modelo 3D.

La diferencia de posicidn entre los puntos azules y las dianas es evidentemente nula, debido a
que se han utilizado de referencia para definir el SCP y realizar el escalado de la ortofoto.

Como se puede ver en la siguiente fotografia, se ha detectado un punto (coloreado en rojo)
que tiene mucho error, debido a que se encuentra en una zona bastante conflictiva del
modelo; ya que es muy irregular y se encuentra en un saliente de la pared.

El punto verde que se muestra ampliado corresponde al punto, de todos los restantes con
mayor diferencia entre el punto de control y las coordenadas; lo que significa que tiene menor
precision.
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Imagen 6.26: Visualizacion en detalle de los puntos mds significativos.

El punto magenta que vemos en la imagen anterior, corresponde al punto de los no utilizados
para la creacion del modelo con mayor distancia a la diana.

Imagen 6.27: Visualizacion de los puntos numerados.

Una vez realizado este analisis previo procedemos a medir todas las precisiones de cada uno
de los puntos, las cuales se encuentran ordenadas en la siguiente tabla:
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NP Precision NP Precision
796 0,003
797 0,009
798 0,004
833 0,033

Tabla 6.4: Errores de todos los puntos. (La tabla completa se
encuentra en el Anexo 6)

Como se puede ver, descartando el punto de mayor error, el de los demas es siempre menor
de 0,010 metros.

Por lo tanto evaluando la diferencia entre el error mds grande y el resto, nos percatamos de
gue el modelo en la zona del punto 833, de color rojo, el modelo no es lo suficientemente
preciso; por lo que tomamos la decisidon de suprimir esa zona en la ortofotografia, de forma
gue la precision final de la ortofoto aumente.

La precisidon de nuestra ortofoto final es de 1 centimetro, lo que nos evidencia un resultado
muy bueno para la metodologia utilizada teniendo en cuenta nuestras necesidades y el uso
gue se le va a dar posteriormente a las ortoimagenes.

Los usos previstos, ademas de servir como documentacion del elementos, podra ser utilizada
por otros participantes en los trabajos en el monasterio, para la realizacion del andlisis
estratigrafico, estudio de degradacidn y clasificacién de técnicas constructivas, y para realizar
el estudio de la cronotipologia de los elementos constructivos, entre otros.

El uso que se le va a dar al producto final no requiere de una precision mayor a la obtenida.

La apariencia de la ortofoto definitiva con la zona problematica suprimida es la siguiente:

Imagen 6.28: Ortofoto final del Arco por Image Master
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6.3.2 ANALISIS DE LA PRECISION DE LA ORTOFOTO DEL “MURO R”
OBTENIDA POR IMAGE MASTER

6.3.2.1 MURO R PANO NORTE

Para la determinacién de la precision de la ortofoto del muro “R” hemos seguido el proceso
general indicado en el apartado denominado “Determinacién de la precisién en
ortofotografias”.

A semejanza del caso anterior de forma grafica se ha realizado un andlisis de precisién,
coloreando los puntos segun su precisién y su naturaleza.

Imagen 6.29: Ortofoto con los puntos coloreados segun precision y naturaleza.

El significado de cada uno de los colores es el siguiente:

Azul -> Puntos utilizados en la definicién del plano imagen.
Verde -> Puntos utilizados (junto a los azules) para la generacion del modelo 3D.
Magenta -> Puntos no utilizados para la generacién del modelo 3D.

La diferencia de los distancia de los puntos azules a la diana en la ortofotografia es nula ya que
estos puntos son los que definen el plano imagen, y por lo tanto, son los utilizados de
referencia para definir el SCP y realizar el escalado de la ortofoto.
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En la imagen que se presenta a continuacidn, se han destacado los puntos con mayor error
tanto del grupo de los utilizados para realizar la orientacion como del de los puntos naturales
tomados como comprobacion.

Como se puede llegar a identificar en la imagen el error en los puntos no empleados en la
orientacién es un poco mayor que en los que si se han utilizado.

Imagen 6.30: Visualizacion en detalle de los puntos mds significativos.

Se puede apreciar que los puntos con mayor error se suelen encontrar generalmente en los
margenes de las ortofotos.

Imagen 6.31: Visualizacion de los puntos numerados.
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Una vez realizado este andlisis previo procedemos a medir todas las precisiones de cada uno
de los puntos, las cuales se encuentran ordenadas en la siguiente tabla:

Puntos Distancia Puntos Distancia
001 0,001
002 0,010
003 0,010
004 0,004
005 0,007
006 0,010
007 0,006

Tabla 6.5: Precisiones de todos los puntos. (La tabla completa se
encuentra en el Anexo 6)

Como se puede ver en la tabla el punto de mayor error de los utilizados en la orientacién es el
punto 742 con Unicamente 5 milimetros de distancia a la diana, y de los naturales no
empleados en la orientacién los de mayor error son el 002, el 003 y el 006 con 1 centimetro de
error. Hay que tener en cuenta que los puntos correspondientes a las dianas en la imagen se
insertan de forma manual por lo que el error es aproximado, aunque mediante el zoom puede
conseguirse un posicionamiento preciso del punto.

Por lo tanto, tras el andlisis realizado podemos sentenciar que la precision final de esta
ortofoto es de 1 centimetro, un resultado muy bueno para el uso que se prevé que se le va a
dar, que evidencia la correcta elaboracidn de nuestro trabajo para la obtencion de los
resultados deseados.

6.3.2.2 MURO R PANO OESTE

En este caso continuamos aplicando el proceso de analisis de la precision igual que en el caso
anterior.

Procedemos también a realizar el analisis previo de precisidn de forma grafica, coloreando los
puntos segun su precision y su naturaleza.

Los colores utilizados también son los mismos que en el resto de casos, con la intencion de
estandarizar todos los analisis de nuestro proyecto. En este caso se incluye el color cian para
los puntos de la base utilizada para escalar.

El significado de cada uno de los colores es el siguiente:
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Azul -> Puntos utilizados en la definicidén del plano imagen.

Verde -> Puntos utilizados (junto a los azules) para la generacidon del modelo 3D.

Cian -> Puntos utilizados como base para el escalado.

Imagen 6.32: Ortofoto con los puntos
coloreados segun precision y naturaleza.

En este caso no disponemos de puntos de
color magenta como en la ortofotografia
anterior debido a que para este pafio no
disponemos de puntos de comprobacién
gue no hayan sido utilizados para realizar la
orientacién. No tenemos puntos naturales
de coordenadas conocidas por lo que
deberemos centrarnos Unicamente en el
analisis de la precisién de los puntos que si
han tomado parte en la orientacion.

Aunque no dispongamos de estos puntos de
comprobacién, como se a verificado en los
casos analizados hasta el momento, los
errores de los puntos de comprobacidn son
de rango similar a los de los puntos de
apoyo de coordenadas conocidas; por lo que
los resultados obtenidos a partir de los
puntos disponebles se podran considerar
representativos.

Los puntos de color cian, son los utilizados como base para escalar la ortofoto; pero al

contrario de los puntos azules en el caso anterior, estos puntos no tendran error cero. Esto no

es asi porque el punto base del escalado no se incluye en la base a partir de la que se escala.

Imagen 6.33: Visualizacion en detalle de los puntos mds significativos.
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Los puntos que se muestran mas detalladamente en la imagen anterior se corresponden con
los puntos que graficamente parecen tener una diferencia mayor entre las coordenadas de los
puntos tomados mediante topografia y el centro de la diana de la ortofoto.

Estos dos puntos tienen un error bastante similar; y como se puede distinguir, la direccién del
error es también bastante parecida. Esto nos demuestra que los errores de los puntos de una
zona determinada de la ortofoto tienen un comportamiento similar.

Imagen 6.34: Visualizacion de los puntos numerados.

Una vez realizado este analisis previo procedemos a medir todas las precisiones de cada uno
de los puntos, las cuales resumimos en la siguiente tabla:

Puntos Distancia
752 0,004
757 0,006

Tabla 6.6: Precisiones de todos los puntos.
(La tabla completa se encuentra en el Anexo 6)

Como se observa en la tabla y de forma correcta hemos evaluado de forma grafica, los puntos
con mayor error son el 756 y el 757. Aun asi el error de estos puntos es bastante pequefio, en
el caso de haber dispuesto de puntos ajenos a la orientacién lo mas probable es que en los
puntos de este tipo que se ubicasen en los bordes de la imagen el error fuese algo mayor.
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También es cierto en este caso, que a pesar de que no tener puntos de este tipo, los puntos de
la orientacidn estdn bastante bien distribuidos por toda la superficie asi que la Unica zona que
podria tener algo mas de error seria la parte alta que tiene ausencia de puntos, esto no se
puede certificar por lo tanto no se tendra en cuenta.

También como ya se ha mencionado, del resto de andlisis de precisién de otras ortofotos
podemos extraer que en la mayoria de los casos el error de los puntos de comprobacién no ha
sido muy diferente a los del resto.

Finalmente, tras el analisis realizado podemos fijar la precisidn final de la ortofoto de este
muro en su pano oeste, teniendo en cuenta que el error maximo es de 6 milimetros; en 1
centimetro como poco, en el caso de tener en cuenta la zona mds alta del muro carente de
puntos de control.

Los 6 milimetros de precisidon se trata de un buen resultado, ya que es mayor del minimo
requerido para nuestros objetivos. Puede llegar a ser normal que los errores sean menores, ya
que el tamafio del muro es menor, los puntos de control recubren todo el muro y la distancia
maxima a un punto de control es menor en todas las zonas del muro.

6.3.3 ANALISIS DE LA PRECISION DE LA ORTOFOTO DEL ARCO DE LA
IGLESIA OBTENIDA POR PHOTOMODELER

Se realiza un analisis de precision de forma grafica, coloreando para esta demostracién los
puntos segun su precisidén y su naturaleza.

Imagen 6.35: Ortofoto con los puntos coloreados segun precision y naturaleza.
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El significado de cada uno de los colores es el siguiente:

Azul -> Puntos utilizados en la definicién del plano imagen.
Verde -> Puntos utilizados (junto a los azules) para la generacidn del modelo 3D.
Magenta -> Puntos no utilizados para la generacidn del modelo 3D.

Como los puntos azules han sido los utilizados para la definicion del origen del sistema de
coordenadas de la ortofoto y para el escalado de la misma, no es perceptible en estos puntos
ningun error.

Los puntos en color verde son los utilizados en la orientacidn y los de color magenta son los no
utilizados en la orientacién, pero de los que disponemos de coordenadas; por lo que nos
serviran como puntos de comprobacién para la definicién de la precisién de la ortofoto.

El punto verde que se encuentra destacado en la siguiente fotografia, aparentemente se trata
del punto con méaximo error, es decir que existe mayor diferencia entre la posicién de la diana
y las coordenadas de los puntos de apoyo medidas en campo.

Imagen 6.36: Visualizacion en detalle de los puntos mds significativos.

Los otros dos puntos mostrados en detalle, se tratan de puntos de comprobacidn, y tienen un
error menor que el punto verde de error maximo.
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Imagen 6.37: Visualizacion de los puntos numerados.

Una vez realizado este analisis previo, se puede realizar toda la medicién de los errores de
cada uno de los puntos, las cuales se encuentran ordenadas en la siguiente tabla:

NP Distancia NP Distancia
796 0,008
797 0,008
798 0,008

Tabla 6.7: Errores de todos los puntos. (La tabla completa se
encuentra en el Anexo 6)

A partir de los datos de la tabla, confirmamos que como se habia apreciado en el andlisis
grafico, el punto 836 es el que tiene un error mayor.

Los puntos utilizados de comprobacién presentan un error menor, lo que evidencia que el
error no depende de la utilizacién o no del punto en la orientaciéon del modelo; por lo que la
orientacién esta correctamente realizada.

Por lo tanto, habiendo obtenido un error maximo en los puntos medidos de 1,3 centimetros;
podemos fijar la precision de nuestra ortofoto final en 1,5 centimetros, lo que nos evidencia
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un resultado bueno para la metodologia utilizada teniendo en cuenta nuestras necesidades y
el uso que se le va a dar posteriormente a las ortoimdgenes.

En comparacion a la ortofoto obtenida con Image Master, esta tiene una precision un poco
menor; es de 1,5 centimetros frente a 1 centimetro de la de Image Master. Esta diferencia no
es muy significativa; por lo que se puede sentenciar que el resultado de las ortofotos
generadas con los dos programas, en lo relativo a la precisién, es bastante parecido en ambos
casos.

6.3.4 ANALISIS DE LA PRECISION DE LA ORTOFOTO DEL “MURO R”
OBTENIDA POR PHOTOMODELER

6.3.4.1 MURO R PANO NORTE

Para la determinacién de la precisidn de la ortofoto del muro “R” obtenida por Photomodeler,
hemos aplicado la metodologia propuesta en este mismo proyecto.

Se ha realizado un andlisis gréafico, coloreando los puntos segun su precision y su naturaleza.

Imagen 6.38: Ortofoto con los puntos coloreados segun precision y naturaleza.

El significado de cada uno de los colores es el siguiente:

Azul -> Puntos utilizados en la definicién del plano imagen.
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Verde -> Puntos utilizados (junto a los azules) para la generacion del modelo 3D.
Magenta -> Puntos no utilizados para la generacién del modelo 3D.

Los puntos azules no presentan diferencia ninguna con las dianas de la ortofoto, debido a que
han sido utilizados para la generacién del modelo.

En la imagen que se presenta a continuacién, se han destacado los puntos con mayor error
tanto de los utilizados para realizar la generacién del modelo como del de los puntos naturales
utilizados como comprobacién.

En este caso el error mayor aparenta ser el de la diana no utilizada para la generacion del
modelo; mientras que el otro punto presenta una diferencia algo menor entre las coordenadas
medidas y la posicion de la diana en la ortofoto.

Imagen 6.39: Visualizacion en detalle de los puntos mds significativos.

Es comprensible que el error mayor aparezca en un punto natural, ya que cada uno de los
posicionamientos sobre él; tanto al generar el modelo como al realizar el analisis comparativo,
introduce un error producido también en cierta medida por la indeterminacion a la hora de la
identificacion del punto.
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Imagen 6.40: Visualizacion de los puntos numerados.

Una vez realizado este andlisis previo se ha procedido a medir todas las diferencias de
coordenadas de cada uno de los puntos, las cuales se encuentran recopiladas en la siguiente
tabla:

Puntos Distancia Puntos Distancia

0,002
0,006
0,007
0,002
0,007
0,013

AN HIWIN|F

Tabla 6.8: Precisiones de todos los puntos. (La tabla completa se
encuentra en el Anexo 6)

Segun los resultados de la tabla, el punto que muestra un error mayor es la nimero 6; que es
el que ya se habia indicado en el analisis previo. Su error es de 1,3 centimetros. Este error
difiere un poco al del resto de los puntos, ya que el siguiente con mayor error es el punto 812,
que presenta un error de 7 milimetros. Este punto a diferencia del anterior, si que se ha
utilizado para la orientacion del modelo.

Por lo tanto, tras el andlisis realizado, se puede definir la precision final de la fotografia como
de 1,5 centimetros; ya que la precision de la ortofoto se corresponde con el error maximo de
todos los puntos analizados, y en este caso asciende a 1,3 centimetros. El resultado, a pesar de
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ser un poco peor que los obtenidos en las ortofotos generadas con Image Master, cumple las
expectativas; y mdas aun corroborando que la mayoria de puntos tienen un error menor.

Como se ha explicado anteriormente, también es posible que sea debido a la identificacion del
punto al realizar el escalado.

6.3.4.2 MURO R PANO OESTE

En este caso se continda aplicando la misma metodologia de analisis de la precisién que en el
caso anterior.

Procedemos a realizar el andlisis previo de precisiéon de forma grafica, coloreando los puntos
segun su precisidén y su naturaleza.

Los colores utilizados también son los mismos que en los casos anteriores, incluyendo el color
cian para distinguir los puntos utilizados para realizar el escalado pero que no tendran error
cero; ya que la base del escalado no contiene al punto origen.

El significado de cada uno de los colores es el siguiente:

Azul -> Puntos utilizado como origen y punto base del desplazamiento.
Verde -> Puntos utilizados (junto a los azules y cian) para la generacién del modelo 3D.
Cian -> Puntos utilizados como base para el escalado.

Para realizar el escalado de la ortofoto se
han utilidado los puntos de color cian. Se
han seleccionado estos puntos debido a que
conforman la distancia mas larga posible, y
por lo tanto al utilizar una base mas grande
el escalado serda mejor.

No se dispone de puntos naturales
susceptibles de ser utilizados como
comprobacién por lo que tendremos que
reducir el andlisis a los puntos que tenemos
y que han sido utilizados en la generacion
del modelo 3Dy la ortofotografia.

Imagen 6.41: Ortofoto con los puntos
coloreados segun precision y naturaleza.

Como ya se ha mencionado el escalado de la imagen se ha realizado con los puntos de color
cian manteniendo como punto base el de color azul.
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Imagen 6.42: Visualizacidon en detalle de los puntos mds significativos.
En la imagen anterior se muestran ampliados los puntos que presentan mayor error, aunque

este error aparenta ser muy pequefio segun la percepcion sobre la ortofoto.

Se puede comprobar que el hecho de haber utilizado los puntos para escalar no influye en
mejorar la precisién del mismo, como en el caso de tomar la base de escalado incluyendo el
punto base.

Obviamente, el punto origen, de color azul; tiene error nulo ya que es el utilizado como
referencia para encajar la ortofoto en los puntos tomadas por topografia clasica.

7538 x/9¢2

LA,

757& s 31{756

Imagen 6.43: Visualizacion de los puntos numerados.
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Una vez realizado este andlisis previo realizamos el cdlculo de las diferencias que presentan los
puntos entre sus coordenadas mediadas y las posiciones de las dianas en la imagen. Etas
distancias se resumen en la siguiente tabla:

Puntos Distancia

Tabla 6.9: Precisiones de todos los puntos.
(La tabla completa se encuentra en el Anexo 6)

Como se observa en la tabla y de correctamente hemos evaluado de forma gréfica, los puntos
con mayor error son el 753 y el 757. Este error es muy pequefio, y aunque existe la zona
superior de la ortofoto en la que no tenemos ningun punto de comprobacion;
presumiblemente, en esa zona el error no superaria los 6 u 8 milimetros. Esto no se puede
asegurar, pero al no distinguirse la zona como de geometria susceptible a provocar grandes
errores, y al no encontrarse muy lejos de los puntos disponibles; no resulta muy aventurado
suponer que el error no excederia de estos 6 milimetros. También corrobora esta teoria, que
en el resto de casos estudiados los errores de los puntos de comprobaciéon no son mucho
mayores a los de los puntos utilizados en la generacién del modelo.

Tras realizar este andlisis, se determina la precisién final de la ortofoto en 1 centimetro como
maximo.

Esta precision milimétrica supera las expectativas del trabajo, ya que los usos que se les va a
dar a estas ortofotos no requieren de tanta precisidon; nos resultaria suficiente con una
precisidn cercana al centimetro.
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7.1 ANALISIS COMPARATIVO

7.1.1 DEFINICION DE VARIABLES DE COMPARACION

Para realizar una comparacién lo mas completa posible, y que abraque todos los procesos
cubiertos por los programas; es necesaria la definicién de unos factores de comparacién a los
que cefirnos.

Atendiendo a cada uno de estos factores, procederemos a realizar la comparativa, definiendo
las diferencias, ventajas y desventajas de los diferentes programas.

La definicidn de los factores se ha realizado a partir del andlisis de las caracteristicas generales
mds importantes del tipo de programas utilizados. Ha sido durante su estudio y aprendizaje,
cuando se ha comprendido cuales son los pasos generales que se realizan, y que conforman las
caracteristicas propias de cada programa.

Finalmente los factores evaluados como factibles de usarse en la comparacién son los
siguientes:

e Formatos de entrada

e Calibracién de la camara

e Numero de pasos del proceso

e Capacidad de intervencién en el proceso
e Edicion de mallas y nubes de puntos

e Generacién de los productos

e Calidad de los resultados

e (Capacidad de exportacién

e Tiempo / velocidad del proceso completo
e Aspecto visual y comodidad de trabajo

A continuacién se explica cada uno de los factores, indicando los aspectos concretos que se
trataran para cada programa en lo respectivo a cada factor.

Formatos de entrada

En este apartado se describiran los tipos de fichero que cada programa permite utilizar, y se
evaluaran las ventajas e inconvenientes de cada caso y formato.

Calibracion de la cdmara

Para este apartado, se describirdan las posibilidades que cada programa nos ofrece en lo
referente a la calibracidn; tipos de calibracién y su comparacion.

Numeros de pasos del proceso

166



Documentacion y representacion de paramentos verticales en riesgo de colapso.
Aplicacién en el Monasterio de San Prudencio (Clavijo, La Rioja). 7. COMPARATIVA

Se enumeraran todos los pasos que se debe realizar con cada programa para ejecutar un
trabajo completo con cada programa.

Capacidad de intervencidén

Se evaluard la capacidad de intervencién que tiene el usuario durante la ejecucién de los
procesos, los pardmetros que se permite definir al usuario y el grado de automatizacién que
éstos presentan.

Edicién de mallas y nubes de puntos

En este factor se evaluard tanto la capacidad de ediciéon; como la facilidad, rapidez y
comodidad de la misma.

Generacién de los productos

En este apartado se analizard la creacion de los modelos 3D, las ortofotos y las secciones con
los diferentes programas.

Calidad de los resultados

Se evaluard, tanto a nuestro juicio como cuantitativamente mediante el analisis de la precisién
realizada, la calidad de los resultados que se obtienen en los distintos software.

Capacidad de exportacién

Se describirdn los elementos que permite exportar cada programa, y los formatos en los que se
puede realizar.

Tiempo / velocidad del proceso completo

Se evaluard en la medida de lo posible el tiempo que se tarda en completar un trabajo
estandar con cada uno de los programas, y que procesos resultan mas agiles o mas lentos en
los mismos.

Aspecto visual y comodidad de trabajo

Se analizara de forma subjetiva el aspecto grafico de cada programa y la comodidad de
realizacion del trabajo.

7.1.2 COMPARACION (DIFERENCIAS, VENTAJAS Y DESVENTAJAS)

En la presente comparacion se van a evaluar las caracteristicas de cada programa basandonos
en los factores de comparacion definidos en el apartado anterior. Ademas de indicar las
diferencias, ventajas y desventajas de cada programa; se va a indicar segln nuestro criterio
gué programa es mas ventajoso en lo relativo a cada factor.
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7.1.2.1 FORMATOS DE ENTRADA

Los formatos de entrada aceptados por cada uno de los programas estan recopilados en la
siguiente tabla.

IMAGE MASTER PHOTOMODELER SCANNER
Imagenes * jpg; *.bmp * jpg; *.bmp; *.png; *.tif
Puntos *.csv; *.gep; *.apa; *.sim; *.txt *.dxf; *.0bj; *.3ds; *.pmc; *.txt
Nubes de puntos y *cl3; *.clr; *.ptx; *.pts; *.dxf; | *.asc; *.dat; *.stl; *.obj; *.ply;
mallas *.csv; *oixt; *.tin * byu; *.facet
Ortofotos * jpg; *.bmp; *.tif -

Elevation text: *.hei
Otros Field Scan: *.fsc
Field Orientation: *.foe

TopSURYV Scanning: *fsn

Tabla 7.1: Formatos de importacion aceptados en cada programa

Ambos programas permiten la importacién en varios formatos, pero la principal diferencia es
la capacidad que tiene Image Master de importar otros tipos de ficheros como, por ejemplo,
las ortofotos.

La ventaja que tiene Photomodeler es que acepta mas formatos de imdgenes; aunque esto no
es un problema en Image Master, ya que el formato comiunmente utilizado es JPEG, y ademas,
en el caso de las imagenes es sencillo realizar las conversiones de formato.

El programa que presenta mas posibilidades en este apartado es Image Master, por lo que esto
supondra un punto a favor para dicho software.

Image Master: +1

7.1.2.2 CALIBRACION DE LA CAMARA

Con respecto a la calibracién de la cdmara que se ha utilizado, si que existen bastantes
diferencias entre los métodos que proponen los diferentes programas.

Por ejemplo, Image Master solamente permite realizar la calibracién a partir de la toma de
fotografias a un patréon de calibracién compuesto por una matriz de puntos presentados en
formato papel, que el programa detecta automaticamente. Photomodeler, por otra parte,
también permite realizar la calibraciéon de un modo similar, aunque la hoja de calibracién es
diferente, ya que cada programa tiene una especifica.

A pesar de que el método de calibracién es similar, presenta bastantes diferencias en lo
relativo al nivel de intervencion asumible por el usuario. En Image Master la capacidad de
intervencién del usuario es muy reducida ya que el proceso es automatico. El usuario
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Unicamente tendra que intervenir en el caso de que el programa no sea capaz de identificar las
marcas de la hoja de calibracién automaticamente, las cuales deberdn ser marcadas por el
usuario.

En Photomodeler, por el contrario, el nivel de intervencién del usuario es mucho mayor. La
deteccion de las marcas de la matriz de calibracién es también automatica y en caso de no
detectar todas las marcas deberan ser marcadas manualmente. En este programa, el usuario
es capaz de analizar el resultado de la calibracién a partir de los residuos de todos los puntos.
En el caso de que la calibracidon no sea todo lo precisa deseable, el usuario puede eliminar
algunos de los puntos que tienen mas error; o asumir una precisién un poco menor en la
calibracion.

Aunque desde algun punto de vista, puede ser mas cdmodo y sencillo el que el proceso sea
completamente automadtico, esto puede presentar multitud de problemas; ya que si el
programa no es capaz de detectar las marcas habria que volver a tomar las fotografias de
calibracién, mientras que con un nivel de intervencién mayor se podria solucionar el problema,
relegdndose la repeticion de la toma de las fotografias a una ultima opcidn.

Ademas de este sistema de calibracién cldsico para este tipo de programas fotogramétricos,
Photomodeler permite la calibracidon de la cdmara de forma inversa, sin necesidad de tomar
fotografias a la hoja de calibracidn, por dos métodos diferentes.

La primera posibilidad es realizar la calibracién a partir de las coordenadas conocidas de, al
menos, cinco puntos de control que aparezcan en las fotografias; y la otra es realizar la
calibracién, a partir de unos pardmetros aproximados de una camara similar, e identificando
una cantidad considerable de puntos homélogos.

La ventaja de la calibracién con puntos de coordenadas conocidas, es que se asigna una
camara independiente a cada fotografia y por lo tanto se calculan unos pardmetros especificos
para cada una. Por esta razon seria posible en este caso tomar las imagenes en modo “AF” de
autoenfoque, y de esta forma asegurarnos que las fotografias resultaran bien enfocadas.

El caso de Orthoware es similar a la segunda de las opciones de calibracién inversa de
Photomodeler. Calcula los pardmetros de calibracién, dando también la posibilidad de calcular
camaras independientes para cada imagen, a partir de la identificacién de puntos homélogos.
Lo caracteristico de este programa es que la identificacion de los puntos homdlogos es
automatica por correlacion por lo que el nUmero de puntos obtenidos es mayor, y por lo tanto
la calibracidn de mayor calidad y mas rapida.

Por lo tanto, por las caracteristicas descritas, en la comparacidon entre Image Master y
Photomodeler; este ultimo saldria mejor parado, ya que permite una serie de opciones que
resultan muy interesantes y que en Image Master no estd disponible.

Photomodeler: +1

169



Documentacion y representacion de paramentos verticales en riesgo de colapso.
Aplicacién en el Monasterio de San Prudencio (Clavijo, La Rioja). 7. COMPARATIVA

7.1.2.3 NUMERO DE PASOS DEL PROCESO

En la siguiente tabla se recogen la serie de pasos de que consta el proceso para cada uno de

los casos.
IMAGE MASTER PHOTOMODELER SCANNER
- Crear nuevo proyecto - Iniciacién del proyecto
- Abririmagenes - ldentificacidn de puntos homoélogos
- Importacidn de los puntos de control - Orientacion de imagenes
- Marcado de los puntos de control - Importacidn de los puntos de control
- Creacion de los pares - Marcado de los puntos de control
- Dibujado de las lineas de rotura - ldealizado de las imagenes
- Generacion de la superficie - Creacion de la nube de puntos
- Limpieza del modelo - Limpieza de la nube
- Generacion y de la ortofoto - Generacion de la malla
- Exportacién de la ortofoto - Limpieza del modelo
- Generacion de la ortofoto

Tabla 7.2: Pasos del proceso en Image Master y Photomodeler

Como se puede ver a partir del numero de pasos de la tabla, en Photomodeler el proceso
resulta ser mas largo y laborioso.

Existen varias diferencias entre los pasos en ambos programas. Por ejemplo en Image Master,
los puntos de control son introducidos directamente identificAndolos en todas las fotografias;
mientras que en Photomodeler en un primer momento se identifican los puntos homdlogos
incluyendo los puntos de los que se han tomados las coordenadas, y posteriormente, tras
importar los puntos de control se relacionan las coordenadas con el punto correspondiente ya
identificado anteriormente.

Otra diferencia es que mientras Image Master crea las mallas directamente a partir de las
fotografias, en Photomodeler este proceso se divide en 12 pasos que pueden ser ejecutados
individualmente, o ejecutar Unicamente los que se desean; estos pasos son: “Filter Isolated
Points”, “Register & Merge”, “Denoise Point Cloud”, “Decimate Point Cloud”, “Mesh Point
Cloud”, “Decimate Triangles”, “Fill Holes”, “Unify Normals”, “Fill Fjords”, “Smooth”, “Sharp
Smooth” y “Contours”.

También existe diferencia en la creacién de las ortofotos, mientras que en Photomodeler se
creay se exporta directamente, en Image Master son dos pasos diferenciados.

Otra peculiaridad de Image Master es que ofrece la posibilidad de creacidn de lineas de rotura,
de forma que la malla creada se ajuste mejor a la geometria del elemento en las zonas mas
criticas.

Aunque el proceso en Photomodeler es mas largo, la capacidad de seleccionar de forma
individual los pasos para la generacién de las nubes de puntos y las mallas, se convierte en una
caracteristica muy importante, por lo que se trata de un punto a favor de Photomodelerer.

Photomodeler: +1
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7.1.2.4 CAPACIDAD DE INTERVENCION EN EL PROCESO VS AUTOMATIZACION DEL PROCESO

En cuanto a la capacidad de intervencidn, Photomodeler presenta muchas mds posibilidades.
Ademas de los 12 pasos que se han descrito en el apartado anterior y que nos posibilitan
realizar el proceso por partes, e incluso decidir que partes del proceso queremos ejecutar o no;
Photomodeler también nos permite definir los pardmetros de creacidon de nubes de puntos.
Por el contrario Image Master presenta un proceso muy automatizado, sobre todo en lo
respectivo a la generacion de la superficie.

A pesar que desde un punto de vista técnico, podria ser preferible la mayor capacidad de
intervencién ofrecida por Photomodeler; en este caso no lo es tanto, incluso puede llegar a
volverse en su contra. Photomodeler no nos da las indicaciones necesarias para comprender
correctamente el funcionamiento de estos parametros, y como conseguir que las nubes
tengan desde un principio menos ruido y menos zonas sin puntos. Por esta razén, resulta muy
complicado conseguir nubes muy buenas, ya que los pardmetros dptimos a definir en cada
caso deberian de ser obtenidos mediante experimentacidn lo que hacen que esta tarea no sea
todo lo agil que debiese. Seria necesario mucho tiempo de trabajo con el programa para llegar
a dominar, de forma experimental, el efecto de la variacién de los valores de cada parametro.

En Image Master, sin embargo, el nivel de intervencién posible es bastante menor; pero a la
contra, el resultado es muy bueno la mayoria de las veces, por lo que resulta mucho m3s eficaz
gue la mayor capacidad de intervencion de Photomodeler.

Por esta razén, aunque Image Master permite la definicion de menos variables, permite
generar las nubes de puntos y las superficies con mas solvencia.

Image Master: +1

7.1.2.5 EDICION DE MALLAS Y NUBES DE PUNTOS

La capacidad de edicién de mallas y nubes de puntos es bastante similar entre los dos
programas. Ambos dan la oportunidad de recortar tanto las nubes de puntos como las mallas,
seleccionando los elementos de forma individual o marcando un poligono.

La Unica diferencia es que, para mi parecer, la edicion en Image Master resulta un poco mas
comoda ya que también el modo de visualizacién del modelo es mas comodo, y la forma de
hacer las selecciones de los elementos también.

Image Master: +1

En este apartado, resulta también muy interesante, hacer un inciso en la comparaciéon de
Image Master y Photomodeler; y comentar las caracteristicas tanto de MeshlLab como de
Rapidform.
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Estos software no resultan comparables a los anteriores, ya que se tratan de programas
especificos para la edicion de nubes de puntos y mallas de tridngulos por lo que las
capacidades son mucho mayores para el desarrollo de este tipo de trabajos.

Ambos permiten trabajos con las nubes y las mallas como el combinado, la depuracién, el
recorte,... Comparando MeshlLab con Rapidform, este segundo resulta mas facil de manejar,
mas intuitivo y permite muchas mas acciones. Esto puede deberse a que el indice de
desarrollo alcanzado por Rapidform es mayor, ya que MeshLab es un programa creado por la
universidad de Pisa; y seguramente los medios técnicos y sobre todo econdmicos diferiran
muchisimo ya que Rapidform es un programa comercial, mientras que MeshLab se distribuye
de forma gratuita.

El manejo de Meshlab resulta mas complicado porque se trata de un programa creado por
maodulos de forma que cada una de las acciones que el programa realiza se ha programado por
uno de los colaboradores en el proyecto de creacién, y por lo tanto, acciones que en un
software normal se realizarian mediante un icono, en MeshLab requieren de la ejecucién de
tres acciones; como por ejemplo la creacidn de superficies.

7.1.2.6 GENERACION DE LOS PRODUCTOS

En el caso del modelo 3D, como ya se ha indicado previamente, la generacién en Image Master
es mas solvente, realizdndose de forma agil y sencilla. En Photomodeler, por el contrario es un
poco mas engorrosa aungque tampoco presenta ningln problema.

En lo que a MeshLab e Rapidform respecta, también son capaces de generar superficies
aunque este es un apartado de Rapidform en el que no se ha indagado. En el caso de MeshLab
el resultado no es tan bueno como en el resto, aunque puede ser una solucién en algunos
casos ya que es un software de libre distribucién. Tiene el problema de que no permite el
trabajo con texturas fotograficas, aunque para superficies creadas a partir de nubes de puntos
muy densas, la textura puede resultar bastante realista.

Con respecto a las ortofotografias, su generaciéon resulta muy sencilla tanto en ImageMaster
como en Photomodeler con la diferencia de la manera de definicidn del plano imagen o de
ortoproyeccion; a partir de dos puntos en Image Master y a partir de tres en Photomodeler. Es
mas interesante definir el plano a partir de tres puntos ya que proporciona bastante mas
libertad. Ya que el eje Y del plano de ortoproyeccién en Image Master siempre serd la vertical
del sistema de coordenadas de los puntos de apoyo.

También hay que decir, que aunque Imagemaster requiera dos pasos para la generacién de las
ortofotos esto se convierte en una ventaja, ya que antes de exportar la ortofoto la puedes
examinar a tamafo real, mientras que en Photomodeler sélo se puede previsualizar en una
pequefia ventana.

Mencionar que las secciones han sido obtenidas con Rapidform ya que se ha evaluado como la
manera mas sencilla de hacerlo, de acuerdo a las opciones disponibles.
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Para este factor de comparacion, no es posible decantarse por ninguno de los dos programas,
ya que Image Master es mejor en la generacién del modelo y Photomodeler en la generacidn
de la ortofoto.

Image Master: +1

Photomodeler: +1

7.1.2.7 CALIDAD DE LOS RESULTADOS

El andlisis de la calidad de los resultados debe basarse tanto en el analisis de la precisién de
cada producto como en la valoracion del aspecto visual del resultado.

En lo relativo a los modelos tridimensionales, el analisis de la precisién se ha realizado
mediante la comparacidon de coordenadas de los puntos de control y de las dianas sobre el
modelo, en Image Master; y mediante la comparacién de las coordenadas de los puntos de
control y de los puntos restituidos de las dianas por el programa, en Photomodeler.

Esto es asi porque, aunque la manera éptima de realizarlo es como se ha realizado en Image
Master; esto no es posible en Photomodeler ya que el programa no permite realizar
mediciones sobre la superficie, ni tampoco conocer las coordenadas de los puntos de las nubes
de puntos.

El analisis de la precisién de los modelos se encuentra descrito en el apartado correspondiente
del capitulo de Resultados.

Las precisiones obtenidas para cada modelo son las presentadas en la siguiente tabla:

IMAGEMASTER PHOTOMODELER SCANNER
ARCO 2cm 1cm
MURO “R” 1,5cm 1,5cm

Tabla 7.3: Precisiones de los modelos

Como se ve en la tabla, las precisiones de los modelos de Image Master resultan algo menores,
aunque hay que tener en cuenta, que los errores medidos en Photomodeler se ven reducidos
ya que los puntos restituidos utilizados en la medicién de distancias para el andlisis de la
precisidn se ven afectados por la orientacion del modelo.

Aun asi se puede decir, que atendiendo a los resultados obtenidos, los modelos de
Photomodeler resultan un poco mds precisos; aunque estas diferencias no resultan del todo
significativas.

Respecto al aspecto visual del modelo hay que decir que Image Master supera a
Photomodeler. Como se puede observar en los modelos expuestos en el apartado de anlisis
de la precisidn de los modelos por ambos programas, el modelado de la superficie resulta
mejor en Image Master. Ademas, los modelos por Photomodeler tienen la deficiencia de que al
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acercarse a la superficie se distinguen en la textura los tridngulos que conforman la malla, lo
gue le otorga al modelo una apariencia menos agradable y menos rigurosa.

Para las ortofotografias también se ha realizado el anélisis de la precisidn, para este caso se ha
realizado la comparacién de coordenadas entre los puntos de control y la posicién de las
dianas en la ortofoto.

Las precisiones obtenidas han sido las siguientes:

IMAGEMASTER PHOTOMODELER SCANNER
ARCO lcm 1,5cm
MURO “R” PANO NORTE 1cm 1,5cm
MURO “R” PANO OESTE 1cm 1cm

Tabla 7.4: Precisiones de las ortofotos

Como se comprueba en la tabla, a pesar de que para los modelos la precisién en mayor en
Photomodeler, en las ortofotos no es asi resultando algo mas precisas las generadas en Image
Master; aunque la diferencia tampoco es muy significativa.

La diferencia entre las precisiones de los modelos y de las ortofotos, puede ser debida a que en
los modelos las distancias se miden en tres dimensiones, y en el caso de las ortofotos
solamente en dos.

La apariencia visual de las ortofotos es muy buena en ambos casos, la diferencia es que al
tratarse de productos derivados del modelo, las deficiencias de estos se trasmiten a las
ortofotos. En el caso de que exista alguna zona sin modelar, esta tampoco aparecerd en la
ortoimagen.

Por ultimo sobre las secciones, indicar que se obtienen directamente a partir de las superficies
generadas, y que estas tendrdn las mismas precisiones que los modelos de las que se derivan.

Por lo tanto, atendiendo a que las precisiones obtenidas en los dos programas son bastante
similares, y a que la apariencia visual es mejor en Image Master; podemos concluir que en
general Image Master nos proporcionard unos resultados mejores, y ademas obtenidos de
forma mas rapida y sencilla.

Image Master: +1

7.1.2.8 CAPACIDAD DE EXPORTACION

Los posibles formatos de exportacion cada uno de los programas se encuentran recopilados en
la siguiente tabla:
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IMAGE MASTER PHOTOMODELER SCANNER
Puntos *.csv; *.apa; *.sim; *.txt *.dxf; *.3ds; *.wrl; *.obj; *.raw;
Nubes de puntos * ptx; *.pts; *.dxf; *.csv; *.txt *.igs; *.3dm; *.stl; *.ma; *.kml;
Mallas *.dxf; *.tin; *.wrl * kmz; *.ms; *.fbx
* jpg; *.bmp; *.tif *tif; *.bmp; *.pcx; *.tga; *.png;
Ortofotos *plt; *.psd; *.iff; *.cal, *.sgi;
*.rgb
Animacion - *.avi

Tabla 7.5: Formatos de exportacion posibles en cada programa

Ambos programas presentan varios formatos posibles para la exportacién, aunque
cuantitativamente como se puede observar en la tabla anterior Photomodeler presenta mas
opciones.

Aunque esto es un punto a favor, esto no quiere decir que en Image Master esto sea un
problema, ya que dispone de los formatos cominmente mds utilizados como son el TXT, DXFy
VRML.

Un punto a favor de Photomodeler, es también es al posibilidad de exportar una animacién del
modelo, ya que esta es una herramienta muy util como forma de difusion del trabajo
realizado. Para la difusidon, también resulta interesante la posibilidad de crear imagenes y
videos 3D por medio de anaglifos.

En este apartado Photomodeler presenta mds opciones asi que esto supone un punto a favor
de este software.

Photomodeler: +1

7.1.2.9 TIEMPO / VELOCIDAD DEL PROCESO COMPLETO

El tiempo de generacién de las nubes de puntos no se ha cuantificado rigurosamente, pero es
obvio, segln las experiencias, que Image Master resulta algo mas rdpido que Photomodeler,
entre otras cosas porque el numero de pasos es menor. Mientras que en Image Master los
procesos que mas se demoran son la identificacién de puntos, el dibujado de las lineas de
rotura, la generacién del modelo y la edicion del mismo; en Photomodeler son mas procesos:
identificacion de puntos, importacidon de los puntos de control, generaciéon de la nube de
puntos, limpieza de la nube, generacidn de la superficie y edicién de la superficie.

También hay que decir que el proceso de generacion de las mallas se demora un poco mas en
Photomodeler, aunque realmente esto no esta muy contrastado en este caso ya que para cada
programa se han utilizado ordenadores diferentes.

La mayor rapidez en la ejecucion del trabajo completo por parte de Image Master, se convierte
en uno de los principales puntos a favor.

Image Master: +1
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7.1.2.10 ASPECTO VISUALY COMODIDAD DEL TRABAJO

En cuanto al aspecto visual general de los dos programas, en mi opinién, ninguno presenta
ninguna deficiencia grande; aunque para mi gusto yo me quedaria con Photomodeler en lo
gue a las barras de herramientas se refiere.

Por el contrario, a mi juicio, Photomodeler también presenta una deficiencia bastante notoria
en el visualizador 3D. Mientras que para desplazarte por la vista en Image Master lo realizas
con los botones del ratén directamente, en Photomodeler hay que pulsar un icono concreto
todo el tiempo. También resulta, este visualizador, bastante mas lento cuando el modelo tiene
coordenadas grandes.

Por otra parte, Photomodeler aventaja a Image Master en la identificacion de los puntos
homodlogos y de control ya que en esta operacién Photomodeler resulta mds rdpido y sencillo.

Por lo tanto, a mi juicio en cuanto a aspecto y comodidad, en general; Image Master es
notoriamente mas cémodo, ya que la diferencia en el visualizador resulta concluyente.

Image Master: +1

7.1.2.11 CONCLUSION DE LA COMPARACION

Por lo tanto, finalmente realizando una revisién de las comparaciones realizadas, obtenemos
qgue Image Master resulta mas ventajoso en 6 de los 10 factores analizados, mientras que
Photomodeler lo es Unicamente en 3. En el factor restante los dos programas son igual de
competitivos, ya que presentan ventajas e inconvenientes a nivel similar.

Teniendo ademas en cuenta, que Image Master resulta mas ventajoso en los factores mas
importantes; como son la generacién de los productos, la calidad de los mismos y el tiempo
que se tarda en obtenerlos, es obvio decidirse por la utilizacién de Image Master. Ademas, en
otro factor importante, como es el precio del software, ambas herramientas tienen un coste
similar por lo que no resultaria un factor decisivo.

A modo de resumen se concluye que las caracteristicas mds positivas de Photomodeler, son la
calibracion y la capacidad de intervencién; mientras que el punto fuerte de Image Master es la
generacidn de los productos, la rapidez y el aspecto visual de los resultados.

Por ultimo, como conclusién de la comparacidn se propone el empleo de Image Master en la
ejecucion de trabajos de documentacidon de paramentos verticales similares al realizado en
ente proyecto

A continuacidn se presenta una tabla resumen de este apartado de comparacion:
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Formatos de entrada

Calibracion de la cdmara

TOPCON IMAGE MASTER®

Imagenes: *.jpg; *.bmp

Puntos: *.csv; *.gcp; *.apa; *.sim; *.txt
Nubes y mallas: *.cl3; *.clr; *.ptx; *.pts;
* dxf; *.csv; *.txt; *.tin

Ortofotos: *.jpg; *.bmp; *.tif

Elevation text: *.hei

Field Scan: *.fsc

Field Orientation: *.foe

TopSURYV Scanning: *fsn

Calibracion tipica mediante fotografias
tomadas a una hoja de calibracidn.
Proceso automatizado, capacidad de
intervencién Unicamente en la deteccidn
de marcas.

PHOTOMODELER SCANNER®

Numero de pasos del proceso

Capacidad de intervencion

Edicion de mallas y nubes de puntos

Generacion de los productos®

Calidad de los resultados™

Capacidad de exportacién

Tiempo / Velocidad del proceso
completo

Aspecto visual y comodidad de trabajo

¥ o0s 12 pasos son: “Filter Isolated Points”, “Register & Merge”, “Denoise Point Cloud”, “Decimate Point Cloud”, “Mesh Point Cloud”, “Decimate Triangles”, “Fill

Los principales son:
Identificacion puntos de control
Dibujado de lineas de rotura
Generacién de la superficie
Limpieza del modelo
Generacion de la ortofoto

Nivel de intervencion posible menor que
en Photomodeler. El resultado es bueno
la mayoria de las veces por lo que en
definitiva resulta un software mas eficaz.

Capacidad de edicién buena. Mayor
comodidad en la visualizaciéon del modelo
3Dy el la seleccidn de los elementos.
Modelo 3D: generacion rdpida vy
automatica.

Ortofoto: generacion sencilla, definicién
del plano imagen a partir de 2 puntos y
previsualizacién a tamafio real antes de la
exportacion.

Modelo 3D: Arco ->2 cm

Muro “R” -> 1,5 cm

Ortofoto: Arco -> 1 cm

Muro “R” norte -> 1 cm

Muro “R” oeste -> 1 cm

Modelado y aspecto visual de los modelos
muy bueno. Ortofotos con buen aspecto y
precisas.

Puntos: *.csv; *.apa; *.sim; *.txt
Nubes: *.ptx; *.pts; *.dxf; *.csv; *.txt
Mallas: *.dxf; *.tin; *.wrl

Ortofotos: *.jpg; *.bmp; *.tif

Trabajo bastante rdpido. Trabajos mas
tediosos: identificacion de puntos,
dibujado de lineas de rotura. Un Unico
procesado para la generacion del modelo.
Generacion de la ortofoto répida.

Apariencia visual correcta. Sistema de
identificacion de puntos de control un
poco mas engorroso que el de
Photomodeler.

Holes”, “Unify Normals”, “Fill Fjords”, “Smooth”, “Sharp Smooth” y “Contours”.

20 . . . . .z .. . ,
Respecto a este factor los dos programas estan muy parejos, ambos tienen cualidades muy buenas; pero también deficiencias. Por esta razén se les otorga un

empate.

2t Hay que tener en cuenta que el andlisis de la precisidon de los modelos se ha realizado de forma distinta entre Image Master y Photomodeler. En Photomodeler los

Imagenes: *.jpg; *.bmp; *.png; *.tif
Puntos: *.dxf; *.obj; *.3ds; *.pmc

Nubes y mallas: *.asc; *.dat; *.stl; *.obj;
*.ply; *.byu; *.facet

Calibraciodn tipica con hoja de calibracién.
Capacidad de intervencién grande.
Posibilidades de calibraciéon inversa: a
partir de 5 puntos de coordenadas
conocidas o a partir de pardmetros
aproximados de una cdmara similar.

Pasos similares a Image Master, a
excepcion de que la generacién de nubes
de puntos y de la superficie son
independientes, permitiendo la edicidon
previa de las nubes.

Generacion del modelo dividida en 12 pa-
sos' ejecutables de forma independiente.
Nivel de intervencidn posible muy alto. 12
pasos independientes y ademas definicion
de parametros para la generacién de las
nubes de puntos.

No se dan instrucciones de cémo variar
los pardmetros para conseguir mejores
resultados, por lo que se convierte en una
desventaja del programa.

Capacidad de edicion similar a Image
Master. Visualizacién menos agradable y
un poco mas lento al borrar elementos.
Modelo 3D: generacion mas lenta y
engorrosa.
Ortofoto: generacion sencilla, definicién
del plano imagen a partir de 3 puntos o
planos definidos (vistas). Previsualizacidn
en una ventana muy pequefia.
Modelo 3D: Arco -> 1 cm
Muro “R” -> 1,5 cm

Ortofoto: Arco -> 1,5 cm

Muro “R” norte -> 1,5 cm

Muro “R” oeste -> 1 cm
Se distinguen los triangulos en la textura
de los modelos. Aspecto poco riguroso.
Modelado un poco peor que en Image
Master.
Puntos, nubes vy mallas: *.dxf; *.3ds;
*wrl; *.0bj; *.raw; *.igs; *.3dm; *.stl;
*.ma; *.kml; *.kmz; *.ms; *.fbx
Ortofotos: *.tif; *.bmp; *.pcx; *.tga;
*.png; *.plt; *.psd; *.iff; *.cal; *.sgi; *.rgb
Animacion: *.avi
Trabajo rapido. Rapida identificacién de
puntos. Necesarios varios procesos largos:
idealizado de las imagenes, generacién de
las nubes de puntos, creacién de la
superficie, generacién de las ortoima-
genes bastante mas lento.

Aspecto visual agradable. Deficiencia
notoria en el visualizador 3D, sistema de
navegacion bastante incomodo y con
coordenadas grandes dificultad para
gestionar la informacion.

puntos comprobados se ven de cierta forma afectados por la orientacidn, por lo que es normal que la diferencia entre coordenadas salga un poco menor.
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8.1 PROPUESTA METODOLOGICA

Tras el estudio de las caracteristicas y posibilidades ofrecidas por los programas objetos de
estudio en el presente proyecto. Y tras la experimentacion y prueba de procedimientos
realizados con ambos programas, se puede decir, que ha sido posible crearse una opinién
fundamentada sobre las mejores caracteristicas de cada uno de los programas; asi como de
gue metodologia que es mejor seguir tanto para la toma de las fotografias, los puntos de
apoyo, el control de los resultados obtenidos,...

Muchas de las metodologias descritas son similares a las que se vienen aplicando en los
trabajos realizados en el Laboratorio de Documentacién Geométrica del Patrimonio, y las
cuales se consideran muy efectivas.

En el siguiente apartado se procede a una descripcién resumida de la metodologia de trabajo
mas recomendable en mi opinién, definida tanto a partir del andlisis de la metodologia de
trabajo llevada a cabo en el LDGP como de la propia experiencia obtenida en la elaboracion de
los trabajos de este proyecto.

8.1.1 PLANIFICACION

La planificacion es definitivamente uno de los apartados mas importante de la ejecucion de
cualquier trabajo. De ésta depende la optimizacién de los recursos disponibles y la correcta
consecucién de todos los objetivos marcados.

La planificacion debe abarcar todas las fases del trabajo de forma que en todo momento
sepamos que debemos de hacer y cual es el siguiente paso a realizar para la consecucién del
objetivo.

Un trabajo correctamente planificado, resulta mas eficiente, y se ejecuta de una forma mas
sencilla.

Por esta razén recibe mayor importancia la definicion de unas pautas de actuacién como las
que se fijan en el presente apartado.

La planificacidn se debe iniciar definiendo los objetivos del trabajo que se va a realizar, asi
como los productos que se quieren obtener como resultado. Una vez definidos los objetivos,
hay que evaluar las posibles vias para alcanzarlos atendiendo a la multitud de variables que se
pueden dar. En esta tarea de evaluacidn, puede servir de ayuda la elaboracién de un diagrama
indicando todas las alternativas.

Una vez que hemos definido las posibles alternativas debemos seleccionar la que mas se
adecue a nuestro caso, no sélo en lo relativo a nuestros objetivos; sino que también hay que
tener en cuenta los medios a nuestro alcance. Ya que estos seran los que nos limiten en gran
medida la capacidad de actuacion.
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8.1.2 MATERIALIZACION DEL APOYO

En lo relativo al tipo de dianas que se van a utilizar para la materializacion sobre los elementos
de los puntos de apoyo, se cree conveniente optar por un tipo de dianas bicolor de uno de los
siguientes tipos, como se viene haciendo en el LDGP:

www.ldgp.es

Imagen 4.5: Dianas para la materializacion del apoyo

Algunos programas disponen de reconocimiento de dianas o cdlculo del centro de una diana
por método sub-pixel. Estas dianas se basan en el contraste, por lo que deberan ser bien un
punto blanco sobre fondo negro, o un punto negro sobre fondo blanco.

Bien es cierto que ese tipo de dianas es dptimo para los programas que disponen de la funcién
de reconocimiento de las misma, pero para la deteccién manual son peores, ya que es
bastante complicado poder indicar cual es el centro de un circulo completamente negro.

Por esta razén se encuentra mas conveniente la utilizacion de dianas similares a las de la
imagen anterior, ya que tanto el contraste como la interseccion de las figuras, hace que resulte
mas sencillo para un operador la localizacion del centro de la diana.

En lo que respecta a la identificacién de cada una de ellas, como se realiza en el Laboratorio de
Documentacién Geométrica del Patrimonio; resulta dptimo identificar a cada una de las dianas
con un cddigo uUnico. De esta forma en trabajos grandes, con un nimero muy elevado de
puntos de apoyo, o entre puntos de apoyo de proyectos diferentes; no existird confusién entre
las coordenadas de cada uno de los puntos, ya que las coordenadas irdn referidas de forma
univoca a su diana correspondiente.

Las dianas se usan plastificadas para que resistan mejor las inclemencias meteoroldgicas, y
perduren un mayor espacio de tiempo inalteradas, por si existiese la necesidad de repetir
alguna de las fotografias.

Para fijar las dianas al paramento existen varias posibilidades como la silicona o la masilla
adhesiva. La silicona resulta mas efectiva ya que se fija mejor al elemento y tampoco lo
deteriora en gran medida, por el contrario tarda un poco en secarse por lo que habra que
tenerlo en cuenta al pegar las dianas. También hay que tener en cuenta, que provoca cierto
grado de deterioro en la superficie; mientras que la piedra no se ve alterada existen otra serie
de materiales mas delicados en los que se debera optar por otro adhesivo que resulte inocuo
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para el material. Existen también una serie de siliconas denominadas neutras que minimizan el
deterioro de los materiales delicados.

La disposiciéon mds adecuada depende siempre del elemento, aunque una disposiciéon en forma
de cuadricula, con las dianas repartidas por toda la superficie puede resultar eficiente en la
mayoria de los casos.

La ubicacién de las dianas debe hacerse teniendo en cuenta cémo van a ser todas las
fotografias de forma que aparezcan suficientes dianas en cada fotografia.

Siempre es bueno poner alguna diana mas de las necesarias por si surge algin problema, como
que alguna de las dianas se caiga, o que nos equivoquemos al tomar las coordenadas de la
misma.

A la vez que se van disponiendo las dianas, es muy recomendable ir dibujando un croquis que
indique su ubicacién en el muro. Este croquis nos ayudara a identifica posteriormente los
puntos sobre las fotografias.

8.1.3 MEDICION DE COORDENADAS

La medicidn de las coordenadas de los puntos de apoyo se debe de la forma mads ordenada
posible, ya que es muy importante que no se nos olvide tomar ninguno de los puntos; también
es recomendable medir seguidos todos los puntos del mismo elemento tanto para que las
condiciones sean las mismas y las medidas resulten mas homogéneas, como para que las
coordenadas estén mds ordenadas al ser descargadas. Puede resultar interesante colocar la
dianas de forma ordenada sobre los muros, y de esta forma serd mas facil seguir el orden vy
evitaremos olvidarnos de medir alguna de las dianas.

Es fundamental, como en todo trabajo topografico, comprobar el trabajo realizado mediante la
revisién frecuente de las referencias. De esta forma garantizaremos que las mediciones son
correctas, y si ha surgido algin problema por movimiento del instrumento, lo percibiremos lo
antes posible para poder solucionarlo de manera inmediata y sencilla; antes de que hayamos
realizado mucho trabajo de forma inutil.

8.1.4 TOMA DE LAS FOTOGRAFIAS

La disposicion de las fotografias a tomar dependera definitivamente tanto del programa que se
va utilizar (fotogrametria estereoscdpica o convergente) como del objeto que se estd
fotografiando.

Para fotogrametria estereoscdpica se realizardn una serie de fotografias con los mismos
pardmetros de configuracion, con la finalidad de que toda la serie resulte lo mas uniforme
posible.
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Al realizar las fotografias se ha de tener en cuenta que exista un recubrimiento entre las
imagenes del mismo par de al menos el 60 %, y de que todos los elementos del objeto se vean
también como minimo en dos fotografias.

Hay que tener en cuenta que para poder crear la malla completa de un objeto deben poder
verse todos sus elementos en las fotografias; por lo que a la hora de decidir la ubicacién de las
tomas se deben tener en cuenta las zonas que estan ocultas en unas fotografias para que
aparezcan en otras.

Es muy importante realizar una planificacion detallada de cémo y cuando se van a realizar las
fotografias de cada objeto; ya que las condiciones de luz varian a lo largo del dia,
proyectandose sombras, generando ocultamientos.

Para fotogrametria convergente también hay que tener en cuenta la uniformidad de las series
y el solape necesario. La serie de fotografias debe cubrir aproximadamente un angulo de 90°

;

realizando una toma cada 10° 6 15°.

8.1.5 TRATAMIENTO Y GESTION DE DATOS

Este es un apartado bastante importante, ya que de la gestion y el tratamiento de los datos
depende en gran medida la optimizaciéon del uso de los recursos disponibles. Sin embargo
suele ser habitualmente un apartado en el que no se pone mucho énfasis.

Por su importancia se encuentra fundamental la correcta documentacion de todo el proceso
de trabajo realizado, dejando constancia de los pasos ejecutados y de los resultados obtenidos.
Esta documentacion es de gran importancia, sobre todo, en la adquisicién de datos y en su
gestion.

Se debe dejar siempre constancia del proceso seguido para la toma de datos y el sistema
empleado para su almacenamiento. Esta documentacidon se puede realizar a través de un
informe, y también a partir de la edicidon de los metadatos de cada archivo.

Los metadatos son una serie de informacion adjunta a los datos, y que describen como ha sido
su adquisicidn, el instrumento con el que han sido tomados, el operador, el lugar, la fecha y
hora,...

Los metadatos de los ficheros dependeran del tipo de fichero, asi por ejemplo para una
fotografia sera conveniente conocer los datos habituales del fichero EXIF?*; como la camara, la
focal, la fecha y hora, la sensibilidad, la velocidad, la apertura, la resolucidn,... También puede
ser interesante el objetivo utilizado, el operador que la ha tomado,...

En el caso de un fichero de coordenadas resultara interesante también el operador, el modelo
del instrumento, el sistema de coordenadas utilizado, etc.

2 EXIF (EXchangable Image file Format). Parte del archivo fotografico que contiene informacién adicional sobre la
fotografia; como fecha y hora, distancia focal, cdmara con que se ha tomado, tamafio de la imagen,...
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Cada tipo de fichero y cada trabajo pueden requerir metadatos concretos, aunque los
metadatos se adaptaran a estandares para que siempre consten de los mismos campos
cubriendo todas las necesidades.

También es un aspecto fundamental a tener en cuenta, la perdurabilidad de la informacién. Es
importante en la gestion de la informacion el duplicado de todos los datos obtenidos, en dos
soportes diferentes, de esta forma si surge algun problema con uno de sistemas no
perderemos la informacion ya que la encontraremos disponible en el otro.

La ejecucion de copias de seguridad de toda la informacién obtenida es fundamental, y estas
copias de deben realizar con la mdxima periodicidad posible. Esta dependera del volumen de
informacidn con la que se trabaje, pero si es posible, lo dptimo es trabajar con sistemas espejo
gue duplican la informacidn en ubicaciones remotas.

Para hacer que el trabajo pueda ser lo mas eficiente posible se deben fijar unos estandares de
actuacion, tanto en el almacenamiento como en el nombrado de los ficheros. Los nombres de
los ficheros deben ser intuitivos y descriptivos evitando cddigos complicados. El sistema
utilizado se documentard correctamente para que cualquier persona pueda conocer lo que
cada carpeta contiene.

8.1.6 PROCESADO DE LOS DATOS Y OBTENCION DE LOS PRODUCTOS,
METODOLOGIA MAS VENTAJOSA

En este proyecto se han estudiado dos alternativas para la elaboracidn de los modelos 3D y la
exportaciéon de ortofotos. Estas alternativas han consistido en el software Topcon Image
Master y Photomodeler Scanner 6. Se ha realizado la evaluaciéon de la metodologia mas
satisfactoria para la obtencidn de los resultados propuestos.

Este apartado se concibe Unicamente como un resumen de lo que se desarrolla en el apartado
de comparacion del presente proyecto.

Del estudio de las caracteristicas de los dos programas, se obtiene una evaluacién de los
mismos, en la que finalmente resulta preferible el software de Topcon.

Basandose en que ambos programas, son capaces de obtener tanto el modelo tridimensional
como las ortofotos, las razones que decantan la balanza a favor de Image Master son las
siguientes:

En primer lugar Image Master supera la capacidad de importacion de Photomodeler,
permitiendo la importacion de mas tipos de elementos. También hay que decir que por el
contrario, el nimero de formatos de imagenes admitidos, es menor; pero sin embargo es este
tipo de ficheros los que menos problemas ofrecen para cambiarlos de formato, ya que existen
multitud de programas de edicién de imagenes, incluso de uso doméstico, que permiten
realizar dichas transformaciones de formato. Habra que tener en cuenta de todas formas, que
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no tenga lugar una pérdida de informacidn al realizar el cambio de formato. En algunos casos,
y dependiendo el programa utilizado, se puede perder la informacién de los metadatos.

Por otra parte, el trabajo con el programa resulta mas sencillo en el caso de Image Master; ya
que se trata de un proceso mas automatizado y por lo tanto mas 4gil. Es cierto que desde un
punto de vista técnico seria preferible que ofreciese una mayor capacidad de intervencidn, la
cual si ofrece Photomodeler; pero sin embargo, la dificultad de gestionar la capacidad de
intervencién y los resultados obtenidos, hacen que sea mas beneficiosa la automaticidad del
proceso en Image Master que la capacidad de intervencidn ofrecida por Photomodeler.

Respecto a la edicién de las mallas y nubes de puntos, hay que decir que la forma de realizarse
y las posibilidades que ofrecen son muy similares en ambos software; aunque si hay que hacer
referencia a que Image Master es un poco mas rapido a la hora de recortar la malla. Lo que si
es un factor decisivo es el modo de visualizacién del modelo, ya que el visualizador 3D de
Photomodeler pierde muchos puntos respecto al de Image Master; porque la navegacién es
bastante mas dificultosa, y con nubes de coordenadas globales tiene dificultad para gestionar
los datos y se vuelve lento en sus reacciones.

Con respecto a la generacidn de los productos, ambos programas tienen pros y contras. En la
generacion del modelo tridimensional, Image Master es mas eficaz; lo genera mas rapido y de
forma mas sencilla. El contra estd en la definicién del plano de proyeccién de la ortofoto. En
Photomodeler se define el plano a partir de tres puntos, lo cual permite total libertad;
mientras que en Image Master se define Unicamente mediante dos puntos, resultando
siempre ser la vertical el eje Y de la ortoproyeccion.

La calidad de los resultados es bastante similar respecto a la precisidn, en el caso de las
ortofotos en ambos casos andan alrededor del centimetro, evaluando la diferencia entre las
coordenadas tomadas y la posicion de las dianas en la fotografia; sin embargo, la apariencia
visual tanto del modelo como de la ortofoto resulta bastante mejor en Image Master lo que
hace que el producto resulte mas util.

La velocidad del proceso es mas rapida en Image Master y el tiempo de trabajo necesario para
elaborar un proyecto completo, menor, ya que es necesario realizar menos pasos.

Los Unicos puntos de la comparacién en los que sale ganando Photomodeler son en la
capacidad de exportacion, ya que este ofrece mas alternativas; y en la calibracién de la
camara.

La calibracion es la diferencia mas grande entre los programas, ya que Photomodeler ademas
de la calibracion habitual con patrén de calibracidn, ofrece la posibilidad de de realizar la
calibracion inversa por dos métodos: la utilizacion de puntos de control de coordenadas
conocidas o el calculo de los pardmetros de calibracién a partir de otros de una camara de
caracteristicas similares.

El proceso de trabajo completo en los dos programas se encuentra descrito detalladamente en
el apartado flujo de trabajo en el capitulo de ejecucidn.
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8.1.7 CONTROL DE LOS RESULTADOS

En el caso de las fotografias y de los puntos de apoyo fotogramétrico se realiza un control in
situ en el momento de la adquisicion, bien comprobando en el LCD de la cdmara la fotografia
tomada o mediante la medicién a una referencia, en el caso de los puntos de apoyo.

Ademas de esto se realizard un control importando los puntos en AutoCAD y comprobando
gue su disposicidon aparentemente sea correcta.

Durante el proceso de datos y obtencién del modelo, se realiza el control necesario mediante
la supervisién de los residuos de los puntos que nos ofrece el programa y revisando los
resultados de la generacién de la malla.

Para el caso de las ortofotos, se realiza un andlisis de la precision en AutoCAD, comparando la
posicién de las dianas en la fotografia y las coordenadas del apoyo tomado en campo.

8.2 CONCLUSIONES DE LA ELABORACION DEL PROYECTO

A modo de resumen, el proyecto comenzd en el mes de noviembre con una primera toma de
contacto con Photomodeler, aunque no fue hasta febrero cuando se pudo ofrecer una
dedicacién completa al proyecto. Desde entonces hasta su presentacion en Julio se ha llevado
a cabo tanto la documentacion de los paramentos en riesgo de colapso, como el analisis
comparativo de los programas.

Las horas de trabajo dedicadas a este proyecto suman aproximadamente unas 1000 horas, de
las cuales 60 % se han dedicado al aprendizaje de los programas y a realizacién de modelos de
prueba. El resto del tiempo se ha dedicado a la obtencidn de los productos requeridos segun
los objetivos del proyecto, y a la redaccion de esta memoria.

El nimero de horas puede parecer excesivo, pero hay que mencionar que el aprendizaje de la
utilizacién de los programas se ha realizado de forma auténoma, lo que lo ralentiza un poco;
pero sobre todo porque antes de abordar la generaciéon de los modelos finales, se han
realizado multitud de pruebas con fotos diferentes de varios muros que no son finalmente
objetivo del proyecto.

Es gracias a toda esta experimentacidn realizada, a la practica obtenida en el manejo, y al
conocimiento alcanzado de los programas; gracias a lo cual se ha sido capaz de realizar el
analisis critico fundamentado de los software utilizados.
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8.3 CONCLUSIONES FINALES

Las conclusiones principales del trabajo realizado se pueden dividir en dos apartados, uno la
documentacion de los paramentos verticales; y el otro el analisis comparativo de los software
fotogramétricos utilizados.

En lo que a la documentacidn se refiere se concluye:

- La planificacién resultara un apartado decisivo en la optimizaciéon de los recursos
necesarios para la consecucion de los trabajos de documentacion a realizar. La
experiencia también tomard un papel muy importante en el aprovechamiento de los
recursos y en la calidad del material obtenido como resultado del trabajo de campo.

- En cuanto a los objetivos del proyecto referentes a la documentacién de los
paramentos en riesgo de colapso, estos se han completado correctamente obteniendo
unos resultados acorde con las expectativas planteadas inicialmente. Adquiriendo la
capacidad de resolver los problemas sobrevenidos analizando la mejor solucién
posible, segun los recursos disponibles, para cada caso.

- Mediante los trabajos realizados se ha obtenido la documentacién geométrica de los
paramentos de su estado actual. Estos elementos se califican en riego de colapso, lo
que significa que previsiblemente pueden sufrir alteraciones a corto o medio plazo.
Esto abre una via de estudio de las variaciones sufridas por estos elementos en un
espacio de tiempo determinado, en la que se podrian realizar una serie de
documentaciones de los elementos que ya se han estudiado en este proyecto para
determinar el deterioro y las variaciones sufridas por el paso del tiempo.

De lo referente al andlisis comparativo de los programas utilizado se obtiene as siguiente
conclusioén:

- Tras definir una serie de factores sobre los que se ha realizado la comparacién de los
software, se concluye a Image Master como el programa madas conveniente para
realizar los trabajos objetivo del proyecto. Image Master se posiciona como un
programa mas sencillo de utilizar, mas rapido y mas eficaz; y en general como fuente
de unos productos de mayor calidad visual y geométrica, y de similar rigor en lo que a
las precisiones de los productos se refiere, en comparacién con Photomodeler
Scanner.

También, hacer referencia a que este proyecto, al igual, que los realizados por mis compafieros
del LDGP no conforman en si mismos el objetivo primordial; sino que forman parte de un
proyecto general continuista de los trabajos iniciados en el proyecto IP Erasmus, el cual
necesita seguir siendo desarrollado como propulsor de la documentacién del patrimonio y de
la puesta en valor de los enclaves culturales de nuestro entorno.
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Por ultimo no me gustaria terminar sin reiterar mi gratitud tanto a los tutores de mi proyecto,
cuya inestimable ayuda ha sido fundamental para el correcto desarrollo del proyecto; como a
todos mis compafieros del LDGP, los cuales siempre han estado ahi para echar una mano
cuando lo he necesitado y para proporcionarme el apoyo moral que en algunos momentos del
trabajo es tan necesario.

Siempre estaré orgulloso de haber vivido esta experiencia en el Laboratorio, y sobre todo, de
haber convivido con gente tan genial como todos mis compafieros.
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ANEXO 1: CARACTERISTICAS



Leica TPS1200

Especificaciones tecnicas

y caracteristicas del

sistema

Modelos y opciones

TC TCR TCRM
Medicion de angulos . . . . . . .
Medicion de distancias (IR) . . . . . . .
PuntoPreciso medicién distancias sin prisma (RL) . . . .
Motorizada . . . . .
Reconocimiento Automatico de Prisma (ATR) . . . .
PowerSearch (PS) . .
Luces Replanteo (EGL) ° o o . . . .
Unidad Control Remoto (RX1220) o ° ° ° ° ° °
GUS74 Guiado Laser 3 °
SmartStation (ATX1230) o o ° ° ° ° °
e = Estandar o = Opcional
Medicion Angular
Tipo 1201 Tipo 1202 Tipo 1203 Tipo 1205
Precision Hz, V 1" (0.3 mgon) 2" (0.6 mgon) 3" (1 mgon) 5" (1.5 mgon)
(desviacion estandar, ISO 17123-3)  Resoluciéon de pantalla: 0.1" (0.1 mgon) 0.1" (0.1 mgon) 0.1" (0.1 mgon) 0.1" (0.1 mgon)
Método Absoluto, continuo, diametral
Compensador Rango de Trabajo 4' (0.07 gon) 4' (0.07 gon) 4' (0.07 gon) 4' (0.07 gon)
Precisién 0.5" (0.2 mgon) 0.5" (0.2 mgon) 1.0" (0.3 mgon) 1.5" (0.5 mgon)
Método Compensador de doble eje centrado

Medicion de distancias (IR)

Alcance Prisma Circular (GPR1):
Prisma 360° (GRZ4):

Miniprisma (GMP101):

(condiciones atmosféricas medias)

Diana Reflectante (60 mm x 60 mm):

Minima distancia medible:
Modo Estandar:

Modo Rapido:

Modo Tracking:
Resolucion pantalla:

Precision / Tiempo Medicion
(desviacion estandar, 1SO 17123-4)

Método

3000 m

1500 m

1200 m

250 m

1.5m

2 mm + 2 ppm / tip. 1.5 s

5 mm + 2 ppm / tip. 0.8 s

5 mm + 2 ppm / tip. < 0.15 s
0.1 mm

Medicion de fase (coaxial, laser infrarrojo invisible)

Puntero R100/R300 medicion distancias sin prisma (LR)

PuntoPreciso R100:
PuntoPreciso R300:
Minima distancia medible:

Alcance
(condiciones atmosféricas medias)

Largo Alcance al prisma circular (GPR1):

Precision / Tiempo Medicion
(desviacion estandar, 1SO 17123-4)

Sin prisma < 500 m:
Sin prisma > 500 m:
Largo Alcance:

170 m/100 m (Carta Kodak Gris reflexivo 90% / 18% reflexivo)
500 m/300 m (Carta Kodak Gris reflexivo 90% / 18% reflexivo)
1.5m

1000 m - 7500 m

3mm+2ppm/tip.3- 65, max. 12 s
5mm+ 2 ppm/tip.3- 65, max. 12 s

5mm + 2 ppm/ tip. 2.5 s, max. 12 s

Tamano del punto laser A 20 m: Aprox. 7 mm x 14 mm
A 100 m: Aprox. 12 mm x 40 mm
Método PuntoPreciso R100: Medicion de fase (coaxial, laser rojo visible)
PuntoPreciso R300: Sistema de Analisis (coaxial, laser rojo visible)
Motorizada

Velocidad Maxima Velocidad Rotacion:

45° /s




Reconocimiento Automatico de Prisma (ATR)

Alcance Modo ATR / Modo LOCK

Prisma Circular (GPR1):

1000 m / 800 m

(condiciones atmosféricas medias) Prisma 360° (GRz4): 600 m / 500 m
Miniprisma (GMP101): 500 m / 400 m
Diana Reflectante (60 mm x 60 mm): 55 m (175 ft)
Minima distancia medible: 1.5m/5m
Precision / Tiempo medicion Precision Posicionamiento: < 2mm
Tiempo medicién: 3-4s
Velocidad maxima (Modo LOCK) Tangencial (modo estandar): 5m/sa20m,25m/sal00m
Radial (modo tracking): 4m/s
Método Procesamiento Imagen Digital (haz laser)
PowerSearch (PS)
Alcance Prisma Circular (GPR1): 200 m
(condiciones atmosféricas medias) Prisma 360° (GRZ4): 200 m (perfectamente alineado al instrumento)
Miniprisma (GMP101): 100 m
Minima distancia medible: 5m
Tiempo de blisqueda Tiempo busqueda tipico: <10s
Velocidad maxima Velocidad Rotacion: 45° /s

Método

Procesamiento Imagen Digital (abanico rotante I3ser)

Luces Replanteo (EGL)

Alcance
(condiciones atmosféricas medias)
Precision

Rango de trabajo:
Precision posicionamiento:

5m- 150 m
5cma 100 m

Datos Generales

Anteojo
Aumentos: 30 x
Apertura libre objetivo: 40 mm

Campo de vision:
Rango de enfoque:
Teclado y pantalla

1°30' (1.66 gon) / 2.7 m a 100 m
1.7 m al infinito

Plomada Laser
1.5mmal5m
2.5mma l.5m

Precision centrado:
Diametro punto Iaser:
Tornillos sin fin

N° de tornillos: 1 horizontal / 1 vertical

Bateria (GEB221)

Pantalla:
Teclado:

Angulos mostrados:
Distancia mostrada:
Posicion:
Almacenamiento datos
Memoria Interna:

Tarjeta de memoria:
Numero de grabaciones:
Interface:

Nivel circular
Sensibilidad:

LCD 1/4 VGA (320*240 pixeles), grafica, iluminacion,
pantalla tactil (opcional)

34 botones (12 funcion, 12 alfanuméricos),
iluminacién

360° ' ", 360° decimal, 400 gon, 6400 mil, v%
Metro, pie int., pie/pulgada, pie US, pie/pulgada US
Posicion | estandar, Posicion Il opcional

32 MB (opcional)

CompactFlash (32 MB y 256 MB)

1750 / MB

RS232, Bluetooth® Wireless-Technology (opcional)

6' /2 mm

Tipo:

Voltaje:

Capacidad:

Tiempo de trabajo:

Pesos

Estacion total:

Bateria (GEB221):

Base nivelante (GDF121):
Especificaciones del entorno
Rango de temperatura de trabajo:
Rango de temperatura de
almacenamiento:

Polvo / Agua (IEC 60529):
Humedad:

I6n-Litio
7.4\

3.8 Ah

tip. 6-8h

4.8 - 5.5kg
0.2 kg
0.8 kg

-20°C a +50°C
-40°C a +70°C

IP54
95%, sin condensacion

Unidad de Control Remoto (RX1220)

Comunicacion
Unidad de Control

Bateria (GEB211)

Pesos

Especificaciones del entorno

Via radio modem integrado

Pantalla: LCD 1/4 VGA (320*240 pixeles), grafica, pantalla tactil, iluminacion
Teclado: 62 botones (12 funcién, 40 alfanuméricos), iluminacion

Interface: RS232

Tipo: I6n-Litio

Voltaje: 7.4V

Capacidad: 1.9 Ah

Tiempo de trabajo: tip 10 h

Unidad de Control RX1220: 0.6 kg

Bateria (GEB211): 0.1 kg

Adaptador al bastén: 0.25 kg

-30°C a +65°C

-40°C a +80°C

P67

Inmersién temporala 1 m

Rango de temperatura de trabajo:

Rango de temperatura de almacenamiento:
Polvo / Agua (IEC 60529):

Resistencia al agua (MIL-STD-810F):




Jeica

MADE TO MEASURE

LEICA TCR 307. TECHNICAL SPECIFICATIONS

Technical data TC/TCR 302 TC/TCR 303 TC/TCR 305 TC/TCR 307
Telescope

Magnification 20x

Field of View 17 30" (26m at 1km)

Reticla lllumination Bright / Dim Selectabls

Angle Measurement

Mathod Absolute, Diametrical Absolute Absolute Absolute
Display least count 17{0.1mgon} 1*{0.5mgon} 1*{0.5mgon) 1"i0.5mgon)
Accuracy (DIN 18723, ISO 12857) 2"{0.6mgon) 3(Imgon) 5"(1.5mgon) 7"{2Zmgon)
Compensator

Systam Integrated electronic dual axis, Liguid

Working Range = 4

Setting Accuracy 0.5 1* 1.5~ 2
Distance Measurement

Infrared (IR} Coaxial

Rangs" to 1 Leica GPR1 prism 3000m 3000m 3000m 2500m
Range" to 1 Laica GMP102 prism 1200m

Range to Retro Tape (60mm x 0mm) 250m

Accuracy (Fine/Rapid/Tracking)

2mm + 2ppm / 5mm + 2ppm [ 5mm + 2ppm

Meaasuring Time (Fine/Rapid/Tracking)

Visible Laser® [RL} Coaxial

<18/<05s/<03s

Range" to suitable surface without reflactor 80m
(Short moda) — White side of grey card
Range" to Leica GPR1 prism {Long mode) 5000m

Accuracy (Short/Long/Tracking}

3mm + 2ppm / 5mm + Zppm / 5mm + 2ppm

Maasuring Time (Short/Long/Tracking)

35 + 15/ 10m (=30m} / 255/ 15 + 0.35 / 10m {=30m}

Spot size at 50m

12mm elliptical

Laser Class
System

21

Data storage: Internal memonry

4000 data records

Data storage: External

Connect to external data recorder via Interface port

Sarial Interface

RS232

Data axchange

G5l [ IDEX / Definable Formats

On-board Programs

Surveying / Set Qut / Tie Distance / Area [ Free Station

Built-in Functions

REM / REC [ IR-RL Switch [ Delete Last Record

Display LCD 8 lines x 24 characters [ 40mm x 65mm with built-in ilumination
Keyboard 12 kays {Alphanumeric input) optional 2nd keyboard

Laser Plummet

Type Laser Pointer with adjustable intensity

Accuracy +0.8mm at 1.5m

Operation Environment

Operation tempearatura -20°C to 50°C

Protection to IEC529 {(Dust and water) P54

Humidity 95% RH, non condensing

Storage temperature —40°C to 70°C

Dimensions and Weights

Gross dimensions (L x W x H)

151mm x 203mm x 316mm

Waight {instrument only}
Power Supplies

45kg 4.2kg 4.2kg 4.2kg

Battary (Standard)

NiMH / Standard Camcorder

Voltage/Capacity

6V / 1800mAH (GEB111)

Continuous use - angle mode =4 hours
No. of measuremeants with distance =1000
Racharging time 1 hour

Opticnal power supplies {Adapter required)

NiMH 6V / 3.6Ah (GEB121) / 6x LRE AA 1.5V Alkaline cells

'} Average atmospheric conditions; slight haze or some clouds, slight heat shimmer

%y Only walid for TCR models



Especificaciones: EQS 5 mark

SENSOR DE IMAGEN
Tipo

Pixeles efectivos

Total de pixeles

Formato

Filtro de paso bajo
Limpieza del sensor

Tipo de filtro del color
PROCESADOR DE IMAGEN
Tipo

OBJETIVO

Montura del objetivo
Longitud focal

ENFOQUE

Tipo

Sistema AF/ Puntos AF
Gama del AF

Modos AF

Seleccion del punto AF

Representacion del punto
AF seleccionado

AF predictivo™
Bloqueo AF

Luz de ayuda al AF
Enfoque manual

Ajuste preciso del enfoque
automético

CONTROL DE LA EXPOSICION

Modos de medicién

Gama de medicién

Bloqueo AE

Compensacion de la exposicion

Muestreo automdtico de
la exposicién (AEB)
Sensibilidad 150

OBTURADOR
Tipo
Velocidad

BALANCE DE BLANCOS
Tipo

Ajustes

Balance de blancos personalizado
Muestreo del balance de blancos

VISOR

Tipo

Cobertura (Vertical/Horizontal)
Aumento

Distancia del ojo

Correccién didptrica
Pantalla de enfoque

Espejo

Informacién en el visor

Previsualizacién de la profundidad

Obturador del ocular

CMOS de 36 x 24 mm
Aprox. 21,10 Megapixeles
Aprox. 22 Megapixeles
3:2

Incorporado/Fijo

Sistema de Limpieza Integrada EOS,
con revestimiento de flior

Colores primarios

DIGIC &

EF (excepto objetivos EF-S)
Equivalente a 1,0x de la longitud
focal del objeuvo

TTL-CT-SIR con un sensor CMOS

9 puntos AF tipo cruz

(f/2,8 en el centro)

-0,5-18 EV (a 23 °Cy 100 ISO)

Al Focus, Foto a foto, Al Servo
Seleccién automadtica,

seleccién manual

Sobreimpreso en el visor e indicado
en el panel LCD de la parte superior
y en la pantalla de Control répido
Si, hasta 8 metros

Se bloquea cuando se pulsa el
disparador hasta la mitad en el
modo AF foto a foto o cuando se
pulsa el botén AF-ON.

Emitida por un flash Speedlite
opcional especifico

Se selecciona en el objetivo, de forma
predeterminada en Modo Live View
CFn -8,

+/-20 pasos

Se ajustan todos los objetivos en la
misma cantidad, ajusta hasta

20 objetivos individualmente

Medicién TTL a plena abertura con
SPC en 35 zonas

(1) Medicién evaluativa (relacionada
con todos los puntos AF)

(2) Medicion parcial

(aprox. 8% del visor en el centro)
(3) Medicion puntual

(aprox. 3,5% del visor en el centro)
(4) Medicién promediada con
preponderancia central

1-20 EV (a 23 °C con un objetivo
de 50 mm /1,4, 100 1SO;

Auto: funciona en el modo AF foto a
foto con medicién evaluativa, cuando
se consigue el enfoque Manual:
mediante el botén de bloqueo de

AE (exposicién automatica) en los
modos de la zona creativa.

+/-2 EV en incrementos de 1/3 0 1/2
(se puede combinar con el muestreo
automdtico secuencial AEB).

3 disparos +/2 EV en incrementos
de 1/2 0 1/3 de punto

Auto (100-3.200), 100-6.400

(en incrementos de 1/3 o 1 paso
completo). La sensibilidad ISO se
pueden ampliar a L:50, H1: 12.800
y H2:25.600

Obturador plano-focal controlado
electrnicamente

30-1/8.000 s (en incrementos de
1/2 01/3 de paso), B (Exposicion
larga; toda la gama de velocidades de
obturacién. La gama disponible varia
dependiendo del modo de disparo)

Balance de blancos automdtico con
el sensor de imagen

Ajuste AWB, luz dia, sombra,
nublado, tungsteno, luz fluorescente
blanca, flash, personalizado,
temperatura 'de color. Compensacién
del balance de blancos:

1. Azul/Ambar +/-9

2. Magenta/Verde +/-9.

Si, se puede guardar un ajuste

+/-3 niveles en incrementos de un
punto 3 imagenes de muestreo
sucesivas por cada disparo del obtu-
rador Se puede seleccionar dominante
azul/dmbar o magenta/verde.

Pentaprisma

Aprox. 98%

Aprox. 0,71x®

Aprox. 21 mm (desde el centro de
la lente del ocular)

-3a+1 ™ (dioptrias)
Intercambiables (3 tipos opcionales).
Pantalla de enfoque estdndar
esmerilada de precision Eg-A

Medio espejo de retorno rapido
(Transmisidn: relacion de reflexion
40:60, no se produce bloqueo por
parte del espejo con |os objetivos
EF 600 mm f/4 o mds cortos)
Informacién AF: Puntos AF, luz de
confirmacion del enfoque.
Informacién de la exposicion:
velocidad de obturacién, valor de la
abertura de diafragma, sensibilidad
1SO (siempre a la vista), bloqueo de
AE (exposicién automatica), nivel/
compensacion de la exposicién,
circulo de medicién puntual, aviso
de la exposicién, muestreo de la
exposicion AEB. Informacion del flash:
flash preparado, sincronizacién a alta
velocidad, bloqueo de la exposicion
con flash (FE), compensacién de la
exposicion del flash, luz de reduccién
de 0jos rojos. Informacién de la
imagen: correccién del balance de
blancos, informacién de la tarjeta CF,
fotografia en blanco y negro, ndmero
maximo de disparos (informacion de
2 digitos), prioridad tonal a las altas
luces, carga de la bateria.

de campo Si, con el botén de
previsualizacién de la profundidad
de campo

En la correa

PANTALLA LCD
Tipo

. Cobertura
Angulo de visién (horizontal/vertical)
Revestimiento

Ajuste de la luminosidad

Opciones de presentacion
de la informacién

FLASH
Modos

Sincro-X

Compensacion de la exposicion

del flash

Muestreo de la exposicion con flash
Bloqueo de la exposicidn con flash
Sincronizacion a la segunda cortinilla

Zapata de contacto central / Terminal PC
Compatibilidad con flashes externos

Control del flash externo

DISPARO
Modos

Estilos de Imagen

. Espacio de color
Procesamiento de la imagen

Modos de avance

Disparos en serie

MODO VISION EN
DIRECTO ‘LIVE VIEW’
Tipo

Cobertura

Velocidad de disparo en serie
Enfoque

Medicion

Opciones de presentacion de
la informacién

FORMATO DE ARCHIVO
Tipo de imagen fija

Grabacion RAW+JPEG simultdnea

Tamafo de la imagen

Tipo de video

Tamano del video
Duracién del video

Carpetas

Numeracién de archivos

OTRAS FUNCIONES
Funciones personalizadas
Etiqueta metadatos

Pantalla LCD / lluminacién
Resistencia al agua/polvo
Sensor de Orientacion Inteligente
Zoom de reproduccién

Formatos de presentacién de
la informacién

Presentacion de diapositivas

Histograma

Aviso de altas luces
Proteccién y borrado de imagenes

Verificacién de datos

Pantalla LCD Clear View TFT de
7,6 cm (3,0”), de aprox.
920.000 pixeles
Aprox. 100%
Aprox. 170°
Antirreflejos Dual
Auto: usando un sensor externo de
luz ambiente. Manual: ajustable a
uno de siete niveles

(1) Pantalla de control rdpido

(2) Ajustes de cdmara

Flash automdtico E-TTL II, Medicién

manual

1/200 s

+/-2 EV en incrementos de 1/2 o

1/3 de punto

g[, compatible con un flash externo
i

Si

Si /St

E-TTL Il con flashes Speedlite serie

EX, posibilidad de disparar varios

flashes sin cables.

Através de la pantalla del menu de

la cdmara

Auto (fotos y video), auto creativo,
AE (exposicién automética)
programada, AE con prioridad a

la obturacion, AE con prioridad a la
abertura, manual (fotos y video),
personahzado (3 opciones)
Estandar, retratos, paisajes, neutro,
fiel, monocromo, tres modos
definidos por el usuario

SRGB y Adobe RGB

Prioridad Tonal a las Altas Luces
Optimizador de la lluminacién
Automatico (4 ajustes)

Reduccién del ruido en las
exposiciones largas

Reduccion del ruido en los ajustes
de sensibilidad 1SO Alta (& ajustes)
Correccién Automética de la
lluminacién Periférica del Objetivo
Foto a foto, disparos en serie L,
disparos en serie H, autodisparador
(2 s +adistancia, 10 s + a distancia)
Max. aprox. 3,9 fps. (velocidad
mantenida hasta que se llene

la tarjeta (JPEG)™ (con tarjetas
UDMA), 13 imagenes (RAW))©

Visor electrénico con sensor de
imagen

Aprox. 100% (horizontal y vertical)
30 fps

Enfoque manual (se puede ampliar
laimagen 5x o 10x en cualquier
punto de la pantalla

Autofoco: modo Répido, modo en
directo ‘Live’, modo de Deteccién
de la Cara en directo

Medicién evaluativa en tiempo real
con sensor de imagen

El tiempo de medicion activo se
puede cambiar

2 reticulas sobreimpresas,
Histograma

JPEG: Buena, normal (compatible
Exif 2.2 [Exif Print] / Regla de
disefio para sistema de archivo de
cdmara (2.0), RAW: RAW, sSRAW1T,
SRAW?2 (14 bits, Canon RAW
original, 22 edlcwon) compatible
con formato de pedido de copias
digitales [DPOF] 1.1

Si, cualquier combinacion de RAW +
JPEG, SRAW1 + JPEG, SRAW2 + JPEG
es posible.

JPEG: (G) (5.616 X 3.744, (M)
4.080x2.720, (P) 2.784 x 1.856
RAW: (RAW) 5.616 X 3.744,
(SRAW 1) 3.861 x 2.574,

(SRAW 2) 2.784 x 1.856

MOV (video: H.264, sonido: PCM
lineal)

HD 1.920x1.080 (16:9) 29,97, 25,
23,976 fps

SD 640 x 430 (4:3) 29,97, 25 fps
Duracién mdxima 29 minutos

59 segundos, tamafio archivo
maximo 4 GB

Se pueden crear y seleccionar
carpetas manualmente

(1) Numeracién consecutiva

(2) Reajuste automatico

(3) Reajuste manual

25 funciones personalizadas con
71 ajustes

Informacién sobre derechos de
autor del usuario (se ajusta con

EOS utility)
Si /St

51

S
1,5x-10x

(1) Una imagen con informacion
(2 niveles)

(2) Una |magen

(3) Indice & imagenes

(&) Indice 9 imdgenes

(5) Visién ampliada

Seleccion de imagenes: Todas las
imdgenes, por fecha, por carpeta
Tiempo de reproduccion: 1/2/3/5
segundos

Repeticion: activada/desactivada
Luminosidad: Si,

RGB: Sf

Si

Borrado: una imagen, todas

las imdgenes de una carpeta,
imdgenes marcadas, imagenes sin
proteger

Proteccién: borrado de la proteccion
de una imagen cada vez

Se pueden afadir a la imagen los
datos de verificacién de la imagen
original (se requiere el OSK-E3 para
la verificacion)

Categorfas del mend

Idiomas de los menus

Actualizacién del firmware

INTERFAZ

Ordenador
Otros

IMPRESION DIRECTA

Impresoras Canon

PictBridge

TARJETA DE MEMORIA
Tipo

SISTEMAS
OPERATIVOS COMPATIBLES
PCy Macintosh

SOFTWARE

Visualizacién e impresién
Procesamiento de la imagen
Otros

FUENTE DE ALIMENTACION

Baterfa

Duracién de la baterfa

Comprobacién de la bateria
Ahorro de energia

Fuente de alimentacion y
cargadores de baterfas

ESPECIFICACIONES FiSICAS

Materiales del cuerpo
Entorno operativo

Dimensiones (An x Al x Prof)
Peso (sélo el cuerpo)

ACCESORIOS

Visor

Transmisor de Archivos Inaldmbrico
Objetivos
Flash

 Empunadura-baterfa
Controlador/interruptor a distancia

Otros

(1) 2 mends de disparo

(2) 2 ments de reproduccion
(3) 3 mends de configuracién
(4) mend de funciones
personalizadas

(5) Mi Mend

25 idiomas: Inglés, Aleman,
Francés, Holandés, Danés,
Portugués, leandes \Ial\ano,
Noruego, Sueco, Espaﬁol, Griego,
Ruso, Polaco, Checo, Hiingaro,
Rumano, Ucraniano, Turco, Arabe,
Tailandés, Chino simplificado, Chino
tradicional, Coreano y Japonés
Posibilidad de actualizacién por
parte del usuario.

USB de alta velocidad

Salida mini HDMI, salida de video
(PAL/NTSC), terminal sistema

de extension (para el WFT-E4 1),
micréfono externo (mini clavija
estéreo)

Impresoras fotograficas compactas
Canon e impresoras PIXMA
compatibles con PictBridge

N

CompactFlash tipo I/ Il (compatible
con Microdrive, compatible con
UDMA), almacenamiento externo
con WFT-E4 I

Windows XP SP3, Vista SP1/SP2
(excl. Starter Edition), Windows 7
05X 10.4-10.6

ZoomBrowser EX / ImageBrowser
Digital Photo Professional
PhotoStitch, EOS Utility (incluye
Remote Caplure WET utility’,
Original Data Security Tools"),
Picture Style Editor

“Requiere un accesorio opcional

Baterfa ion-litio LP-EG recargable
(suministrada), 1 pila CR1616 para
la fecha y los ajustes

Aprox. 850

(a 23 °C, exposicién automdtica
50%, exposicion con flash 50%)©
Aprox. 750

(@o0°C, exposidon automadtica 50%,
exposicion con flash 50%)

6 niveles + porcentaje

La corriente se desconectaa 1, 2, 4,
8,15 0 30 minutos.

Adaptador de corriente alterna ACK-E6,
Cargador de baterias LC-EG, cargador
de baterfas para coche CBC-E6

Tapas del cuerpo de aleacién de
magnesio

0 - 40 °C, humedad relativa del
85% 0 menos
152x113,5x75 mm

Aprox. 810 gramos

Concha del ocular Ef, lente de
ajuste didptrico serie E con marco
de goma Ef, extensor del ocular
EP-EX15lII, visor en dngulo C
Transmisor de Archivos Inaldmbrico
WFT-E4 I

Todos los objetivos EF (excepto los
objetivos EF-S)

Flashes Canon Speedlite (220EX,
270EX, 380EX, 420EX, 430EX,
430EX I, 550EX, 580EX, 580EX I,
flash anular macro MR-14EX, flash
doble macro MT-24EX, transmisor
Speedlite ST-E2)

Mando a distancia con contacto tipo
N3, controlador jnaldmbrico LC-5,
mando a distancia RC-6

Kit de Seguridad de Datos
Originales OSK-E3

1 Con el objetivo EF 300 mm /2,8L IS USM a 50 km/h

2 Indice de exposicién recomendado

3 Con un objetivo de 50 mm enfocado a infinito, -1m-1 dioptrias

4 Resolucién grande buena (calidad 8)

5 Resultados obtenidos seguin el Método Canon de Pruebas Normalizadas,
JPEG, 100 IS0, Estilo de Imagen estdndar. Varia dependiendo del sujeto,
la marca de la tarjeta de memoria y su capacidad, asf como la calidad de
grabacion de la imagen, la sensibilidad SO, el modo de avance, el Estilo
de Imagen, las funciones personalizadas, etc.

6 Segun las normas de la CIPAy utilizando las baterfas/pilas proporcionadas
y el formato de tarjeta de memoria de la cdmara, salvo indicacién en

contrario

Todos los datos han sido obtenidos seguin el Método Canon de Pruebas
Normalizadas, salvo indicacién en contrario. Sujeto a cambios sin previo aviso.




Distagon T* 2,8/21 ZF

Expanding your horizons

This full-frame lens is the direct successor to the
legendary Distagon 2,8/21. It has been redesigned
on the basis of the proven design and equipped with
modern, environmentally friendly types of glass.

It continues to set standards in terms of image
quality and color correction. Glass types with
abnormal partial dispersion and high refractive index
provide the foundation for photos without color
fringes right to the edges, even with an /2.8.
Carefully designed optics, the internal mechanical
design of the barrel, and the use of T* coatings on all
lens element surfaces have resulted in very good
reduction of glass-to-glass and glass-to-film
reflection.

A precise mechanical design, a good feel and
smooth function of the focusing ring helps you in
arranging your photos. Internal focusing and the
0.22 m close range enable high-quality photos with
unusual perspectives.

The use of standard screw-on filters and the lens
shade included in the delivery package expand the
application possibilities of this lens.

Technical Specification

Focal length: 21 mm

Aperture range: /2.8 — /22

Number of elements/ groups: 16/ 13

Focusing range: 0.22 m — infinity

Image ratio at close range: 1:5

Coverage at close range: 18 cm x 12 cm

Angular field diag./horiz./vert.: 90°/ 81°/ 59°

Position of the entrance pupil: 24 mm behind the
front lens

Filter: M82 x 0.75

Weight: 620 g

Dimensions: dia. 87 mm, length incl. caps: 110 mm

Length from bayonet to front: 86mm

Sept 2008. Subject to change.

Carl Zeiss AG
Camera Lens Division
73446 Oberkochen

Tel: +49 (0) 7364 20-6175
Fax: +49 (0) 7364 20-4045
Email: photo@zeiss.de
www.zeiss.de/photo

We make it visible.



ANEXO 2: CERTIFICADOS



LEICA TCR307

Certificado de Verificacion y Control

N° de Certificado 300557022

Fecha 13.01.2009 Leica Geosystems, s.I.
Ibarrekolanda, 36

48015 Bilbao - Deusto
Teléfono +34 94 447 3104
Fax +34 94 447 3393
leica- tems.
UNIVERSIDAD DEL PAIS VASCO www.leica-geosystems.com

E.U.L.T. Ind. e Ing.Tec.Topog.

NIEVES CANO, 12
01006 VITORIA

SPANIEN
Namero de cliente 50198
Instrumento TCR307 rl.Taquimetro es.base, set
N° de Serie 681043
Técnico 110336

Proceso de Verificacion y Control:

El instrumento ha sido verificado y controlado conforme a los procedimientos establecidos
por Leica Geosystems, S.L. segin el manual del instrumento en cuestion.

Resultados:
Temperatura durante la verificaciéon (°C): 24

Entrada Tolerancia Salida Incertidumbre
Desviacion Hz (Gon) 0.0015 0.0020 0.0003 0.0007
Desviacién Vt (Gon) 0.0025 0.0020 0.0003 0.0008
Desviacion distancia (mm) 0.1 2mm+ 2ppm 0.1 0.1
(Distanciémetro infrarrojo)
Desviaciéon distancia (mm) 2.0 3mm+2 ppm 2.0 0.1

(Distanciémetro laser)

Patrones empleados:
Angulos:
Colimador de ejes: Wild n® 9694 (Incertidumbre asociado con el patrén: 0.0005 gon)

Distancia:

La base de distancias ha sido calibrada por el Centro Espafiol de
Metrologia con un taquimetro electrénico de 0,01 mm de resolucioén,
con trazabilidad a patrones nacionales

Comentarios:
Los resultados se refieren al momento y condiciones en que se efectuaronlas mediciones y
poseen trazabilidad a patrones nacionales o a patrones extranjeros

No se permite la reproduccién parcial de este certificado sin la aprobacién por escrito de
Leica Geosystems, s.l.
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LEICA TPS1205

Certificado de Verificacion y Control

N° de Certificado 300729234
Fecha 28.01.2011 Leica Geosystems, s.I.
Autov.Fuencarral-Alcobendas
Km 15'700, n° 24
Edif. Europa 1, Portal 3, 1°
28108 ALCOBENDAS (Madrid)
UNIVERSIDAD DEL PAIS VASCO o s a E ey
X (+34) 91 744 0741
E.U.LT. Ind. e Ing.Tec.Topog. www.leica-geosystems.com

NIEVES CANO, 12
01006 VITORIA

Niamero de cliente 50198

Instrumento TCR1205 R300, taquimetro + EDM sin ref.
N° de Serie 213379

Técnico 125458

Proceso de Verificacion y Control:

El instrumento ha sido verificado y controlado conforme a los procedimientos establecidos
por Leica Geosystems, S.L. segin el manual del instrumento en cuestién.

Resultados:
Temperatura durante la verificacién (°C): 24

Entrada Tolerancia Salida Incertidumbre
Desviacion Hz (Gon) 0.0020 0.0015 0.0015 0.0009
Desviacién Vt (Gon) 0.0022 0.0015 0.0015 0.0008
Desviacién distancia (mm) 1 Tmm + 1.5ppm 1 0.2
(Distanciémetro infrarrojo)
Desviaciéon distancia (mm) 2 2mm + 2ppm 2 1.3

(Distanciémetro laser)

Patrones empleados:
Angulos:
Colimador de ejes: Wild n® 10802 (Incertidumbre asociado con el patrén: 0.0005 gon)

Distancia:

La base de distancias ha sido calibrada por el Centro Espafiol de
Metrologia con un taguimetro electrénico de 0,01 mm de resolucién,
con trazabilidad a patrones nacionales

Comentarios:
Los resultados se refieren al momento y condiciones en que se efectuaron las mediciones y
poseen trazabilidad a patrones nacionales o a patrones extranjeros

No se permite la reproduccion parcial de este certificado sin la aprobaciéon por escrito de
Leica Geosystems, s.|. Este documento no tiene
caracter de calibracion.

Leica

www.leica-geosystems.com 171 - when it has to be right Geosystems



CANON EOS 5D MARK Il + OBJETIVO CANON 35 mm (PHOTOMODELER SCANNER)

Cameras in Project Name

Canon EOS 5D Mark I [35.00] Canon EOS 5D Mark Il [35.00]
[Default] Calibration Used by Photos
Canon EOS 5D Mark II [35.00] - Type hone
Idealized Calibrator
Image Size
Focal Length 4

—_— W: 5616 H: 3744
36.2662
- Fiducials
Format Size

W 36513 H: 24332 Type: | beiiduiotsm

Fiducials:  mm

Principal Point

[ Modify.. |
X 185434 . 121265 "

Lens Distortion Al ol

Ki: 7.284e005 P1: 29112006 Make: Canon
K2 64016008 P2 13536005 poget
K3 0.000e+000

Canon EOS 5D Mark
Il

Focal Length

[ New ] [ Delete J Calibration Quality Values 35.0000
Overall Residual RMS:  0.1596
[ Copy ] [ Set as Default ]

Maximun Residual: 0.6399 Format Size
|Loadfiomdisk... ||  Libraw.. |  PhotoCoverage (%} 94 W 37.0585 H: 243332

[ 0K ] l Cancel ] [ Help




CANON 5D MARK Il + OBJETIVO ZEISS 21 mm (PHOTOMODELER SCANNER)

Cameras in Proiect Name
Canon EOS 5D Mark II [21.00] Canon EOS 5D Mark Il [21.00]
[Default] Calibration Used by Photos
Canqn EOS 5D Mark I [21.00] - Type hone
Idealized Calibrator
Image Size
Focal Length

= W 5616 H: 3744
21.9875
Fiducials

Format Size -
W 36.5043 H: 243332 Type: __o iducials

Fiducials:  mm

Principal Point

(Modify.. |
% 183538 v: 121225 —

EXIF Fields
Make: Canon

Lens Distortion
K1: 2032e-004 P1: 4.746e-006

K2 -3621e007 P2 6547006 Model
K3: 0.000e+000

Canon EOS 5D Mark
Il

Focal Length

[ New ] [ Delete J Calibration Quality Values 21.0000
Overall Residual RMS:  0.2267

| Copy [ SetasDefaul |  \onumRescust 11770 Format Size
|Load fiomdisk... | | Libraw.. |  PhotoCoverage (% 92 W: 37.0586 H: 24.3332

[ 0K ] [ Cancel J [ Help




CANON EOS 5D MARK Il + OBJETIVO CANON 35 mm (IMAGE MASTER)

[ Lens Distortion Curve ]
Camera File Name: fmet15.cmr
Display Scale ( Lens Distortion ): 4.0

Jlh

Interior Orientation Parameters
Focal Length f: 35.148067 [mm)]
Principal Point Xp: 17.952983 [mm]
Principal Point Yp: 11.801403 [mm]

Lens Distortion Parameters
Radial Distortion K1: 7.816239e-005
Radial Distortion K2: -7.163985e-008
Tangential Distortion P1: 1.107042e-005
Tangential Distortion P2: -1.804244e-005

Pixel Size Xr: 6.3 [um]
Pixel Size Yr: 6.3 [um]

Max of Before Correction: 53.173 [Pixel]

Black Line: Ideal Value
Red Line: Before Correction



CANON 5D MARK Il + OBJETIVO ZEISS 21 mm (IMAGE MASTER)

[ Lens Distortion Curve ]
Camera File Name: fmet16.cmr
Display Scale ( Lens Distortion ): 4.0

Interior Orientation Parameters
Focal Length f: 21.009384 [mm)]
Principal Point Xp: 17.553642 [mm)]
Principal Point Yp: 11.534916 [mm]

Lens Distortion Parameters
Radial Distortion K1: 2.155644e-004
Radial Distortion K2: -4.245722e-007
Tangential Distortion P1: -7.434786e-006
Tangential Distortion P2: -1.130067e-005

Pixel Size Xr: 6.2 [um]
Pixel Size Yr: 6.2 [um]

Max of Before Correction: 37.937 [Pixel]

Black Line: Ideal Value
Red Line: Before Correction



ANEXO 3: DESCRIPCION DEL SOFTWARE UTILIZADO



DESCRIPCION DE LOS SOFTWARE UTILIZADOS

PHOTOMODELER SCANNER 6

Los propios creadores definen su programa de la siguiente forma: “Photomodeler Scanner te
provee de las herramientas para crear precisos modelos 3D de alta calidad y medidas a partir
de las fotografias” (www.photomodeler.com).

Version 6

© Eos Systems Inc, 1992 - 2008
This program is protected by copyright law and international treaties.

Photomodeler Scanner se trata de un software que permite la elaboracion de modelos
digitales en tres dimensiones a partir de las fotografias estereoscdpicas digitales de un objeto.
A partir de este modelo 3D generado, existe la posibilidad de obtencidn de las ortofotos de los
elementos.

Photomodeler ha funcionado en las versiones anteriores con imagenes convergentes, pero en
Photomodeler Scanner se introduce una variacién; ya que se emplea la correlaciéon automatica
para la generacidon de las nubes de puntos, y es por esta razén por la que se requieren
imagenes mas parecidas entre si, de forma que se facilite este proceso automatico.

En el presente proyecto se ha utilizado para la generacion de nubes de puntos y mallas de las
zonas de riesgo documentadas, asi como para la obtencién de los modelos tridimensionales de
los elementos arquitectdnicos objeto de estudio del proyecto, como de las ortofotografias de
los mismos.

TOPCON IMAGE MASTER

Image Master se define a si mismo como: “Un software para realizar mediciones 3D a partir de
imagenes estereoscopicas, generar ortoimagenes y modelos 3D utilizando imagenes tomadas
por camaras digitales, que tienen cada vez mas pixeles y un precio mas econémico” (Manual
Image Master).



image Mas‘l'er

©2007 TOPCON All Rights Res

Image Master ha sido utilizado en nuestro caso para los mismos fines que Photomodeler: la
elaboracion de los modelos tridimensionales de los objetos a documentar, asi como para la
obtencién de ortofotografias. De esta forma, obteniendo los productos requeridos por ambas
metodologias, seremos capaces de elaborar una evaluacion de los dos software.

ORTHOWARE

Los responsables de la empresa creadora de Orthoware lo definen como: “Un potente
software fotogramétrico que permite generar ortofotografias de forma sencilla y rapida. Ha
sido disefiado para maximizar su potencial en trabajos de objeto cercano con tomas
convergentes” (Manual Orthoware).

ORTHOWARE ©

-(@ metria

Othoware es un software cuya finalidad es la obtencidon de ortofotografias a partir de
imdagenes convergentes.

No ha podido ser eficientemente utilizado debido a multiples problemas con los equipos
disponibles, en los cuales no se ha logrado hacer funcionar correctamente el programa.
Aunque si hemos sido capaces de crearnos una opinidén critica a partir del estudio de sus
caracteristicas, de la experiencia parcial en su proceso y de una demostracion realizada por un
responsable de la empresa creadora.

RAPIDFORM



Los documentos publicitarios de este software lo describe de la siguiente manera:
“Rapidform® XOS™/Scan ofrece es el primer programa del mundo que ofrece un procesado de
datos de escaneado totalmente automatizado”, “Rapidform XOS es el programa de ingenieria
inversa mas recomendable para trabajos con operaciones sobre nubes de puntos, mallas,
mallas texturizadas, curvas y superficie en un entorno integrado”, “Rapidform XOS admite
sobradamente todas las formas de trabajo de ingenieria inversa a partir de datos de escaneado
3D” (www.rapidform.com).

X0O0Ss
RAPIDFORM® XOS/SCAN™
t E . v

)
Copyright © INUS Technology, Inc. All rights reserved. | www.rapidform.com RAPIDFORM

En nuestro caso especifico, aunque no se ha podido estudiar a fondo todas las posibilidades
gue nos ofrece, nos es Util para el tratamiento de nubes de puntos y mallas, para unién de las
mismas y para la extraccion de las secciones de mayor interés de los elementos
documentados.

MESHLAB

La pagina de MeshLab define su software de la siguiente forma: “MeshlLab es un cdédigo
abierto portatil y extensible para el sistema de procesamiento y edicién de mallas triangulares
3D no estructuradas. El sistema estd destinado a la transformacion de los modelos tipicos no
estructurados y no tan pequefios que surgen en la digitalizacién en 3D, proporcionando un
conjunto de herramientas para la edicion, la limpieza, la inspeccidn, la representacién y la
conversion de este tipo de mallas” (meshlab.sourceforge.net).

MeshLab



En definitiva MeshLab es un software abierto creado por los alumnos la Universidad de Pisa, el
cual se puede utilizar para la edicién de mallas y nubes de puntos, pudiendo ser descargado de
la web gratuitamente.

En nuestro caso utilizamos MeshLab para el analisis somero de las posibilidades que nos ofrece
para la creacidn de superficies a partir de nubes de puntos, y como herramienta de difusion e
intercambio de nubes de puntos y mallas.

AUTOCAD 2002 Y 2008

Autodesk AutoCAD es un programa de disefio asistido por ordenador para dibujo en dos y tres
dimensiones. Desarrollado y comercializado por la empresa Autodesk.

AutoCAD

En este proyecto ha sido utilizado para el analisis de la precisidn de las ortofotografias, para la
gestidn de las secciones obtenidas de los muros y para la elaboracién de los planos, entre otras
tareas.


http://es.wikipedia.org/wiki/Software
http://es.wikipedia.org/wiki/Dise%C3%B1o_asistido_por_computadora
http://es.wikipedia.org/wiki/Gr%C3%A1ficos_3D_por_computadora
http://es.wikipedia.org/wiki/Gr%C3%A1ficos_3D_por_computadora
http://es.wikipedia.org/wiki/Gr%C3%A1ficos_3D_por_computadora
http://es.wikipedia.org/wiki/Autodesk

ANEXO 4: RESENAS DE ESTACIONES



RESENA DE ESTACION INVERSA

Proyecto:
Documentacion de las zonas de riesgo del Monasterio de San Prudencio
Nombre de estacion: Fecha:
INVO1 30 de Marzo de 2011
Tipo de orientacidn: COORDENADAS DE LA ESTACION
Interseccion inversa UTM 30 -ETRS89 Cota ortométrica
X (m): 548275,265
Lugar: Y (m): 4688492,081
Clavijo (La Rioja) Z(m): 710,918

Reseiia literal:
Estacion inversa sin materializar, calculada a partir de las coordenadas de las dianas medidas
previamente para el apoyo fotogramétrico. Ubicada en la zona norte del muro "P".

Puntos utilizados en la interseccion inversa
Diana X (m) Y (m) X (m)
792 548270,731 | 4688492,543| 711,894
793 548270,822 |4688494,894| 712,894
794 548273,179 | 4688495,052| 712,643
795 548271,617 |4688494,976| 713,518

.

i i 2

"

Precision:
Punto de comprobacion: X (m): Y (m): Z(m):
BM10 0,003 0,007 0,004

Notas:
Interseccion a partir de dianas colocadas Unicamente para tal efecto. Se toman los puntos del
pafio sur del muro "P".




RESENA DE ESTACION INVERSA

Proyecto:
Documentacion de las zonas de riesgo del Monasterio de San Prudencio
Nombre de estacion: Fecha:
INV02 30 de Marzo de 2011
Tipo de orientacidn: COORDENADAS DE LA ESTACION
Interseccion inversa UTM 30 -ETRS89 Cota ortométrica
X (m): 548270,710
Lugar: Y (m): 4688481,303
Clavijo (La Rioja) Z(m): 710,908

Reseiia literal:
Estacion inversa sin materializar, calculada a partir de las coordenadas de las dianas medidas
previamente para el apoyo fotogramétrico. Ubicada al este de la iglesia entre los muros "P" y "R".

Puntos utilizados en la interseccion inversa
Diana X (m) Y (m) X (m)
705 548271,381 | 4688488,652| 714,198
706 548275,646 |4688488,856| 711,499
732 548279,876 | 4688477,625| 714,757
739 548285,386 |4688478,410| 713,711

Precision:
Punto de comprobacion: X (m): Y (m): Z(m):
BM10 -0,004 -0,007 0,004

Notas:
Se toman los puntos visibles del muro "P" y el pafio oeste del muro "R".




RESENA DE ESTACION INVERSA

Proyecto:
Documentacion de las zonas de riesgo del Monasterio de San Prudencio
Nombre de estacion: Fecha:
INVO3 30 de Marzo de 2011
Tipo de orientacidn: COORDENADAS DE LA ESTACION
Interseccion inversa UTM 30 -ETRS89 Cota ortométrica
X (m): 548240,057
Lugar: Y (m): 4688488,736
Clavijo (La Rioja) Z(m): 709,490

Reseiia literal:
Estacion inversa sin materializar, calculada a partir de las coordenadas de las dianas medidas
previamente para el apoyo fotogramétrico. Ubicada al norte de la iglesia entre el muro norte
y eI IIJII

Puntos utilizados en la interseccion inversa
Diana X (m) Y (m) X (m)
724 548271,537 | 4688488,716| 715,134
727 548271,253 | 4688489,645| 713,820
785 548243,430 | 4688484,923| 711,896
789 548247,173 | 4688485,157| 711,160

2

e e AT 7“8“;-(".5-‘ ’ “

Precision:

Punto de comprobacion: X (m): Y (m): Z(m):

Notas:
Se toman los puntos visibles del muro ")" y del muro norte de la iglesia por la parte exterior.




RESENA DE ESTACION INVERSA

Proyecto:
Documentacion de las zonas de riesgo del Monasterio de San Prudencio
Nombre de estacion: Fecha:
INV0O4 30 de Marzo de 2011
Tipo de orientacidn: COORDENADAS DE LA ESTACION
Interseccion inversa UTM 30 -ETRS89 Cota ortométrica
X (m): 548245,828
Lugar: Y (m): 4688483,205
Clavijo (La Rioja) Z(m): 704,709

Reseiia literal:
Estacion inversa sin materializar, calculada a partir de las coordenadas de las dianas medidas
previamente para el apoyo fotogramétrico. Ubicada en el interior de la iglesia proxica al muro
norte.

Puntos utilizados en la interseccion inversa
Diana X (m) Y (m) X (m)
796 548238,170 | 4688482,369| 706,863
797 548237,916 |4688479,499| 705,293
798 548238,026 |4688479,147| 706,513
799 548247,901 |4688477,169| 705,777

Precision:

Punto de comprobacion: X (m): Y (m): Z(m):

Notas:
Se toman los puntos del arco y del muro sur.




RESENA DE ESTACION INVERSA

Proyecto:

Documentacion de las zonas de riesgo del Monasterio de San Prudencio

Nombre de estacion: Fecha:

10 de Marzo de 2011

BM10

COORDENADAS DE LA ESTACION

Tipo de orientacidn:

UTM 30 -ETRS89 Cota ortométrica

Coordenadas conocidas
X (m): 548285,647
Lugar: Y (m): 4688485,310
Clavijo (La Rioja) Z(m): 712,009

Reseia literal:

Estaca de madera con un clavo de acero, en la zona sur del munasterio frente al muro "R".

Punto orientacion: Valores al estacionar (a ref.):
BM11 Hz: 320,1555
V: 83,9880
Referencia: Valores al final (a ref.):
Diana 710 Hz: 320,1575
V: 83,9895

Croquis referencia:

En el pafio este del muro "P".

Precision:

X (m):

Y (m):

Z(m):

Punto de comprobacion:

Notas:

Se toman los puntos visibles del muro "P" y los del pafio norte del muro "R".




RESENA DE ESTACION INVERSA

Proyecto:

Documentacion de las zonas de riesgo del Monasterio de San Prudencio

Nombre de estacion:
BM11

Fecha:
30 de Marzo de 2011

Tipo de orientacidn:
Coordenadas conocidas

COORDENADAS DE LA ESTACION

UTM 30 -ETRS89 Cota ortométrica

Lugar:
Clavijo (La Rioja)

X (m): 548254,571
Y (m): 4688489,600
Z(m): 708,973

Reseia literal:

Estaca de madera con un clavo de acero, en la zona al norte de la iglesia.

Punto orientacion:
BM10

Valores al estacionar (a ref.):

Referencia:

Diana 724

Hz: 103,3125
V: 83,1880
Valores al final (a ref.):
Hz: 103,3120
V: 83,1910

Croquis referencia:

En el pafio oeste del muro "R".

Punto de comprobacion:
BMO09

Precision:
X (m): Y (m): Z(m):
-0,007 0,008 -0,006

Notas:

Se toman los puntos que faltaban del muro "R" y del muro "P".




PROGRAMA INTENSIVO ERASMUS
Documentacién Geométrica del

Patfrimonio

Integracion europea de tecnologias

Monasterio de San Prudencio del Monte
Laturce (La Rioja), 2009/10

INTENSIVE ERASMUS PROGRAM

Geometric Documentation of Heritage: European

integration of technologies

Coordenadas / Coordinates:

Anamorfosis / Anamorphosis:

Mean sea level) :

Estacion /
Benchmark: BM10 UTM 30 - ETRS89 0,999629
Fecha / Date: 2010-05-11 X/ Easting : | 548285,647
Municipio / . o
Town Council Clavijo Y / Northing : | 4688485,310
Provincia / Province: La Rioja Z (Ortométrica / 712,009

Resefia literal: Estaca de madera con clavo de acero incrustado, situada sobre un pequefio
monticulo, en el extremo oeste, del muro sur de cierre del edificio que contiene las celdas.
Description: Stainless steel nail on a wooden stake, at the west extreme of the south wall that

include the cell’s building.




INTENSIVE ERASMUS PROGRAM

Geometric Documentation of Heritage: European
integration of technologies

PROGRAMA INTENSIVO ERASMUS
Documentacién Geométrica del
Patfrimonio

Integracion europea de tecnologias

ey

Yy

Monasterio d San Puncio del Monte
Laturce (La Rioja), 2009/10

Estacion / BM11 Coordenadas / Coordinates: Anamorfosis / Anamorphosis:
Benchmark: UTM 30 - ETRS89 0,999629
Fecha / Date: 2010-05-11 X/ Easting : | 548254,571
Municipio / . o
Town Council Clavijo Y / Northing : | 4688489,600
Provincia / Province: La Rioja Z (Ortometrica / 708,973
Mean sea level) :

Resena literal: Estaca de madera con clavo de acero incrustado, situada al norte del muro norte

de cierre de la iglesia.
Description: Stainless steel nail on a wooden stake, at the north of the north wall that include the

church.




PROGRAMA INTENSIVO ERASMUS
Documentacién Geométrica del

Patfrimonio

Integracion europea de tecnologias

Monasterio de S‘an.‘PrUde)ncio del Monte
Laturce (La Rioja), 2009/10

INTENSIVE ERASMUS PROGRAM

Geometric Documentation of Heritage: European

integration of technologies

Estacion / BM13 Coordenadas / Coordinates: Anamorfosis / Anamorphosis:
Benchmark: UTM 30 - ETRS89 0,999629
Fecha / Date: 2010-05-11 X/ Easting : | 548226,258
Municipio / . o
Town Council Clavijo Y / Northing : | 4688493,320
Provincia / Province: La Rioja Z (Ortometrlca{ 707,259
Mean sea level) :

extremo oeste.

Resefa literal: Estaca de madera con clavo de acero incrustado, dentro del yacimiento, en el

Description: Stainless steel nail on a wooden stake, inside the site, at the west extreme.




ANEXO 5: RESENAS DEL APOYO



RESENA PUNTOS DE APOYO FOTOGRAMETRICO

Proyecto: Documentacién geométrica de las zonas de riesgo del Monasterio de San Prudencio (Clavijo) Zona: Arco de la Iglesia
Lugar: Monasterio de San Prudencio (Clavijo) |Fecha toma del apoyo: 19- 04 - 2011 Estacion Total: Leica TCR307
PUNTOS DE APOYO
PUNTO X (m) Y (m) X (m)

3 548238,039 (4688483,921| 704,868
42 548237,901 |4688478,716 704,740
734 548238,041 (4688484,534| 707,186
796 548238,170 (4688482,369| 706,863
797 548237,916 (4688479,499| 705,293
798 548238,026 (4688479,147| 706,513
832 548238,171 (4688483,724| 706,246
833 548238,723 (4688484,331| 706,226
836 548237,961 (4688484,141| 708,571
837 548237,937 (4688484,068| 709,585
838 548238,017 (4688483,341| 707,987
840 548238,068 (4688482,246| 707,691
841 548238,018 (4688482,680| 705,608
842 548237,987 (4688481,344| 706,535
843 548238,130 (4688481,306| 707,272
844 548237,975 (4688480,282| 707,408
845 548237,954 |4688478,344 705,985
901 548237,886 (4688478,610| 702,576
902 548238,099 (4688477,782| 702,525
903 548238,144 (4688477,871| 704,061

Notas:
El punto en azul es un punto mal medido por lo que no se muestran sus coordenadas.




RESENA PUNTOS DE APOYO FOTOGRAMETRICO

Proyecto: Documentacién geométrica de las zonas de riesgo del Monasterio de San Prudencio (Clavijo)

Zona: Muro "R" pafo norte

Lugar: Monasterio de San Prudencio (Clavijo)

|Fecha toma del apoyo: 10- 03 - 2011

Estacion Total: Leica TPS1205

PUNTOS DE APOYO
PUNTO X (m) Y (m) X (m)
731 548277,663 |4688477,712 714,011
732 548279,876 |4688477,625 714,757
733 548281,438 |4688477,618| 714,848
734 548277,807 |4688477,547 711,210
735 548279,685 |4688477,639| 712,224
737 548282,456 |4688477,697| 713,848
738 548283,908 |4688477,762| 714,162
739 548285,386 (4688478,410| 713,711
740 548282,514 |4688477,714 712,753
741 548283,740 |4688477,785 712,888
742 548285,432 |4688478,487| 712,691
744 548283,798 |4688477,769 710,714
811 548281,666 |4688477,698| 711,566
812 548282,440 |4688477,695 710,792
1 548277,775 |4688477,706 714,203
2 548281,734 |4688477,671 714,058
3 548281,488 |4688477,684 711,702
4 548277,677 |4688477,520 712,220
5 548279,457 | 4688477,499 717,923
6 548281,966 |4688477,609 716,619
7 548285,025 |4688478,310( 713,198

Notas:

Los puntos magenta son puntos naturales.

El punto en azul es un punto mal medido por lo que no se muestran sus coordenadas.




RESENA PUNTOS DE APOYO FOTOGRAMETRICO

Proyecto: Documentacién geométrica de las zonas de riesgo del Monasterio de San Prudencio (Clavijo) Zona: Muro "R" pafo norte

Lugar: Monasterio de San Prudencio (Clavijo) |Fecha toma del apoyo: 10 - 03 - 2011 Estacion Total: Leica TPS1205

1: Punto negro en la piedra. Notas:

2: Esquina de la zona clara. Puntos naturales para ser utilizados
3: Esquina izquierda formada por la grieta. como comprobacién.

4: Esquina superior derecha de la piedra. Maracados también en la resefia

5: Mancha blanca entre las dos piedras. anterior de forma general.

6: Esquina inferior derecha de la piedra.

7: Esquina inferior izquierda del ladrillo.




RESENA PUNTOS DE APOYO FOTOGRAMETRICO

Proyecto: Documentacién geométrica de las zonas de riesgo del Monasterio de San Prudencio (Clavijo)

Lugar: Monasterio de San Prudencio (Clavijo) |Fecha toma del apoyo: 30-03 - 2011 |Estaci6n Total: Leica TCR307
PUNTOS DE APOYO
PUNTO X (m) Y (m) X (m)
752 548277,446 |4688476,625 714,251
753 548277,460 |4688477,408 714,200
754 548277,485 |4688476,611| 712,535
755 548277,494 |4688477,327 712,531
756 548277,531 |4688476,307| 709,468
757 548277,547 |4688477,363 709,544

Notas:




ANEXO 6: TABLAS DE ERRORES



TABLA DE ERRORES DEL MODELO DEL ARCO OBTENIDO POR IMAGE MASTER

NP X diana (m) | Y diana (m) | Z diana (m) | X modelo (m) | Y modelo (m) | Z modelo (m) | Distancia en X (m) | DistanciaenY (m) | DistanciaenZ (m) | Distancia (m) | Dist. abs X (m) | Dist. absY (m) | Dist. abs Z (m)
3 8238,039 8483,921 704,868 8238,027 8483,919 704,872 0,012 0,002 -0,004 0,013 0,012 0,002 0,004
42 8237,901 8478,716 704,740 8237,888 8478,712 704,743 0,013 0,004 -0,003 0,014 0,013 0,004 0,003
796 8238,170 8482,369 706,863 8238,178 8482,374 706,863 -0,008 -0,005 0,000 0,010 0,008 0,005 0,000
797 8237,916 8479,499 705,293 8237,912 8479,506 705,296 0,004 -0,007 -0,003 0,008 0,004 0,007 0,003
798 8238,026 8479,147 706,513 8238,024 8479,154 706,518 0,002 -0,007 -0,005 0,007 0,002 0,007 0,005
832 8238,171 8483,724 706,246 8238,166 8483,721 706,248 0,005 0,003 -0,002 0,006 0,005 0,003 0,002
833 8238,723 8484,331 706,226 8238,740 8484,326 706,225 -0,017 0,005 0,001 0,018 0,017 0,005 0,001
834 8238,041 8484,534 707,186 8238,047 8484,535 707,186 -0,006 -0,001 0,000 0,006 0,006 0,001 0,000
838 8238,017 8483,341 707,987 8238,015 8483,343 707,992 0,002 -0,002 -0,005 0,003 0,002 0,002 0,005
840 8238,068 8482,246 707,691 8238,066 8482,244 707,693 0,002 0,002 -0,002 0,003 0,002 0,002 0,002
841 8238,018 8482,680 705,608 8238,013 8482,676 705,610 0,005 0,004 -0,002 0,007 0,005 0,004 0,002
842 8237,987 8481,344 706,535 8237,987 8481,343 706,536 0,000 0,001 -0,001 0,001 0,000 0,001 0,001
843 8238,130 8481,306 707,272 8238,133 8481,305 707,270 -0,003 0,001 0,002 0,004 0,003 0,001 0,002
844 8237,975 8480,282 707,408 8237,978 8480,281 707,410 -0,003 0,001 -0,002 0,003 0,003 0,001 0,002
845 8237,954 8478,344 705,985 8237,951 8478,341 705,990 0,003 0,003 -0,005 0,005 0,003 0,003 0,005
901 8237,886 8478,610 702,576 8237,868 8478,602 702,573 0,018 0,008 0,003 0,020 0,018 0,008 0,003
902 8238,099 8477,782 702,525 8238,114 8477,790 702,529 -0,015 -0,008 -0,004 0,017 0,015 0,008 0,004
903 8238,144 8477,871 704,061 8238,140 8477,869 704,063 0,004 0,002 -0,002 0,005 0,004 0,002 0,002
Magenta Puntos no utilizados en la generacion del modelo.
Verde Puntos utilizados en la generacién del modelo.
Dist. abs X (m) | Dist. abs Y (m) | Dist. abs Z (m) | Distancia (m)
* Punto origen E max (m) 0,018 0,008 0,005 0,020
E min (m) 0,000 0,001 0,000 0,001
Puntos Distancia Puntos Distancia E medio (m) 0,007 0,004 0,008 0,008
3 0,013 840 0,003 desv. Est. (m) 0,009 0,005 0,002 0,006
42 0,014 841 0,007
796 0,010 842 0,001
797 0,008 843 0,004
798 0,007 844 0,003
832 0,006 845 0,005
833 0,018 901 0,020
834 0,006 902 0,017
838 0,003 903 0,005




TABLA DE ERRORES DEL MODELO DEL ARCO OBTENIDO POR PHOTOMODELER

NP X diana (m) | Y diana (m) | Z diana (m) | X modelo (m) | Y modelo (m) | Z modelo (m) | Distancia en X (m) | DistanciaenY (m) | DistanciaenZ (m) | Distancia (m) | Dist. abs X (m) | Dist. absY (m) | Dist. abs Z (m)
3 8238,039 8483,921 704,868 8238,037 8483,918 704,871 0,002 0,003 -0,003 0,005 0,002 0,003 0,003
42 8237,901 8478,716 704,740 8237,902 8478,720 704,741 -0,001 -0,004 -0,001 0,004 0,001 0,004 0,001
796 8238,170 8482,369 706,863 8238,177 8482,374 706,861 -0,007 -0,005 0,002 0,009 0,007 0,005 0,002
797 8237,916 8479,499 705,293 8237,920 8479,509 705,294 -0,004 -0,010 -0,001 0,011 0,004 0,010 0,001
798 8238,026 8479,147 706,513 8238,027 8479,156 706,514 -0,001 -0,009 -0,001 0,009 0,001 0,009 0,001
832 8238,171 8483,724 706,246 8238,171 8483,720 706,247 0,000 0,004 -0,001 0,004 0,000 0,004 0,001
833 8238,723 8484,332 706,226 8238,729 8484,332 706,227 -0,006 0,000 -0,001 0,006 0,006 0,000 0,001
834 8238,041 8484,534 707,186 8238,042 8484,537 707,186 -0,001 -0,003 0,000 0,003 0,001 0,003 0,000
838 8238,017 8483,341 707,987 8238,016 8483,343 707,985 0,001 -0,002 0,002 0,002 0,001 0,002 0,002
840 8238,068 8482,246 707,691 8238,067 8482,244 707,689 0,001 0,002 0,002 0,002 0,001 0,002 0,002
841 8238,018 8482,680 705,608 8238,016 8482,676 705,610 0,002 0,004 -0,002 0,004 0,002 0,004 0,002
842 8237,987 8481,344 706,535 8237,985 8481,343 706,535 0,002 0,001 0,000 0,002 0,002 0,001 0,000
843 8238,130 8481,306 707,272 8238,129 8481,305 707,269 0,001 0,001 0,003 0,001 0,001 0,001 0,003
844 8237,975 8480,282 707,408 8237,975 8480,282 707,407 0,000 0,000 0,001 0,000 0,000 0,000 0,001
845 8237,954 8478,344 705,985 8237,955 8478,346 705,986 -0,001 -0,002 -0,001 0,002 0,001 0,002 0,001
901 8237,886 8478,610 702,576 8237,877 8478,606 702,574 0,009 0,004 0,002 0,010 0,009 0,004 0,002
902 8238,099 8477,782 702,525 8238,104 8477,782 702,523 -0,005 0,000 0,002 0,005 0,005 0,000 0,002
903 8238,144 8477,871 704,061 8238,147 8477,873 704,062 -0,003 -0,002 -0,001 0,004 0,003 0,002 0,001
Magenta Puntos no utilizados en la generacion del modelo.
Verde Puntos utilizados en la generacién del modelo.
Dist. abs X (m) | Dist. abs Y (m) | Dist. abs Z (m) | Distancia (m)
* Punto origen E max (m) 0,009 0,010 0,003 0,011
E min (m) 0,000 0,000 0,000 0,000
Puntos Distancia Puntos Distancia E medio (m) 0,003 0,003 0,005 0,005
3 0,005 840 0,002 desv. Est. (m) 0,004 0,004 0,002 0,003
42 0,004 841 0,004
796 0,009 842 0,002
797 0,011 843 0,001
798 0,009 844 0,000
832 0,004 845 0,002
833 0,006 901 0,010
834 0,003 902 0,005
838 0,002 903 0,004




TABLA DE ERRORES DEL MODELO DEL MURO “R” OBTENIDO POR IMAGE MASTER

NP X diana (m) | Y diana (m) | Z diana(m) | X modelo (m) | Y modelo (m) | Z modelo (m) | Distancia en X (m) | DistanciaenY (m) | Distancia enZ (m) | Distancia (m) | Dist. abs X (m) | Dist. absY (m) | Dist. abs Z (m)
731 8277,663 8477,712 714,011 8277,667 8477,717 714,010 -0,004 -0,005 0,001 0,007 0,004 0,005 0,001
732 8279,876 8477,625 714,757 8279,879 8477,630 714,755 -0,003 -0,005 0,001 0,006 0,003 0,005 0,001
733 8281,438 8477,618 714,848 8281,440 8477,622 714,848 -0,002 -0,004 0,000 0,005 0,002 0,004 0,000
734 8277,807 8477,547 711,210 8277,810 8477,552 711,211 -0,003 -0,005 -0,001 0,006 0,003 0,005 0,001
735 8279,685 8477,639 712,224 8279,688 8477,643 712,225 -0,003 -0,004 -0,001 0,005 0,003 0,004 0,001
811 8281,666 8477,698 711,566 8281,666 8477,702 711,565 0,000 -0,004 0,001 0,004 0,000 0,004 0,001
737 8282,456 8477,697 713,848 8282,456 8477,701 713,848 0,000 -0,004 0,000 0,004 0,000 0,004 0,000
738 8283,908 8477,762 714,162 8283,905 8477,767 714,161 0,003 -0,005 0,001 0,005 0,003 0,005 0,001
739 8285,386 8478,410 713,711 8285,383 8478,413 713,711 0,003 -0,003 -0,001 0,004 0,003 0,003 0,001
740 8282,514 8477,714 712,753 8282,514 8477,717 712,754 0,000 -0,003 -0,001 0,003 0,000 0,003 0,001
741 8283,740 8477,785 712,888 8283,739 8477,786 712,888 0,001 -0,001 0,000 0,002 0,001 0,001 0,000
742 8285,432 8478,487 712,691 8285,433 8478,487 712,692 -0,001 0,000 -0,001 0,001 0,001 0,000 0,001
812 8282,440 8477,695 710,792 8282,439 8477,700 710,793 0,001 -0,005 -0,001 0,005 0,001 0,005 0,001
744 8283,798 8477,769 710,714 8283,799 8477,769 710,715 -0,001 0,000 -0,001 0,001 0,001 0,000 0,001
1 8277,775 8477,706 714,203 8277,777 8477,711 714,202 -0,003 -0,005 0,001 0,006 0,003 0,005 0,001
2 8281,734 8477,671 714,058 8281,744 8477,675 714,059 -0,009 -0,004 -0,001 0,010 0,009 0,004 0,001
3 8281,488 8477,684 711,702 8281,496 8477,696 711,707 -0,008 -0,012 -0,006 0,014 0,008 0,012 0,006
4 8277,677 8477,520 712,220 8277,682 8477,527 712,219 -0,005 -0,007 0,001 0,008 0,005 0,007 0,001
5 8279,457 8477,499 717,923 8279,460 8477,504 717,924 -0,003 -0,005 -0,002 0,006 0,003 0,005 0,002
6 8281,966 8477,609 716,619 8281,978 8477,616 716,617 -0,012 -0,007 0,003 0,014 0,012 0,007 0,003
7 8285,025 8478,310 713,198 8285,020 8478,312 713,202 0,005 -0,002 -0,004 0,006 0,005 0,002 0,004
752 8277,446 8476,625 714,251 8277,440 8476,625 714,247 0,006 0,000 0,004 0,006 0,006 0,000 0,004
753 8277,460 8477,408 714,200 8277,459 8477,408 714,199 0,001 0,000 0,001 0,001 0,001 0,000 0,001
754 8277,485 8476,611 712,535 8277,486 8476,614 712,536 -0,001 -0,003 -0,001 0,003 0,001 0,003 0,001
755 8277,494 8477,327 712,531 8277,499 8477,327 712,534 -0,005 0,000 -0,003 0,005 0,005 0,000 0,003
756 8277,531 8476,307 709,468 8277,533 8476,311 709,470 -0,002 -0,004 -0,002 0,004 0,002 0,004 0,002
757 8277,547 8477,363 709,544 8277,551 8477,365 709,544 -0,004 -0,002 0,000 0,004 0,004 0,002 0,000
Magenta Puntos no utilizados en la generacién del modelo.
Verde Puntos utilizados en la generacién del modelo. Dist. abs X (m) | Dist. absY (m) | Dist. abs Z (m) | Distancia (m)
E max (m) 0,012 0,012 0,006 0,014
* Punto origen E min (m) 0,000 0,000 0,000 0,001
E medio (m) 0,003 0,004 0,001 0,005
desv. Est. (m) 0,004 0,003 0,004 0,003
Puntos Distancia Puntos Distancia Puntos Distancia
731 0,007 740 0,003 5 0,006
732 0,006 741 0,002 6 0,014
733 0,005 742 0,001 7 0,006
734 0,006 812 0,005 752 0,006
735 0,005 744 0,001 753 0,001
811 0,004 1 0,006 754 0,003
737 0,004 2 0,010 755 0,005
738 0,005 3 0,014 756 0,004
739 0,004 4 0,008 757 0,004




TABLA DE ERRORES DEL MODELO DEL MURO “R” OBTENIDO POR PHOTOMODELER

NP X diana (m) | Y diana(m) | Zdiana(m) | X modelo (m) | Y modelo (m) | Z modelo (m) | Distancia en X (m) | DistanciaenY (m) | DistanciaenZ (m) | Distancia (m) | Dist. abs X (m) | Dist. absY (m) | Dist. abs Z (m)
731 8277,663 8477,712 714,011 8277,663 8477,711 714,007 0,000 0,001 0,004 0,004 0,000 0,001 0,004
732 8279,876 8477,625 714,756 8279,876 8477,624 714,756 0,000 0,001 0,000 0,001 0,000 0,001 0,000
733 8281,438 8477,618 714,848 8281,437 8477,617 714,848 0,001 0,001 0,000 0,001 0,001 0,001 0,000
734 8277,807 8477,547 711,210 8277,807 8477,548 711,205 0,000 -0,001 0,005 0,001 0,000 0,001 0,005
735 8279,685 8477,639 712,223 8279,685 8477,640 712,221 0,000 -0,001 0,002 0,001 0,000 0,001 0,002
811 8281,666 8477,698 711,566 8281,666 8477,701 711,561 0,000 -0,003 0,005 0,003 0,000 0,003 0,005
737 8282,456 8477,697 713,848 8282,457 8477,695 713,849 -0,001 0,002 -0,001 0,002 0,001 0,002 0,001
738 8283,908 8477,762 714,162 8283,907 8477,761 714,163 0,001 0,001 -0,001 0,001 0,001 0,001 0,001
739 8285,386 8478,410 713,711 8285,386 8478,409 713,713 0,000 0,001 -0,002 0,001 0,000 0,001 0,002
740 8282,514 8477,714 712,753 8282,516 8477,713 712,753 -0,002 0,001 0,000 0,002 0,002 0,001 0,000
741 8283,740 8477,785 712,888 8283,740 8477,784 712,888 0,000 0,001 0,000 0,001 0,000 0,001 0,000
742 8285,432 8478,487 712,691 8285,430 8478,488 712,693 0,002 -0,001 -0,002 0,002 0,002 0,001 0,002
812 8282,440 8477,695 710,792 8282,440 8477,699 710,789 0,000 -0,004 0,003 0,004 0,000 0,004 0,003
744 8283,798 8477,769 710,714 8283,797 8477,771 710,714 0,001 -0,002 0,000 0,002 0,001 0,002 0,000
1 8277,774 8477,706 714,203 8277,775 8477,706 714,201 -0,001 0,000 0,002 0,001 0,001 0,000 0,002
2 8281,734 8477,671 714,058 8281,741 8477,679 714,057 -0,007 -0,008 0,001 0,011 0,007 0,008 0,001
3 8281,488 8477,684 711,702 8281,495 8477,695 711,703 -0,007 -0,011 -0,001 0,013 0,007 0,011 0,001
4 8277,677 8477,520 712,220 8277,678 8477,515 712,217 -0,001 0,005 0,003 0,005 0,001 0,005 0,003
5 8279,457 8477,499 717,923 8279,455 8477,506 717,919 0,002 -0,007 0,004 0,007 0,002 0,007 0,004
6 8281,966 8477,609 716,619 8281,971 8477,611 716,619 -0,005 -0,002 0,000 0,005 0,005 0,002 0,000
7 8285,025 8478,310 713,198 8285,023 8478,308 713,204 0,002 0,002 -0,006 0,003 0,002 0,002 0,006
752 8277,446 8476,625 714,251 8277,445 8476,627 714,254 0,001 -0,002 -0,003 0,002 0,001 0,002 0,003
753 8277,460 8477,408 714,200 8277,458 8477,410 714,203 0,002 -0,002 -0,003 0,003 0,002 0,002 0,003
754 8277,485 8476,611 712,535 8277,484 8476,612 712,537 0,001 -0,001 -0,002 0,001 0,001 0,001 0,002
755 8277,494 8477,327 712,531 8277,497 8477,326 712,534 -0,003 0,001 -0,003 0,003 0,003 0,001 0,003
756 8277,531 8476,307 709,468 8277,529 8476,306 709,471 0,002 0,001 -0,003 0,002 0,002 0,001 0,003
757 8277,547 8477,363 709,544 8277,550 8477,358 709,544 -0,003 0,005 0,000 0,006 0,003 0,005 0,000
Magenta Puntos no utilizados en la generacién del modelo.
Verde Puntos utilizados en la generacion del modelo. Dist. abs X (m) | Dist. abs Y (m) | Dist. abs Z (m) | Distancia (m)
E max (m) 0,007 0,011 0,006 0,013
* Punto origen E min (m) 0,000 0,000 0,000 0,001
E medio (m) 0,002 0,003 0,002 0,003
desv. Est. (m) 0,003 0,004 0,003 0,002
Puntos Distancia Puntos Distancia Puntos Distancia
731 0,004 740 0,002 5 0,007
732 0,001 741 0,001 6 0,005
733 0,001 742 0,002 7 0,003
734 0,001 812 0,004 752 0,002
735 0,001 744 0,002 753 0,003
811 0,003 1 0,001 754 0,001
737 0,002 2 0,011 755 0,003
738 0,001 3 0,013 756 0,002
739 0,001 4 0,005 757 0,006




TABLA DE ERRORES DE LA ORTOFOTO DEL ARCO OBTENIDA POR IMAGE MASTER

NP X diana (m) | Y diana (m) | X ortofoto (m) | Y ortofoto(m) | Distancia en X (m) | DistanciaenY (m) | Distancia (m) | Dist. abs X (m) | Dist. abs Y (m)
3 5,207 0,128 5,207 0,128 0,000 0,000 0,000 0,000 0,000
42* 0,000 0,000 0,000 0,000 0,000 0,000 0,000 0,000 0,000
796 3,659 2,123 3,658 2,121 0,001 0,002 0,003 0,001 0,002
797 0,783 0,553 0,792 0,553 -0,009 0,000 0,009 0,009 0,000
798 0,434 1,773 0,437 1,776 -0,003 -0,003 0,004 0,003 0,003
832 5,013 1,506 5,006 1,506 0,007 0,000 0,007 0,007 0,000
833 5,635 1,486 5,602 1,483 0,033 0,003 0,033 0,033 0,003
834 5,820 2,446 5,824 2,445 -0,005 0,001 0,005 0,005 0,001
838 4,626 3,247 4,632 3,250 -0,005 -0,003 0,006 0,005 0,003
840 3,533 2,951 3,531 2,953 0,002 -0,002 0,003 0,002 0,002
841 3,966 0,868 3,963 0,868 0,003 0,000 0,003 0,003 0,000
842 2,629 1,795 2,630 1,794 -0,001 0,001 0,001 0,001 0,001
843 2,595 2,532 2,588 2,529 0,007 0,003 0,008 0,007 0,003
844 1,567 2,668 1,568 2,669 -0,001 -0,001 0,001 0,001 0,001
845 -0,371 1,245 -0,375 1,247 0,005 -0,002 0,005 0,005 0,002
901 -0,106 -2,164 -0,109 -2,171 0,002 0,007 0,007 0,002 0,007
902 -0,928 -2,215 -0,928 -2,217 0,000 0,002 0,002 0,000 0,002
903 -0,838 -0,679 -0,849 -0,681 0,010 0,002 0,010 0,010 0,002
Azul Puntos utilizados para el escalado de la orofoto.
Magenta Puntos no utilizados en la generacion de la ortofoto. Dist. abs X (m) | Dist. abs Y (m) | Distancia (m)
Verde Puntos utilizados en la generacién de la ortofoto. E max (m) 0,033 0,007 0,033
E min (m) 0,000 0,000 0,000
* Punto origen E medio (m) 0,005 0,002 0,006
desv. Est. (m) 0,009 0,003 0,007
NP Distancia NP Distancia
796 0,003 841 0,003
797 0,009 842 0,001
798 0,004 843 0,008
832 0,007 844 0,001
833 0,033 845 0,005
834 0,005 901 0,007
838 0,006 902 0,002
840 0,003 903 0,010




TABLA DE ERRORES DE LA ORTOFOTO DEL ARCO OBTENIDA POR PHOTOMODELER

NP X diana (m) | Y diana (m) | X ortofoto (m) | Y ortofoto (m) | Distancia en X (m) | Distancia en Y (m) | Distancia(m) | Dabs X(m) | DabsY (m)
3 5,208 0,000 5,208 0,000 0,000 0,000 0,000 0,000 0,000
42 0,000 0,000 0,000 0,000 0,000 0,000 0,000 0,000 0,000
796 3,717 2,024 3,710 2,028 0,007 -0,004 0,008 0,007 0,004
797 0,805 0,533 0,797 0,534 0,008 -0,001 0,008 0,008 0,001
798 0,486 1,759 0,478 1,759 0,008 0,000 0,008 0,008 0,000
832 5,047 1,377 5,049 1,379 -0,002 -0,002 0,003 0,002 0,002
833 5,669 1,330 5,670 1,332 -0,001 -0,002 0,002 0,001 0,002
834 5,888 2,302 5,878 2,302 0,010 0,000 0,010 0,010 0,000
836 5,529 3,703 5,517 3,698 0,011 0,006 0,013 0,011 0,006
838 4,711 3,131 4,705 3,132 0,007 -0,001 0,007 0,007 0,001
840 3,604 2,859 3,605 2,861 0,000 -0,002 0,002 0,000 0,002
841 3,984 0,769 3,986 0,770 -0,002 -0,001 0,002 0,002 0,001
842 2,674 1,727 2,673 1,729 0,001 -0,002 0,002 0,001 0,002
843 2,656 2,459 2,657 2,463 -0,001 -0,004 0,004 0,001 0,004
844 1,633 2,625 1,633 2,627 0,001 -0,002 0,002 0,001 0,002
845 -0,340 1,252 -0,340 1,252 -0,001 0,000 0,001 0,001 0,000
901 -0,165 -2,164 -0,160 -2,160 -0,006 -0,004 0,007 0,006 0,004
902 -0,981 -2,201 -0,983 -2,196 0,002 -0,005 0,005 0,002 0,005
903 -0,857 -0,667 -0,855 -0,664 -0,002 -0,003 0,003 0,002 0,003
Azul Puntos utilizados para el escalado de la orofoto.
Magenta Puntos no utilizados en la generacion de la ortofoto. D abs X(m) | Dabs Y (m) | Distancia (m)
Verde Puntos utilizados en la generacién de la ortofoto. E max (m) 0,011 0,006 0,013
E min (m) 0,000 0,000 0,000
* Punto origen E medio (m) 0,004 0,002 0,005
desv. Est. (m) 0,005 0,002 0,004
NP Distancia NP Distancia
796 0,008 841 0,002
797 0,008 842 0,002
798 0,008 843 0,004
832 0,003 844 0,002
833 0,002 845 0,001
834 0,010 901 0,007
836 0,013 902 0,005
838 0,007 903 0,003
840 0,002




TABLA DE ERRORES DE LA ORTOFOTO DEL MURO R PANO NORTE OBTENIDA POR IMAGE MASTER

NP X diana (m) | Y diana (m) | X ortofoto (m) | Y ortofoto(m) | Distancia en X (m) | Distancia enY (m) | Distancia (m) | Dist. abs X (m) | Dist. abs Y (m)
731 4,793 0,162 4,793 0,162 0,000 0,000 0,000 0,000 0,000
732 2,580 0,908 2,578 0,910 0,002 -0,002 0,003 0,002 0,002
733 1,018 1,000 1,016 1,003 0,003 -0,003 0,004 0,003 0,003
734 4,649 -2,639 4,649 -2,638 0,000 -0,001 0,001 0,000 0,001
735 2,771 -1,625 2,769 -1,623 0,002 -0,002 0,003 0,002 0,002
811 0,790 -2,282 0,790 -2,283 0,000 0,001 0,001 0,000 0,001
737 0,000 0,000 0,000 0,000 0,000 0,000 0,000 0,000 0,000
738 -1,452 0,314 -1,449 0,312 -0,003 0,002 0,003 0,003 0,002
739 -2,928 -0,138 -2,930 -0,135 0,002 -0,003 0,003 0,002 0,003
740 -0,058 -1,096 -0,060 -1,094 0,002 -0,002 0,003 0,002 0,002
741 -1,283 -0,961 -1,285 -0,960 0,002 -0,001 0,002 0,002 0,001
742 -2,973 -1,157 -2,978 -1,155 0,005 -0,002 0,005 0,005 0,002
812 0,016 -3,056 0,016 -3,056 0,000 0,000 0,001 0,000 0,000
744 -1,342 -3,134 -1,343 -3,133 0,002 -0,001 0,002 0,002 0,001
1 4,682 0,354 4,682 0,355 0,000 -0,001 0,001 0,000 0,001
2 0,722 0,210 0,712 0,214 0,010 -0,004 0,010 0,010 0,004
3 0,968 -2,147 0,959 -2,143 0,009 -0,004 0,010 0,009 0,004
4 4,778 -1,629 4,775 -1,627 0,003 -0,002 0,004 0,003 0,002
5 2,998 4,074 2,997 4,081 0,002 -0,006 0,007 0,002 0,006
6 0,490 2,771 0,480 2,772 0,010 -0,001 0,010 0,010 0,001
7 -2,567 -0,651 -2,566 -0,645 0,000 -0,006 0,006 0,000 0,006
Azul Puntos utilizados para el escalado de la orofoto.
Magenta Puntos no utilizados en la generacion de la ortofoto. Dist. abs X (m) | Dist. abs Y (m) | Distancia (m)
Verde Puntos utilizados en la generacién de la ortofoto. E max (m) 0,010 0,006 0,010
E min (m) 0,000 0,000 0,000
* Punto origen E medio (m) 0,003 0,002 0,004
desv. Est. (m) 0,003 0,002 0,003
Puntos Distancia Puntos Distancia
732 0,003 812 0,001
733 0,004 744 0,002
734 0,001 1 0,001
735 0,003 2 0,010
811 0,001 3 0,010
738 0,003 4 0,004
739 0,003 5 0,007
740 0,003 6 0,010
741 0,002 7 0,006
742 0,005




TABLA DE ERRORES DE LA ORTOFOTO DEL MURO R PANO NORTE OBTENIDA POR PHOTOMODELER

NP X diana (m) | Y diana (m) | X ortofoto (m) | Y ortofoto(m) | Distancia en X (m) | Distancia enY (m) | Distancia (m) | Dist. abs X (m) | Dist. abs Y (m)
731 4,796 0,000 4,796 0,000 0,000 0,000 0,000 0,000 0,000
732 2,609 0,820 2,608 0,823 0,001 -0,002 0,003 0,001 0,002
733 1,052 0,965 1,051 0,967 0,000 -0,002 0,002 0,000 0,002
734 4,557 -2,795 4,557 -2,795 0,000 0,000 0,000 0,000 0,000
735 2,714 -1,718 2,715 -1,716 -0,001 -0,002 0,002 0,001 0,002
811 0,712 -2,308 0,714 -2,312 -0,002 0,004 0,004 0,002 0,004
737 0,000 0,000 0,000 0,000 0,000 0,000 0,000 0,000 0,000
739 -2,931 -0,039 -2,927 -0,039 -0,003 0,000 0,004 0,003 0,000
740 -0,095 -1,093 -0,094 -1,092 -0,001 -0,001 0,001 0,001 0,001
741 -1,315 -0,917 -1,313 -0,918 -0,002 0,001 0,003 0,002 0,001
742 -3,011 -1,057 -3,007 -1,056 -0,004 0,000 0,004 0,004 0,000
812 -0,087 -3,055 -0,082 -3,059 -0,006 0,004 0,007 0,006 0,004
744 -1,447 -3,087 -1,442 -3,088 -0,005 0,001 0,005 0,005 0,001
1 4,691 0,196 4,690 0,198 0,001 -0,002 0,002 0,001 0,002
2 0,728 0,186 0,722 0,185 0,006 0,000 0,006 0,006 0,000
3 0,895 2,178 0,888 -2,175 0,007 -0,003 0,007 0,007 0,003
4 4,720 -1,789 4,719 -1,787 0,001 -0,002 0,002 0,001 0,002
5 3,135 3,971 3,127 3,970 0,007 0,000 0,007 0,007 0,000
6 0,583 2,753 0,571 2,755 0,013 -0,002 0,013 0,013 0,002
Azul Puntos utilizados para el escalado de la orofoto.
Magenta Puntos no utilizados en la generacion de la ortofoto. Dist. abs X (m) | Dist. abs Y (m) | Distancia (m)
Verde Puntos utilizados en la generacién de la ortofoto. E max (m) 0,013 0,004 0,013
E min (m) 0,000 0,000 0,000
* Punto origen E medio (m) 0,003 0,001 0,004
desv. Est. (m) 0,005 0,002 0,003
Puntos Distancia Puntos Distancia
732 0,003 812 0,007
733 0,002 744 0,005
734 0,000 1 0,002
735 0,002 2 0,006
811 0,004 3 0,007
739 0,004 4 0,002
740 0,001 5 0,007
741 0,003 6 0,013
742 0,004




TABLA DE ERRORES DE LA ORTOFOTO DEL MURO R PANO OESTE OBTENIDA POR IMAGE MASTER

NP X diana (m) | Y diana (m) | X ortofoto (m) | Y ortofoto(m) | Distancia en X (m) | DistanciaenY (m) | Distancia (m) | Dist. abs X (m) | Dist. abs Y (m)
752 0,703 1,720 0,704 1,716 -0,001 0,004 0,004 0,001 0,004
0,000 0,002
0,000 0,001
755* 0,000 0,000 0,000 0,000 0,000 0,000 0,000 0,000 0,000
0,001 0,005
757 -0,037 -2,987 -0,037 -2,993 0,000 0,006 0,006 0,000 0,006
Azul Puntos utilizados como origen y punto base.
Puntos utilizados en la generacién de la ortofoto. Dist. abs X (m) | Dist. abs Y (m) | Distancia (m)
Cian Puntos base del escalado. E max 0,001 0,006 0,006
E min 0,000 0,000 0,000
* Punto origen E medio 0,000 0,003 0,003
desv. Est. 0,001 0,002 0,002
Puntos Distancia
752 0,004
757 0,006

TABLA DE ERRORES DE LA ORTOFOTO DEL MURO R PANO OESTE OBTENIDA POR PHOTOMODELER

NP X diana (m) | Y diana (m) | X ortofoto (m) | Y ortofoto(m) | Distancia en X (m) | DistanciaenY (m) | Distancia (m) | Dist. abs X (m) | Dist. abs Y (m)

0,003 0,000

0,004 0,001

0,000 0,001

755* 0,000 0,000 0,000 0,000 0,000 0,000 0,000 0,000 0,000

0,003 0,001

0,004 0,001

Azul Puntos utilizados como origen y punto base.
Puntos utilizados en la generacién de la ortofoto. Dist. abs X (m) | Dist. abs Y (m) | Distancia (m)
Puntos base del escalado. E max 0,004 0,001 0,000
E min 0,000 0,000 0,000
* Punto origen E medio 0,000 0,000 0,003
desv. Est. 0,003 0,001 0,002
Puntos Distancia




ANEXO 7: VALORACION ECONOMICA



ESTIMACION DEL RENDIMIENTO

La estimacion del rendimiento se realiza para los trabajos de documentacion de un paramento
vertical, de forma andloga a la realizada en el presente proyecto. La generacion de los modelos
se realiza con el software Topcon Image Master, ya que se ha designado como mas eficiente
en el analisis comparativo.

En la siguiente tabla, se indica el tiempo estimado para la elaboracion de cada una de las
tareas necesarias para la documentacién de un Unico paino de un paramento, por un equipo de
trabajo compuesto por dos ingenieros topdgrafos.

TAREA DURACION
Planificacion 1,5 horas
Ascenso al yacimiento 25 minutos
Establecimiento de la red de coordenadas 2 horas
Toma de fotografias 20 minutos
Medicidon del apoyo 30 minutos
Descenso desde el monasterio 25 minutos
Volcado de los datos 30 minutos
Identificacion de los puntos 20 minutos
Orientacién 5 minutos
Dibujado lineas de rotura 1 hora
Generacion del modelo 1,5 horas
Limpieza del modelo 1 hora
Generacion y exportacion de la ortofoto 20 minutos
Generacion de las secciones 30 minutos
Generacion de los planos 40 minutos

De la tabla anterior se deriva que el tiempo necesario estimado es de 11 horas y 5 minutos, de
las cuales 5 horas y 10 minutos son de trabajo en campo y 5 horas y 55 minutos de trabajo en
gabinete; pero hay que tener en cuenta que este valor es para el primero de los pafios.

Para los pafios sucesivos, el tiempo de planificacién no se trata de una progresion lineal, sino
que para cada pafio de mas se dedicara aproximadamente 20 minutos extra en el trabajo de
planificacién, y es obvio que el establecimiento de la red se realiza solamente una vez; asi
como el descenso y el descenso al Monasterio.

Por lo tanto, a partir del segundo pafio el tiempo estimado serd de 7 horas y 5 minutos, de las
cuales 1 hora y 10 minutos son de trabajo de campo y 5 horas y 55 minutos de trabajo en
gabinete.

DURACION DE LOS TRABAJOS A REALIZAR

El trabajo realizado en el proyecto consta de la documentacién de 2 muros compuestos en
total Unicamente por tres pafos; por lo tanto el tiempo total estimado necesario es de 25




horas y 15 minutos; consistentes en 7 horas y 30 minutos de trabajo en campo y 17 horas y 45
minutos de trabajo en oficina.

El desplazamiento hasta el yacimiento constard de dos trayectos (ida y vuelta), de 1 horay 30
minutos cada uno. Estas horas quedan fuera del horario laboral de 8 horas estipulado, por lo
que se tendran en cuenta como horas extra computandose en el calculo de las horas
trabajadas aplicando la correspondiente bonificacidn, segun lo indicado por el convenio
aplicado.

Finalmente, el cdmputo global de dias trabajados en las labores de documentacion descritas,
ascenderd a un total de 3,16 dias trabajados.

CALCULO DE HORAS TRABAJADAS (CONVENIO DE INGENIERIAS)

- Segun el articulo siguiente del Convenio, la jornada laboral ascendera a 1806 horas anuales.

Articulo 23. .Jornada laboral.

1. Durante el afio 2007, la jornada ordinaria maxima de trabajo efec-
tivo, en computo anual, sera de mil ochocientas diez (1.810) horas.

A partir del 1.° de enero de 2008 dicha jornada maxima anual sera de
mil ochocientas seis (1.806) horas.

La distribucion semanal de la jornada ordinaria anual podra pactarse
con los representantes de los trabajadores en la empresa, teniendo en
cuenta que, en ningun caso, se podran realizar mas de nueve horas ordi-
narias diarias de trabajo efectivo. De acuerdo con lo establecido en el
articulo 37.2 del Texto Refundido de la Ley del Estatuto de los Trabajado-
res, ninguna fiesta laboral sera recuperable.

BOE n? 130, Pdg. 25049 del Jueves 29 de Mayo de 2008; Articulo 23

Se ha fijado que el trabajador disfruta de 16 horas en permisos, y que trabaja a lo largo del afio
24 horas extra.

- Segun el Convenio, las horas extra se compensaran por tiempos de descanso equivalente mas
el 75 %.

4. Salvo pacto individual en contrario, las horas extraordinarias se
compensaran por tiempos equivalentes de descanso incrementados, al
menos, en el setenta y cinco por ciento. Previo acuerdo entre empresa y
trabajador, la compensacion con tiempo de descanso se hara acumulando
horas hasta completar, al menos, el tiempo equivalente a una jornada, que
se disfrutara dentro del mismo ano natural en que se hayan realizado las
horas extraordinarias o, como maximo, en la primera semana del mes de
enero siguiente.

BOE n® 130, Pdg. 25052 del Jueves 29 de Mayo de 2008; Articulo 36



A continuacién se calcula el total del nimero de horas trabajadas teniendo en cuenta las horas
de permisos, las horas extra y su compensacién y bonificacion:

1806 (Horas segun convenio)

-16 (Permisos)

1758

+24  (Horas extra)

-24  (Compensacién horas extra)

-18 (Bonificacién horas extra) (75%)
1772 horas



Mano de obra y empleados

Nivel 2 (Topografo)

PARTIDAS COTIZABLES

Salario 17.038,62 €
Antigiiedad 0,00 €
Plus convenio 2.048,90 €
Total cotizables 19.087,52 €

PARTIDAS NO COTIZABLES

1/2 dietas 0
Dieta completa 0
Seguro 300
Total no cotizables 300
TOTAL 26.430,81 €
€/HORA 14,92 €
€/ DIA 119,33 €

COTIZACION
Contingencias generales
Base 19.087,52 €
Tipo 0,236
Cuota 4.504,65 €
Accidente y enfermedad
Base 19.087,52 €
Tipo' 0,07
Cuota 1.336,13 €
FOGASA + Desempleo
Base 19.087,52 €
Tipo 0,063
Cuota 1.202,51 €
Total cotizacién 7.043,29 €

[cotizables + no cotizables + cotizacidn]

(1772 horas)
(8 horas diarias)

(B*T]

(B*T]

[B*T]
[C.G.+A.yE. +FOG]

1 Tipo de cotizacion estimado por accidente o enfermedad para un topdgrafo que trabaja habitualmente
en campo y por lo tanto esta mas expuestos a posibles accidentes.

Precios segun el Convenio de la Ingenieria 2008 y Revisidn Salarial 2009.

Sin antigliedad.

Instrumentos de Campo

Precio Cantidad
ET TPS1205 12.000,00 € 1 12.000,00 €
Tripode 385,00 € 1 385,00 €
Prisma 221,00 € 1 221,00 €
Jaléon 188,00 € 1 188,00 €
Bateria repuesto 214,00 € 1 214,00 €
TOTAL 13.008,00 €

Estacién Leica TPS1205. Incluye tarjeta de memoria, bateria y estuche.

Precio Cantidad
MARK I 1.999,00 € 1 1.999,00 €
Tarjeta memoria 115,00 € 2 230,00 €
Bateria repuesto 90,00 € 1 90,00 €
Bolsa 30,00 € 1 30,00 €
Canon 35 mm 100,00 € 1 100,00 €
Zeiss 21 mm 700,00 € 1 700,00 €
TOTAL 2.349,00 €
Cémara Canon EOS 5D Mark II.
Precio Cantidad
HIPER PRO GPS 23.395,53 € 1 23.395,53 €
Tripode 385,00 € 2 770,00 €
TOTAL 24.165,53 €

Topcon Hiper Pro GPS Base + Movil




Amortizacion instrumentos de Campo

ET TPS1205 MARK Il GPS HIPER PRO

P. Compra 13.008,00 € 2.349,00 € 24.165,53 €
P.Venta 1.000,00 € 300,00 € 2.500,00 €
Afos 6,67 6,67 6,67
Amortizacidn 1.800,30 € 307,20 € 3.248,21 €
Seguro (10%) 180,03 € 30,72 € 324,82 €
Rev. + Cert. 95,00 € 95,00 € 95,00 €
Reparaciones 150,00 € 80,00 € 100,00 €
€/ ANO 2.225,33 € 512,92 € 3.768,03 €
€/DIA 10,05 € 2,32 € 17,01 €

Total 29,37 €

[(P.C.-P.V.) / Al
[A*0,10]

+Rep.]
[P.C. + P.V + Am + S +Rev. +Por.
[(€/ANO) / 221,5]

El precio de la estacién incluye todo el material necesario para su uso (tripode, jalon, prisma,...).
Portes incluidos en el precio.
221,5 Dias de trabajo al afio

Coef. Max. (%) Coef. Min . (%) |Periodo min. Periodo max.
15 7,14 6,67 14
[100/ P. max.] [100 / P. min.]
Amortizacién material variado
Precio Cantidad Afios Amortizacion
Flexdmetro 11,00 € 2 2 11,00 €
Chaleco reflect. 15,00 € 3 2 22,50 €
Clavo 0,70 € 80 1 56,00 €
Estaca 0,27 € 30 1 8,10 €
Diana 0,70 € 1 1 0,70 €
Maceta 33,00 € 5 1 165,00 €
Pegadianas 100,00 € 2 250,00 €
Silicona 3,00 € 1 1 3,00 €
Teléfono movil' 35,00 € 11 1 385,00 €
Portatil 650,00 € 1 4 162,50 €
Internet movil’ 30,00 € 11 1 330,00 €
€/ ANO 1.393,80 €
€/DIA 6,29 €
1 Cuota mensual
221,5 Dias de trabajo al afio
Oficina
Ordenadores Software Imp. Multifunc. Ploter 2 Mobiliario 3
P. Compra 1.100,00 € 17.721,00 € 120,00 € 2.009,37 € 1.600,00 €
P. Venta 0,00 € 0,00 € 0,00 € 300,00 € 0,00 €
Afios 4,00 3,03 6,67 6,67 10
Amortizacién 275,00 € 5.847,93 € 18,00 € 256,41 € 160,00 €
TOTAL / ANO 6.557,34 €

[0+ S+ Imp + Plo + Mob]

1 Windows XP + Oficce 2007 + Autocad 2011 + Mdt + Image Master + Photomodeler + Rapidform
2 Ploter HP Desingjet T610 24"/ 610 mm
3 2 Escritorios, 1 Mesa de reuniones, 5 Sillas, 2 Estanterias, Papelera,...




Software

Windows 7 117,00 €
Oficce 2007 329,00 €
Autocad 2011 4.775,00 €
Image Master 1.500,00 €
Photomodeler Sc 2.000,00 €
Rapidform 9.000,00 €
TOTAL 17.721,00 €
Coef. Max. (%) |Coef. Min. (%) |Periodo min. Periodo max.
Ordenadores 25 12,50 4,00 8
[100/P.max.]  [100/P. min.]
Coef. Max. (%) |Coef. Min. (%) |Periodo min. Periodo max.
Ploter y Multifun. 15 7,14 6,67 14
[100/P.max.]  [100/P. min.]
Coef. Max. (%) |Coef. Min. (%) |Periodo min. Periodo max.
Software 33 16,67 3,03 6
[100/P.max.]  [100/P. min.]
Amortizacién vehiculo
FURGONETA
P. Compra 12.469,55 €
P. Venta 1.000,00 €
Afos 6,25
Amortizacion 1.835,13 €
Seguro 2.000,00 €
ITV 35,51 €
Impuesto Cir. 95,00 €
Coste Fijo 3.965,64 €J[A+S+ITV +IC] Consumo 7,5 1/100km
Combustible 3.241,88 € Combustible 1,235 €/I
Revisiones 335,00 € Uso 35000 km/afio
Neumaticos 436,00 € € / afio 3.241,88 €
Reparaciones 280,00 €
Coste Variable 4.292,88 €][C+ R+ N + Rep]
€/ ANO 8.258,51 €
€/DIA 36,58 €
€/KM 0,24 €]((€/ANO) / 45000 km]
CF/DIA 17,90 €][CF / 221,5]
CV/DIA 19,38 €][CV / 221,5]
CF/DIA+€ /KM 32,54 €][CF / DIA +((( 35000/221,5)/100)*7,5)*1,235]

Fiat Fiorino Cargo SX N1 1,3 Mjt 95CV Diesel.
Seguro a todo riesgo sin franquicia.
221,5 dias de trabajo al afio.

Coef. Max. (%) |Coef. Min. (%) |Periodo min. Periodo max.
16 7,14 6,25 14
[100/P.max.]  [100/P. min.]




Dietas, Horas extra y Desplazamientos

Dieta Dias Trabajadores TOTAL
|Dietas 10,00 € 1 2 20,00 €

€/Km Km Coches TOTAL
ICoche 0,24 € 180 1 42,47 €

[Media dieta | 10,00 €
| Documentacion paramentos verticales a 90 Km de Vitoria

Unidad €/dia Dias TOTAL
Topografos campo 2 119,33 € 238,65 €
Topografo oficina 1 119,33 € 2,2 262,52 €
Instrumentos 1 29,37 € 1 29,37 €
Material Variado 1 6,29 € 1 6,29 €
Dietas 20,00 €
Coches 42,47 €
Costes Directos 599,31 €
Oficina 29,05 € 2,2 63,90 €
Gastos Generales 63,90 €
CD + GG 663,21 €
Benef. Industrial 99,48 €
Imprevistos 66,32 €
TOTALSIN IVA 829,02 €
IVA 149,22 €
TOTAL 978,24 €

Imprevistos el 10%

Beneficio Industrial = 15%

IVA=18%

[Dieta * Dias * Trabajadores]

[€/Km * Km * Coches]



ANEXO 8: PLANOS



INDICE DE PLANOS

e Plano 1: Ortofotos muro “R” por Image Master

e Plano 2: Ortofotos muro “R” por Photomodeler

e Plano 3: Ortofoto Arco por Image Master

e Plano 4: Ortofoto Arco por Photomodeler

e Plano 5: Secciones verticales del Arco

e Plano 6: Secciones horizontales del Arco

e Plano 7: Secciones verticales muro “R" n21vy 2

e Plano 8: Secciones verticales muro “R” n23y4

e Plano 9: Seccion vertical muro “R” n25

e Plano 10: Secciones horizontales muro “R” n26vy 7
e Plano 11: Secciones horizontales muro “R” n28y 9
e Plano 12: Modelo muro “R” por Image Master

e Plano 13: Modelo muro “R” por Photomodeler

e Plano 14: Modelo Arco por Image Master

e Plano 15: Modelo Arco por Photomodeler
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Fecha: Julio 2011

N° de plano: 4

Proyecto: Documentacion y representacion de paramentos verticales en riesgo de
colapso. Aplicacién en el Monasterio de San Prudencio (Clavijo, La Rioja).
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Documento: SECCIONES HORIZONTALES DEL ARCO N° de plano: 6

Fecha: Julio 2011

Escala: 1/50
Autor: Pablo Ibafez de Elejalde Landa

Proyecto: Documentacion y representacion de paramentos verticales en riesgo de colapso. Aplicacion
en el Monasterio de San Prudencio (Clavijo, La Rioja).
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N° de plano: 10

Autor: Pablo Ibafez de Elejalde Landa

Fecha: Julio 2011

Escala: 1/50
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Autor: Pablo IbafRez de Elejalde Landa Fecha: Julio 2011

Proyecto: Documentacion y representacion de paramentos verticales en riesgo de colapso. Aplicacion
en el Monasterio de San Prudencio (Clavijo, La Rioja).
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ANEXO 9: CONTENIDO DEL CD ADJUNTO



CONTENIDO DEL DVD ADJUNTO

Con la presente memoria se proporciona un DVD adjunto con los datos utilizados para la
obtencidn de los productos, y los productos en si mismos.

En el DVD se adjunta la siguiente informacion:

- Las fotografias utilizadas para la generaciéon de los modelos 3D, en formato JPEG,
separadas por modelos y programa en las que se han utilizado.

- Las calibraciones de la camara con los dos objetivos utilizados, tanto para Image
Master como para Photomodeler.

- Llas series de fotografias que no han sido utilizadas, pero que se ha considerado que
pueden resultar mas utiles, de toda la galeria de imagenes tomadas en campo.
- Lamemoriay los anexos en formato PDF.

- Las imagenes de la caratula del DVD y del lomo del fichero tanto en formato PSD, de
Adobe Photoshop, como JPEG.

- Los modelos 3D, en formato VRML y DXF, de los muros de los cuales se han podido
obtener.

- Las ortoforografias en formato JPEG de todos los muros separadas por muros, por
pafios y por programas utilizados para obtenerlas.

- Los planos, tanto en formato PDF como DWG 2000/LT2000 (para evitar las
incompatibilidades), de todas las ortofotos, los modelos y las secciones obtenidas a
partir de los mismos.

Por dltimo a continuacion se presenta el esquema de la distribucidn de los ficheros en el DVD,
sirviendo este de indice para poder conocer rapidamente la ubicacién de cada uno de los
ficheros:

- Documentacion paramentos en riesgo
o Fotografias
= Imagenes utilizadas

e Arco Image Master (jpg)

e Arco Photomodeler (jpg)

e Calibraciones (jpg)
o fmet05 (jpg)
o fmet06 (jpg)
o fmetl5 (jpg)



- Memoria

o fmetl6(jpg)
e Muro R Image Master (jpg)
e Muro R Photomodeler (jpg)

e Arco serie 1 (jpg)

e Arco serie 2 (jpg)

e Muro R Convergentes (jpg)

e Muro R Estereoscoépicas (jpg)

Memoria (pdf)

(0]

Anexos (pdf)

o Caratula DVD (psdy jpg)

o Lomo memoria (psdy jpg)

- Productos

o Modelos 3D

VRML Arco IM (wrl)
VRML Arco PM (wrl)
VRML Muro R IM (wrl)
Arco IM (dxf)

Arco PM (dxf)

o Ortofotografias

Ortofoto arco por Image Master (jpg)
Ortofoto arco por Photomodeler (jpg)
Ortofoto muro R pafo norte por Image Master (jpg)
Ortofoto muro R pafio norte por Photomodeler (jpg)
Ortofoto muro R pafo oeste por Image Master (jpg)
Ortofoto muro R pafio oeste por Photomodeler (jpg)

1 Plano muro p norte + oeste IM (jpg y dwg)

2 Plano muro p norte + oeste PM (jpg y dwg)

3 Plano arco IM (jpg y dwg)

4 Plano arco PM (jpg y dwg)

5 Plano secciones verticales arco (jpg y dwg)

6 Plano secciones horizontales arco (jpg y dwg)

7 Plano secciones verticales muro R n2 1 —4 (dwg)

7 Plano secciones verticales muro Rn2 1y 2 (pdf)

8 Plano secciones verticales muro R n2 3 y 4 (pdf)

9 Plano seccion vertical muro R n2 5 (jpg y dwg)

10 Plano secciones horizontales muro R n2 6 y 7 (pdf)
10 Plano secciones horizontales muro R (dwg)

11 Plano secciones horizontales muro R n2 8 y 9 (pdf)
12 Plano modelo muro R IM (jpg y dwg)

13 Plano modelo muro R PM (jpg y dwg)

14 Plano modelo arco IM (jpg y dwg)

15 Plano modelo arco PM (jpg y dwg)
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